CHAMELEON™
NFS™
for Windows
TCP/IP Applications for Windows
Installation & User's Guide
Chameleon NFS for Windows
TCP/IP Applications for Microsoft Windows

Installation and User’s Guide
Version 4.6
ChameleonNFS for Windows, Version 4.6
Part number 102-46-0995
Copyright 1990-1995 NetManage Inc.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopied, recorded, or otherwise, without prior written permission from NetManage, Inc.

Automatic Internet, Chameleon, ChameleonNFS, Chameleon32NFS, Chameleon 32, Internet Chameleon, NETMANAGE, and NEWT are trademarks of NetManage, Inc. IBM PC/XT/AT and PS/2 are registered trademarks of International Business Machines Corporation. Sun is a registered trademark of Sun Microsystems, Inc. Microsoft Windows is a registered trademark of Microsoft Corporation. Post-it is a registered trademark of 3M. InPerson™ is a trademark of Silicon Graphics, Inc. Sound Blaster is a trademark of Creative Labs. Adobe Acrobat Pro is a registered trademark of Adobe Systems Incorporated. All other product names are trademarks of their respective manufacturers.

Copyright 1986 by Carnegie Mellon

Permission to use, copy, modify, and distribute this program for any purpose and without fee is hereby granted, provided that this copyright and permission notice appear on all copies and supporting documentation, the name of Carnegie Mellon not be used in advertising or publicity pertaining to distribution of the program without specific prior permission, and notice be given in supporting documentation that copying and distribution is by permission of Carnegie Mellon and the Massachusetts Institute of Technology. Carnegie Mellon makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Copyright 1984,1985 Massachusetts Institute of Technology

Permission to use, copy, modify, and distribute this program for any purpose and without fee is hereby granted, provided that this copyright and permission notice appear on all copies and supporting documentation, the name of M.I.T. not be used in advertising or publicity pertaining to distribution of the program without specific prior permission, and notice be given in supporting documentation that copying and distribution is by permission of M.I.T. M.I.T. makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Important: You should carefully read the license terms and conditions included in this package before you open or use the product. If you do not agree with the terms and conditions, you should promptly return the product unopened.
Contents

Chapter 1. Overview ........................................................................................................ 1
Chapter 2. Installation and Setup ................................................................................. 13
Chapter 3. Customizing Your Setup ............................................................................ 35
Chapter 4. Using Dialup Protocols ............................................................................ 51
Chapter 5. Using Routing .......................................................................................... 71

Host Connectivity - Terminal Emulation
Chapter 6. Telnet and ASCII Terminal Emulation ..................................................... 75
Chapter 7. TN3270 Terminal Emulation ...................................................................... 101
Chapter 8. TN5250 Terminal Emulation .................................................................... 115
Chapter 9. Serial to Telnet ....................................................................................... 123
Chapter 10. Modem Server ...................................................................................... 129
Chapter 11. 3270 Printer Emulator ........................................................................... 131
Chapter 12. Session Manager .................................................................................... 137
Chapter 13. Visual Script Editor/ Visual Script Player ............................................. 139

File and Print Sharing
Chapter 14. NFS - Network Drives ........................................................................... 149
Chapter 15. NFS Utilities ......................................................................................... 173
Chapter 16. FTP - File Transfer ............................................................................... 175
Chapter 17. TFTP - File Transfer ............................................................................. 193
Chapter 18. LPR/LPD .............................................................................................. 197

Email and Messaging
Chapter 19. Mail and Mail Administration .................................................................. 205
Chapter 20. Directory Server .................................................................................... 239
Chapter 21. Phone Tag .............................................................................................. 241
Chapter 22. Tag-It! .................................................................................................... 245
Chapter 23. NewtPROFS ......................................................................................... 249
GroupWare - Collaboration Tools

Chapter 24. NEWTCal ................................................................. 263
Chapter 25. InPerson ................................................................. 269
Chapter 26. NEWTScan ............................................................. 277

Internet Navigation and Browsing

Chapter 27. WebSurfer ............................................................. 281
Chapter 28. Personal Web Server .............................................. 295
Chapter 29. WebSpider ............................................................ 299
Chapter 30. NEWTNews ........................................................... 305
Chapter 31. Archie ................................................................. 313
Chapter 32. Talk ................................................................. 319
Chapter 33. NEWTView ........................................................... 325
Chapter 34. Gopher ............................................................... 327
Chapter 35. Automatic Internet ................................................. 331
Chapter 36. NEWTSound ....................................................... 337

Desktop Management

Chapter 37. Ping - Network Testing ......................................... 339
Chapter 38. Finger ............................................................... 341
Chapter 39. Whois .............................................................. 343
Chapter 40. Bind - Name Server ............................................... 347
Chapter 41. PC NetTime .......................................................... 349
Chapter 42. Name Resolver ..................................................... 353
Chapter 43. NISLookup .......................................................... 355
Chapter 44. R-Commands ....................................................... 357
Chapter 45. NEWT and SNMP ................................................ 365
Chapter 46. Diagnostic Center ............................................... 371
Chapter 47. Internet Relay Chat ............................................. 373
Appendix A. Windows for Workgroups ..................................... 387
Appendix B. Open Data-Link Interface (ODI) ......................... 409

Glossary

Index

Reader's Comment Form
Chapter 1. Overview

ChameleonNFS combines an NFS client/server and a powerful set of network applications, all built on top of TCP/IP for Microsoft Windows. Network drives appear and act as local drives through the use of the NFS (Network File System) protocol.

The TCP/IP protocols provided with ChameleonNFS are also available as a separate product called NEWT. NEWT gives Microsoft Windows users a degree of network access previously available only to workstation and mainframe users.

Through the exclusive use of TCP/IP for all network communication, the user is guaranteed transparent access to a wide variety of systems that support these same protocols. Your Windows-based PCs can seamlessly integrate into existing network environments, or expand small networks into large ones, without the painful changes commonly associated with these transitions.

Most applications have both client and server capabilities. This permits building of peer-to-peer networks of PCs without the use of a centralized workstation or mainframe. This also eliminates the need for a proprietary protocol for PC-to-PC communication; it also means that TCP/IP no longer needs to be used only to provide host access.

The standard Network Device Interface Specification (NDIS) or Open Data-Link Interface (ODI) are used for all communication with the network adapter. This permits a single version of NEWT to work across a wide variety of industry-standard network adapters. Any network adapter that supports the NDIS interface is compatible with NEWT, regardless of its manufacturer or type. This same standard also permits NEWT to run concurrently with a wide variety of existing network operating systems using the same network adapter.

In the past, PC users who wanted this level of connectivity were restricted by the capabilities of DOS and available hardware. Both Microsoft Windows and workstation-class PC hardware require that a new set of products take advantage of these capabilities. NetManage is the premier supplier of these products. Our products are not adaptations of previous DOS products. Instead they are unique applications that take full advantage of Windows-based systems.

Product Features

ChameleonNFS incorporates a number of features not normally found in other networking products such as:

- NFS client and server
- Mounting/unmounting of network drives from within Windows File Manager
• Multiple windows running multiple TCP/IP sessions
• Applications that include both client and server functions
• Implementation as Windows DLL (not a TSR)
• Use of a Windows point-and-click user interface
• Context-sensitive online help
• TCP and UDP protocol support
• Industry standard NDIS or ODI network adapters support
• Ethernet, token ring, SLIP, PPP, CSLIP, and ISDN interfaces
• Concurrent LAN and serial interfaces
• Integrated Serial dialing and gateway access
• Optional TCP/IP development kits

ChameleonNFS Applications

The following table describes the different ChameleonNFS applications and includes each application's icon. The applications are presented by type (such as installation and setup tools).

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation and Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NEWTShooter</td>
<td>![Icon]</td>
<td>Lets you directly send information from other applications to Mail and WebSurfer</td>
</tr>
<tr>
<td>Custom</td>
<td>![Icon]</td>
<td>Lets you set up and configure your network</td>
</tr>
<tr>
<td>Dialer</td>
<td>![Icon]</td>
<td>Lets you connect interfaces to the Internet and modify interfaces</td>
</tr>
<tr>
<td>Host Connectivity – Terminal Emulation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Telnet and ASCII Terminal</td>
<td>![Icon]</td>
<td>Lets you connect your PC with a UNIX or VMS host and many types of BBS using Telnet or Asynchronous connections</td>
</tr>
<tr>
<td>TN3270</td>
<td>![Icon]</td>
<td>Emulates 3270 terminals for connecting to IBM hosts</td>
</tr>
<tr>
<td>TN5250</td>
<td>![Icon]</td>
<td>Emulates 5250 terminals for connecting to IBM hosts</td>
</tr>
<tr>
<td>Tool</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Serial to Telnet</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets you use any serial terminal emulation application in your system to communicate over Telnet (TCP/IP)</td>
</tr>
<tr>
<td>Modem Server</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets you use one of your PCs as a modem server for other PCs on the same LAN</td>
</tr>
<tr>
<td>3270 Printer</td>
<td><img src="image" alt="Icon" /></td>
<td>Emulates an IBM 3287 system printer and enables you to print IBM S/370 and S/390 Sessions to various printers. The 3270 Printer application makes the printer appear to the host as if it were an IBM system printer.</td>
</tr>
<tr>
<td>Session Manager</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets you manage multiple Chameleon terminal emulation sessions from within a single program</td>
</tr>
<tr>
<td>Visual Script Editor</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets you dynamically reconfigure the user interface, perform random access file operations, automate tasks, modify current functionality, and handle incoming events with the Telnet and ASCII terminal, TN3270, TN5250, Mail, and FTP applications</td>
</tr>
<tr>
<td>File and Print Sharing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NFS</td>
<td><img src="image" alt="Icon" /></td>
<td>Provides network drive services across a wide variety of systems through the Network File System</td>
</tr>
<tr>
<td>NFS Utilities</td>
<td><img src="image" alt="Icon" /></td>
<td>Converts text files and displays filename mapping between UNIX and Windows</td>
</tr>
<tr>
<td>FTP Client</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets you connect to FTP servers and transfer files to and from wide variety of remote computers</td>
</tr>
<tr>
<td>FTP Server</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets other Internet users directly access files on your PC</td>
</tr>
<tr>
<td>TFTP</td>
<td><img src="image" alt="Icon" /></td>
<td>Lets you transfer one file at a time to and from remote host computers that do not support FTP</td>
</tr>
<tr>
<td>Tool</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LPR/LPD</td>
<td>![icon]</td>
<td>Lets files be printed remotely over the network</td>
</tr>
</tbody>
</table>

**E-mail and Messaging**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail</td>
<td>![icon]</td>
<td>Lets you send and receive electronic mail</td>
</tr>
<tr>
<td>Mail Administration</td>
<td>![icon]</td>
<td>Provides additional functions for managing Mail</td>
</tr>
<tr>
<td>Directory Server</td>
<td>![icon]</td>
<td>Lets you keep a company-wide address book, or any other address book, available for other users</td>
</tr>
<tr>
<td>Phone Tag</td>
<td>![icon]</td>
<td>Provides a handy method of recording and sending phone memos</td>
</tr>
<tr>
<td>Tag-It!</td>
<td>![icon]</td>
<td>Provides a method of sending informal messages to other people</td>
</tr>
<tr>
<td>NewtPROFS</td>
<td>![icon]</td>
<td>Lets your PC exchange Pmail with IBM mainframes</td>
</tr>
</tbody>
</table>

**GroupWare – Collaboration Tools**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEWTCal</td>
<td>![icon]</td>
<td>Lets you schedule appointments in an online calendar</td>
</tr>
<tr>
<td>InPerson</td>
<td>![icon]</td>
<td>Lets you have audio and video online working sessions with people in other locations</td>
</tr>
<tr>
<td>NEWTScan</td>
<td>![icon]</td>
<td>Scans images and sends them through e-mail</td>
</tr>
</tbody>
</table>

**Internet Navigation and Browsing**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebSurfer</td>
<td>![icon]</td>
<td>Lets you browse hypertext documents published on World Wide Web (WWW) servers</td>
</tr>
<tr>
<td>Tool</td>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Personal Web Server</td>
<td>![Icon]</td>
<td>Lets you publish multimedia hypertext documents on the WWW</td>
</tr>
<tr>
<td>WebSpider</td>
<td>![Icon]</td>
<td>Lets you create and design documents over WWW</td>
</tr>
<tr>
<td>NEWTNews</td>
<td>![Icon]</td>
<td>Lets you subscribe to news groups on the Usenet, and to read and post articles</td>
</tr>
<tr>
<td>Archie</td>
<td>![Icon]</td>
<td>Lets you view and retrieve public-domain files from anonymous FTP hosts</td>
</tr>
<tr>
<td>Talk</td>
<td>![Icon]</td>
<td>Lets you participate in real-time conversations with remote user Act as both a client and server, and responds to remote talk requests as a pop-up dialog box with or without sound</td>
</tr>
<tr>
<td>Internet Relay Chat (IRC)</td>
<td>![Icon]</td>
<td>Lets Internet users talk to one another in real-time</td>
</tr>
<tr>
<td>NEWTView</td>
<td>![Icon]</td>
<td>Lets you display, copy, and print bit-mapped graphics files produced by various applications</td>
</tr>
<tr>
<td>Gopher</td>
<td>![Icon]</td>
<td>Lets you browse thousands of public Gopher information servers</td>
</tr>
<tr>
<td>Automatic Internet</td>
<td>![Icon]</td>
<td>Lets you sign up for an Internet account online. Automatically configures your software for connection to the Internet</td>
</tr>
<tr>
<td>NEWTSound</td>
<td>![Icon]</td>
<td>Lets you run a sound file</td>
</tr>
<tr>
<td>Desktop Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ping</td>
<td>![Icon]</td>
<td>Checks your connection to a specified computer</td>
</tr>
<tr>
<td>Finger</td>
<td>![Icon]</td>
<td>Displays information about users on a specified computer</td>
</tr>
</tbody>
</table>
### Tool Description

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WhoIs</td>
<td>![Icon]</td>
<td>Provides information about other network users including phone numbers and e-mail addresses</td>
</tr>
<tr>
<td>Bind</td>
<td>![Icon]</td>
<td>Provides name server functions as a Domain Name Server (DNS)</td>
</tr>
<tr>
<td>PC NetTime</td>
<td>![Icon]</td>
<td>Lets you synchronize the time between your PC and any time server</td>
</tr>
<tr>
<td>Name Resolver</td>
<td>![Icon]</td>
<td>Lets you easily retrieve the IP address of a known host or the hostname of an IP address</td>
</tr>
<tr>
<td>NISLookup</td>
<td>![Icon]</td>
<td>Displays information retrieved from the Network Information Service (NIS) including map entries, domain and server names</td>
</tr>
<tr>
<td>R-Commands</td>
<td>![Icon]</td>
<td>Lets you enter and execute the rcp (remote copy) and rsh (remote shell) UNIX commands in a Windows environment</td>
</tr>
<tr>
<td>NEWT</td>
<td>![Icon]</td>
<td>Provides network statistics and information and agents for network management</td>
</tr>
<tr>
<td>Diagnostic Center</td>
<td>![Icon]</td>
<td>Captures TCP/IP packets</td>
</tr>
</tbody>
</table>

### Other Products

NetManage is committed to expanding network capabilities in line with existing products, such as ChameleonNFS. We will maintain our high standards for ease of use and integration with Windows.

Our current set of products includes:

- Chameleon: TCP/IP applications package for Windows
- Chameleon32NFS: TCP/IP applications package for Windows NT
- Chameleon/X: Chameleon bundled with Xsession
- ChameleonNFS/X: ChameleonNFS bundled with Xsession
- Chameleon/D: TCP/IP applications package for both DOS and Windows
- Internet Chameleon: Internet dialup access
- NEWTWatch: SNMP-based desktop management
• NEWT-SDK: Development kit for TCP/IP DLL, FTP DLL, SMTP DLL and SNMP DLL
• RPC-SDK: Development kit for ONC RPC/XDR
• ECCO Simplicity, ECCO Lite, ECCO Professional: Personal information managers

We also have native-language versions of Chameleon and ChameleonNFS:
• French
• German
• Japanese

Using This Manual

Use this manual to install, set up, and customize ChameleonNFS on your computer. This manual also contains detailed information about all the user applications.

To use this document, you are assumed to be familiar with Microsoft Windows, DOS, and basic TCP/IP terminology. You will find troubleshooting sections at the end of each chapter. These sections provide a simple way to quickly diagnose any problems you may encounter. The Glossary at the end of the manual also defines basic terminology.

Finding Help

All applications include online documentation in the form of standard Windows help. This is available at all times from within the application, limiting the need to refer to this documentation.

To access online help from any application, select Contents from the Help menu. You can navigate through a variety of topics by choosing the buttons along the top of the window, as well as by selecting underlined text. Hypertext links are provided to cross-reference information.

You may obtain printed information by selecting Print Topic from the File menu; you may also copy text, using the Edit menu.

Starting Applications

To start an application, choose (double-click) the corresponding icon. To start another copy of the same application, double-click on the icon again. Some applications may be opened multiple times.

There is no need to quit a particular application to start another. Each application is totally independent of the others. You may minimize an application to help conserve screen space if the desktop becomes too cluttered. Double-click on the screen background to bring up the task list; you can then switch directly to a running application. Note that the FTP application opens two sessions for each connection.
Configuration Files

Every application uses a configuration file to maintain its settings. This file is automatically loaded every time the application is started. Use the File menu to create a new default configuration (New), save the current settings (Save or Save As...), open another configuration file (Open...), or exit the application (Exit). If you quit an application without explicitly saving changes, the application displays a dialog box asking if changes should be saved.

Dialog Box Fields

A down-arrow button next to a dialog box field indicates that additional predefined selections are available for that value. Choose the button and a drop-down list box appears, containing these selections. Some dialog box fields may also let you type in an alternate selection.

Error checking is performed on values entered into dialog boxes. Entering invalid values results in a beep and displays the insertion point at that field. Other dialog boxes may not permit an action until all required fields have been supplied. For example, sending mail is disabled until the destination address is specified.

Fields in which IP addresses are entered have a red button to the left of the first field. This can be used to clear the entire address entry.

Status Bar

All applications provide you the option of showing or hiding the application's status bar. The status bar is displayed at the bottom of the application window, where it shows messages and provides status and statistics about the current application.

Toolbar

The Toolbar command lets you display or hide an application's toolbar. The toolbar gives you quick mouse access to some of the application's functions.

Smart Buttons

The option to display toolbar buttons, including each icon's description, is available in all applications.
Changing Column Width and Order

In some applications you can change the width of each column or field. You can also rearrange fields if you want to view them in a different order. To change the width of a column, do the following:

1. Position the mouse pointer at the right side of the column border for the column you want to resize.

2. Drag the column border to the desired size.

To move a column, select the column you want to move and drag it to its new position.

Using NEWTShooter

NEWTShooter is a tool that lets you place information from other applications into the Mail or WebSurfer applications.

Copying information with NEWTShooter produces the same results you would get if you copied using the Windows clipboard, except you do not have to use the Copy and Paste commands or leave your current application. NEWTShooter is simply a faster and more efficient way to copy. You can send information from word-processing, database, spreadsheet, drawing, mailing, painting, and other types of programs directly into the Mail application, and you can copy selected text (normally a URL) into the URL field in WebSurfer.

The NEWTShooter icon appears by default in the upper left corner of the active program window at all times.

Loading NEWTShooter

NEWTShooter loads automatically when starting Mail, or you can load NEWTShooter manually when desired.

To turn this setting off, do the following:

1. From Mail, select the Preferences... option from the Settings menu.

2. Select the Misc tab and deselect the Load Shooter option.

To load NEWTShooter manually, choose the NEWTShooter icon in Program Manager.

Using NEWTShooter Options

NEWTShooter lets you place selected text in the following locations:

- address field in Mail
- body of a Mail message
- edit URL field in WebSurfer
To place selected text from your current application using NEWTShooter, do the following:

1. Select the text you want to copy from your current program.
2. Choose the NEWTShooter icon. A list of options appears directly under the NEWTShooter icon.
3. To place the text in the address field in mail, choose the Address Mail To option. A new Create mail message appears with the selected text in the Address field.
4. To place the text in the body of a mail message, choose the Mail Selected Text option. A new Create mail message appears with the selected text in the mail message body.
5. To place the text in the URL field in WebSurfer, choose the WebSurf Selected URL option. The WebSurfer main window appears with the selected text in the URL field.

**Exiting NEWTShooter**

To exit NEWTShooter, open NEWTShooter and choose the Exit NEWTShooter command. Or, turn off the Load Shooter option in the Preferences dialog box in Mail and then exit the Mail application.

**License Violation Detection**

A license violation occurs when multiple copies of a single licensed copy of the product are present on a network. Under the license agreement, each copy of the product is for a single user only and must not be shared.

Chameleon is not copy-protected and may be freely installed on any type of disk. Although you can make as many copies of the product as you like, the software notifies all illegal copies of a license violation.

Each copy of the software must have a unique serial number and key code. When the software detects a duplicate serial number on the network, a message is displayed on all duplicate serial numbered copies. This message interrupts all work in progress on the computers involved.

**Note:** All network activity is disabled after the license violation has been detected. The Chameleon applications appear to run normally, but communication over the network is disabled.
Customer Support

Before you use Chameleon, complete the registration card enclosed and mail it to NetManage. This will ensure that you will be provided with customer support. It will also allow us to keep you up-to-date on new products as they are introduced. NetManage provides support for its customers.

We can be reached at the following:

**West Coast**
- Sales Phone: (408) 973-7171
- Sales Fax: (408) 257-6405
- Support Phone: (408) 973-8181
- Support Fax: (408) 973-8272

**East Coast**
- Sales Phone: (603) 888-2800
- Support Phone: (603) 888-3500
- Fax: (603) 888-0304

**Internet**
- Sales: sales@netmanage.com
- Support: support@netmanage.com
- Compuserve: 70640, 1074
- BBS: (408) 257-3794, 8-N-1

**International**
- Internet: intl_support@netmanage.com
- Israel
  - Phone: +972-4-550234
  - Fax: +972-4-550122
- France
  - Phone: +33-1-47720808
  - Fax: +33-1-42046599
- Germany
  - Phone: +49 (0)8165/923300
  - Fax: +49 (0)8165/923329
- UK
Chapter 2. Installation and Setup

This chapter discusses hardware and software requirements, installation setup, and multiple protocol installation information.

Hardware Requirements

The following minimum hardware configuration must be available before you begin installation of Chameleon:

- IBM PC (or compatible computer) with 4 MB or more of RAM, 386 CPU or later capable of running Microsoft Windows in Enhanced mode, mouse, 1.44 HD 3.5” floppy disk drive, and a hard disk with at least 20 MB free for product installation.
- One of the following:
  - A modem. The modem can be either an external modem that you can connect to a COM port of your computer or an internal modem configured to use a specific COM port.
  - A high speed ISDN connection and an ISDN adapter card that supports either COM port emulation or the new WinISDN driver standard
- One or more network interfaces: any NDIS-compliant or ODI network adapter (Ethernet or Token Ring), serial communication port (SLIP, PPP, or CSLIP), or WinISDN-compliant ISDN adapter.
- For the NEWTScan application, a Twain compatible scanner.
- Optionally, a sound card.

Software Requirements

- DOS version 5.0 or later
- Microsoft Windows 3.1, WFW 3.1, or 3.11 running in Enhanced Mode
- An NDIS driver for your network interface, or Open Data-Link Interface (ODI) if not running SLIP or PPP. The most popular NDIS drivers are provided on the installation diskettes. If the driver you need is not included, you can usually find it in a diskette provided with your network adapter, or you can download it from an electronic bulletin board. The ODI support will be installed only if an existing ODI installation is detected.
Preparing for Installation

To complete your installation, you will need some system and network information. Use the following form to help you collect the necessary information before you start the installation process. Example values are shown in brackets. If you are unsure of any information you need, see your system administrator.
## General

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where to install software</td>
<td>C:\NETMANAG</td>
</tr>
<tr>
<td>Interface type</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Internet address</td>
<td>156.27.1.51</td>
</tr>
<tr>
<td>Host name</td>
<td>my host</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.0.0</td>
</tr>
</tbody>
</table>

### For LAN interfaces

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter vendor name</td>
<td>3COM</td>
</tr>
<tr>
<td>Adapter type</td>
<td>3C503</td>
</tr>
<tr>
<td>Interrupt level</td>
<td>5</td>
</tr>
<tr>
<td>I/O base address</td>
<td>0x300</td>
</tr>
</tbody>
</table>

### For SLIP/CSLIP/PPP interfaces

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM port</td>
<td>COM2</td>
</tr>
<tr>
<td>Baud rate</td>
<td>9600</td>
</tr>
<tr>
<td>Flow control</td>
<td>Hardware</td>
</tr>
<tr>
<td>Modem type</td>
<td>Hayes</td>
</tr>
<tr>
<td>Telephone number</td>
<td>408-123-1234</td>
</tr>
</tbody>
</table>

### For ISDN interfaces

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>ISDN.TEK</td>
</tr>
<tr>
<td>Board Type</td>
<td>ISDN.TEK1</td>
</tr>
<tr>
<td>IRQ_Level</td>
<td>5</td>
</tr>
<tr>
<td>Memory</td>
<td>0x300</td>
</tr>
<tr>
<td>SPID1</td>
<td></td>
</tr>
<tr>
<td>SPID2</td>
<td></td>
</tr>
</tbody>
</table>

### Optional

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Name</td>
<td>netmanage.com</td>
</tr>
<tr>
<td>Default gateway</td>
<td>156.27.1.1</td>
</tr>
<tr>
<td>Domain server address</td>
<td>156.27.1.2</td>
</tr>
</tbody>
</table>

## Installing ChameleonNFS

How you install ChameleonNFS depends on whether this is the first time you are installing it on your computer. Discussions on installing ChameleonNFS for the first time and installing an upgrade follow. Complete the procedure appropriate for the type of installation you are doing. Then verify the installation as discussed in the Verifying Installation and Setup section in this chapter.
Installing ChameleonNFS for the First Time

A Windows-based program is provided to simplify installation, permitting completion within minutes in most cases. The installation program requires several diskettes supplied with your Chameleon product.

The installation program copies the necessary files, modifies some system configuration files, creates a new program group and set of icons, and runs the Custom application to complete the setup of your system. Make sure that your network adapter is installed and diagnosed before you begin your installation.

To install ChameleonNFS for the first time, do the following:

1. Complete the preparation form included in the Preparing for Installation section of this chapter.

2. If necessary, refer to additional information as discussed in the following list:
   - If you are running another network protocol, refer to the Installing With Multiple Protocols section in this chapter.
   - If you are configuring your system for SLIP/CSLIP/PPP access, refer to the Using Dialup Protocols chapter.
   - If you are configuring your system as a network router, refer to the Router chapter.

3. Back up your CONFIG.SYS, AUTOEXEC.BAT, WIN.INI, and SYSTEM.INI system files.
   Some files are automatically changed during the installation process. For details on the changes made during the installation, see the Changes Performed on Configuration Files section of this chapter.

4. If necessary, back up additional files. As discussed in the following table, which additional files you back up depends on the interface you are using:

<table>
<thead>
<tr>
<th>Interface Type</th>
<th>Files to Back Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDIS</td>
<td>PROTOCOL.INI</td>
</tr>
<tr>
<td>ODI</td>
<td>NET.CFG</td>
</tr>
<tr>
<td></td>
<td>PROTOCOL.INI (if you are using Windows for Workgroups)</td>
</tr>
<tr>
<td>ISDN</td>
<td>ISDN.INI</td>
</tr>
</tbody>
</table>

   If you are using ISDN for the first time, an ISDN.INI file will be created when you install the Chameleon product.

5. Install your Chameleon product as discussed in your quick install card.
6. Check the installation as discussed in the Verifying Your Installation and Setup section in this chapter.

**Setting Up NEWT**

Once installation is complete, the Custom application takes you through the following steps that let you set up NEWT. If you are performing an upgrade installation, Custom will not start automatically.

**Note:** You can always run the Custom application separately (after you install the software) to change any values you specify; there is no need to run Setup again.

- After Custom starts, the Add Interface dialog box appears. In the Name text box, type a descriptive name for the interface. From the Type drop-down menu, choose the interface type (Ethernet, Token Ring, SLIP, PPP, or CSLIP). Choose the OK button and a new line entry is added to the Custom window for this interface.

![Add Interface dialog box](image)

- For LAN interfaces, the Hardware dialog box appears for NDIS only. For ODI, the Hardware... command is unavailable because your adapter should already be configured and functioning. Select the network adapter vendor name and adapter type.

![Hardware dialog box](image)

For each combination, there can be a different set of additional values that must be specified (for example, interrupt and base address). The defaults for these values are automatically selected, based on adapter type. Select the values that match your network adapter settings and choose the OK button.
For the ISDN interface, the information you provide is used by the ChameleonNFS product to configure your ISDN.INI file for use with your adapter board.

If your network card is not included in our vendor list, you can still use the ChameleonNFS product by entering information about this card in the 'Other' selection during the Hardware Setup.

To configure Custom to work with a network card not listed in our supported vendor list, do the following:

1. Complete the preparation form included in the Preparing for Installation section of this chapter.

2. Choose the Custom icon to start Custom. The Custom window appears.

3. Choose the Hardware... command from the Setup menu.

   The Hardware dialog box appears.

4. Specify information in the Hardware dialog box as discussed in the following table.

   **Note:** The information you provide is used by the ChameleonNFS product to configure your PROTOCOL.INI and CONFIG.SYS files for use with your adapter board. If you are familiar with the configuration of these files you may want to manually edit them and bypass the Other hardware setup in Custom by choosing None. If you choose to have Custom configure your PROTOCOL.INI and CONFIG.SYS files and your ISDN.INI file, you can still edit them manually later.

   The following information also applies to the ISDN.INI file.

<table>
<thead>
<tr>
<th><strong>Option</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Choose Other to specify that you are using another vendor.</td>
</tr>
<tr>
<td>Section Name</td>
<td>Type the name of the header in the PROTOCOL.INI file used to describe your network card.</td>
</tr>
</tbody>
</table>
This name is placed in square brackets in the PROTOCOL.INI file. To determine this information look at the sample PROTOCOL.INI file that comes with your network cards NDIS driver.

<table>
<thead>
<tr>
<th>Driver Name</th>
<th>Type the name used by the Drivername= parameter in the PROTOCOL.INI file. To determine this information look at the sample PROTOCOL.INI file that comes with your network cards NDIS driver.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver File</td>
<td>Type the actual name of the NDIS driver file for your network card. Entering this information will edit the CONFIG.SYS file to load the NDIS driver for your card.</td>
</tr>
<tr>
<td>Text box at the bottom of the dialog box</td>
<td>Enter additional parameters necessary for the PROTOCOL.INI network adapter section as required by your specific card. Consult the instructions that accompany your network adapter card for details. The information will typically appear under the NDIS or LAN Manager sections of the documentation.</td>
</tr>
</tbody>
</table>

In this example, entering the required information in the dialog box produced the following entries in the PROTOCOL.INI file.

```
[DEPCA]
Drivername=DEPCA$
MaxMulticast = 12
MaxTransmits = 32
AdapterName = DE200
RamAddress = 0xD000
Interrupt = 3
[Netmanage]
Drivername=NETMNG$
Bindings=DEPCA
```

**Note:** Standard Micro Systems line of PLUS and ELITE Series adapter boards will require you to use the SMC provided NDIS driver, SMCMAC.DOS, rather than the MACWD.DOS driver originally supplied by Western Digital. You can get this driver by contacting SMC or downloading it from their BBS. A representation of the entries require in the PROTOCOL.INI file is listed below:

```
[SMCMAC_NIF]
Drivername=SMCMAC$
IOBase=0x280
RamAddress= 0xD000
```
5. Choose the OK button.

6. In the Internet Address dialog box that appears, type your IP address.

Avoid illegal addresses such as broadcast (0.0.0.0), subnet broadcast (156.27.0.0 or 156.27.255.255), or loopback (127.x.x.x). The following table indicates which IP addresses are available and which ones are reserved.

<table>
<thead>
<tr>
<th>Class</th>
<th>Address or Range</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0.0.0.0</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>1.0.0.0 through 126.0.0.0</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>127.0.0.0</td>
<td>Loopback Reserved</td>
</tr>
<tr>
<td>B</td>
<td>128.0.0.0</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>128.1.0.0 through 191.254.0.0</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>191.255.0.0</td>
<td>Reserved</td>
</tr>
<tr>
<td>C</td>
<td>192.0.0.0</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>192.0.1.0 through 223.255.254</td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>223.255.255.0</td>
<td>Reserved</td>
</tr>
<tr>
<td>D, E</td>
<td>224.0.0.0 through 255.255.255.254</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>255.255.255.255</td>
<td>Broadcast</td>
</tr>
</tbody>
</table>

7. In the Subnet Mask dialog box that appears, type the number of subnet mask bits or drag the dialog box’s subnet partition graphic display to the correct location. Then choose the OK button.
The subnet division is used to partition the IP address into a network portion and a host portion, if needed. See the Custom online help for more information. Depending on your network, a subnet mask may be optional.

8. In the Host Name dialog box that appears, type the network name of your computer. Then choose the OK button.

9. In the Domain Name dialog box that appears, type the name of the domain in which your computer resides. Then choose the OK button.

10. If your network uses the Network Information Service (NIS), specify the NIS domain name as discussed in the Customizing Your Setup chapter.

   NIS centralizes network administration including host and user list management. For details on NIS, see the Customizing Your Setup chapter.

11. Define the order in which your computer searches for IP address information. To do so, use Custom to define the host resolution order as discussed in the Customizing Your Setup chapter.

12. Select Save from the File menu to save your configuration.
   • If Custom needs to install an NDIS driver for your network card, it may prompt you to insert a specific diskette.
If you are using ODI, you will be prompted to specify the directory in which the NET.CFG file is located. Refer to Appendix B for detailed information on using ODI.

13. You are prompted to reboot, which you need to do to permit the NDIS drivers to load before you can use ChameleonNFS. Choose the OK button. ChameleonNFS exits Windows and restarts your computer.

Upgrade Installation

How you upgrade your installation depends on whether you are upgrading a NetManage Chameleon product or another vendor's product. Separate discussions on the different upgrades follow.

Upgrading a NetManage Chameleon Product

If you are performing an installation of a newer version of Chameleon on a system that is already able to communicate on the network, do the following:

1. Complete the preparation form included in the Preparing for Installation section of this chapter.

2. Start Windows in Enhanced Mode.

3. Perform the upgrade installation steps described on the quick install card.

4. Check the installation as discussed in the Verifying Your Installation and Setup section in this chapter.

Installing ChameleonNFS with Another Vendor's TCP/IP Stack

If you are installing ChameleonNFS on a computer that already has an installed TCP/IP product from another vendor, do the following:

1. Complete the preparation form included in the Preparing for Installation section of this chapter.

2. Perform the upgrade installation steps described on the quick install card.

3. When you run Setup as discussed in the quick install card, you are prompted to confirm whether you want to keep the other vendor's stack. If you kept the other vendor's stack, go to step 4. If you did not keep the other vendor's stack, do the following:

   a) Remove all lines from the CONFIG.SYS, WIN.INI, and SYSTEM.INI files associated with the other vendor's TCP/IP product.
b) Check additional files for other TCP/IP products and remove the lines associated with those products. The following table indicates which files to check for the different interfaces:

<table>
<thead>
<tr>
<th>Interface Type</th>
<th>Files to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDIS</td>
<td>PROTOCOL.INI</td>
</tr>
<tr>
<td>ODI</td>
<td>NET.CFG</td>
</tr>
<tr>
<td></td>
<td>PROTOCOL.INI (if you are using Windows for Workgroups)</td>
</tr>
</tbody>
</table>

c) Reboot the system.

d) Run Setup again.

3. Check the installation as discussed in the Verifying Your Installation and Setup section in this chapter.

**Application Hints**

ChameleonNFS installation creates a program group, with icons representing various applications.

If you plan on using multiple instances of an application frequently (for example, multiple Telnet sessions to different hosts), you can use the following technique to increase your productivity.

- Use the Program Manager application to add a new program item to the Chameleon group. Select New from the File menu to create the new icon. Note that this procedure can be duplicated any number of times to create custom icons for different systems.

- To create a Telnet icon that connects to a system named H.P., type H.P. for the description of the item, and add a parameter to the TELNET.EXE command line to specify the system name.

- To create a Ping icon that tests connectivity to a particular IP address, type the IP address for the description, and add a parameter to the PING.EXE command line to specify the IP address.

- The new ChameleonNFS group appears with these new customized icons. Choose an icon to launch the application and immediately connect to the specified system.

**Note:** Please see Appendix A if you are installing:

- Windows for Workgroups 3.11 and ChameleonNFS over NDIS.
- Windows for Workgroups 3.11 and ChameleonNFS over NDIS with no workgroup networking installed.
• Windows for Workgroups 3.11 and ChameleonNFS and Novell 3.X shell/ODI or later.
• Windows for Workgroups 3.11 and ChameleonNFS and Novell 3.X shell/ODI or later, with no workgroups networking installed.

Changes Performed on Configuration Files

During the installation process, changes are made to some configuration files. This section shows examples of how configuration files are modified during an installation. The modified files include: WIN.INI, AUTOEXEC.BAT, CONFIG.SYS, PROTOCOL.INI, and SYSTEM.INI.

The following examples for an NDIS installation assume that the C:\NETMANAG directory was specified and a 3COM EtherLinkII (3C503) network adapter was selected. Your files may differ slightly, depending on the network adapter you actually select.

WIN.INI Changes

The following lines are added to your WIN.INI file:

    [TCPIP]
    FILE=C:\NETMANAG\TCPIP.CFG
    ID=XXXX

Caution: Back up your TCP/IP section in the WIN.INI file because it contains vital information about ChameleonNFS.

AUTOEXEC.BAT Changes

• The following line is inserted at the beginning of your PATH variable in your AUTOEXEC.BAT file:

        PATH=C:\NETMANAG;

• The following line is added to your AUTOEXEC.BAT file:

        C:\NETMANAG\NETBIND

Note that the NETBIND.COM program is not unique to Chameleon; it is actually the standard Microsoft program used in LAN Manager and other applications.

CONFIG.SYS Changes

The following lines are added to your CONFIG.SYS file:

    DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG
    DEVICE=C:\NETMANAG\ELNKII.DOS
    DEVICE=C:\NETMANAG\NETMANAG.DOS

Note that the Protocol Manager (PROTMAN.DOS) and the NDIS driver (ELNKII.DOS) are not unique to Chameleon; they are actually the standard Microsoft driver for LAN
Manager and the NDIS driver from your network adapter vendor. If you are using ODI, refer to the appendix that discusses ODI installation.

The Protocol Manager driver entry must point to the location of the PROTOCOL.INI file.

**PROTOCOL.INI Changes**

The following lines are added to your PROTOCOL.INI file:

```
[EtherLinkII]
DRIVERNAME=ELNKII$
INTERRUPT=3
TRANSEIVER=OnBoard
IOADDRESS=0x300

[NETMANAGE]
DRIVERNAME=NETMNG$
BINDINGS=EtherLinkII
```

If you select an ODI setup and are not using Windows for Workgroups, a PROTOCOL.INI file will not be created. Only the NET.CFG file is modified.

The EtherLinkII section describes values for your network adapter. These values must match those configured for your network adapter either using hardware jumpers, or a software setup program supplied with the network adapter.

The NETMANAGE section describes a network protocol for NEWT. The BINDINGS statement binds the protocol to your network adapter. You may specify additional bindings for a protocol if you have more than one network adapter section.

**SYSTEM.INI Changes**

- The following lines are added to your SYSTEM.INI file:

  ```
  [BOOT]
  NETWORK.DRV=C:\NETMANAG\mult46.DRV

  [BOOT DESCRIPTION]
  NETWORK.DRV=NETMANAGE CHAMELEONNFS

  [386Enh]
  DEVICE=C:\NETMANAG\NMTCPIP.386
  DEVICE=C:\NETMANAG\NMREDIR.386
  ```

- The following directory is created:

  C:\NETMANAG

- The following files are copied to your C:\NETMANAG directory:

  PROTOCOL.INI
  PROTMAN.DOS
NETMANAG.DOS
NETBIND.COM
Applications and Help files
NDIS driver for your specific network internet card

If you select an ODI setup and are not using Windows for Workgroups, a
PROTOCOL.INI file will not be copied.

Verifying Installation and Setup

To verify that the installation process was successful, check your own IP address using a
Ping application that is available with your TCP/IP product. If the Ping application
fails, try the following to diagnose the problem:

☐ Be sure that there were no errors reported when the NDIS or ODI drivers are loaded
after rebooting the system.

☐ Be sure that there were no errors reported when the NETBIND.COM program was
executed after rebooting the system.

☐ Run your Ping application. If a dialog box appears and indicates an interface
initialization failure, check your network adapter settings and verify that they match
those specified in the Custom application.

☐ If your system appears to crash or freeze, a conflict between NDIS, Windows, and
other drivers may be the problem. Memory managers, such as EMM386, must have
EXCLUDE statements for address ranges used by your network adapter. The
interrupt setting may be in conflict with another device.

☐ Use your Ping application to check your local IP address. If this fails, you may have
specified an illegal IP address.

☐ If you are able to ping other hosts on the network but not a device on the network,
then try an IP address rather than HOST.NAME. If this fails, use the NEWT
application statistics to determine if there are packet errors, a failure to receive or
transmit, and so on. Lots of errors usually indicates a network adapter setting
problem. Failure to receive anything usually indicates an interrupt problem.
Receive problems may also mean an incorrect Ethernet Type setting or Frequent
Destinations with incorrect physical addresses.

☐ Make sure the order of the drivers in CONFIG.SYS is correct.

☐ Start Windows in Enhanced Mode.

☐ If you want to refer to systems by name and not IP address, you must first define a
host table or domain server. Refer to the Customizing Your Setup chapter for more
information.

☐ If you want to communicate with systems that are on a different subnet, you must
first define a default gateway or add Route Entries. Refer to the Customizing Your
Setup chapter for more information.
Once these procedures are complete, you should have no problem using any of the Chameleon applications. If a particular application fails to work, refer to the Troubleshooting section in the chapter discussing that application.

**Installing With Multiple Protocols**

A multiple protocol setup is required when you want to run Chameleon simultaneously with another network operating system. This is accomplished through the NDIS support of multiple protocols for a single network adapter. The setup varies, depending on the type of network operating system.

**Note:** Two TCP stacks cannot be run on the same PC, in order to have two network protocols running on the same PC. You must use protocols other than TCP, such as NETBEUI, XNS, or others.

**Microsoft LAN Manager**

The Microsoft LAN Manager network operating system, when using the NetBEUI protocol, provides commonly used network services. This software uses the NDIS interface and can coexist with the Chameleon and ChameleonNFS products. No additional software is needed.

Follow the installation instructions described earlier in this section.

Select None for the network adapter vendor name when the Hardware dialog box is displayed. The LAN Manager Installation has already installed the protocol manager, PROTMAN.DOS, and the NDIS driver for your network card. Therefore, both Chameleon and ChameleonNFS do not require that you repeat this process.

During the LAN Manager installation your CONFIG.SYS file is updated with the PROTMAN.DOS and the network card driver. Edit the CONFIG.SYS file to load the NETMANAG.DOS driver. The following is an example of a CONFIG.SYS file following a LAN Manager install. The last line was added manually upon completion of the installation.

```
DEVICE=C:\LANMAN.DOS\DRIVERS\PROTMAN\PROTMAN.DOS /I:C:\LANMAN.OS
DEVICE=C:\LANMAN.DOS\DRIVERS\TOKENRING\IBMTOK\IBMTOK.DOS
DEVICE=C:\NETMANAG\NETMANAG.DOS
```

Edit the PROTOCOL.INI file contained in the LANMAN.DOS directory to include a section head for the driver that you are currently using. In the following example a section name for an IBM Token Ring was added:

```
[NETMANAGE]
DRIVERNAME=NETMNG$
BINDINGS=tokenring
```

Make sure *all* bindings sections match the installed network driver section name in brackets [], for example [Token Ring] or [3C509_nif].
Delete the NETBIND command from your AUTOEXEC.BAT file. In most LAN Manager installations, the NETBIND function is assumed available during the execution of the NET START WORKSTATION process.

**IBM LAN Support Program Configuration with Chameleon**

You need the following before configuring Chameleon with IBM's LAN Support Program drivers for NDIS:

- IBM LAN Support 1.3.5 or higher
- NETBIND 2.1
- IBMTOK 2.02

To follow are installation tips for concurrent use of ChameleonNFS and the LAN Support Program 802.2 drivers used by PC Support/400, NetSoft Router, and Personal Communications/3270.

To install LAN Support Program drivers and Chameleon NFS, do the following:

1. Install LAN Support Program drivers and then install ChameleonNFS.
   
   It is best to install the LAN Support Program 802.2 drivers with the DXMAID utility prior to installing ChameleonNFS. The PROTOCOL.INI file is placed in its default directory, LSP, and the following statements are added to the CONFIG.SYS file:
   
   ```
   DEVICE=C:\LSP\PROTMAN.DOS /I:C:\LSP
   DEVICE=C:\LSP\xxxxxxx.DOS <-- Driver for Ethernet or Token-Ring card
   DEVICE=C:\LSP\DXMA0MOD.SYS 001
   DEVICE=C:\LSP\DXME0MOD.SYS
   DEVICE=C:\LSP\DXMT0MOD.SYS O=N
   ```

2. Edit CONFIG.SYS so that there is only one DEVICE statement for the adapter driver, and that it is loaded before NETMANAG.DOS. For details, see the Editing CONFIG.SYS for the IBM LAN Support Program section.

3. Edit the PROTOCOL.INI file in the LSP directory, so that the DXME0$ and NETMNG$ drivers point to the same LAN Adapter section. For details, see the Editing PROTOCOL.INI for the IBM LAN Support Program section.

4. If you want to use the newer versions of PROTMAN.DOS and NETBIND.COM supplied with ChameleonNFS rather than the versions installed by the IBM LAN Support Program, see the Using the Latest Versions of PROTMAN.DOS and NETBIND.COM section.
Editing CONFIG.SYS for the IBM LAN Support Program

After installing ChameleonNFS, make the following edits to CONFIG.SYS so that there is only one DEVICE statement for the adapter driver, and that it is loaded before NETMANAG.DOS. Use the LSP version of PROTMAN.DOS and keep the PROTOCOL.INI file in the LSP directory.

DEVICE=C:\LSP\PROTMAN.DOS /I:C:\LSP
DEVICE=C:\LSP\ELNK3.DOS
REM The following line was added by ChameleonNFS mm/dd/yy
DEVICE=C:\NETMANAG\NETMANAG.DOS
DEVICE=C:\LSP\DXMA0MOD.SYS 001
DEVICE=C:\LSP\DXME0MOD.SYS
DEVICE=C:\LSP\DXMT0MOD.SYS O=N

Editing PROTOCOL.INI for the IBM LAN Support Program

Edit PROTOCOL.INI so that the DXME0$ bindings and the NETMNG$ bindings both point to the same adapter driver section. The following is an example using a 3COM EtherLink III adapter:

```ini
[PROTMAN_MOD]
DriverName=PROTMAN$

[DXMAIDXCFG]
DXME0_NIF=DXME0.NIF
DXMJ0MOD_NIF=DXMJ0MOD.NIF
EL3IBMDS_NIF=EL3IBMDS.NIF
EL3IBMDS2_NIF=EL3IBMDS.NIF
SMCDOSJP_NIF=SMCDOSJP.NIF
SMCDOSJP2_NIF=SMCDOSJP.NIF
SMCDOSAT_NIF=SMCDOSAT.NIF
SMCDOSAT2_NIF=SMCDOSAT.NIF
SMCDOSMC_NIF=SMCDOSMC.NIF
SMCDOSMC2_NIF=SMCDOSMC.NIF

[DXME0_NIF]
DriverName=DXME0$
Bindings=EL3IBMDS_NIF

[EL3IBMDS_NIF] <--- Section will vary depending on adapter
DriverName=ELNK3$
MAXTRANSMITS=8
;[EtherLink3] <--- Delete this section because it duplicates
;DRIVERNAME=ELNK3$

[NETMANAGE]
DRIVERNAME=NETMNG$
BINDINGS=EL3IBMDS_NIF <--- Must point to the adapter driver section, in this case, EL3IBMDS_NIF.
```
Using the Latest Versions of PROTMAN.DOS and NETBIND.COM

After you install ChameleonNFS, there will be versions of PROTMAN.DOS and NETBIND.COM in the NETMANAG directory that are more current than the versions supplied by IBM with LAN Support Program. It is not required, but you can change the path for these programs in CONFIG.SYS and AUTOEXEC.BAT to get the latest versions. To do so, do the following:

1. In CONFIG.SYS, specify the following:
   
   \DEVICE=C:\NETMANAG\PROTMAN.DOS \I:C:\LSP

2. In AUTOEXEC.BAT, specify the following:
   
   C:\NETMANAG\NETBIND

Microsoft Windows for Workgroups

For information on how to install WorkGroup Chameleon, refer to the appendix that discusses Windows for WorkGroups.

Novell and Chameleon

ChameleonNFS supports ODI drivers thus letting it run with Novell Netware. Refer to the section that discusses installing ODI in the Customizing Your Setup chapter.

Banyan Vines and Chameleon

Integrating Chameleon or ChameleonNFS to run with Banyan Vines requires that Vines is configured to use NDIS for the network card support.

Version 4.10, 4.11, and 5.5 or higher of Vines supports the use of NDIS drivers in place of the native Banyan packet drivers on Ethernet cards. Vines 5.50 will support both Ethernet and Token Ring NDIS drivers.

The Vines NDIS configuration is done through the PCCONFIG utility. Refer to your Vines documentation for configuring Vines for NDIS. Once Vines is configured to use NDIS drivers, you can begin to add Chameleon to the system.

If you have not already installed Chameleon, follow the installation instructions in the Chameleon or ChameleonNFS manual. When the Custom utility asks you to define the type of hardware installed, select NONE. When the Chameleon installation is done, check your CONFIG.SYS, AUTOEXEC.BAT, and CONFIG.SYS files to make sure they are configured like the examples that follow.

The examples are based upon an installation of Vines on a PC using a 3COM 3C503 EtherlinkII Ethernet card. Any Ethernet (or Token Ring card with Vines 5.50) that Vines supports over NDIS can be used. Be aware that if you are using a card other than the one in our example, the information specific to your card will be different from the entries in this example.
**CONFIG.SYS**

The CONFIG.SYS file should load the NDIS drivers from the directory where the Vines workstation software is located, for example C:\BAN.

A CONFIG.SYS set up for Vines and Chameleon will look like the following:

```
Device=c:\ban\protman.dos /I:c:\ban
```

The /I: parameter tells PROTMAN.DOS where to find PROTOCOL.INI.

```
Device=c:\ban\ELNKII.DOS
Device=c:\netman\netmanag.dos
```

**AUTOEXEC.BAT**

The AUTOEXEC.BAT file should not load the program NETBIND.COM from the \NETMANAG directory because the BAN command will perform the NETBIND function.

**PROTOCOL.INI**

The following is an example of a PROTOCOL.INI configured for both Chameleon and Banyan Vines (4.10 or later). The PROTOCOL.INI has to be in the same directory as your Vines files (BAN.COM, NDISBAN.COM, and so on) as referenced in the CONFIG.SYS.

```ini
[PROTOCOL MANAGER]  <-------- (This section is optional, see the Vines documentation
Drivername=protman$
[Vines_Xif]  <-------- (This section is optional see the Vines documentation
Drivername=NDISBAN$
Bindings=EtherlinkII$
[ EtherLinkII]
 DRIVERNAME=ELNKII$
 INTERRUPT=5
 TRANSCEIVER=External
 IOADDRESS=0x300
[ NETMANAGE]
 DRIVERNAME=NETMNG$
 BINDINGS=EtherLinkII
```

**Verifying Setup for Multiple Protocols**

To verify that your multiple protocol setup was performed correctly, do the following:

- Perform the verification steps described in the Installation and Setup chapter to verify that Chameleon is working properly. You may want to temporarily remove your network operating system while you verify that Chameleon works correctly.
- Make sure that network operating system drivers loaded properly when the system started.
- Verify that you have access to your network drives from DOS.
- Verify that you have access to your network drives from Windows.

Troubleshooting

Before installing with any network protocol (such as Novell, LAN Support, Banyan, and so on), refer to the sections in this chapter that discuss how to configure ChameleonNFS so that it can co-exist with these network protocols.

Miscellaneous Boot Time Errors

- Lanman v2.1 Netbind: Error 33, unable to bind...
  
  Look for the following:
  
  - Check the PROTOCOL.INI file to make sure there are no misspellings or incorrect entries.
  - Check your CONFIG.SYS to make sure the correct drivers are loading. The following three lines should be added to the end of the file:
    
    ```
    device=c:\netmanag\protman.dos /i:c:\netmanag
    device=c:\netmanag\(your network adapter ndis driver)
    device=c:\netmanag\netmanag.dos
    ```
  
- LanMan Netbind error 41: unable to bind...
  
  This error message indicates the network adapter cannot be found or cannot initialize the driver. To respond to this message, do the following:
  
  - Check the PROTOCOL.INI file to ensure there are no misspellings or incorrect entries.
  - If you are using a network adapter that is not provided in the "Custom" setup utility, it may be necessary to use the sample PROTOCOL.INI file that came with the network driver you are installing with.

- If everything appears to bind without any errors but you are unable to use the Ping application, do the following:
  
  - Check NEWT to see if a physical address appears.
  - If there is a physical address, check to see that the IP address and subnet for your host PC are correct. Verify that the device you are attempting to connect to is a valid address.
  - If you are on Ethernet, check Custom to verify the Ethernet type you have selected. In most cases the Ethernet/Dix option should be selected. If you have chosen IEEE, try selecting DIX option, save settings to Custom and restart windows.
  - Check the interrupt setting for the network card. Verify that it is not conflicting with any other system hardware interrupts (for example, mouse, printer, and so on).
• If your network adapter has a shared RAM capability verify that the memory manager you are using is correctly excluding this range from memory if the shared RAM option is enabled. A good test for this consists of starting Windows with the following option: win /D:X. This excludes the entire upper memory blocks from Windows upon starting Windows. Try to ping again. If you can ping successfully, then the shared RAM is not being properly excluded.

• Perform a network adapter internal test to verify that the adapter is functioning properly. Most network card vendors provide this utility on a separate diskette.
Chapter 3. Customizing Your Setup

The initial setup performed in the preceding chapter can be further customized through the use of the Custom application or the Dialer application. Before any changes can take effect, you must exit all Chameleon applications including the NEWT application (refer to the installation instructions on the quick install card.) The next time a Chameleon application is launched, the changes take effect. There is no need to restart Windows. The following sections discuss setting passwords and modifying an interface to customize your set up. For more information on Open Data-Link Interface (ODI), see the appropriate appendix.

Setting Passwords

To prevent users who do not have permission from changing Custom configurations, you can select the Set Password... option from the File menu to set a password for the Custom application. To set a password, do the following:

1. Choose the Custom icon.
2. Choose the Set Password... command from the File menu.
3. Type your password in the New Password box.
   
   If you have already set a password, Custom prompts you for your old password before you set up the new password.
4. Type the new password in the Confirm Password field and choose the OK button.

To delete your old password, type your old password and choose the OK button. You are prompted to enter your new password and confirm.

Modifying an Interface

Custom supports several types of interfaces. These include: Ethernet, Token Ring, FDDI, SLIP, PPP, CSLIP, or ISDN. Dialer supports SLIP, CSLIP, PPP, and ISDN interfaces.

You can modify these various interfaces. Most of the modifications you make to an interface are done through Custom's Configuration dialog box. You access this dialog box through either Custom or Dialer.
The tabs available in the Configuration dialog box depend on the type of interface you are configuring and whether you open the dialog box in Custom or in Dialer. The following table summarizes the function of each tab and whether a tab is available in Custom only or in both Custom and Dialer.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Function</th>
<th>Available in</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Configuration</td>
<td>Sets the IP address, subnet mask bits, and configures Chameleon dynamically</td>
<td>Custom (All interfaces)</td>
</tr>
<tr>
<td>Name Resolution</td>
<td>Specifies server information so that the mapping of IP addresses and computer names can be resolved</td>
<td>Custom (All interfaces)</td>
</tr>
<tr>
<td>Gateway</td>
<td>Sets the default gateway and two alternates and provides routing information</td>
<td>Custom (All interfaces)</td>
</tr>
<tr>
<td>Port</td>
<td>Sets communication port options</td>
<td>Custom and Dialer (Serial interfaces only)</td>
</tr>
<tr>
<td>Dial</td>
<td>Lets you enter telephone numbers you want to dial and set connection options</td>
<td>Custom and Dialer (ISDN and serial interfaces only)</td>
</tr>
<tr>
<td>Call Type</td>
<td>Sets options that provide support for data, video, voice, or X.25 calls</td>
<td>Custom and Dialer (ISDN interfaces only)</td>
</tr>
<tr>
<td>Modem</td>
<td>Sets options you need to configure if you are using a modem</td>
<td>Custom and Dialer (Serial interfaces only)</td>
</tr>
<tr>
<td>Tab</td>
<td>Function</td>
<td>Available in</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Login</td>
<td>Lets you setup a login command and specify a login script</td>
<td>Custom and Dialer (ISDN and serial interfaces only)</td>
</tr>
<tr>
<td>Advanced</td>
<td>Lets you enter IP and physical address information for frequent connections, set up an interface as a primary interface, set the interface type or Ethernet type, and set multiple interface connection options</td>
<td>Custom (All interfaces)</td>
</tr>
</tbody>
</table>

Details on performing the tasks summarized in the preceding table are given in this chapter and the Using Dialup Protocols and Using Routing chapters.

**Opening the Configuration Dialog Box in Custom**

To open the Configuration dialog box in Custom, do the following:

1. Choose the Custom icon.
2. In the Custom window's list box, select the interface you want to modify.
3. Choose the Configuration... command from the Setup menu.

   The Configuration dialog box appears. The tabs available in this dialog box depend on the type of interface you selected.

**Note:** You can also open the Configuration dialog box by choosing (double-clicking) the interface you want to modify in the Custom window's list box.

**Opening the Configuration Dialog Box in Dialer**

To open Custom's Configuration dialog box from within Dialer, do the following:

1. Choose the Dialer icon.
2. Choose the desired interface in the Selected Interfaces option.
3. Choose the Configure.... button.

   The Configuration dialog box appears. The tabs available in this dialog box depend on the type of interface you selected.

**Note:** Dialer does not let you add or delete interfaces. Those operations must be done in Custom.
Setting IP and Dynamic Configuration Options

You set IP and dynamic configuration options to

- define the computer's IP address and subnet mask
- configure Chameleon dynamically by setting up your computer as a client using one of the following protocols:
  - UDP/IP bootstrap protocol (BOOTP) client
  - Dynamic Host Configuration Protocol (DHCP) client
  - Reverse Address Resolution Protocol (RARP) client

Your computer uses these protocols to find its configuration information, such as its IP address. For details on a protocol, see the section in this chapter discussing that protocol.

To set IP and dynamic configuration options, do the following:

1. In Custom, select the IP Configuration tab in the Configuration dialog box.

2. In the IP Address text box, type your IP address.
   
   Avoid illegal addresses such as broadcast (0.0.0.0), subnet broadcast (156.27.0.0 or 156.27.255.255), or loopback (127.x.x.x). For information about which IP addresses are available and which ones are reserved, see the IP address table in the Installation and Setup chapter.

3. In the Mask Bits text box, type the number of subnet mask bits.

   The subnet division is used to partition the IP address into a network portion and a host portion, if needed. See the Custom online help for more information. Depending on your network, a subnet mask may be optional.
4. Select the Use Dynamic Configuration check box. Then choose the button of the protocol (BOOTP, DHCP, RARP) you want your computer to use to find its configuration information.

**Note:** RARP is not available for serial dialup interfaces.

This chapter includes separate discussions on each of the protocols you can choose. For details on a particular protocol, see the appropriate section.

5. If you chose the BOOTP button and you want to specify a server IP address, do so in the BOOTP Server IP Address text box.

**Note:** If you do not specify a server IP address, the BOOTP request will broadcast on the network. This is usually preferable.

6. To save the configuration information on your computer, select the Reuse Dynamic Data check box.

If you store the configuration information obtained from a BOOTP or DHCP server, your computer will have access to that information if the server becomes unavailable.

7. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

**About a BOOTP Client**

The UDP/IP bootstrap protocol (BOOTP) permits a workstation to find its Internet address and other configuration information, such as default gateway and domain name server. A workstation running BOOTP client broadcasts onto the network a BOOTP request packet.

A machine running the BOOTP server application returns a response that includes the host's Internet address, the address of a boot server, the address of a default gateway, and other configuration information such as the addresses of the domain name servers, the subnet mask, and its host and domain name.

**Note:** The BOOTP information returned by the server will supersede your current configuration.

The BOOTP server must be on the same subnet or else a BOOTP helper is needed on the router.
**About a DHCP Client**

The Dynamic Host Configuration Protocol (DHCP) permits a workstation to find its Internet address and other configuration information, such as the default gateway and domain name server.

A machine running the DHCP server application returns a response that may include the host’s Internet address, the address of a boot server, the address of a default gateway and other configuration information such as the addresses of the domain name servers, the subnet mask, and its host and domain name.

DHCP is more flexible and returns more information than BOOTP. It is a dynamic lease, meaning it may return different IP addresses depending upon what negotiation has taken place between your workstation and the DHCP server.

The DHCP server must be on the same subnet or else a DHCP helper is needed on the router.

**About a RARP Client**

The Reverse Address Resolution Protocol (RARP) permits a workstation to find its IP address. It returns no additional information other than the IP address which is based on a MAC address (Media Access Control). This protocol is useful for users who only have access to a Reverse ARP server. RARP is not as flexible as BOOTP or DHCP.

*Note:* RARP is not available for serial dialup interfaces.

**Name Resolution**

Computers on the network can identify one another through their IP address. However, you probably use names rather than cumbersome IP addresses to identify computers. The names and IP addresses need to be mapped to one another. You could do this by defining a host table on many computers on the network. As an alternative to a host table on many computers, some networks use a centralized name server to maintain name-to-IP address mappings.

Custom lets you

- specify server information
- define a host table

**Specifying Server Information**

Specify server information to

- define which servers your computer can obtain name-to-IP address mapping information
- specify in which order your computer searches for IP addresses
One or more tables may be referenced. These tables include the local host table available on your computer, a domain name server (DNS) if specified, and an NIS server if specified.

To specify server information, do the following:

1. In Custom, select the Name Resolution tab in the Configuration dialog box.

2. In the Host Name text box, type the network name of your computer.

3. In the DNS Domain Name text box, type the name of the domain in which your computer resides.

4. In the NIS Domain Name text box, type the NIS domain name.

   If you do not specify an NIS domain name or enter an invalid name, NIS will not be used. The NIS server is determined by broadcasting to the specified NIS domain. Since multiple servers may be present in a given domain, the first server to respond to the broadcast is the NIS server used.

5. Specify the order in which the tables that determine the IP address for a given host name are referenced. To do so, choose the desired option from the Host Resolution Order drop-down menu.

   The default resolution order is: 1) local HOSTS file 2) DNS.

   The HOSTS file is a table you can create as discussed in the Defining a Host Table section.

6. Specify which servers maintain name-to-IP address mappings. You do so by typing a server's IP address in the Domain Servers text box and then choosing the Add button.

   The IP address of a domain name server (DNS) and up to two alternates may be added to the list box. If you add one or more domain servers, a name lookup
request is sent to the IP address of the DNS. If the request is not satisfied, the
alternates are queried in the order specified in the dialog box.

You can delete an IP address from the list box by selecting that address and then
choosing the Delete button.

7. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your
     settings by choosing the Save command from the File menu.

Note: Chameleon can also be used as a domain server. Refer to the Bind chapter for
more information.

The ChameleonNFS product supports DNS and NIS.

**Defining a Host Table**

Specifying systems by IP address is cumbersome and the addresses are hard to
remember, whereas using names is a much more natural process. A standard hosts file
(HOSTS), defined on many computers, can be used for this purpose.

To define the host table, do the following:

1. In Custom, choose the Host Table... command from the Services menu.

2. Type or select a host name, and choose the Add or Modify button. After all changes
   are completed, choose the Save button to update the host table file.

   ![Host Table](image)

   A second dialog box appears in which the IP address for the specified name and its
   aliases can be entered.
3. For each alias, type the name and choose the Add button. Once all changes are completed, choose the OK button to return to the Host Table dialog box.

**Note:** Changes to the host table can be made at any time, even while a Chameleon application is running. Once these changes are saved, every program will have access to these new settings. The host table entries appear in all Chameleon applications as a list of selections for a host name choice.

You may copy an existing host table file from another Chameleon installation, or from another system, such as a Sun workstation. Place the file in your Chameleon directory under the name HOSTS.

**Setting Up Default and Alternate Gateways**

Communication is normally limited to the systems directly connected to your network. Many networks actually consist of a collection of networks (called subnets) interconnected with routers (or gateways).

These routers are responsible for letting one subnet talk to any other indirectly connected subnet. To specify which router should receive communication destined for addresses in an unknown subnet, you need to set up a default gateway.

You can configure your set up for multiple gateway capability. This means if the first entry fails, the second and third gateway entries will be automatically tried.

The default and alternate gateways must exist on the same subnet as your local PC. For example, if your IP address is 123.27.1.2, your default gateway might be 123.27.1.1, assuming the subnet mask value is the same.

**Note:** For more information about subnet masks, refer to the section that discusses Network Addresses under the Custom application.

To set up a default gateway and its alternates, do the following:

1. In Custom, select the Gateway tab in the Configuration dialog box.
2. Specify the IP addresses of the default gateway and its alternates. To add a gateway's IP address, do the following:
   
a) Type the IP address in the Gateway text boxes located at the top of the dialog box.

   b) Choose the Add button.

   The IP address is added to the Gateway list box. If you decide later to delete the IP address from the Gateway list box, do so by selecting the address and then choosing the Delete button.

3. Do one of the following:
   
   • Select another tab if you want to continue customizing your setup.
   
   • Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

The Gateway tab also lets you set up routers as discussed in the Using Router chapter.

**Configuring Advanced Settings**

You can use Custom to set the following:

• frequent destinations

• primary interface

• Ethernet type

• multiple interface configuration
1. In Custom, select the Advanced tab in the Configuration dialog box.

![Ethernet Configuration Dialog Box]

2. If you plan to use the connection frequently, type the IP address and the physical address in the appropriate text boxes. Then choose the Add button.

When communication is first attempted to a particular IP address, the network software must determine the physical address for that IP address. This is accomplished through the use of the Address Resolution Protocol (ARP). You can avoid repeating this process for frequently requested connections by entering both addresses (IP address and physical address) in the Advanced tab.

**Caution:** Be careful when setting frequent destinations; an incorrect physical address may cause network communication conflicts.

3. If you want the interface to be the primary one, select the Primary Interface check box.

Many software packages assume that the system on which it is running contains only one network interface and therefore has only one IP address. Because NEWT can support multiple interfaces concurrently confusion can result. The Primary Interface check box indicates which interface should supply the IP address of this system for these applications as well as default gateway and DNS.

**Caution:** This setting is automatically set by Custom to the correct interface; modifications to this setting should be performed with caution.

4. If you are using Ethernet, use the Ethernet Type drop-down menu to specify the type of Ethernet packets your computer can transmit and receive.

Ethernet physical layer packets are one of two forms: DIX or IEEE. The vast majority of networks use DIX, though all systems are designed to receive IEEE packets as well.

ChameleonNFS can receive both DIX and IEEE packets simultaneously and will send out the format selected in the dialog box. Many other machines will only receive the selected format.
Caution: Unless you are absolutely positive that you are on an IEEE packet network, do not change this value. Many systems do not respond correctly to IEEE packets, making troubleshooting your network very difficult.

5. If you have set up your computer with multiple interfaces, you need to define how their operation is controlled. To do so, set the multiple interface configuration options as discussed in the Using Routing chapter.

6. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

**Adding New Interfaces**

To add an interface, do the following:

1. In Custom, choose the Add... command from the Interface menu.

![Add Interface dialog box](image)

2. In the Name text box, type the name you want to assign to the interface.

3. From the Type drop-down menu, choose the type of interface you want to add.

4. Choose the Hardware... command from the Setup menu. Enter the appropriate information in the Hardware dialog box.

   For LAN interfaces, you need only configure hardware settings if you are using NDIS. The Hardware... command is unavailable for ODI because your adapter should already be configured and functioning.

   The options available in the Hardware dialog box depend on the type of interface you are configuring.

5. Choose the Configuration... command from the Setup menu. The Configuration dialog box appears.

6. Enter the IP address and subnet mask bits information. For details on specifying these options and the other IP Configuration options, see the Setting IP and Dynamic Configuration Options section.
7. Select the Name Resolution tab and enter an NIS domain name (if you are using NIS), and the host resolution order. For details on specifying these options and the other Name Resolution options, see the Specifying Server Information section.

8. If desired, configure the options on the other tabs.

Selecting the ISDN Interface

You can select the Integrated Services Digital Network (ISDN) interface during the installation process. You can also select this interface after installation if you already have a dialup interface and are adding ISDN.

To add the ISDN interface, do the following:

1. In Custom, choose the Add... command from the Interface menu.

   ![Add Interface Window]

2. Choose ISDN from the Type drop-down menu. The ISDN interface name appears on the Custom window.

   ![Custom Interface Window]

3. Choose the Hardware... command from the Setup menu.
4. Select the desired vendor from the Vendor drop-down menu. Type the appropriate numbers in the SPID1 and SPID2 text boxes and choose the OK button. Do not make any other changes in the Hardware dialog box.

You can obtain the SPID1 and SPID2 numbers from your ISDN providers.

Note: The IRQ_Level and Memory fields are the card defaults. If you need to change the hardware, you need to make the appropriate changes in the IRQ_Level and Memory fields.

5. Choose the Configuration... command from the Setup menu. Then select the Call Type... tab in the Configuration dialog box.

You can also access the Call Type tab from Dialer.

6. Choose the appropriate data type and speed. Then choose the OK button.

The Data and B 64K options are the default selections. This default configuration should be compatible with your system.

Note: If you encounter any problems using 64K, check that your ISDN provider supports this speed end-to-end. If not, use the B 56K option instead.

7. If you want diagnostic information displayed in the log window at the time of connection, select the Diagnose check box. Choose the OK button.

The Board Number option specifies the ISDN board number.

For details on the Multiple Protocol options, see your online help.

To make a successful ISDN call you need to complete all the other Custom application sections that are relevant such as login and Dial/phone number.

**INETD Configuration**

The INETD (Internet Services Daemon) feature is based upon the UNIX INETD super-server which automatically launches other servers when requested. INETD saves memory and helps eliminate the necessity to launch individual servers.
For example, if someone wants to reach you using the Talk application and you do not have it open, but have it listed in your INETD configuration, then INETD will open it automatically when it senses that someone is trying to reach you through Talk.

**Installing Servers Under INETD**

To install servers under INETD, do the following:

1. Choose the Custom icon.

2. Choose the INETD Configuration... command from the Services menu. The INETD Configuration dialog box appears.

   All the servers that INETD can open when requested are listed in the Services list box. A default list of servers that NetManage supplies initially appears.

3. Select the server or servers you want to install and choose the right-arrow button (>>). All selected servers will now appear under the Installed field.

   To remove any installed servers, select the desired server in the Installed field and choose the left-arrow (<<) button.

4. Choose the OK button to save changes.

   **Note:** For any changes to take effect, you must restart Windows.

**Adding New Servers to INETD**

If you want to add additional servers that are not in the default list, do the following:

1. From the INETD Configuration dialog box, choose the Advanced button. The Advanced dialog box appears.
2. In the Description option, enter the name of the server you want to add. For example, if you want to add a winsock-based Gopher server, you could specify gopher server for this option.

3. In the Command line option, type the pathname of the server application you want to add. Then specify the port number in the Port field, and the protocol type in the Protocol field.

4. Choose the Add button to add the server to the list of servers in the INETD Configuration dialog box.
Chapter 4. Using Dialup Protocols

This section discusses how to use the following serial protocols:

- SLIP (Serial Line Interface Protocol)
- CSLIP (Compressed SLIP Protocol)
- PPP (Point to Point Protocol)

Before attempting a dialup connection using SLIP, CSLIP, or PPP, some additional settings are needed. These settings are made once initial installation and setup is complete. They vary, depending on the type of Serial/IP connection you are using. A sample of the various configurations that are supported includes:

- Direct serial connection (no modems)
- Modem connection directly to another system
- Modem connection through an Internet Provider (for example, PSI)
- Modem connection in Answer mode

Once a Serial/IP connection has been established, it appears to all network applications no differently than a LAN interface. This is an important point in that the network addressing rules that apply for LAN interfaces must also apply to Serial/IP interfaces.

For example, the two systems on the Serial/IP network (your local system and the remote system) must have a unique IP address (such as 123.27.4.1 and 123.27.4.2).

If one of the systems is a PC running ChameleonNFS with two interfaces, standard router addressing must apply. For example, the router may have an Ethernet side with address 135.27.4.1 and a Serial/IP side of 136.27.4.1. This places them on the separate subnets. Your Serial/IP address must be on the Serial/IP subnet.

Additional Information about SLIP/CSLIP/PPP

- SLIP and CSLIP are basically the same protocol, except header compression is used in CSLIP packet format. The TCP connection is faster when compressed header is used.
- PPP has the ability to negotiate several parameters such as header compression and IP addressing. PPP is faster due to header compression and larger packet sizes and provides enhanced security.
- The default MTU (Maximum Transmission Unit) for PPP is 1500.
- The default MTU for SLIP/CSLIP is 1006.
• CHAP and PAP - special packet format for negotiation of security with PPP (this is supported by NetManage PPP).

• NetManage PPP is in PASSIVE mode for the first 3 sec. If NetManage PPP does not receive any negotiation packet within first 3 sec, it will change to the ACTIVE mode begin PPP negotiation.

• SLIP / PPP / CSLIP are 8bit protocols (currently ChameleonNFS only supports 8bit login).

**SLIP/CSLIP/PPP Setup**

To set up NEWT for dialup access using SLIP, CSLIP, or PPP, do the following:

1. Follow the instructions described in the Installation and Setup chapter, but select SLIP, or any other serial connection interface as the interface type.

2. In Custom or Dialer, select the Port tab from the Configuration dialog box.

3. Specify the appropriate values for your dialup connection as discussed in the Changing Port Options section.

   **Note:** Changes to port settings other than the baud rate and connector settings should be performed with caution. In particular, hardware flow control is the default setting due to binary communication requirements.

4. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.
SLIP/CSLIP/PPP Routing and Configuration

When setting up a SLIP connection, verify that the local PC and the remote device that you are dialing into (remote SLIP host) are on the same sub-net.

Example

If the IP address of the remote SLIP host is 156.27.50.1 and the sub-net mask is 255.255.255.0 (a class B address subnetted 8 bits) then the local PC's (HOST) IP address can be 156.27.50.2 with the same subnet mask.

Refer to the above example to note that a local PC and the remote server are located on the same subnet.

If the remote SLIP host is a Chameleon PC with multiple interfaces (SLIP/PPP and Ethernet), then you must make sure that the SLIP/PPP and Ethernet interfaces are configured on separate subnets.

Example

<table>
<thead>
<tr>
<th>SLIP/CSLIP/PPP Network</th>
<th>Ethernet network</th>
</tr>
</thead>
<tbody>
<tr>
<td>(A)---------------------</td>
<td>(B) (C)-----------</td>
</tr>
</tbody>
</table>

Remote PC: Router: Host
running Chameleon

In order to understand the addressing better, assign an IP address to each of the devices on the sample network

(A) -- Remote PC - 156.27.50.2  Subnet mask - 255.255.255.0

(B) -- SLIP/PPP interface on the Server: 156.27.50.1  (Chameleon PC with two interfaces defined)

Subnet mask: 255.255.255.0

(C) -- Ethernet interface on the Server : 156.27.10.1  (Chameleon PC with two interfaces defined)

Subnet mask: 255.255.255.0

(D) -- Host on the Ethernet network : 156.27.10.2

Subnet mask: 255.255.255.0

In order to establish communication from device (A) to device (D). Device (D) must know how to route back to the SLIP/CSLIP/PPP network via device (C). You can accomplish this by specifying Device C as the Default Gateway for Device D.

After addressing issues are resolved, verify the SLIP/PPP port settings in the CUSTOM application (assuming that the user has defined SLIP, CSLIP or PPP interface already).
Pre-Configured Dial-up Internet Access

Chameleon comes with pre-configured setups for many of the popular Internet access providers. Note that Chameleon allows you to connect to the Internet as a full TCP/IP host, rather than login through a shell account. If you have a shell account, contact your Internet Service Provider about upgrading to a full SLIP, PPP, or ISDN account. After selecting the dial-up Internet provider of your choice and establishing a SLIP or PPP account with them, start Custom and choose the Open... command from the File menu to open the configuration file for that provider.

We provide a configuration file with predefined interfaces configured for different access providers, for example PSI (Performance Systems International).

If a pre-configured setup is not available for your chosen provider, or you want to define an interface to connect to some other host, select Cancel, and then proceed with the instructions that follow in this chapter for creating a new SLIP or PPP interface.

The setups include the appropriate values for certain entries in custom, such as Domain Name Server. Most importantly, they also have preconfigured login scripts to simplify the login process. Certain providers, such as PSI, use dynamic IP assignment at login so the user is not even required to supply an IP address.

Simply select the correct interface and enter the missing values in custom for IP address, host name, domain name, port, modem, dial, and login. After saving these values and restarting custom you will be ready to connect. You may change any of the pre-set values in Custom, if necessary.

SLIP and PPP Differences from Ethernet Interfaces

Note that certain values in custom are not applicable to SLIP or PPP interfaces and do not need to be set. In particular, custom no longer requires either a Subnet Mask or Default Gateway for these interfaces. Other entries that will be ignored for SLIP and PPP are values for Route Entries or Frequent Destinations.
Changing Between SLIP, PPP, and CSLIP

You can easily change the interface type between SLIP, PPP, and CSLIP by using the Interface Type option. Therefore, if you are using the pre-defined interfaces, you can automatically change the type of access defined for the provider of your choice by doing the following:

1. Select the Advanced tab in the Configuration dialog box.

2. From the Interface Type drop-down menu, choose the appropriate interface type button (SLIP, CSLIP, or PPP) and choose the OK button.

Changing Port Options

Note: Changes to port settings other than the Baud Rate and Connector settings should be performed with caution. In particular, hardware flow control is the default setting due to binary communication requirements.

To change port settings, do the following:

1. In Custom or Dialer, select the Port tab from the Configuration dialog box.

2. Specify the appropriate values for your dialup connection.

   SLIP/PPP/CSLIP are 8-bit protocols and must have the following settings: 8 Data Bits, 1 Stop Bit, and None Parity.

   Note: Changes to port settings other than the Baud Rate and Connector settings should be performed with caution. In particular, hardware flow control is the default setting due to binary communication requirements.

   ChameleonNFS does not support 7bit login.
3. Do one of the following:
   • Select another tab if you want to continue customizing your setup.
   • Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

Changing Modem Settings

To change modem settings, do the following:

1. In Custom or Dialer, select the Modem tab in the Configuration dialog box.

2. From the Model list box, select the appropriate modem type and then choose the Select button.
   
   If your modem is not listed, selecting Hayes for the modem type works across most modem types. To indicate a direct null-modem connection, select [Direct connect - no modem]. A direct connection does not require any dialing.

3. In the Modem Init text box, type the modem initialization string that you want sent to your modem to prepare it for a dial-in connection. In the Dial Prefix text box, you can enter information that prepares the modem for dialing. In the Dial Suffix text box, you can enter information that signals the modem that dialing is to end.

   NetManage supplied modem initialization strings are:
   • ^M (Ctrl + M): ASCII#13, <Enter>
   • ~ (Tilde) - time delay, each '~' is a one second delay

   **Note:** For information about any other string settings, refer to the manual provided by your modem vendor.

4. In the Answer Setup text box, type the string that you want sent to your modem to prepare it to answer a dial-back attempt.
5. In the Hangup Command text box, type the string that is to tell your modem to hang up.

6. From the Max Speed drop-down menu, choose the speed at which your PC is to communicate with your modem. The available speeds are in bits per second (BPS).

7. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

**Changing Dial Settings**

To change dial settings, do the following:

1. In the Custom window, select the interface you want to change. Then choose the Configuration... command from the Setup menu.

2. In Custom or Dialer, select the Dial tab in the Configuration dialog box.

3. If a prefix must precede the telephone number you want to dial, select the Use Prefix check box. Then type the desired prefix in the Use Prefix text box. If a prefix is unnecessary, skip this step.

   The numbers you include in the Use Prefix text box can be any number that must precede the area code and phone number you want to dial. Typically such numbers are another country’s access code or an access line. (Dialing 9 before you can dial out is an example of using an access line.)

4. Specify the phone number you want to dial by either selecting it from the Telephone Number list box or typing it in the Telephone Number text box. If you want to indicate Answer mode when connected, leave the Telephone Number text box blank.
You can create a list of frequently dialed numbers by doing the following:

a) Type the desired number in the Telephone Number text box.

b) Choose the Add button.

The specified number is added to the Telephone Number list box. If you decide later to delete a number from the Telephone Number list box, select that number and choose the Delete button.

5. If a suffix must follow the telephone number, select the Use Suffix check box and then type the desired suffix in the Use Suffix text box. If a suffix is unnecessary, skip this step.

A suffix is any additional numbers that you will need to enter before the connection can be made. For example, you can include a credit card or calling card number in the Use Suffix text box. A suffix could also be the numbers you are prompted for by your Internet provider’s voice mail.

You can keep your credit card or calling card numbers private by selecting the Hide Suffix check box.

6. If you anticipate that the connection may take a long time, increase the value specified in the Timeout If Not Connected text box.

The minimum value for the timeout before disconnecting is 30 seconds.

7. Specify the method you want to use for disconnecting by doing one of the following:

- If you want to disconnect any serial interface connection manually, choose the Manual button. You disconnect manually by selecting the interface you want to disconnect and then choosing the Disconnect menu option.

- If you want the interface connection disconnected automatically when the system detects no traffic (no packets being sent to or received from your system) for a specified amount of time, choose the No Traffic button. Then type the number of minutes and seconds you want to elapse before the interface is disconnected because no traffic was detected.

- If you want the interface connection to disconnect automatically when the system detects no open connections, choose the No Open Connections button. For example, if you are currently connected and running the FTP application, the interface connection will automatically disconnect after you close the FTP connection according to the specified timeout. If you choose this option, you need to type the number of minutes and seconds you want to elapse before the interface is disconnected because there is no open connection.

8. If you want to automatically connect or disconnect your interface through another application (such as FTP), select the Dial On Demand check box.
For example, if you select this option, your system will automatically dial up when you choose Connect in FTP. Depending on how you selected your Disconnect option under the Dial tab, your serial connection can also automatically terminate when you disconnect your FTP session.

**Caution:** You should always check your dial-up connections at the end of a session to be sure they are closed. Not all modems operate identically and unusual circumstances such as a PC being accidentally powered off may not guarantee a complete disconnect.

9. Set dial preferences by selecting or clearing the remaining check boxes. The following table describes the additional options you can set:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Suffix</td>
<td>Select this check box if you want asterisks (***}) rather than numbers to appear in the Use Suffix text box. This helps you keep your credit card or calling card numbers private.</td>
</tr>
<tr>
<td>Open Log When Connecting</td>
<td>Select this check box if you want to display the log while the connection is being made.</td>
</tr>
<tr>
<td>Signal When Connected</td>
<td>Select this check box if you want to be signaled with a beep when a connection is made.</td>
</tr>
<tr>
<td>Prompt For Calling Card Number</td>
<td>Select this check box if you want a prompt to appear reminding you to enter a calling card number while a connection is being made.</td>
</tr>
<tr>
<td>Redial After Timing Out</td>
<td>Select this check box if you want to automatically redial if there is a connection try time out.</td>
</tr>
<tr>
<td>Redial After Carrier Is Lost</td>
<td>Select this check box if you want to automatically redial after a connection is lost.</td>
</tr>
</tbody>
</table>

10. Do one of the following:

- Select another tab if you want to continue customizing your setup.
- Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.
Specifying Login Settings and Script Edit Settings

You can specify login settings and integrate serial scripting features into Custom itself. You no longer need to use the SLIP.INI file that was used in previous versions of Chameleon to make changes to the scripts. Or, you can choose to use the Interactive Log Window feature instead (refer to next section.)

To set your login settings and edit a script, do the following:

1. In Custom or Dialer, select the Login tab.

2. Type the username, password, and startup command string for dialup service providers.

   These fields are transmitted when the login script is executed. The username is required for the script to be executed even if there is no need for a username.

3. In the Script text box, enter the script you want to edit. If you already know what you want to edit, you can edit the script directly in this field. Otherwise, do the following:

   • To display each Expect and associated Send statement, use the left arrows (<<) to move backward through the script, and use the right arrows (>>) to move forward through the script.

   • To replace existing statements in the script, move through the script until the desired Expect and Send statements appear. Make the necessary changes. Then select the section you want to replace in the above script and choose the Replace button.

   • To insert new statements in the script, type new Expect and Send statements in the appropriate text boxes. Place your cursor in the Script text box where you want to insert the new statements and choose the Insert button.

4. Choose the Done button when the script changes are complete.
5. Choose the Save command from the File menu to save these changes.

6. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

If you prefer to manually connect to the host rather than automatically using the script, select the Ignore Script check box and then refer to the Using the Interactive Log Window Feature (Custom Terminal) section.

**Using the Interactive Log Window Feature (Custom Terminal)**

Use the Interactive Log Window feature if you prefer to manually connect to the host before establishing a script, or if you want to test your connection before creating a script.

If you already have an established script, follow steps 1-6. If you do not have a script defined then follow steps 3-6.

**Note:** Make sure you have completed the Port, Modem, and Dial settings before using the Custom Terminal feature.

1. In Custom or Dialer, select the Login tab.
2. Select the Ignore Script check box and choose the OK button.
3. In Custom choose the Connect menu option. In Dialer, choose the Connect... button.
   
The Custom-Terminal log window appears. You will hear the dial tone and see the dialing information appear in the Custom Terminal dialog box.

4. In the Custom Terminal log window, enter your login and password at the Login and Password prompts.
5. Choose the Set IP button to display the Internet Address dialog box. Enter your known IP address or the IP address given by the host in the Custom Terminal window and choose the OK button. Note that the IP Address button is equivalent to the -i option in Script.
6. In the Custom-Terminal log window, choose the Done button when the login process (entered and set IP Address) is complete. The Connect menu item in Custom now changes to Disconnect.

If you begin to see an unrecognized series of ASCII characters in the Terminal window, then most likely the remote server has finished the login process and begun PPP negotiation. Or the remote server is sending SLIP data packets. Choose the Done button to end the login process.

7. When the connection is complete, choose the Close button to close the Custom Terminal log window.

Note: You can also close the Custom Terminal log window after your system is connected by choosing the Close button. However, if you choose the Close button while a connection is taking place, a prompt appears asking if you want to disconnect.

Configuring MTU Sizes

Chameleon now has a configurable MTU size for serial interfaces. The default value for MTU is 1500 for PPP and 1006 for SLIP and CSLIP. To change the MTU value you can edit your WIN.INI file as follows:

```
[TCPIP] section, add:
pppmtu=1500
slipmtu=1006
```

(Depending on your server configuration, it should not exceed this value)

The MTU corresponds to the largest packet that can be sent over the serial line. Packets are often smaller than 1000 bytes, so applications like Telnet may not show an improvement by raising the MTU, since most Telnet packets are small, containing only a few data characters.

For NFS, the recommended Read and Write size should be set to a value of at least 128 bytes less than the MTU value, at a multiple of 256, to allow for packet header information. For example, if your MTU is set to 1500, you will want to use a maximum Read and Write value of 1280. You can set this value lower if necessary. For a default MTU of 1006, use NFS R size/W size of 768.

Note: For additional information on configuring read and write size using SLIP and PPP, please refer to the section that discusses dialup protocols.
Connecting and Disconnecting the Interface

Once the interface has been properly defined as described in the Setup section of this chapter, you must connect the interface using the Custom application. This is accomplished by selecting the interface in the Custom application and selecting the Connect menu item. A dialog box appears indicating that a connection is in progress. Once the connection is successfully established, the Connect menu item changes to Disconnect.

Choose the Disconnect menu option to terminate the connection after you have completed your work to disconnect manually. Choose the Log... command to view the connection progress.

Note: If you have chosen the No Traffic or No Open Connections items under the Dial menu then the connection will automatically terminate according to the timeout specified.

An icon appears at the beginning of the interface entry to signify that the interface is connected. It then appears in the list of current interfaces in the NEWT application. Disconnecting the interface removes the plus sign and the entry from the NEWT application. The icon for Custom also changes, indicating the connection. This appears when the Custom application is minimized. Note that NEWT will show a captured IP address.

You may change any of the setup values and connect the interface without saving the changes to the configuration file. This can be used to try a variety of settings before settling on the best one for your purposes. You can also use the Duplicate menu item in the Interface menu to create copies of an interface entry that differ only slightly, such as the IP, subnet, port, and so forth, each with its own telephone number. Additional SLIP entries may also be defined with entirely different settings.

Establishing Connections with Dialer

To use Dialer to connect a serial or ISDN interface to the Internet, do the following:

1. Choose the Dialer icon.
2. Specify the desired interface in the Selected Interfaces option.
3. If you want to configure an ISDN interface so that it can support up to two calls at the same time, select the Use MultiLink Protocol check box.
4. If you need to dial any numbers before dialing the desired phone number, select the Use Prefix check box then type the necessary numbers in the Use Prefix text box. If no numbers must precede the phone number, skip this step.

The numbers you include in the Use Prefix text box can be any number that must precede the area code and phone number you want to dial. Typically such numbers
are another country’s access code or an access line. (Dialing 9 before you can dial out is an example of using an access line.)

5. In the Telephone Number text box type the area code and phone number you want to use when connecting to the selected interface.

6. If you need to enter additional numbers after dialing the phone number, select the Use Suffix check box. Then type the additional numbers in the Use Suffix text box. If such numbers are not necessary, skip this step.

   For example, you can enter a credit card or calling card number in the Use Suffix text box. You could also use the Suffix text box to enter the numbers you are prompted for by your Internet provider’s voice mail.

7. Choose the Connect button.

**Verifying Setup**

To verify that your SLIP/CSLIP/PPP setup was performed correctly, do the following:


2. Choose the Custom icon and connect the interface.

3. Verify the IP address and phone number

4. Make sure the COM port is available and not in use by another application (such as Microsoft Windows Terminal) if the connect reports an error immediately.

5. Verify that the Modem and Dial settings are correct if the connect reports an error after communicating with the modem. If you have an external modem, you can use the lights on the modem to help diagnose modem communication problems.

6. Verify that the port settings in Custom are 8 Data Bits, 1 Stop Bit, and None Parity.

7. Use the Log window to determine where errors occur.

8. Use the Ping application to check the domain name server IP address.

9. If you have trouble connecting, try again using a lower baud rate, for example 2400.

Once you do these steps, you should have no problem using any of the Chameleon applications. If a particular application fails to work, refer to the Troubleshooting section of the specific application chapter.

**Using PAP and CHAP**

Our PPP negotiation supports two authentication protocols:

- Password Authentication Protocol (PAP)
• Challenge Handshake Authentication Protocol (CHAP)

The server has to be configured to use PAP or CHAP.

The user login and password defined in Custom are used during the PAP/CHAP process. The user login is stored in the Custom User Name field and the PAP password or the CHAP secret are stored in the Custom Password field. On remote systems that have the three fields (Login, Password, and CHAP Secret), you can normally disable their Password field.

By default an interactive window will pop up to allow you to log into the SLIP server and start a SLIP session. You can write a Script to automate this process.

**SLIP/CSLIP/PPP Scripting**

Use SLIP, CSLIP, or PPP's scripting language if you require automatic network dialogs different than the ones provided. You can define a different script for each serial line interface.

**Writing Login/Connection Scripts**

The scripting language is used to negotiate the initial login to the remote host. The remote host could be a UNIX system, a special SLIP/CSLIP/PPP router like a Telebit NetBlazer, a Chameleon PC or a terminal server that supports the SLIP, CSLIP or PPP protocols.

The scripting language is simply a series of alternating Expect and Send statements. The Expect statements tell the script to wait for a character or a series of characters before it Sends a reply. The Send statements send the information in response to a prompt (the preceding Expect) from the remote host.

**Script Example#1**

If you define both a SLIP and a PPP interface in the Custom utility, your Script will look something like this:

```
name: $u$r word: $p$r -n $6$c$r -i
```

By default, no script is created which requires the user to do manual logon in the interactive window.
In order to successfully execute a dial-up script, you must know the login sequence, the exact prompts, the order, and the information for which you are prompted.

**Script Example #2**

If you need to send a username at the Login prompt, the script will look like this:

```
Login: $u$r
```

Login: - is the exact prompt to be expected *(expects are case sensitive)*

$u - will send the login name from the User Name field in Custom

$r - will send a CR (Carriage Return)

**Script Example #3**

Sometimes you need to send a Carriage Return (CR) (hit ENTER) to the "wake-up" server, before you can send the username. The script will look like this:

```
-n $r Login: $u$r
```

-n Skip an expect. Anything following this character will be a send. In the above example we are sending a CR represented by the $r character.

Let's take a look at the following script for interface:

```
name: $u$r word: $p$r -n $6$c$r -i
```

After the dial-up is complete and the baud rate is negotiated, the script tells Chameleon to expect the characters "name:" contained in the initial prompt from the remote host. After the prompt is received the program will send the userID (the $u parameter) and a Carriage Return ($r).

Chameleon next expects the password prompt "word:". Even though the actual prompt says "password:" , you only need to put in the last few characters of any prompt to create an "expect" string. After the prompt is seen by the script, the script will send the value contained in the login Password field in Custom and a CR ($p$r).

Then the script waits for a 6 second delay ($6), sends the command to start SLIP, CSLIP or PPP (represented by $c which sends the value specified in the Startup Command field of CUSTOM application LOGIN menu), after skipping an expect with the (-n) parameter. The script reads -n $6$c$r immediately after the password is sent.

The (-i) option at the end of the script, tells the system to expect an IP address (an IP address displayed in text by the remote SLIP host). The (-i) is not used for PPP. PPP negotiates the addresses automatically.

**Script Example #4**

Suppose the remote device that the user is dialing into has a (login:) prompt instead of the (name:), and no SLIP command. The script will look like this:

```
login: $u$r word: $p$r
```
A user can specify all of the send commands right in the script.

For example, we have a userID: Joe and the password: Chameleon

The script will look like this:
login: Joe$r word: Chameleon$r

Note: Use the $s option, if you want to create a send string with spaces.
If the user is sending the parameters directly in the script file, the user must specify something in the Username field under the Custom login menu. If the Username field is blank, the script will not be sent.

Modifying Existing Scripts

If you choose to modify the scripts provided, update the SLIP file using the following scripting language syntax:
<expect1><send1><expect2>...

Words are separated by white space, that is, spaces or tabs. Within a <send> string you can include the following escapes:

<table>
<thead>
<tr>
<th>Escape</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$n</td>
<td>send a new line</td>
</tr>
<tr>
<td>$r</td>
<td>send a carriage-return</td>
</tr>
<tr>
<td>$s</td>
<td>send a space</td>
</tr>
<tr>
<td>$b</td>
<td>cause a short &quot;break&quot; on the line</td>
</tr>
<tr>
<td>$t</td>
<td>send a tab</td>
</tr>
<tr>
<td>$1 - $9</td>
<td>pause the indicated number of seconds</td>
</tr>
<tr>
<td>$xXX</td>
<td>send the character with ASCII Decimal code XX</td>
</tr>
<tr>
<td>$u</td>
<td>send the user id</td>
</tr>
<tr>
<td>$p</td>
<td>send the password</td>
</tr>
<tr>
<td>$c</td>
<td>send the Startup Command</td>
</tr>
<tr>
<td>$d</td>
<td>send the phone number</td>
</tr>
<tr>
<td>$$</td>
<td>send a &quot;$&quot; character</td>
</tr>
<tr>
<td>$f</td>
<td>define a prompt</td>
</tr>
<tr>
<td>$g</td>
<td>define an encrypted prompt</td>
</tr>
<tr>
<td>$1</td>
<td>call-back feature</td>
</tr>
<tr>
<td>$-</td>
<td>skip a send</td>
</tr>
</tbody>
</table>
Within an <expect> string you can include the following escapes:

<table>
<thead>
<tr>
<th>Escape</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>expect &quot;-&quot;</td>
</tr>
<tr>
<td>-n</td>
<td>skip an expect</td>
</tr>
<tr>
<td>-i</td>
<td>expect IP address (to replace your own)</td>
</tr>
</tbody>
</table>

**Prompting Users for Information**

By using the $f prompt or $1 prompt, you can prompt users for information. Separate discussions on using each prompt follow.

**Defining Prompts with the $f Prompt**

Use the $f prompt to define a prompt (caption title) that you want to appear on your login message box. Normally, you would want to use $f when using a secure ID and you have to manually respond to a security prompt.

For example, in the following SLIP0 script, the user is prompted to enter his or her password at connect time. This is because the $f<prompt> is defined as Password.

```
login: $u$r word: $fPassword$r
```

When $f is encountered, a dialog box appears with an edit field whose label is the Prompt (in this case Password). In this example, the user is prompted to enter his or her password at connect time.

**$f Prompt Example**

```
login: $fEnter_Login$r
```

This script prompts you, by displaying a dialog box in Windows, to enter a login name. The text Enter_Login specifies the name of the dialog box that appears when the script encounters the $f parameter.

In the script, after the login prompt is received the dialog box named Enter_Login appears on the screen. Type in the username and choose the OK button.

**Defining Prompts with the $1 Prompt**

To use the $1 prompt, the SLIP or PPP server must be configured for a call-back account. In the following example, the user first makes a typical SLIP connection. The $1 prompt will cause Custom to close the connection and put the modem in call-back mode, anticipating a call from the server.

**Note:** You can place the $1 prompt anywhere in the script.

```
[SLIP1]
login: $u$r word: $p$r $1
```
Expecting an IP Address in SLIP

When you are expecting an IP address in SLIP, in some cases the remote server can return a message such as:

My IP address is xxx.xxx.xxx.xxx  Your IP address is xxx.xxx.xxx.xxx

If you are using the -i option and expecting an IP address to be assigned by the server, using the -i by itself will not work. The IP address captured by the -i option will be the first IP address found on this line, which is the IP address of the server. In this case, you must put an expect on the first IP address and use the $- option to skip all the data until the next IP address is located.

For example, the system returns the following message:

My IP address is 156.27.1.1  Your IP address is 156.27.1.155

Using the above example, the script might look something like this:

name: $u$r word: $p$r -n $6$c$r 27.1.1 $- -i

In the above example, we are using 27.1.1 to expect the first address, then the $- option is used to skip to the next IP address value on the same line.

Example Script Entry

The following pre-configured script is set up for use with PSInet, and the corresponding interface defined in PSINET.CFG:

name: $u$r word: $p$r -n $6$c$r -i

Which translates to:

Expect: name: (end of username:)

Send: user id and a carriage-return

Expect: word: (end of password:)

Send: password and a carriage-return

(skip an expect)

(wait for 6 seconds)

Send: the command line and a carriage-return

(wait for an IP address, in the form of a.b.c.d)
Dial-up Login (Internet Service Providers)

There are many companies that offer an Internet connectivity solution, and each solution provides a different login procedure. NetManage has an easy solution that offers dial-up scripting capabilities, thus allowing you to write a simple script that automates the login procedure. Before connecting to an Internet Service Provider you must have access to the following information:

- Type of connection (SLIP/CSLIP/PPP)
- Phone number
- Username and password
- Local IP address (if not dynamically assigned)
- Default Gateway IP address (IP address of the provider)
- IP address for Domain Name Server (optional)
- Mail Gateway, Mail Server and POP Server IP addresses (if Mail application will be used) (optional)

After you have obtained the above information and added it to the ChameleonNFS Custom application, you will be able to dial out.

When configuring the PORT settings in Custom you must use:

- Data Bits (other bit settings not supported currently)
- Stop Bit
- Parity None

Note: You must fill in the User Name field, located in the Login tab, in order execute the dial-up script. If you are only required to send a PASSWORD, you must have a dummy entry in the User Name field.

Multiple SLIP/CSLIP/PPP Interfaces

If you want to have more than one SLIP, CSLIP, or PPP interface, add the interfaces through Custom as discussed in the Customizing Your Setup chapter.

For example, when you add SLIP interfaces they will automatically be named as SLIP0, SLIP1, SLIP2, SLIP 3, SLIP4 and so on. However, you can change the default names and specify the IP numbers and domain names.
Chapter 5. Using Routing

Routers are used to interconnect subnets. This permits the breakup of large networks into smaller workgroup networks with transparent connections between these workgroups. Each individual system need only specify a default gateway for routing network traffic to unknown subnets. Each router knows about the overall network in order to make intelligent decisions about how to route individual packets.

Chameleon supports routing between multiple networks through the use of static route entries. This is a perfect solution for moderate routing needs, where a dedicated router is not available. An example is someone in the field dialing in with SLIP and being rerouted to the Ethernet.

The Custom application can be used to define multiple network interfaces of any type. Routing is performed automatically between these networks. To perform routing to additional networks that are not directly connected to the router, static route entries must be defined. Each entry must consist of the subnet that you want to route to, and the next router in the transmission sequence.

Note: Systems with multiple interfaces do not use a defined default gateway when routing between network interfaces. Only directly connected interfaces and any defined route entries are consulted when routing packets.

Using Multiple Interfaces

ChameleonNFS provides sophisticated support for multiple interfaces built into the TCP/IP protocol stack. Configuration for this support is done through the Custom application.

Within Custom you define multiple interfaces by adding an interface and specifying the interface type, its default gateway, and its DNS. Once you have configured the various LAN and dialup interfaces you can control their operation by the following:

1. In Custom, select the Advanced tab in the Configuration dialog box.
2. Select or clear the Always prompt user when changing the primary interface check box.

Select this check box if you want to be prompted each time you select an interface. The prompt will ask you to confirm whether you want the selected interface to be the new primary interface. If you do not want the prompt to appear, clear this check box.

If you select this check box, Custom displays a dialog box that shows you what all the parameter values for the current primary interface are and what they will change to if you change the primary interface.

For example, suppose you have multiple LAN interfaces each with its own default gateway defined. Most of the time when you change primary interfaces you want the default gateway for that interface to be used. However there might be a few occasions where you want the default gateway on the first interface to continue to be used even when the second interface was last selected. By selecting this option you will be warned each time the primary interface is about to be changed so that you can decide if you want the change to take place.

3. Select or clear the following Make selected interface the primary interface check box.

If you select this check box, the protocol stack will check whenever data needs to be sent out to see if the data is destined for any of the local networks to which the PC is attached. If the packet is not destined for any of the local nets, then the packet will be sent to the default gateway of the currently selected interface which is also the primary interface. The selected interface is the one that is currently highlighted.

For example, suppose you have a PC with both a LAN and dial-up connection where the LAN connection has a default gateway defined for it and the dial-up connection is connected to the Internet. Both interfaces have a DNS defined for them. If you were to Ping a site on the Internet, NetManage's TCP/IP protocol stack, NEWT, would need to decide which DNS to use to resolve the name of the host you were trying to Ping. Since you have checked the first check box in
multiple interfaces the decision would be made by using the DNS for the selected/primary interface even though either DNS could be used.

4. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

For details on the other options available on the Advanced tab, see the Customizing Your Setup chapter.

**Router Setup**

Installation of additional interfaces in the Custom application is performed in the same manner as described in the Installation and Setup chapter. Once these interfaces are defined and it is verified that they are installed correctly, route entries must be defined for each accessible network that is not a local interface.

**Note:** Routing between locally defined interfaces is automatic: no route entries are required.

To route each entry specified from within the Custom or Dialer application, do the following:

1. In Custom, select the Gateway tab in the Configuration dialog box.

   ![Gateway Configuration Dialog Box](image)

   2. Type the network address in the Network text boxes and the subnet bits in the Subnet text box. Then type the IP address of the gateway router that should receive packets sent to the specified network.

      **Note:** The network address must be fully specified, up to the host portion of the address. The network address must end with a zero (0). For example, a
class B address with eight subnet bits must be specified as X.X.X.0 (for example, 137.27.4.0).

The gateway must be on the locally connected subnet interface. (For SLIP interfaces, specification of a gateway is not needed.)

3. Choose the Add button.

4. If you want to add additional routers, repeat steps 2 and 3. You can enter up to five routes per interface.

5. Do one of the following:
   - Select another tab if you want to continue customizing your setup.
   - Choose the OK button to close the Configuration dialog box. Then save your settings by choosing the Save command from the File menu.

Verifying Setup

To verify that your router setup was performed correctly, do the following:

- Use the Ping application from a system on one of the networks to ping the local side of the router. If this fails, refer to the Verifying Installation and Setup section in the Installation and Setup chapter.

- Use the Ping application to ping another interface of the router. A failure usually indicates improper setting of the default gateway or subnet mask. Ensure that the default gateway specifies the IP address of this router.

- Use the Ping application to ping through the router to another network. A failure can indicate a route entry error on the router. It is also possible that the remote host does not know how to respond properly. Make sure the network destination and subnet are properly set up for this router. You can use the NEWT application to verify route entries by selecting Route from the Tables menu to display all defined routes.
Chapter 6. Telnet and ASCII Terminal Emulation

The Telnet and ASCII Terminal application is a terminal communications program that allows you to connect your PC with a UNIX or VMS host computer and various types of BBS (bulletin board service), using the following connection types:

- Telnet TCP/IP protocol
- Rlogin
- Async communications protocol

Telnet and ASCII Terminal can be invoked in several ways as described in online help. The connection may be established using a modem on both the local PC and the remote host computer, or an RS232-C cable can be used to connect the PC to the remote host computer. (RS232-C is the physical-layer protocol standard used for asynchronous communications.)

Note: An animated icon of a telephone indicates that a connection is established when the Telnet and ASCII Terminal application is minimized.

The current preferences and host name can be saved to a configuration file (default is TELNET.CFG). The configuration file is loaded when the Telnet and ASCII Terminal application is started.

Supported Terminal Types

The Telnet and ASCII Terminal application allows you to emulate the following terminal types: TTY, ANSI, ANSI-BBS, ANSI-SCO, AT386, VT52, VT100, VT220, VT320, VT340, VT420, TVI950, TVI955, WYSE50, and WYSE60.
Starting Telnet and ASCII Terminal

As with all the terminal emulator applications, there are several methods for starting the application. See online help for a list of these methods.

Connecting to a Host

The connection details that you must specify for the Telnet and ASCII Terminal application depend upon whether you are using the Telnet connection type, the Rlogin Connection Type or the Async Connection Type. The Telnet and ASCII Terminal Connect menu contains three tab dialogs allowing you to specify connection-type options for Telnet, for Rlogin, and/or for Async.

If you have already defined one or more connection profiles, you may highlight and select a connection profile from the list box. If additional details are required for the connection, the appropriate connection type dialog (Telnet, Rlogin, or Async) will automatically be displayed.

Session Menu

The Session Menu is displayed only after you make a connection to a host. The specific Session Menu differ, depending on the selected connection type. See online help for more information about Session Menu commands.

Telnet Connection Type

The Telnet connection type provides virtual terminal services for a wide variety of remote systems over a TCP/IP network, using the Telnet protocol. You can use the Telnet connection type to connect to any computer that is connected to the Internet. The Telnet connection type is performed over a TCP/IP stack as a full WinSock-compliant application.
Telnet connection settings are defined using the Settings/Preferences command (Terminal, History and Printer sub-options). If you are not using a predefined connection profile, you must add the following information to connect to a host:

**Host:** You must provide the application with a remote host name (or IP address) to which you wish to connect.

**Note:** You can specify a shortened version of the host name (such as “rainbow”) if the name is listed on the local domain name server or host table. Otherwise, you must specify the IP address or the full Internet host name.

**Emulate:** The default terminal emulation type is VT320. You can select a different emulation type from the scrolling list.

**Port:** Telnet’s default port number is port 23. Connection to a specific port (other than port 23) is provided for additional devices with terminal login capabilities (such as network routing hubs). You may have multiple Telnet and ASCII Terminal sessions active concurrently.

If you have already defined a connection profile for a Telnet connection type, its name will be displayed in the list box.

**NVT Mode**

When you first connect to a host, before any telnet negotiation takes place, the connection is in NVT mode (line mode). In NVT mode, anything you type is echoed locally to your screen and is sent to the host only when you type ENTER or RETURN. This mode is indicated in the status bar, which displays “NVT” instead of the emulation type selected.

For most hosts, telnet negotiation procedures take place as soon as you are connected to the host, at which point Telnet is automatically set to the emulation type selected. (You will see the selected emulation type displayed in the status bar.) However, a few hosts do not negotiate these options, in which case, the session remains in NVT mode. To force the session into an emulation mode, you can deselect the Session Menu/NVT command. To resume NVT mode, reselect the Session Menu/NVT command.
Rlogin Connection Type

The Rlogin Connection Type establishes a remote login session from your terminal to the remote machine (user directory), specified as host.

If you are not using a predefined Connection Profile, you must specify the following information in the Rlogin Connect dialog box:

**Host**: Specify the remote host to which you wish to connect.

**Username**: Specify both the local user name and the remote user name as follows:

- **Local User Name**: This is the username that gives you permission to access the remote machine or remote user directory.
  
  The remote machine may have files named `/etc/hosts.equiv` and `.rhosts`, containing a list of trusted host names with which it shares user names. Users with the same user name on both the local and remote machine may rlogin from the machines listed in the remote machine’s `/etc/hosts.equiv` file or `.rhosts` file without supplying a password.

- **Remote User Name**: This is the name of the remote user on the host, who has given your Local User Name permission to access that user’s directory.

Asynchronous Connection Type

The Asynchronous (Async) connection type allows you to connect a remote host using the serial COM port of your PC. When you select the Async connection type, the Connection dialog box does not contain a host field; rather, it contains a **Dial** field.
**Dial:** Specify the number that you wish the modem to dial. You may leave this field blank if you wish to connect directly to the COM port.

If you do not specify a phone number, the Async connection type connects to the COM port by default. When you set up this type of connection, a blank screen is displayed. You can then specify additional commands to connect and log in to a remote host, or to communicate directly with the modem. When connecting to the COM port, you can manually specify modem commands (such as the AT Command) or specify commands relevant to any other equipment connected to that COM port (such as a remote host via an RS232-C cable).

**Emulate:** You can use the default terminal emulation, ANSI-BBS, or select another terminal emulation from the list. For example, when the ANSI-BBS emulation is selected, the default terminal setting is 25 lines, the default font is NewtPC, and the default background is black.

**More:** You can choose the More button to display the Asynchronous Communication Settings dialog to define or modify your settings before you connect. Alternatively, you can also define these settings in Settings/Preferences/Async menu option.
Using a Connection Profile

If you have already defined a Connection Profile that meets your current needs, you can select the connection profile description (name) from the list box and click OK, or double-click on it.

The list box contains two column headings, as follows:

- **Type**: Indicates whether the connection profile is for an Async or a Telnet connection type.
- **Name**: Indicates the name specified for the connection profile description via the Settings/Connection Profile... command.

You can control the order in which list box displays the connection profiles in either or both of the following ways:

- Double-click on the Type or Name column heading to sort all connection profiles according to that characteristic.
- Double-click on the arrow in the upper right corner of the list box to sort the connection profiles in ascending or descending order.

File-Transfer Protocols

When an Async connection has been made, you can transfer files using any of the following telecommunication protocols:

- ASCII
- KERMIT (default)
- XMODEM
- XMODEM-1K
- YMODEM /Batch
- ZMODEM

Files may be transferred as binary (text and control codes) or ASCII (text only).

Working in a Session

When a connection has been made and you have logged in to the remote host, your PC performs all functions offered by an actual terminal connected to a host.

In addition to the terminal session features, you will also have access to other features provided by using a PC with MS-Windows and Chameleon installed, such as:

- Fonts
- Log file
Capture to file
Cut and paste
History buffer
Clear and reset
Colors

For general information about fonts, colors, cut and paste, and the log file, see online help. The following sections of this chapter describe the Capture to File, History Buffer, Clear and Reset features.

**Capture to File**

Using this function, you may store the whole session as it is displayed on the screen to a text file (with the extension .cap) for later use (such as to review, edit, print, or insert the file to an e-mail message or to another text file, and so forth).

To use this feature, you can either choose the Capture button or choose the File/Capture to file menu command. You are then prompted to select Text Only or All data.

**Text Only**: Captures and stores only data displayed in the session window on a line-by-line basis.

**All data**: Captures and stores all communications between the host and the terminal, including both data and escape sequences.

When you have selected whether Text Only or All data are to be captured, you are prompted with a Capture Incoming data to file dialog box.
In the Capture Incoming data to file dialog box, enter the file name to which data will be captured and its location. You may choose to Append the contents of this session to an already existing file by choosing the Append checkbox.

When the session is ended or you wish to stop the capture, you can either choose the Capture button or choose the File/Capture to File command.

You are then prompted with a Stop Capture YES/NO dialog box.

After you have completed capturing the data to a file, you may use the file as you would use any plain ASCII text file.

**Copy and Paste**

The Edit menu provides Copy and Paste functions. The Edit/Select all menu option allows you to choose which part of the terminal session is to be selected, as follows:

- All of the currently displayed data (the current terminal session)
- Only the history buffer data
- Both the current terminal session and the history buffer

Note: You can also select a portion of the terminal session and/or the history buffer. To do that, drag the mouse pointer to select any part of the data on the screen.

For information on copy and paste options, see online help.

**History Buffer**

The history serves as a continuation for the terminal page. When a history buffer exists, the top portion of the window displays the history buffer and the bottom portion of the window displays the current terminal page.

When you have reached the terminal page size limit, a vertical scroll bar appears and you may scroll both the history and terminal page windows. If you change the window
to a size does not match the terminal page size, a scroll bar will appear as soon as the terminal window limit is reached.

The history buffer provides virtual storage of the terminal session. Data from the terminal session is stored to the history buffer when the terminal page limit has been reached.

For example, assume that the terminal page is set to 24 lines (page size). When the 25th line of the terminal session is echoed from the host, the first line of data from the terminal session moves to the history buffer. The original first line of the terminal session will become the first line of the history buffer. The second line of the terminal session will move to the history buffer as soon as the 26th line is echoed from the host, and so on.

This means that the information from the terminal session is not lost when the terminal page limit is reached. Instead the data moves to the history buffer on a “first-in, first-out” basis.

**History Settings:** You set the size of the history buffer in the Settings/Preferences/History menu suboption. The history buffer limit can be set to a specific number of kilobytes (1 KB of buffer contains approximately 8 lines of history) or to the Maximum option. The maximum size of the history is 4000 KB (which is approximately equivalent to 32000 lines). The minimum history buffer size is 0 KB. Select 0 KB if you prefer to work without a history buffer. You can select which directory will serve as the history virtual buffer. When selecting the size of the history, and choosing the directory, check to be sure that there is enough free disk space.

Separate history scrolling. With this option, the terminal session window and the history window are separated from each other by a split bar. Each window has its own vertical scroll bar, allowing you to scroll each window separately.

When the Separate history scrolling option is not selected, the terminal session window and the history window share a common vertical scroll bar that allows you to scroll them as a single window.

Choose the mode that is more convenient for you.

**Copying or Capturing the History:** The history content is not flushed when you end the session. All information stored in the history virtual buffer may be copied to a
permanent ASCII file using the copy and paste commands. If you specify the Capture to file function before the session begins, you can capture the history buffer data to a file during the session.

**Clear and Reset**

The Telnet and ASCII Terminal application provides the following options for clearing data:

**Clear Terminal Page:** Clears the current terminal page and puts the cursor in the home position at the beginning of the terminal page window. The lines cleared from the terminal page are copied to the history buffer to avoid any loss of data.

**Reset Terminal:** In addition to clearing the terminal page, this option resets all terminal settings to their original settings when you started the connection. Some applications change the value of these settings during the session. Use this option to clear the buffer and to reset the terminal to its initial state.

**Clear History:** Prompts you with a YES/NO dialog box to clear the history buffer. You can use this option to begin a new session with a clean history buffer.

The Settings/Preferences menu option displays a pop-up menu that lets you select terminal preferences for Telnet and Asynchronous connection types, and Async communications settings for an Async Connection.

**Using the Settings Menu**

The Settings menu allows you to specify a variety of options, including various terminal preferences, mapping your keyboard, and more. These settings are saved to a Telnet configuration file, if you select the option for saving your configuration file. Refer to Telnet online help for detailed information about using the Settings menu.

**Logging a Session**

The Settings menu includes the Log command, which allows you to debug programs, report problems, and record demos. See online help for a list of steps in logging a session.

**Mapping Your Keyboard**

Choose the Keyboard... command from the Settings menu remap and view your keyboard. A display of a PC extended keyboard and a IBM 3270 keyboard appears. The PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting specified in the International dialog of the Windows Control Panel.
Using the Settings Menu

The Settings menu allows you to specify a variety of options, including various terminal preferences, such as cursor type; enabling SNMP; settings options for file transfer and file capture; and more. These settings are saved to a TN3270 configuration file, if you select the option for saving your configuration file. Refer to TN3270 online help for detailed information about using the Settings menu.

Logging a Session

The Settings menu includes the Log command, which allows you to debug programs, report problems, and record demos. See online help for a list of steps in logging a session.

Mapping Your Keyboard

Choose the Keyboard... command from the Settings menu remap and view your keyboard. A display of a PC extended keyboard and a PC ANSI keyboard appears. The PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting specified in the International dialog of the Windows Control Panel.

For methods of mapping keys, see online help.
• Keys
• CR -> CR/LF
• National character replacement
• Scroll mode
• Page size
• Miscellaneous
• Cursor

**Emulation Type:** Specify the emulation type to be used as a default setting when a connection is made without using a connection profile. This default emulation will appear as the selected emulation type when you choose the Connect button or the Connect command.

**Keys:** Allows you to select the function of some commonly used keys.

- BACKSPACE may be set to either BACKSPACE or DELETE.
- Keypad mode may be set to either Numeric or Application-dependent
- Cursor may be displayed either as Normal (programmed by NetManage) or Application-dependent.

**CR -> CR/LF:** The UNIX operating system usually ends each line of a text file with a carriage return (CR), whereas DOS usually ends each line of a text file with a carriage return / line feed (CR/LF). This option specifies how the end of lines are to be treated when data is transferred between a host (which uses UNIX) and a terminal (which uses DOS):

- Select Inbound to convert each CR to CR/LF when data is transferred from the host to the terminal.
- Select Outbound to convert each CR to CR/LF at the end of a line when data is being transferred from the terminal to the host.

**National Character Set (7 bit):** Telnet and ASCII Terminal application supports 8-bit character sets. Some computers or applications have only 7-bit character sets. If you
would like to copy and use the National Character Set's special characters on a 7-bit system, select the NRC replacement checkbox option.

For example, you may wish to use the UK pound sign on a system that does not support 8-bit character set. The UK pound sign is not included with the standard 7-bit character set. Use the NRC replacement option to copy it onto the 7-bit character set as a replacement for a character that you do not use.

**Scroll Mode**: Set whether the cursor movements will be Smooth or Jump. Jump mode uses less resources, so that sessions in Scroll mode will be displayed faster than sessions using Smooth mode.

**Page Size**: Specifies how the display will appear when a connection is made. You may specify 132 columns (if this format is requested by the application running on the host), or you can use the default 80 columns page. You may also define the number of rows per terminal page. This parameter also sets the buffer size (as discussed previously in the "History Buffer" section of this chapter).

**Miscellaneous Terminal Settings**: This section of the Terminal Preferences dialog box includes the following settings:

**Local Echo**: Any keypress in a terminal session is passed to the remote host, and the host’s response is echoed onto the terminal display. Thus, the character that you type is not the one you see immediately reflected on the PC display: what you see is the remote host echo to your typing. If you wish to see both the terminal and the remote host responses to your keypress, use the Local Echo option.

You may toggle on/off the following additional settings within the Miscellaneous section of the dialog box:

- Sound
- Exit on Disconnect
- Black Background (option is available only when ANSI-BBS is the selected emulation type)

**Cursor**: Set the cursor shape to one of the following options:

- Block
- Vertical Line
- Dim

**Asynchronous Communications Settings**

You can use the Settings/Preferences Async menu suboption to specify the communications settings for an Async connection type.
The Asynchronous Communications Settings dialog box has two main portions: Communications Parameters and Dialing Parameters. It also has buttons on the side that provide access to additional options.

**Communications Parameters**

Communications parameters specify how the COM port is used for data transfer. The application can automatically select the appropriate communications parameters for your system. This is the recommended method. To enable this automatic configuration, choose the Detect button.

<table>
<thead>
<tr>
<th>Port:</th>
<th>Select the default COM port to be used for the async session. This is the physical port to which either the modem or a RS232-C cable is connected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud Rate:</td>
<td>Select the baud rate of your local modem or the baud rate of the remote modem. The range is 300-115200 bits per second (BPS).</td>
</tr>
<tr>
<td>Flow Control:</td>
<td>Select the way flow control is handled between the sending and receiving devices. The Flow Control options are None, CTS/RTS and XON/XOFF.</td>
</tr>
<tr>
<td>• None:</td>
<td>Select this option if the remote system uses no overflow method.</td>
</tr>
<tr>
<td>• CTS/RTS (clear to send / request to send):</td>
<td>Using CTS/RTS flow control, the sending device activates the RTS signal when it is ready to receive data. When the receiving device is ready to receive data, it activates the CTS signal. The receiving device actively controls the receipt of data, thereby preventing an overrun.</td>
</tr>
<tr>
<td>• XON/XOFF:</td>
<td>XON/XOFF causes your system to pause when the buffer fills. When a fast device is connected to a slower device, the data may be sent to the slower device faster than it can be processed. Even though devices often use buffers, sometimes the slower device cannot keep up with the rate of receipt. XON/XOFF flow control may be used to prevent the faster device from overflowing the slower device’s buffer and causing data loss. Select XON/XOFF if you don’t know what flow control method is used.</td>
</tr>
</tbody>
</table>
In data communications environments, one device sends a message to another
device indication to establish a communications channel. The two devices then
send messages back and forth that enable them to agree on Data flow speed. (The
Detect option finds and inserts the appropriate value automatically.)

**Stop Bits, Parity, and Data Bits:** These settings have to be identical on both ends of the
communications. Check with the remote end so that you can match these settings to
have a usable session between your two modems.

**Set DTR:** Set DTR (data terminal ready) if you wish the terminal to indicate that it
is powered up and ready to send and receive data.

**Wait Call Back:** If you are connecting to a host that provides a call-back service (dials
back to your PC), you can use this option. When this option is selected, the Telnet and
ASCII Terminal application dials to the host, then disconnects and waits for the host to
call back.

**Rx buf size:** You can specify the size of the receive buffer used for the Async
Communications. You may experience loss of data if the program does not
process data received from the other fast enough. The larger the receive buffer,
the less data you may lose.

**Dialing Parameters**

These parameters specify the way the local modem dials to the modem of the remote
host. Specify one of the following values, or use the default values.

**Timeout.** Specify the length of time in milliseconds (ms) for a timeout in case the
remote end does not respond. The default is 60 ms.

**Retries.** Set number of retries in case a timeout occurs. The default is 3 retries.

**Method** Specify Tone or Pulse to indicate which method is being used for dialing.
The default is Tone.

**Modem**

The modem button lets you select a modem type to be used for your async connection. If
you want the Telnet and ASCII Terminal application to Dial, you must first select a
modem type and then type the number to be dialed in the Connect menu (or include it in
a Connection Profile)

1. Select your modem model (or the most compatible one) from the scrolling list box.

2. Choose the Install button to have it installed.
Note: If you are familiar with configuring modems, you can continue to specify the details of the modem configuration when the appropriate modem name is displayed in the Modem Installed field. To specify a detailed modem configuration, choose the Setup button.

Do not change the specific settings unless you are familiar with the technical issues of setting modem parameters: consult your modem user’s guide for the correct settings. Otherwise, simply leave the default settings. The default settings will work for most configurations. Incorrect settings of the modem may cause it to miscarry the connection or to be reinitialized.

Note: NetManage supplied strings in the Modem Settings dialog are as follows:

^M (CTRL+M): ASCII#13, ENTER

~ (Tilde): time delay, each '~' is a one second delay

Detect

The Serial Port Diagnostic pop-up box is displayed when you choose the Detect button in the Asynchronous Communications Parameters dialog box. Use this option to properly configure and confirm the connection for the asynchronous connect type.

Note: Ensure that your modem is plugged in and powered on before using this option.

When you choose the Detect option, the application automatically detects the communications parameters in your PC and inserts the appropriate values (for COM port, baud rate, and so forth) in the Asynchronous Communications Settings dialog box.

You can also use the Detect option to confirm or diagnose the status of the serial ports.
Colors

You can use the Settings/Colors... command to set the colors of several items in the session window. Telnet and ASCII Terminal displays strings' attributes in colors instead of their actual effect. For example, the default color for a blinking string is red on black. The default color for a bold string is yellow on black; and so on. Note that the history buffer colors are also changeable using this window.

Connection Profile

Defining a connection profile is the most efficient way to establish a connection. The Connection Profile dialog box lets you specify all the necessary information for connecting to a remote host. Telnet sessions and asynchronous sessions use different connection profiles, because they differ from one another in some of their connection parameters.

Telnet Connection Profile

The Telnet Connection Profile dialog contains the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Name of the connection that appears in the list box in the Connect dialog box. Must be specified.</td>
</tr>
<tr>
<td><strong>Connection Profile Field</strong></td>
<td><strong>Meaning</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the remote host to which you wish to connect. Must be specified.</td>
</tr>
<tr>
<td>Emulate</td>
<td>Desired emulation type. Choose from the scrolling list box. The default terminal type is VT320.</td>
</tr>
<tr>
<td>Port</td>
<td>The default port is 23, the Telnet communications port. This port is appropriate for most configurations. You can specify an alternate port if so desired.</td>
</tr>
<tr>
<td>Reply As</td>
<td>Some Telnet hosts require that the terminal identify itself differently than the standard Telnet name (for example, DEC-VT1 instead of the usual VT100). If your host needs such identification, input the appropriate emulator type into this field. You may type any character string into this field. The default reply is the same as the emulator type.</td>
</tr>
<tr>
<td>Login Prompt</td>
<td>The login prompt that you would see on your screen. Should be used if automatic login is desired. Case sensitive. Optional.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name that you use to login. Should be used if automatic login is desired. Optional.</td>
</tr>
<tr>
<td>Pwd Prompt</td>
<td>The host password prompt that you would see on your screen. Should be used if automatic login includes password. Case sensitive. Optional.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that you normally enter after you have entered your username. Component of automatic login with password. Optional.</td>
</tr>
<tr>
<td>Icon</td>
<td>You can save the current Connect Profile description as an icon. The icon will be displayed in a window group on your desktop, consisting of customized Chameleon Terminal Emulations. By selecting this icon, you can connect from your desktop to a terminal emulation session using the options specified for this Connection Profile.</td>
</tr>
<tr>
<td>Login Script</td>
<td>You can type or browse to select the name of a script file that automatically logs into the host when you use connect to a host by using this profile. Optional.</td>
</tr>
<tr>
<td>Logout Script</td>
<td>You can type or browse to select the name of an existing script file that automatically logs out of the host specified by</td>
</tr>
</tbody>
</table>
### Connection Profile Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>this profile when you close the application. Optional.</td>
<td></td>
</tr>
</tbody>
</table>

#### Connection profile list

The list box contains the connection profiles that you have already defined.

**Note:** If you want to include the Login Prompt and the Password Prompt as part of your Connection Profile, you should connect and log in to the host and write down the prompts that are displayed for username and password. The specified text string must match the prompts (or a portion of the prompts) as they are displayed.

### Itelnet Security Connection Profile

Itelnet is a specific type of Telnet connection. It is a security mechanism provided by Sun for the Sun/OS platform and allows users to gain access through a security gateway to other corporate internal users or out to the Internet.

For an Itelnet connection, you need to fill out your Connection Profile dialog box as follows:

<table>
<thead>
<tr>
<th>Connection Profile Field</th>
<th>Field Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td>Itelnet</td>
<td></td>
</tr>
<tr>
<td>Host Name:</td>
<td>Name or IP address of the host to which you are connecting.</td>
<td></td>
</tr>
<tr>
<td>Port:</td>
<td>Must be 4514</td>
<td></td>
</tr>
<tr>
<td>Emulated Terminal:</td>
<td>Name of the terminal you want to emulate.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Fill out the remaining fields just as you would for any other connection profile.
Rlogin Connection Profile

The Rlogin Connection Profile dialog contains the following fields:

The Connection Profile fields for an Rlogin Connection are as follows:

<table>
<thead>
<tr>
<th>Connection Profile Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td>Name of the connection that appears on the List field in the Connect option dialog box. Must be specified.</td>
</tr>
<tr>
<td>Host Name:</td>
<td>Name or IP address of the host to which you are connecting. Must be specified.</td>
</tr>
<tr>
<td>Port:</td>
<td>The default (23) Telnet communications port.</td>
</tr>
<tr>
<td>Emulated Terminal:</td>
<td>Name of the terminal you want to emulate. The default is VT320.</td>
</tr>
<tr>
<td>Local Username:</td>
<td>Specify the username that gives you permission to access the remote machine or remote user directory.</td>
</tr>
<tr>
<td>Remote Username:</td>
<td>The remote machine may have files named /etc/hosts.equiv and .rhosts, containing a list of trusted host names with which it shares user names. Users with the same user name on both the local and</td>
</tr>
<tr>
<td><strong>Connection Profile Field</strong></td>
<td><strong>Meaning</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Remote Username</strong></td>
<td>Specify the name of the remote user on the host, who has given your Local User Name permission to access that user's directory.</td>
</tr>
<tr>
<td><strong>Icon</strong></td>
<td>You can save the current Connect Profile description as an icon. The icon will be displayed in a window group on your desktop, consisting of customized Chameleon Terminal Emulations. By selecting this icon, you can connect from your desktop to a terminal emulation session using the options specified for this Connection Profile.</td>
</tr>
<tr>
<td><strong>Login Script</strong></td>
<td>You can type or browse to select the name of a script file that automatically logs into the host when you use connect to a host by using this profile. Optional.</td>
</tr>
<tr>
<td><strong>Logout Script</strong></td>
<td>You can type or browse to select the name of an existing script file that automatically logs out of the host specified by this profile when you close the application. Optional.</td>
</tr>
<tr>
<td><strong>Connection profile list</strong></td>
<td>This list contains the connection profiles that you have defined.</td>
</tr>
</tbody>
</table>
Asynchronous Connection Profile

The Asynchronous Connection Profile dialog contains the following fields:

![Asynchronous Connection Profile dialog](image)

The Asynchronous Connection Profile dialog box contains the following fields specific to asynchronous connection types. (See the descriptions of the Telnet Connection Profile fields for information on the fields that are the same.)

<table>
<thead>
<tr>
<th>Connection Profile Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial</td>
<td>Type in the number you wish that modem to dial to when utilizing this connection profile. If you do not specify a telephone number, the async connection type connects to the COM port by default. When connecting to the COM port, you can manually type in modem commands (such as the AT command) or commands that are relevant to any other equipment connected to that COM port (such as, a remote host via a RS232-C cable).</td>
</tr>
<tr>
<td>More</td>
<td>Choose this button to specify communication settings to be associated with the current connection profile. See the section “Asynchronous Communication Settings” for detailed information on these settings.</td>
</tr>
</tbody>
</table>
**File Transfer**

To transfer files between computers, both computers must use the same file-transfer protocols. The file-transfer protocols are responsible for error detection and ensuring that extraneous data is not stored in the transferred files.

Telnet and ASCII Terminal supports five types of file-transfer protocols: Xmodem, Ymodem, Zmodem, Kermit, and ASCII.

The choice of a file-transfer protocol depends on your configuration. Before transferring files, verify that the file-transfer protocol on the local computer is the same as the file-transfer protocol being used by the remote host. You may also set a default file-transfer configuration using the Settings/File Transfer menu command.

File Transfer can be used for sending files (File/Send File) or receiving files (File/Receive File).

The transfer steps are similar for sending and receiving files:

1. Select the file-transfer protocol.
2. Input the necessary information in the protocol-specific dialog box that appears.
3. Type or select the file name and its directory.

**Printing with Telnet and ASCII Terminal**

There are several ways to print using the Telnet and ASCII Terminal application. You must set up the printer (whether it is an attached or network printer) in the Windows Control Panel. As with any other Windows application, you may select to print to any installed printer.
Printer Settings

Printer settings may be defined in the Settings/Preferences/Printer menu option.

Printer Control Mode: All print commands and data are communicated from the remote host to the printer via the Telnet and ASCII Terminal application. Sometimes the application running on the remote host may send escape sequences (such as, skip to a new page, switch to a different font, and so forth) directly to the printer. This is sometimes referred to as a printer “passthru” state. If you wish to use this mode, select the option “Do not translate printer codes” before sending print jobs to the printer.

Add Form Feed: You may select whether each print job should be separated from the next by adding a blank page before the job, after the job, or both before and after. Alternatively, you may disable this option by selecting None.

Delay Printer Close: You can use this option to allow a specific or unlimited time delay for the printer to complete its job before the host issues a CLOSE command. This option can be used to prevent extraneous form feeds from occurring when using host printer Controlled Mode.

Some hosts send a single print job as multiple sequences of lines. Each sequence of lines is followed by a Stop Mode command, causing a brief interval. When the stop interval expires (timeout), the printing resumes with the next sequence. If you enable the Delay Printer Close command for the specified timeout, the printing will resume on the same page. Otherwise, the next sequence of lines will be treated as a separate print job.

Print Mode

Use the File/Print menu option to select the Print Mode. The Telnet and ASCII Terminal application supports three print modes: Screen, Auto, and Control.

Screen Mode: In Screen mode, you may print all or a selected part of the data currently displayed on the session screen. This option is also available by choosing the screen button from the toolbar.

The range options for Screen Mode are as follows:

- **All**: prints the number of lines specified as the buffer size. This may include blank lines if the buffer size is larger than the number of lines that has been used.
• **Selection:** prints only a selected number or block of lines.
• **Terminal Page:** prints only any actual data in terminal page.

**Auto Mode:** In Auto Mode, incoming data is echoed to both the printer and the terminal display. The data is kept in the printer buffer until this mode is disabled, at which time it is printed.

![Print Settings](image)

**Control Mode:** In Control Mode, all incoming data is directed to the printer. Nothing is displayed on the terminal while this mode is enabled.

**Troubleshooting**

If you experience difficulties using the Telnet and ASCII Terminal application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Use the Diagnose Connection option in the Help menu to make sure that the connection is operational. (If your last connection was a Telnet connection type, this option invokes the Ping application. If your last connection was the async connection type, this option invokes the Detect function.)
- To display graphical characters, use the NEWT, NEWT P, and NEWT SPECIAL fonts from the Fonts... option under the Settings menu.
- If the window display appears incorrect, verify that emulation was specified correctly.
- Disconnect and change the history setting in the Preferences dialog box to scroll further back.
- Select Reset Size from the Settings menu if full-screen applications appear to not fit correctly within the terminal session window.
- Check to see that the appropriate font and size is installed if graphic characters appear incorrectly.
- Check to see that the appropriate font and size is installed, or scroll horizontally, if 132-column mode does not fit within the terminal session window.
**Tips for Telnet Connections**

- Make sure that the remote system provides a Telnet server; note that Chameleon does not provide a Telnet server.
- Ensure that the port is specified correctly; it should be the default (23) in almost all cases.

**Tips for Asynchronous Connections**

You can use the Diagnose Connection Option under the Help menu or the Detect option in the Asynchronous Communications dialog box (under Settings/Preferences/Async) to check your async connection.

- Check to see that the modem is connected.
- Check to see if the line is available. If there is only one available phone line and someone is talking on it, you will not be able to connect to the host.
- Check to see that you are using the correct COM port (the one to which the modem is connected).
- Check to see that the modem was reset.
- Check to see that the communications parameters on the local end match the communications parameters on the remote end.
Chapter 7. TN3270 Terminal Emulation

TN3270 is a terminal emulation communication program for IBM mainframe systems. This application offers 3270 protocol support for IBM hosts with IBM's TCP/IP via supported TCP/IP attachment devices.

**Note:** Support for other Connection types is available with the NetManage Swift product.

**Features**

The TN3270 application includes the following features:

- TN3270 emulates any IBM 3278 or 3279 terminal (models 2, 3, 4, or 5 with full SAA compatibility and RFC 1041).
- The TN3270E standard is now supported according to RFC1647. You can print TN3270 sessions to the IBM 3287 printer using the 3270 Printer application provided with this release.
- International character sets are supported. The PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting specified in the International Dialog of the Windows Control Panel.
- Other windows applications programmers can use the EHLLAPI interface for sending and receiving data with the IBM host using terminal emulation services.
- You may have multiple instances (up to the number of sockets) of the TN3270 application active concurrently.
- To log onto a host other than 3270, use the Network Virtual Terminal (NVT) mode.
- An animated icon signals whether the connection is active or inactive.

TN3270 can be invoked in several ways, as described in online help. TN3270 can be invoked either with arguments `{TN3270 host [ port ] [options] } or without arguments. A list of TN3270 command line options is provided in the online help.

**Note:** To start TN3270 from a command line, you can use the Windows Program Manager/File Menu/Properties command.

The current preferences and host name can be saved to a configuration file (default is TN3270.CFG). The configuration file is loaded when the TN3270 application is started. You can have different configuration files for each session. The default configuration
file the next time you open a connection will be the last configuration file that you saved.

Note: An animated icon of a telephone labeled "3270" indicates that a connection is established when the TN3270 application is minimized.

Starting TN3270

As with all the terminal emulator applications, there are several methods for starting the application. See online help for detailed information.

Connecting to a Host

To connect to a host system on the network, choose the Connect command from the menu bar. If a connection profile has already been defined, you can select a name from the Connection Profiles list box.

Note: The Connect menu contains five tab dialogs: TN3270 (Telnet), NW4SAA, Coax DFT, NT Server Connection, and 802.2. However, only the TN3270 tab dialog is usable; the other connection types are available only with the Swift product.

If you are not using a connection profile, do the following:

1. Type or choose the target host name or IP address. (This identifies the host to which you wish to connect).
2. Use the default port (port 23) or select a different port.
3. Use the default model (model 2) or select a different screen size.
4. Choose a session short name for HLLAPI or use the default value. The default session name is A for your first session, B for the second session, and so forth. If you want to choose a different session name, select a letter from A-Z from the pull-down menu to identify your session. The only valid session names are from A-Z, therefore you can only have 26 sessions at a time.
5. Choose the More button if you wish to select additional options (see the section later in this chapter on "Advanced Options").
6. When you have completed your selections, choose OK.
Defining a Connection Profile

A connection profile allows you to set and store a list of frequently used connections. The connection profiles names will be listed in the Connect dialog box, and allow you to connect automatically to a host. To create a connection profile, you must define a description and host name (or IP address). You may also specify additional options, as desired (see “TN3270 Connection Options”). For general information on creating, modifying, and deleting connection profiles, see online help.

TN3270 Connection Profile

To create a Connection Profile, choose the Connection Profile command from the Settings menu.
The TN3270 Connection Profile dialog box contains the following fields:

<table>
<thead>
<tr>
<th><strong>Connection Profile Field</strong></th>
<th><strong>Meaning</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Name of the connection that appears in the list box in the Connect dialog box. Must be specified.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the host to which you are connecting. Must be specified.</td>
</tr>
<tr>
<td>Port</td>
<td>The default port is 23, the Telnet communications port. This port is appropriate for most configurations. You can specify an alternate port number if so desired.</td>
</tr>
<tr>
<td>Model</td>
<td>Terminal model (defines the maximum screen size used). You can accept the default or select another screen size:</td>
</tr>
<tr>
<td></td>
<td>Model 2: 24 x 80 (default)</td>
</tr>
<tr>
<td></td>
<td>Model 3: 32 x 80</td>
</tr>
<tr>
<td></td>
<td>Model 4: 43 x 80</td>
</tr>
<tr>
<td></td>
<td>Model 5: 27 x 132</td>
</tr>
<tr>
<td>Short Name for HLLAPI</td>
<td>HLLAPI short name that will be assigned to the session if available. When you create the first session, the default name is A. The default name for the second session is B, and so forth. You can choose any letter from the list (A through Z).</td>
</tr>
<tr>
<td>Login Prompt</td>
<td>The login prompt that you would see on your screen. Should be used if automatic login is desired. Case sensitive. Optional.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name that you use to login. Should be used if automatic login is desired. Optional.</td>
</tr>
<tr>
<td>Pwd Prompt</td>
<td>The host password prompt that you would see on your screen. Should be used if automatic login includes password. Case sensitive. Optional.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that you normally enter after you have entered your username. Component of automatic login with password. Optional.</td>
</tr>
<tr>
<td>Icon</td>
<td>You can save the current Connect Profile description as an icon. The icon will be displayed in a window group on your desktop, consisting of customized Chameleon Terminal Emulations. By selecting this icon, you can connect from your desktop to a terminal emulation session using the options specified for this Connection Profile.</td>
</tr>
</tbody>
</table>
### Connection Profile Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Script</td>
<td>This is optional. You can type or browse to select the name of a script file that automatically logs into the host when you use connect to a host by using this profile.</td>
</tr>
<tr>
<td>Logout Script</td>
<td>You can type or browse to select the name of an existing script file that automatically logs out of the host specified by this profile when you close the application. Optional.</td>
</tr>
</tbody>
</table>

#### Connection profile list

The list box contains the connection profiles that you have already defined.

**Note:** If you want to include the Login Prompt and the Password Prompt as part of your Connection Profile, you should connect and log in to the host and write down the prompts that are displayed for username and password. The specified text string must match the prompts (or a portion of the prompts) as they are displayed.

### Advanced Options for TN3270 Connections

To specify additional options, choose the More button in the Connect To or Connection Profile dialog box. An Advanced Settings dialog box appears with the following options. Select the desired options, and choose OK.

#### Advanced Options

<table>
<thead>
<tr>
<th>Advanced Options</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use TN3270E Protocol</td>
<td>Select this option if you want to be able to print this terminal session to an IBM 3287 printer using the 3270 Printer application.</td>
</tr>
<tr>
<td>Device Name</td>
<td>Device name is similar to an “LU name.” This option allows the TN3270 session to be assigned to a particular device name. The TN3270E protocol allows the TN3270 server to organize terminal and printer device pools. The server can assign these device pools for use by specific applications and/or users.</td>
</tr>
<tr>
<td>Extended Data Stream</td>
<td>Select Extended data stream if your Display terminal can support it, and if the application running on the Host requires it.</td>
</tr>
</tbody>
</table>

The Extended Data Stream option emulates an IBM terminal that supports structured field commands. If you select the Extended data stream feature, the Extended Attributes option is automatically selected. If you do not select this option, you will not be able to use structured field support.
### Advanced Options

<table>
<thead>
<tr>
<th><strong>Meaning</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Extended Attributes</strong></td>
</tr>
<tr>
<td>This option enables individual characters within a field to be assigned</td>
</tr>
<tr>
<td>different Attributes (such as highlighting, colors, reverse video,</td>
</tr>
<tr>
<td>underline and blinking modes). Otherwise, Attributes affect the entire</td>
</tr>
<tr>
<td>field. You may select to use</td>
</tr>
<tr>
<td>Extended Attributes as a separate option, even if you do not select to</td>
</tr>
<tr>
<td>use the Extended Data Stream option</td>
</tr>
<tr>
<td><strong>Autoreconnect</strong></td>
</tr>
<tr>
<td>Automatically reconnects the terminal to the host when the host</td>
</tr>
<tr>
<td>disconnects you.</td>
</tr>
<tr>
<td><strong>Exit on Disconnect</strong></td>
</tr>
<tr>
<td>Exits from the TN3270 application (and closes it) when you are</td>
</tr>
<tr>
<td>disconnected from the Host.</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
</tr>
<tr>
<td>Check the Enable option to enable graphics support. Choose the</td>
</tr>
<tr>
<td>Settings button within this section of the dialog box to display another</td>
</tr>
<tr>
<td>dialog box with specific graphics options. (see the section below on</td>
</tr>
<tr>
<td>“Graphics Settings”).</td>
</tr>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>This is the name that appears in the title bar of the terminal</td>
</tr>
<tr>
<td>emulation window when you are connected to the specified terminal</td>
</tr>
<tr>
<td>emulation session. If you do not specify a title name, the host name</td>
</tr>
<tr>
<td>appears in the title bar by default.</td>
</tr>
</tbody>
</table>

### Graphics Settings

You can set graphics options by choosing the Settings button within the Graphics section of the Advanced Settings dialog box (To access the Advanced Settings dialog box, you must choose the More button within the Connect or Connection Profile dialogs.) The Graphics Settings are as follows:

<table>
<thead>
<tr>
<th><strong>Meaning</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graphics Options</strong></td>
</tr>
<tr>
<td><strong>APA Graphics</strong></td>
</tr>
<tr>
<td>Provides IBM3179G and IBM3192G terminal emulation, including APA graphic</td>
</tr>
<tr>
<td>support. This option lets you show graphs on your Session display and use</td>
</tr>
<tr>
<td>the mouse as a graphic pointer. These are vector graphics.</td>
</tr>
<tr>
<td><strong>Program Symbol Graphics</strong></td>
</tr>
<tr>
<td>Lets the host program the fonts to be displayed on the terminal. The</td>
</tr>
<tr>
<td>default font size is 9X12.</td>
</tr>
<tr>
<td><strong>Host font size</strong></td>
</tr>
<tr>
<td>You may select a different font size from the pop down list in the dialog</td>
</tr>
<tr>
<td>box. (The font size selected by the Fonts command from the Settings menu</td>
</tr>
<tr>
<td>must match the font size selected for the Program Symbol Graphics, if the</td>
</tr>
<tr>
<td>Program Symbol Graphics option is enabled.)</td>
</tr>
</tbody>
</table>
Capturing Files

TN3270 allows you to capture a session to a printer or a file. The Capture command is in the File menu. The parameters for the capture may be set by using the Capture command from the Settings menu. See online help for a description of these settings.

Scripts

A script is a file of commands that automate one or more procedures that can be done with the terminal emulation application. You may create a login script to automatically connect and log in to a TN3270 host session; and a logout script to ensure that the session is properly logged out when the session is no longer being used or when the application is closed. You may specify the name of both a login script and a logout script in a connection profile.

Using the Edit Menu

The Edit menu provides copy and paste functions for text and graphics. (The graphics options are available only if enabled through the Advanced Settings of the Connect or Connection Profile dialog.) You can use these functions to extract text (or graphics) to use in other applications. All text pasted to the emulation window is transmitted directly to the host system. For additional information, see online help.

Using the Settings Menu

The Settings menu allows you to specify a variety of options, including various terminal preferences, such as cursor type; enabling SNMP; settings options for file transfer and file capture; and more. These settings are saved to a TN3270 configuration file, if you select the option for saving your configuration file. Refer to TN3270 online help for detailed information about using the Settings menu.

Logging a Session

The Settings menu includes the Log command, which allows you to debug programs, report problems, and record demos. See online help for a list of steps in logging a session.

Mapping Your Keyboard

Choose the Keyboard... command from the Settings menu remap and view your keyboard. A display of a PC extended keyboard and a IBM 3270 keyboard appears. The PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting specified in the International dialog of the Windows Control Panel.
For methods of mapping keys, see online help.

**Setting Hotspots**

Hotspots allows you to enable word selection and define PF templates. After a hotspot has been defined, you can activate the hotspot during a session by selecting a hotspot (using the right mouse button) displayed on the screen. Selecting a predefined hotspot invokes its associated function-key call or terminal command. A hotspot can also be used to invoke a Visual Script. Refer to TN3270 online help for detailed information about setting Hotspots.

**Transferring Files between a PC and a Host**

To transfer files between a PC and a host, perform the following steps:

1. You may choose the File Transfer Setup command from the Settings menu to specify general file-transfer settings (or you may access the File Transfer Settings dialog box by using the More button in the Send File or Receive File dialogs).

2. Choose the Send File or Receive File command from the File menu to perform the actual transfer.
**File Transfer Setup Options**

Choose the File Transfer Setup command from the Settings menu to specify general file-transfer settings or use the More button in the Send File or Receive File dialogs to select these options.

![File Transfer Setup dialog](image)

**Host File Transfer Program Name:** Specifies the name of the host program that executes file transfer operations. The default name is IND$FILE. If the operating system on the host uses a different file-transfer program, you must type in the appropriate file-transfer program name.

**Translation Table File:** If nonstandard ASCII-EBCDIC translation is required, you can provide a file that contains the conversion table. A sample translation file, EBASCII.TAB, is automatically copied into your "netmanag" directory.

**Host Operating System:** Select the host operating system (CMS, TSO, CICS)

**Response Timeout:** Specifies maximum time, in seconds, that the terminal emulation waits for a host response to a PC request. The default is 30 seconds.

**Use Expanded Packets:** The default packet size is 2 K. If you know that the remote host supports packets larger than 2 K, you may choose the Use expanded packets option. This option takes effect only if the extended data stream option (in the Connect To dialog box) has also been configured.

**Sending Files**

Choose the Send File command from the File menu to transfer a local PC file to the remote IBM host. The Send File options differ somewhat for the different host operating systems. Select the appropriate tab dialog for your host operating system: CMS, TSO, or CICS. For detailed information on the options for each of these operating systems, see online help.
For example, the CMS tab displays the following Send File dialog box:

![Send File dialog box](image)

The following fields need to be completed:

**Local File.** Type the local file name (with the full path) or use the Browse button to select the file.

**Remote File:** If you do not select or type a remote file name, the file is copied to the default disk of the remote host with the same name as the local file.

**Note:** Remote file names do not contain a period before the file extension. IBM hosts use a space instead.

If you wish to select a different location, use the Browse button. The 3270 Terminal then displays a message box announcing that it is “Filling host disk list.”

![File Transfer dialog box](image)

When the file list is ready, you are prompted with the CMS File List dialog box.

![CMS File List dialog box](image)

**Disk:** Select A through Z disk name from the Disk list. The asterisk (“*”) indicates the default disk. TN3270 will display file lists only for the disks that you are permitted to
access. Choose the Browse button to get the list of files currently stored in the selected disk.

**File Conversion.** The default transfer is in binary mode. You may select to transfer the file using the ASCII/EBCDIC Conversion option. This converts PC ASCII files into IBM EBCDIC format. Each ASCII file line ends with CR/LF. You may choose to treat each CR/LF as a end of data in a field by selecting the CR/LF check box.

**Existing File:** You may select the following options for transferring to an existing file.

- **Replace:** Overwrites an existing host file, or creates a new file if the host file does not exist. If the host file exists, its attributes are preserved.
- **Append:** Adds the file to the end of the host file, or creates a new file if that file does not exist.
- **Prompt:** Checks if the host file exists. If it exists, you are prompted to replace the existing file or abort the transfer.

**Host File Format.** The host file may be formatted with fixed or variable field length. Select Fixed, Variable, or Default for the transferred and converted file. A line of data in a PC file is converted into one field of the host file.

**Note:** If the data in a line exceeds the field length, the extra data is lost. It is important to remember this before selecting a fixed field length.

**Additional Options:** Valid commands are as follows:

- **Quiet** - The transfer proceeds without displaying any message boxes during the operation.
- **No Progress** - The transfer proceeds without displaying the progress box during the operation.

Use the **More** button if you wish to display “File Transfer Setup” dialog box.

When you have completed specifying the file-transfer settings. you may choose the **OK** button to start the Send File operation. A dialog box is displayed with all the transfer details.

Fixed details are:

- Local file name
- Remote file name
- Status of operation
- Total size of transferring file

Dynamically changing details are:

- Bytes transferred
- % transferred
- Actual FT (file transfer) time elapsed
- Estimated completion time

The TSO and the CICS tab dialog boxes for File Transfer contain similar fields. The TSO tab dialog box has an additional Space button, which displays a Remote File Allocation dialog box for specifying additional information regarding the file being transferred.

The CICS tab dialog box adds an option to send a clear signal to the host prior to beginning of the transfer operation. Also, the CICS tab dialog box omits the record size options.

**Receiving Files**

Choose the Receive File command from the File menu to transfer a file from a remote IBM host file to the local PC. The Receive File options differ somewhat for the different host operating systems. Select the appropriate tab dialog for your host operating system: CMS, TSO, or CICS. For detailed information on the options for each of these operating systems, see online help.

**Using HLLAPI**

HLLAPI (High-Level Language Application Program Interface), which is compatible with IBM EHLLAPI (except for a few unsupported functions) is available when you connect to a host. You can use HLLAPI to program in high-level languages such as COBOL, Pascal, BASIC, or C. Refer to TN3270 online help for more detailed HLLAPI information.

**Troubleshooting**

If you experience difficulties using the TN3270 application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
☐ Ensure that the Connect port is correct: it should be the default (23) in almost all cases.

☐ Choose the Diagnose Connection command from the Help menu to verify connectivity to any remote system to which you want access if a failure to connect has been reported.

☐ If the window display appears incorrect, verify that the extended data stream and extended attribute was specified correctly when you connected.

☐ Verify that you are using the correct model (commonly 2 or 3).

☐ If you cannot continue typing, press the RESET key.

☐ If you have disconnected from your application without logging off and you cannot log in again, use the reconnect option (in TSO) or ask your system administrator to cancel your login (in CMS).

☐ If you cannot use IND$FILE file transfer, make sure that the IBM host command is correct. To test it, type the command (IND$FILE, or another command that replaces it) from the ready prompt of TSO or from the running state of CMS. The host will respond with the version number of your IND$FILE program.

Note: In some early versions of IND$FILE, you will see a blank screen and the cursor will move to the lower right corner of the screen. If this occurs, press PF2 twice to return to normal operations.

☐ Make sure to start file transfer from the ready prompt of TSO or when CMS is in the running state.
Chapter 8. TN5250 Terminal Emulation

TN5250 is a terminal communications program connecting your PC and an IBM AS/400 host. This application offers 5250 protocol support for IBM hosts with IBM's TCP/IP via supported TCP/IP attachment devices.

**Note:** Support for the PCS APPC connection type is available with the NetManage Swift product.

**Features**

The TN5250 application includes the following features:

- Monochrome terminal emulation
- IBM Office Vision commands
- International character sets are supported. The PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting specified in the International Dialog of the Windows Control Panel.
- Other windows applications programmers can use the EHLLAPI interface for sending and receiving data with the IBM host using terminal emulation services.
- You may have multiple instances (up to the number of sockets) of the TN5250 application active concurrently.
- An animated icon signals whether the connection is active or inactive.

TN5250 can be invoked in several ways, as described in online help. TN5250 can be invoked either with arguments `{TN5250 host [port] [options] .}` or without arguments. A list of TN5250 command line options is provided in the online help.

**Note:** To start TN5250 from a command line, you can use the Windows Program Manager/File Menu/Properties command.

The current preferences and host name can be saved to a configuration file (default is TN5250.CFG). The configuration file is loaded when the TN5250 application is started. You can have different configuration files for each session. The default configuration file the next time you open a connection will be the last configuration file that you saved.

**Note:** An animated icon of a telephone labeled "5250" indicates that a connection is established when the TN5250 application is minimized.
Starting TN5250

As with all the terminal emulator applications, there are several methods for starting the application. See online help for detailed information.

Connecting to a Host

To connect to a host system on the network, select the Connect command from the menu bar. If a connection profile has already been defined, you can select a name from the Connection Profiles list box.

Note: The Connect menu contains two tab dialogs: TN5250 (Telnet) and PCS APPC. However, only the TN5250 tab dialog is usable; the other connection type is available only with the Swift product.

If you are not using a connection profile, do the following:

1. Type or choose the target host name or IP address. (This identifies the host to which you wish to connect).

2. Use the default port (port 23) or select a different port.

3. Use the default model (model 2) or select a different screen size.

4. Choose a session short name for HLLAPI or use the default value. The default session name is A for your first session, B for the second session, and so forth. If you want to choose a different session name, select a letter from A-Z from the pull-down menu to identify your session. The only valid session names are from A-Z, therefore you can only have 26 sessions at a time.

5. Choose the More button if you wish to select additional options (see the section later in this chapter on “Advanced Options”).

6. When you have completed your selections, choose the OK button.
Defining a Connection Profile

A connection profile allows you to set and store a list of frequently used connections. The connection profile names will be listed in the Connect dialog box, and allow you to connect automatically to a host. To create a connection profile, you must define a description and host name (or IP address). You may also specify additional options, as desired (see “TN5250 Connection Options”). For general information on creating, modifying, and deleting connection profiles, see online help.

TN5250 Connection Profile

To create a Connection Profile, choose the Connection Profile command from the Settings menu. A connection profile allows you to set and store a list of frequently used connections. The connection profiles names will be listed in the Connect dialog box, and allow you to connect automatically to a host.

For information on creating, modifying, and deleting Connection Profiles, see online help.

TN5250 Connection Profile

To create a Connection Profile, choose the Connection Profile command from the Settings menu.
The TN5250 Connection Profile dialog box contains the following fields:

<table>
<thead>
<tr>
<th>Connection Profile Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Name of the connection that appears in the list box in the Connect dialog box. Must be specified.</td>
</tr>
<tr>
<td>Host</td>
<td>Name or IP address of the host to which you are connecting. Must be specified.</td>
</tr>
<tr>
<td>Port</td>
<td>The default (23) Telnet communications port.</td>
</tr>
<tr>
<td>Model</td>
<td>Specifies maximum rows and columns on the screen. Relevant values are: model 2 (24 x 80) model 5 (27 x 132)</td>
</tr>
<tr>
<td>Session Short Name for HLLAPI</td>
<td>(High-Level Language Application Program Interface) enables other applications to communicate with your terminal emulation session. Each session should be defined with a different name. When you create the first session, the default name is A. The default name for the second session is B, and so forth. You can choose any letter from the list (A through Z).</td>
</tr>
<tr>
<td>Monochrome Terminal</td>
<td>Select if you want monochrome terminal emulation.</td>
</tr>
<tr>
<td>Login Prompt</td>
<td>The host login prompt that you would see on your screen when you login. Optional. Use for automatic login. Case sensitive.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name that you use to log in. Optional. Use for automatic login.</td>
</tr>
<tr>
<td>Pwd Prompt</td>
<td>The password prompt that you would see on your screen. Optional. Use for automatic login. Case sensitive.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that you normally enter after you have entered your user name. Optional component of automatic login.</td>
</tr>
<tr>
<td>Login Script</td>
<td>This is optional. You can type or browse to select the name of a script file that automatically logs into the host when you use connect to a host by using this profile.</td>
</tr>
<tr>
<td>Logout Script</td>
<td>This is optional. You can type or browse to select the name of an existing script file that automatically logs out of the host specified by this profile when you close the application.</td>
</tr>
<tr>
<td>Connection Profile Field</td>
<td>Meaning</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Connection Profile List</td>
<td>This list box contains the connection profiles that you have defined.</td>
</tr>
</tbody>
</table>

**Note:** If you want to include the Login Prompt and the Password Prompt as part of your Connection Profile, you should connect and log in to the host and write down the prompts that are displayed for username and password. The specified text string must match the prompts (or a portion of the prompts) as they are displayed.

**Scripts**

A script is a file of commands that automate one or more procedures that can be done with the terminal emulation application. For additional information, see online help.

**Using the Edit Menu**

The Edit menu provides Copy and Paste functions. All text pasted to the emulation window is transmitted directly to the host system. For additional information see online help.

**Using the Settings Menu**

The Settings menu allows you to specify a variety of options, including various terminal preferences, such as cursor type; enabling SNMP; settings options for file capture; and more.. These settings are saved to a TN5250 Configuration file, if you select the option for saving your configuration file. Refer to TN5250 online help for information about using the Settings menu.

**Logging a Session**

The Settings menu includes the Log command, which allows you to debug programs, report problems, and record demos. See online help for a list of steps in logging a session.
Mapping Your Keyboard

You can remap and view your keyboard by selecting the Keyboard command from the Settings menu. A display of a PC extended keyboard and an IBM 5250 keyboard appears. Note that the PC keyboard displayed in the Keyboard Remap window is based on the keyboard setting specified in the International dialog of the Windows Control Panel.

Setting Hotspots

Hotspots allows you to enable word selection and define PF templates. After a hotspot has been defined, you can activate the hotspot during a session by selecting a hotspot (using the right mouse button) displayed on the screen. Selecting a predefined hotspot invokes its associated function-key call or terminal command. A hotspot can also be used to invoke a Visual Script. Refer to TN5250 online help for detailed information about setting Hotspots.

Using HLLAPI

HLLAPI (High-Level Language Application Program Interface), which is compatible with IBM EHLLAPI (except for a few unsupported functions) is available when you connect to a host. You can use HLLAPI to program in high-level languages such as COBOL, Pascal, BASIC, or C. Refer to TN5250 online help for more information about using HLLAPI.

Troubleshooting

If you experience difficulties using the TN5250 application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
☐ Ensure that the Connect port is correct: it should be the default (23) in almost all cases.

☐ Use the Diagnose Connection command from the Help menu to verify connectivity to any remote system to which you want access if a failure to connect is reported.

☐ If you cannot continue typing, press the RESET key.
Chapter 9. Serial to Telnet

The Serial to Telnet application lets you use any serial terminal emulation application (such as, the Windows Terminal application) in your system to communicate over Telnet (TCP/IP). The Serial to Telnet application includes the following main features:

- Lets you redirect specific COM ports to Telnet
- Emulates a Hayes™-compatible modem.
- Can be used to access network modems.
- Can provide Telnet connections on up to 8 COM ports (COM1-8).

Redirecting COMM Ports to Telnet

The Serial to Telnet application has only one main dialog box, which lets you select and configure the COM ports that you want to redirect to Telnet.

1. Select one or more COMM ports (COM1-8) to redirect to Telnet.
2. Select the desired Terminal Type emulation for the port(s) you have chosen.
3. If you would like to assign additional, optional characteristics to a selected port, choose the Advanced button. For a description of the Advanced options, see the table in the following section, “Advanced Configuration Options.”
4. When you have completed the configuration of the ports, choose the OK button in the Serial to Telnet Configuration dialog box and close the application.
5. A prompt will be displayed, asking you if you wish to restart Windows at this time. When Windows restarts, the COMM ports will be redirected as you specified.
6. To stop redirecting the ports, you should uninstall the configuration by choosing the Uninstall button from the Configuration dialog box.
## Advanced Configuration Options

You may assign the following options to your redirected COM ports:

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
<th>Choice</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Type</td>
<td>Select the desired terminal emulation type</td>
<td>NCD VT100 VT102 VT200 VT220 VT300 VT330</td>
</tr>
<tr>
<td>Interpret IAC</td>
<td>Specifies whether the Serial to Telnet application will interpret and deliver the IAC character (Telnet escape sequence/control character).</td>
<td>Ignore: Does not interpret or deliver the IAC character. Always: Interprets and delivers the IAC character. Transparent: Does not interpret, but does deliver the IAC character.</td>
</tr>
<tr>
<td>Carriage-Return padding</td>
<td>Specifies that the Serial to Telnet application will strip/add a NUL character from/to any Carriage Return, which is not directly followed by a Line Feed. This option will take effect only if the Interpret IAC character is also selected.</td>
<td>Strip away: Strips away any NUL character received following an inbound Carriage Return. Add Null: Adds a NUL character to any outbound Carriage Return that is not directly followed by a Line Feed. In&amp;Out: Performs both inbound and outbound translation, stripping the NUL character following an inbound Carriage Return and adding the NUL character to outbound Carriage Returns. Default. Disable: Does not strip or add Carriage Return padding.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Options</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
</tbody>
</table>
| Break Handling          | Specifies that the Serial to Telnet application will recognize the selected break request from the application. | NONE: default  
AYT: Are You There  
BRK: break  
EC: Erase Character  
EL: Erase Line  
IP: Interrupt Process |
| Request Binary Connection | Specifies that the Serial to Telnet application will request a binary (rather than a terminal mode) connection. | Always: Always requests binary mode connection.  
Default  
8 bit depend: Requests binary connection if the port was opened using a byte length of 8 bits.  
Never: Never requests binary connection; requests terminal mode connection instead. |
| Dead-Lock Timer         | Specifies in tenths of a second how often the Serial to Telnet application should check for incoming data. This timer be specified to handle applications which cause deadlock by continually checking for incoming data from the modem without allowing Windows sufficient time to process messages. | Default: 0. |
| Telnet Echo             | Causes the Serial to Telnet application to request that the Telnet server operate in Echo mode. | This option is enabled by default. |
| Verbose Connection Failure | Specifies that an additional WINSOCK error message will be reported before a NO CARRIER response. | This option is enabled by default. |

**Selecting COMM Port Numbers**

It is recommended that you select all port numbers which you are not using, so that you can have the maximum number of simultaneous Telnet connections. However, note the following guidelines:
• Do not select ports that do have devices attached (such as a modem or a serial mouse) or else you be unable to access that port while the Serial to Telnet Configuration is installed.

• Because of a limitation in how Windows operates in 386-Enhanced mode, most machines will only be able to use COM1-COM4. You may be able to use the higher port numbers if you have a multi-port board that comes with a 386 virtual device driver, which supports port numbers higher than 4.

Configuring your Communications Program for Serial to Telnet

To interface between your serial communications program and the Serial to Telnet application, do the following:

• Instruct your communications program to use one of the COM ports that you selected in the Serial to Telnet Configuration.

• Configure your communications program to use one of the Hayes™-compatible modems (Hayes Smartmodem, OPTIMA, or ULTRA).

• Set the communications parameters in your communications program to any baud rate, with 8 bits, no parity, and 1 stop bit.

• Instead of a phone number, you specify either the IP address or host name of the host to which you wish to connect.

Removing the Redirection of COMM Ports

To stop redirecting the ports, you should uninstall the configuration as follows:

1. Open the Serial to Telnet application.

2. Choose the Uninstall button from the Serial to Telnet Configuration dialog box.


Troubleshooting

If you experience difficulties using the Serial to Telnet application, refer to the following items:

■ Verify that the installation and setup verification steps have been successfully completed.

■ Because of a limitation in how Windows operates in 386-Enhanced mode, most machines will only be able to use COM1-COM4. You may be able to use the higher port numbers if you have a multi-port board that comes with a 386 virtual device driver, which supports port numbers higher than 4.
On some machines, you may run into problems when redirecting COM3 and COM4. Certain terminal programs may either give unnecessary warnings or refuse to access the port. This may be caused by the terminal program’s attempts to detect and avoid possible hardware conflicts. To overcome this type of problem, add the following lines to the [386Enh] section of the SYSTEM.INI file:

```
COM3IRQ=11
COM3BASE=3E8
COM4IRQ=15
COM4BASE=2E8
```

**Note:** If any of the above lines already exists in the [386Enh] section of the SYSTEM.INI file, especially if you have real hardware attached to COM3 and/or COM4, do NOT replace them with the above lines. Doing so may cause you to be unable to access the physical port.

**Note:** If adding the above lines does not solve your problem, you may find it necessary to adjust the numbers provided in these lines.

Trouble with host name: You should instruct your communications program to use the IP address or host name of the host to which you wish to connect (instead of specifying a telephone number as you would for a serial connection). If you specify a hostname, such as ftp.netmanage.com, some terminal programs may try to substitute the Touch-Tone (digit) equivalents for each letter in the host name. In this case, you will need to use the IP address.

Also, if your host name begins with “t” or “p”, you may need to insert either a space or a comma in front of the name in order for it to work properly.

Trouble with IP address: Some terminal programs strip out the period in an IP address, which results in incorrect dialing. If this happens, remove the periods from the IP address and expand each portion of the IP address to 3 digits. For example, the address 11.222.44.1 would be changed to 011222044001.

If you want to connect to a port on the remote host other than the standard Telnet port (port number 23), add the port number in brackets after the IP address. For example, specifying the number 11.222.44.1[25] would connect you to the SMTP server (port 25) on that host.
Chapter 10. Modem Server

The Modem Server lets you use one of your PCs as a modem server for other PCs on the same LAN. Rather than configuring separate modems on each of your PCs, you can centralize your physical access to the Internet to one PC, which has a modem and is configured with Modem Server. The other PCs can connect to the Modem Server PC through the Telnet and ASCII Terminal application. In this way, the other PCs connect to a modem that is available through the Modem Server PC and dial through that modem to an external service (BBS etc.).

Preparing your machine to act as a Modem Server

To make your machine available as a Modem Server for other users, do the following:

1. Open your Modem Server application.

2. Select a Listening Port to be used for the connection by choosing the Listen command from the Connection menu, or use the default port setting, port 23.

3. Specify desired settings by choosing commands from the Settings menu (such as, specifying the baud rate for your COM ports by using the Asynchronous Preferences command).

4. After you have completed your settings, you can make your Modem Server COM port(s) available to be accessed by other users by choosing the COMPort Connecting command from the Connection menu. Users cannot connect to a port until you make it available by using this command.

Note: If you change the settings for a port that is currently busy, the changes will take effect only after the port has been released.

5. Notify potential users of your machine’s IP address or host name, and listening port.
6. You may minimize the application after opening it.

**Connecting to a Modem Server**

To make a connection to a Modem Server, do the following:

1. Using the Telnet and ASCII application, specify the IP address or host name of the Modem Server as the host to which you wish to connect.

2. Select the appropriate port (usually 23).

3. When you have connected to the Modem Server host, a short menu will be displayed as follows:

   **Note:** When you first connect to the Modem Server host, you are not actually connected to a port. You cannot dial out or connect to another host through the Modem Server, until you have used one of the connect or dial commands listed in the Welcome menu.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Meaning</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>connect to port:</td>
<td>Connects to any available COM port.</td>
</tr>
<tr>
<td>d</td>
<td>dial through modem:</td>
<td>Lets you type a number to be dialed by the Modem Server.</td>
</tr>
<tr>
<td>p</td>
<td>dial through a specific port:</td>
<td>Lets you specify which port should be used for dialing out.</td>
</tr>
<tr>
<td>v</td>
<td>connect to a specific port:</td>
<td>Lets you connect to a specified port (if this port is currently available for connection).</td>
</tr>
<tr>
<td>l</td>
<td>list of port &amp; modems</td>
<td>Lists the currently available ports and modems.</td>
</tr>
<tr>
<td>m</td>
<td>this menu</td>
<td>Displays this menu.</td>
</tr>
<tr>
<td>b</td>
<td>bye:</td>
<td>Disconnects from the Modem Server.</td>
</tr>
</tbody>
</table>

4. Type the letter of the command you wish to use. You should use the "l" command before trying to make a connection, so that you can find out what ports and modems are currently available for use.
Chapter 11. 3270 Printer Emulator

The 3270 Printer application allows you to print IBM S/370 and S/390 sessions to various printers by making the printer appear to the host as if it were an IBM 3287 system printer. The printer emulator processes and translates the print jobs received from the host into a protocol that can be handled by a Windows printer.

The 3270 Printer application can be used in any of the following ways:

- By any user of a real or emulated 3270 terminal connected to the system host
- For printing to a local attached printer, a network printer, or a printer connected to the host by coaxial cable
- For printing a session from the TN3270 application

Note: You must choose the “Use TN3270E protocol” option within TN3270 for that terminal emulation session if you want to print using the 3270 Printer application.

Printing with the 3270 Printer Emulator

To print using the 3270 Printer application, you should use the following procedure:

1. Start the printer application.
2. Select connection settings for the session to which you wish to connect.
3. Establish a connection to the host.
4. Minimize the associated printer application. (This is optional. You can leave the application in its non-iconized form, if you prefer.)
5. Select any additional print options and start the print job from within your terminal session.

The 3270 Printer application can be invoked in several ways, as described in online help. 3270 Printer can be invoked either with arguments `{PR3270 host [ port ] [options] . }` or without arguments. A list of command line options is provided in the online help.

Note: To start 3270 Printer application from a command line, you can use the Windows Program Manager/File Menu/Properties command.
Supported Printer Configurations

A print job processed through the 3270 Printer application can be directed to:

- A designated printer attached to the PC workstation
- A print file
- A network printer

**Note:** A network printer can be connected using any valid type of connection (such as, a Novell printer, TCP/IP NFS printer, TCP/IP LPR/LPD printer, and so forth.)

The printer settings options available within the 3270 Printer application depend upon the printer settings specified in the Windows Control Panel.

Connecting to a Session

When you first open the 3270 Printer application, the Basic dialog box is displayed.

To print a terminal session, you must connect the printer emulator to the host. You can connect the printer emulator to the host in any of the following ways:

- Non-preconfigured Connection.
- Preconfigured connection in a connection profile list
- Customized icon
- Connection via the Session Manager application

**Non-Preconfigured Connection**

A non-preconfigured connection allows you to connect the printer emulator to a single session. When the session is disconnected, the settings are lost. The next time that you want to connect to the host, you must re-enter the connection details.

To connect to a host via the printer emulator application dialog box, do the following:

1. Choose the Connect menu command from the basic 3270 Printer application dialog box.
2. A specific connection-type Connect To dialog box will be displayed and you can enter the necessary connection details.

3. When you have specified the desired connection details, choose the OK button.

**TCPIP Connection Type Options**

If you wish to print a TN3270 terminal session, specify the following connection details in the Connect to dialog (Connect menu) or the Connection Profile dialog (Settings menu\Connection Profile command):

**Host Name:** Specify the host name or the IP address of the terminal session.

**Port:** The default port is the standard Telnet port, 23.

![Connection Profile dialog]

**More/Advanced Settings**

If you do not specify any particular setting in the Advanced Settings dialog, the 3270 Printer application will request the TN3270E server to assign any available device name from its generic pool of printer devices. The TN3270E server also maintains separate pools of printer devices that can only be used to satisfy specific terminal session requests. If you wish to request a specific printer device, you must specify the device name in the text box for either the Connect or Associate command, as follows:

- **Connect:** The Connect command requests that the TN3270E server assign the specified device name from the pool of devices reserved for use with the Connect command. The Connect command may be used when requesting either a terminal or printer session. If the specified device name is not available, the server denies the request.

- **Associate:** The Associate command requests that TN3270E server assign the specified device name from the pool of devices reserved for use with the Associate command. These are printer device names, which are paired with the specific...
terminal device names. If the specified device name is not available, the server
denies the request.

Note: To request a specific device name, you must specify the name in either the
Connect text box or the Associate text box. You cannot specify device names in
both text boxes.

Controlling the Print Session

The basic dialog box includes a section of emulated printer buttons. These buttons
represent buttons that appear on actual IBM system printers. The printer buttons
provide the following functions:

Hold: If you choose the Hold button, it stops the host from sending more data to the
printer. This provides you with the ability to manually halt additional input from
the host: for example, to add paper to the printer or to correct a paper jam. In cases
where the print queue is too long, the host will generally detect the problem itself,
and stop sending additional data until the print queue has begun to clear. When the
printer is in a hold state, the Hold button is replaced with a Release button. Choose
the Release button, when you are ready to have the print job continue.

Cancel: This button becomes available only when a print job is being processed. It
allows you to cancel (stop) the current print job.

PA1 and PA2 (Program Access): The use of these buttons depends upon the host
application.

FF (Form Feed): In order to use this button, you must first choose the Hold button.
FF directs the printer to start printing at the beginning of a new page. The printer
will resume printing at the beginning of a new page when you release the printer by
reseleting the Hold button.

Resume: This button allows you to resume a print job. If you are using an LU1
printer, you must choose this button to resume printing after having used the Cancel
button. If you are using an LU3 printer, the host can resume printing itself, whether
or not you choose the Resume button.

Checking the Print Session

You can check the status of your print sessions by choosing the Advanced button from
the basic dialog box. This buttons displays another dialog box, which displays the real
time status of the host, the PC, and the printer.
Using the File Menu

The 3270 Printer application has the standard NetManage application File menu options (New, Open, Save, and Save As), relating to the printer emulator’s configuration file. The Printer Emulator’s configuration file saves settings such as connection profiles and preferences that you have specified during a printer emulator session. The Exit command from the File menu closes the printer emulator application.

Using the Settings Menu

The 3270 Printer application allows you to allows you to specify a variety of options, including various printer output preferences, such as fonts; starting a log; settings options for connection profiles; and more.. These settings are saved to a TN5250 Configuration file, if you select the option for saving your configuration file. Refer to TN5250 online help for detailed information about using the Settings menu.

Preferences

The Preferences command displays a dialog box that allows you to select detailed options (such as fonts, use of carriage returns and line feeds, and so on.) regarding the format of the printer output. Refer to TN5250 online help for detailed information about printer output preferences.

Note: You cannot change preferences during a print session. Also, some options cannot be selected concurrently with other options: options that cannot be selected are dimmed.
Logging a Session

The Settings menu includes the Log command, which allows you to debug programs, report problems, and record demos. See online help for a list of steps in logging a session.

Printing to File

The Print to File command allows you to redirect output from the real Windows printer to a file. You can either type the filename or choose the Browse button. The file will be produced by the printer's driver rather than by the printer application; therefore, to use this option, you must have specified the Print to File option in your Windows Control Panel. This option is available only when the printer session is disconnected or on hold.

Printer Setup

The Printer Setup command allows you to change the printer setup options that have been specified in the Windows Control Panel. In this example, the default printer has been specified in the Windows Control Panel as Printing to a File. If you want to change the printer setup for this session, you can select a different printer by choosing the Specific Printer option. This option is available only when the printer session is disconnected or on hold.
Chapter 12. Session Manager

Session Manager is an application that allows you to manage multiple terminal emulation sessions from within a single program.

With Session Manager you can perform the following functions:

- Open the TN3270, TN5250, and Telnet and ASCII Terminal applications
- View existing TN3270, TN520, and Telnet and ASCII Terminal sessions
- Disconnect and exit from a selected TN3270, TN520, or Telnet and ASCII Terminal session
- Show status of existing terminal emulation sessions
- Invoke an existing connection profile

You can open, close, or view multiple sessions at the same time.

![Session Manager Window]

### Viewing Session Status

The Session Manager window displays the status of Chameleon terminal emulation sessions and the names of any existing connection profiles created within the terminal emulator applications.

The Session Manager window includes the following columns:

**Icons:** The icon column can contain one or more icons.

- A **terminal icon** identifies listbox entries for terminal emulation sessions.
- A **printer icon** identifies listbox entries for printer emulation sessions.
- A **lightbulb icon** identifies each emulation session that has been previously saved to the Session Manager configuration file or that is currently connected. When a
session is connected, the lightbulb icon is illuminated. A profile icon represents existing emulator connection profiles.

**Application**: The name of the emulator application is displayed for currently connected or previously saved emulator sessions. For 3270 and 5250 emulators, this column also includes the HLLAPPI session name.

**Profile Name**: A connection profile name is listed for existing terminal emulator connection profiles. Connection profiles are not listed in the Session Manager window if they are created while the Session Manager is running. Connection Profiles, which have been saved within an emulator application, will be listed in the Session Manager window when it has been restarted.

**Note**: You cannot create a connection profile within the Session Manager application. You create connection profiles within the emulator applications. The Session Manager applications lets you view and activate existing connection profiles from the various emulator applications.

**Connection**: Indicates the connection type (such as, VT100) being used for a communications session.

**Host**: Indicates the name of the remote host for the terminal emulation session.

**Connect Time**: When there is a connection, this column contains a timestamp, indicating the start time of a currently connected session. The start time is indicated in the format of hours:minutes:seconds. This column also indicates the amount of elapsed time (in minutes or hours:minutes) since the beginning of the session. The elapsed time is listed within parentheses. The elapsed time is not indicated until at least one minute has elapsed.

**Troubleshooting**

If you experience difficulties using the Session Manager application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.

- Ensure that the terminal emulator's Connect port is correct: it should be the default (23) in almost all cases.

Use the Diagnose connection item from the Help menu to verify connectivity to any remote system to which you want access if a failure to connect has been reported.
Chapter 13. Visual Script Editor/Visual Script Player

Visual Script Editor is an editor used to write or modify scripts. The editor is user-friendly, helps you to learn the script language, and assists you in building the commands. Visual Script Player allows you to execute a script created with the Visual Script Editor.

These script utilities allow you to dynamically reconfigure the user interface, perform random access file operations, automate tasks, modify current functionality, and handle incoming events. For example, you could write a script to customize an end-user interface that would allow non-technical users to easily access various programs on a variety of hosts.

Note: One of the easiest and most effective ways to familiarize yourself with Visual Script Editor/Player capabilities is to run the demo scripts provided with this application. Run one of the script files (such as, demo.scr or demo1.scr) to see how a script works. You can also copy a sample script file and edit it to suit your needs.

Features

The Visual Script Editor and Visual Script Player include the following features:

- Can be used with the terminal emulator applications (TN3270, TN5250, and Telnet and ASCII Terminal), FTP and Mail.
- Can create, modify, or execute a script from within the TN3270, TN5250, or Telnet applications.
- Provides Simplified Mode commands, a set of commands with a simplified syntax, that make it easier for you to create a script.
- Provides online assistance in using the commands. Select the Assist menu option (represented by the question mark with a pen icon). The Assist menu lets you scroll through a list of commands that can be used with Script and provides command syntax, a command description, and an example for each of the commands. Assist can also help you to build the commands with a dialog box that prompts you to specify the command parameters.

Note: The Assist Screen contains a Print button that allows you to Print the current Command Description, so that you can have a hard-copy for reference.
Simplified Mode Commands

Simplified Mode commands are a set of commands that have a simplified syntax, which are intended to make it easier for you to create a script. The Simplified Mode commands do not require you to specify parameter definitions. Only predefined parameters are used. The predefined parameters are, as follows:

- **Result**: When the script is executed, the text results of the command are stored in this parameter.
- **Row, Column**: When the script is executed, the numeric results of the relevant command are stored in these parameters.

If you want the VSE Assist function to display only Simplified Mode commands, choose the Simplified command from the VSE Settings menu.

Simplified Mode commands must be included within a Simplified Mode block, so that the VSP application can distinguish these commands from regular commands.

A Simplified Mode block must begin with the 'Begin-Simplified' command and continues until the 'End_Simplified' command.

An entire Script can be contained within a Simplified Mode block, or a Simplified Mode block can be simply a portion of a Script.

Help and Assist

The Visual Script Editor online help (represented by the question mark icon) provides information on the Visual Script Editor components and on using the menus.

The online Assist menu option (represented by the question mark with a pen icon) provides information on the commands that can be included in a script. The Assist menu lets you scroll through a list of commands that can be used with Script and provides command syntax, a command description, and an example for each of the commands. Assist can also help you to build the commands, with a dialog box that prompts you to specify the command parameters.

**Note**: The Assist Screen contains a Print button that allows you to Print the current Command Description, so that you can have a hard-copy for reference.
What is a Script?

This section describes what a script is, script components and syntax, how to create a script step-by-step, and script language and its rules. It also provides an overview of how to create, compile, and execute a script.

A script is a sequence of ASCII text lines stored in a file. You can create scripts to automate a variety of tasks, such as:

- Log in to a host
- Perform file operations
- Log data communications to a file
- Synchronize transmissions between host and local computers
- Print, copy and delete files.

Components of the Script Utility

There are three main components of the script utility:

- Visual Script Editor
- Script language
- Visual Script Player

The Visual Script Editor is used to create or modify script files. Script language consists of the sequence of commands that make up the script. The Visual Script Player executes the commands specified in the script file.
Visual Script Language Components

The script file consists of a sequence of command lines in which each line has the following syntax:

[Label:] Command [(parameters)]

Label is an optional name for the command line. Labels are often used for debugging programs and for repeating actions. They are non-executable statements that indicate a location in a script to which the execution can branch. Labels appear in a script followed by a colon (:), and then optionally followed by a command:

```
this_position:
```

Labels can contain up to 32 characters, are not case-sensitive, and can consist of alphabetic and alphanumeric characters, and underscores.

Command is one of the reserved command names. For a list of commands, command syntax, descriptions and examples, refer to the Assist menu in the Visual Script Editor.

Parameter is a text string constant, text string variable, numeric constant or numeric variable:

```
Again: type ("try once more...")
```

In this example, the label is again, the command is type, and the parameter, which is a text string, is "try once more"

See the descriptions of constants and variables below for additional information.

Constants

The following types of constants can be used in a script:

String Constant is a series of characters surrounded by either single or double quotation marks. They can be up to 80 characters in length.

Numeric is a positive or negative integer, such as 14.

Variables

The following types of variables can be used in a script:

String Variable is a type of string operand. Variable names can have up to 32 alphanumeric characters and/or underscores and are not case-sensitive.

Numeric Variable is a type of numeric operand. Variable names can have up to 32 alphanumeric characters and/or underscores and are not case-sensitive.
Error Codes

$result\text{Code}$ and $result\text{Text}$ are global variables that can be included in a script to generate an error message if an error condition occurs during the execution of the script. $result\text{Code}$ can generate an error message number (1 through 10). $result\text{Text}$ can generate error message text. Refer to online help for more information about error codes.

Expressions

The following types of expressions can be used in a script:

**Numeric Expressions:** You can create numeric expressions by joining two or more numerics with an operator (+, -, *, /): numeric expressions can be enclosed in parentheses. You can use a numeric expression as an argument when a single numeric parameter is expected.

```plaintext
set (sum,(four+two)/two)
```

The sum numeric variable is set to the sum of 4 and 2 divided by 2.

**Boolean Expressions:** You can create Boolean expressions by writing expressions consisting of `<left_argument> <boolean_op> <right_argument>`. The left and right arguments must be from the same type (for example, string or numeric). `<boolean_op>` can be one of the following: less than, greater than, or equal to (<, > or =). (For example, index > 18).

Comments

Comments consist of nonexecutable statements that you can put in a script to help explain what is happening in the script. Comments are used for documentation purposes. The general syntax of a comment is:

```plaintext
rem comment text is written here
```

For example:

```plaintext
rem
rem ******************************
rem * Demo program for a Script
rem ******************************
```

Syntax Rules

Follow these general rules when creating or modifying a script:

- In a command line, uppercase and lowercase characters can be mixed for the label, command name, and parameters.
- Spaces and tabs are ignored, unless they appear in a text string value.
• Variables are always global and must be defined.
• The initial value of a string variable is a string with the length zero ("").
• The initial value of a numeric variable is the value zero (0).
• Numeric values are whole numbers (positive or negative).
• Maximum string length is 80 characters.

Text string value is a sequence of ASCII characters within double quotes. If double quotes are used as a character, they must appear twice.

Radio ( "Pick your favorite character" , result_fav ,
"Rhett Butler in ""Gone with the Wind"""",
"Westley in ""Princess Bride"""
)

In this example, the Radio command prompts the user to pick a favorite character from a book. The titles of the books must be specified with duplicate double quotes so that they will appear with quotes in the dialog box displayed to the user.

Functions

A script consists of functions, dialogs, and events.

Function is a group of executable statements that perform a specific action.

• The Script language does not allow function nesting (a function cannot contain another function within it).

• Each script must contain one function named MAIN.

• The function MAIN is always the first function to be executed. The framework for the MAIN function is provided for you in the script template:

  Function (Main)
  .
  .
  .
  EndFunction (Main)

• You may add other functions to the script by specifying the Call command within the MAIN function:

  Function (Main)
  Title ("Welcome")
  Call (Welcome)
The called function, Welcome, is specified outside the MAIN function bounded by:

```plaintext
Function (Welcome)
.
.
.
EndFunction (Welcome)
```

**Dialog** is a type of function that can include multiple prompts and opportunities for user input. You must use the **Inquire** command to invoke a Dialog. The Inquire command can be issued within any function.

The syntax of the Inquire command is:

```plaintext
Inquire (name of Dialog)
```

An example of the Inquire command is as follows:

```plaintext
Function (Main)
.
.
Inquire (StringDlg1)
.
.
EndFunction (Main)
```

This Inquire command invokes the dialog named StringDlg1.

Dialogs create custom dialog boxes that prompt user interaction. A dialog is bounded by a framework marking the beginning and the end of the dialog box definition with the name of the dialog specified within parentheses:

```plaintext
Dialog (StringDlg1)
  commands
  .
  .
EndDialog (StringDlg1)
```

**Event** is a type of function that is executed in the background of the main function. Events are executed from the moment that they are enabled, until they are disabled.
Creating a Script

This section describes how to create, compile, and execute a script.

1. Select the Visual Script Editor icon. A blank template appears on your screen.

2. Start entering script commands in the template. If you need assistance in using the script commands, choose the Assist command. You may choose to display either all Script commands or only Simplified Mode commands. See the following section on "Simplified Mode Commands" for further information on this simplified set of commands.

The Assist dialog box explains many commonly used script commands. It contains the following fields:

- **Command Description**: This block contains the syntax, the definition, and an example of the highlighted command.
- **Current Command**: This line contains the currently selected command. If command parameters are selected, the specified parameters are added to the current command line.
- **Script Commands**: A list box containing all of the script commands. You can scroll through this list to select the command you want to use.
- **Command Parameters**: A series of buttons listing the various types of parameters that can be added to the selected command.

3. Select the desired command from the Commands list box. The command appears in the Current Command field, and a description and correct command syntax appear in the Command Description field.

4. If you want to use the Assist dialog box to guide you through building the command, choose the Select button. When this button is selected, you can choose one of the highlighted command parameters from the Command Parameters field.
To enter a value or text for a command parameter, select the desired parameter. A dialog box appears, requesting you to specify the contents of that command parameter. Your input then appears in the Current Command field.

**Note:** The Assist Dialog box automatically inserts some of the required syntax punctuation, such as commas separating the parameters, and double quotes for text string constants.

5. Choose the OK button. Your command and its parameters now appear in your script template.

For example, to display the message "Hello World" on the screen:

a) Use the scroll bar to select the Type command.

b) Choose the Select button to bring up a dialog box that permits you to enter the parameters for this command.

c) Choose the appropriate parameter type.

   For example, to display the message in this example, you choose the parameter type, "string."

d) After you type the parameter information, it appears in the Current Command line.

e) Choose the OK button.

   The line, Type ("Hello World") appears in your script template.

6. You can repeat these steps for any other commands on the Assist list to continue building your script.

7. When you have finished creating your script, run the program by selecting the Run menu item. Your script program is now executed and the resulting output is displayed on the screen.

**Troubleshooting**

If you experience difficulties using this application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Ensure that the terminal emulation can be invoked manually.
- Ensure that terminal emulation short names are correct.
Chapter 14. NFS - Network Drives

NFS provides network drive services across a wide variety of systems through the NFS (Network File System) Protocol. Network drives act and appear as local drives. All existing Windows applications, such as File Manager, Microsoft Word, and Excel, can access files on NFS drives.

ChameleonNFS provides both client and server implementations of the NFS protocol. Client and server may run concurrently. Server access can be restricted for security.

The following sections describe NFS client and NFS server operations, file conversion and mapping, as well as NFS configuration.

Implementation

The following list identifies three of the many possible implementations of NFS networks you can have using ChameleonNFS:

- ChameleonNFS clients with any NFS host
- ChameleonNFS clients with a ChameleonNFS server
- ChameleonNFS in a peer-to-peer environment

Separate discussions on the three different configurations follow.

ChameleonNFS Clients with Any NFS Host

The following configuration combines ChameleonNFS clients with any NFS server on a network.

ChameleonNFS Clients with a ChameleonNFS Server

The following configuration combines ChameleonNFS clients with a ChameleonNFS server on a network.
ChameleonNFS in a Peer-to-Peer Environment

The following configuration includes exclusively ChameleonNFS client/servers on a network. Because each PC using ChameleonNFS can be both an NFS client and an NFS server, you can create an entire NFS network based exclusively on PCs without any workstations or hosts on the network. Two PCs on the network can concurrently mount each other's disks across the network.

Summary of NFS Tasks

All operations performed on network drives are executed through the standard Windows tools. ChameleonNFS is fully integrated with Windows 3.1 tools and the Windows environment.

Each NFS task or operation is categorized as either an NFS client task or an NFS server task. You execute NFS client tasks through the NFS Utilities, Windows Control Panel, or Windows File Manager. You execute all NFS server tasks through the NFS icon.

The following table lists the tasks you can perform through NFS clients and NFS servers. It also lists which applications and menus to use to complete each task. More detailed information about each task is provided in the following sections.

<table>
<thead>
<tr>
<th>Task</th>
<th>Category</th>
<th>Selection Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initializing your username on network</td>
<td>NFS Client</td>
<td>Control Panel-Network option</td>
</tr>
<tr>
<td>Specifying an authenticator</td>
<td>NFS Client</td>
<td>Control Panel-Network option</td>
</tr>
<tr>
<td>Mounting/unmounting network drives</td>
<td>NFS Client</td>
<td>File Manager-Disk Menu Network Connections</td>
</tr>
<tr>
<td>Task</td>
<td>Category</td>
<td>Selection Point</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Setting NFS mount options (rsize, wsize)</td>
<td>NFS Client</td>
<td>Control Panel-Network option</td>
</tr>
<tr>
<td>Setting file attributes</td>
<td>NFS Client</td>
<td>File Manager-Properties option</td>
</tr>
<tr>
<td>Converting files</td>
<td>NFS Client</td>
<td>Control Panel-Network option or NFS Utilities</td>
</tr>
<tr>
<td>Displaying filename mapping</td>
<td>NFS Client</td>
<td>Control Panel-Network option or NFS Utilities</td>
</tr>
<tr>
<td>Restricting access to an NFS server</td>
<td>NFS Server</td>
<td>NFS Icon</td>
</tr>
<tr>
<td>Assigning directories for export</td>
<td>NFS Server</td>
<td>NFS Icon</td>
</tr>
<tr>
<td>Restricting access to directories</td>
<td>NFS Server</td>
<td>NFS Icon</td>
</tr>
<tr>
<td>Removing a directory from the export list</td>
<td>NFS Server</td>
<td>NFS Icon</td>
</tr>
<tr>
<td>Connecting to a network printer (network printing)</td>
<td>NFS Client</td>
<td>Control Panel-Printers option</td>
</tr>
<tr>
<td>Exporting your printer as a network printer (server printing)</td>
<td>NFS Server</td>
<td>NFS Icon</td>
</tr>
</tbody>
</table>

**NFS Client Functions**

Details on each NFS client function follow.

**Note:** For information about network printing, refer to the NFS-Based Printing section in this chapter.

**Initializing Your Username on the Network**

If you are a first time user, we recommend that you define yourself as a user on the network. All mount requests are first authenticated using the PCNFSD protocol.

If you do not initialize your copy of the software with your username, you are assumed to be the user nobody on the system. The username nobody will let you bypass password
prompts. The username nobody may also let you mount servers and printers that allow public access, but you are granted minimum privileges.

To initialize your username on the network, do the following:

1. Choose the Control Panel icon.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.
   
The Networks dialog box appears.

3. Under Installed Networks, select the NetManage ChameleonNFS (all versions) network and choose the Network... button. The NetManage ChameleonNFS dialog box appears.

4. Enter your username in the Username list box and choose the OK button.

Your username is now saved and will be used by all network mounting and printing operations.

**Specifying an Authenticator**

All mount requests are first authenticated using a program called PCNFSD. The PCNFSD program authenticates a username and password before letting a user mount a network drive. For instructions on how to install PCNFSD on a host, please consult your host documentation.

Normally, the authentication request is processed by the PCNFSD program running on the host on which you mount the disk. However, if PCNFSD is not running on the host being mounted, a central authentication server can be used to authenticate the mount request. To specify a backup authenticator, do the following:

1. Choose the Control Panel icon.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.
   
The Networks dialog box appears.

3. Under Installed Networks, select the NetManage ChameleonNFS (all versions) network and choose the Network... button. The NetManage ChameleonNFS dialog box appears.

4. Select or type the name or IP address of the authenticating server in the Authenticator text box and press the OK button.

The host you specify should be one for which you have an account and which is also running PCNFSD. This host is not necessarily the same host you will be using for either NFS drive or print services.
The ChameleonNFS server includes PCNFSD, which will authenticate any request from another PC client.

**Mounting a Network Drive**

Mount a network drive to connect to an exported directory. To mount a drive from a remote system, do the following:

1. Choose the File Manager icon.

2. Choose the Connect Network Drive... command from the Disk menu.

3. Choose the network button (ChameleonNFS or Other depending on your configuration). A Network Connections dialog box similar to the following appears.

```
<table>
<thead>
<tr>
<th>Drive:</th>
<th>Server:/export</th>
</tr>
</thead>
<tbody>
<tr>
<td>D:</td>
<td></td>
</tr>
<tr>
<td>E: rainbow/local</td>
<td></td>
</tr>
<tr>
<td>F: rainbow/local</td>
<td></td>
</tr>
<tr>
<td>G:</td>
<td></td>
</tr>
<tr>
<td>H:</td>
<td></td>
</tr>
<tr>
<td>I:</td>
<td></td>
</tr>
<tr>
<td>J:</td>
<td></td>
</tr>
<tr>
<td>K:</td>
<td></td>
</tr>
<tr>
<td>L:</td>
<td></td>
</tr>
<tr>
<td>M:</td>
<td></td>
</tr>
<tr>
<td>N:</td>
<td></td>
</tr>
<tr>
<td>O:</td>
<td></td>
</tr>
<tr>
<td>P:</td>
<td></td>
</tr>
<tr>
<td>Q:</td>
<td></td>
</tr>
</tbody>
</table>
```

The servers in the server list are saved in a configuration file. If you want to remove a server from this list, select that server and choose the Remove button.

4. Connect a server’s exported directory to a drive by performing either of the following operations:
   - In the Server:/export text box, type the name of the appropriate server followed by a colon (:), slash (/), and your desired exported directory as shown in the following example. Then select a drive listed in the Drive list box and choose the Connect button.
     astro:/test1
   - Type the server name in the Server:/export text box, and then display that server's directories by either choosing the Browse button or double-clicking the server’s name in the server list. Then select an exported item and either drag it to a drive listed in the Drive box or select a drive and choose the Connect button.

5. If the Username dialog box appears, select or type a username and type the appropriate password.
6. If you want to disconnect a drive, select that drive and choose the Disconnect button.

7. When you have finished connecting and disconnecting drives, choose the Close button to complete the mounting operation.

The mounted drives are now displayed as network drives in the File Manager. You can repeat the mounting process to mount additional drives. The network drives you mount will appear in any other Windows application that you use.

Once a set of network drives is mounted, the configuration is saved in the NFSCNT.CFG file, and automatically mounted every time Windows is started. The following example shows the new D drive as defined in the file.

```
[RESTORE CONNECTIONS]
D:=astro:/test1/jillian
```

All mount requests are first authenticated using the PCNFSD protocol. A PCNFSD authenticator must be running on one or more remote systems to authenticate all mounts. NFS includes the PCNFSD server for NFS server authentication. See the Specifying an Authenticator section in this chapter for more information.

You will be authenticated against the host from which you mount a drive if that host is running PCNFSD. If it is not running PCNFSD, then you will authenticate against the host you defined as your authenticator in the Network dialog box of the Control Panel.

If a password protects the mount, your username is displayed and you are prompted for your password. If you mount more than one drive using the same credentials, you will not need to enter a password for any subsequent mounts you attempt within five minutes.

**Unmounting a Network Drive**

To unmount one or more drives, do the following:

1. Choose the File Manager icon.

2. Choose the Connect Network Drive... command from the Disk menu.

3. Choose the network button (ChameleonNFS or Other depending on your configuration). The Network Connections dialog box appears.

4. Select the appropriate drive and choose the Disconnect button.
Setting NFS Mount Options

NFS Mount Options lets you set the read and write buffer sizes for NFS operations.

To set buffer sizes, do the following:

1. Choose the Control Panel icon.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.
   The Networks dialog box appears.

3. Choose the Network... button to display the NetManage ChameleonNFS dialog box.

4. Choose the Options... button.
   The NFS Mount Options dialog box appears.

5. Enter the appropriate value for the Rsize (read) and Wsize (write) options. Then choose the OK button.
   The default value for each buffer size option is 8192 bytes.

   Note: For serial interfaces, NetManage recommends that you set each option size to 256 bytes.

   The specified sizes will be used for subsequent mounts.

   Note: For additional information on configuring read and write sizes with serial interfaces, please refer to the Customizing Your Setup chapter that discusses dialup protocols.

Manipulating Files

File conventions and structures vary between DOS/Windows and UNIX/NFS. To allow smooth integration between your local Windows files and your network files, ChameleonNFS provides the following features:

- display and setting of file attributes and permissions.
- conversion of text files between UNIX and Windows
• display of the mapping between UNIX and Windows filenames

Note: Although you can convert files and display filename mapping as discussed in this chapter, the NFS Utilities offers a quicker way of doing both tasks. For details, see the NFS Utilities chapter.

Setting File Attributes

NFS file attributes are accessible from within Windows. You can select define UNIX-style read, write, and execute permissions for user, group, and other.

Caution: Make sure you are familiar with the different file attributes before you modify them.

To display or modify attributes for a particular NFS file, do the following:

1. Choose the File Manager icon and select the desired file.
2. Choose the Properties... command from the File menu.

![Properties for CH11.DOC](image)

Note: The selections in the Properties dialog box's Attributes box are DOS file attributes. In some instances, your selections will affect the attributes of NFS files.

3. Choose the Network... button to display a Network Properties dialog box. The settings in the dialog box are NFS file attributes.

![Network Properties for CH11.DOC](image)
4. Assign particular Owner and Group names with the appropriate permissions for the desired file. To do so, enter the User and Group names and then select the appropriate permissions.

**Note:** The Network Properties dialog box lets you set UNIX file permissions on NFS files. It does not affect DOS files on a ChameleonNFS server.

5. Choose the OK button. The Properties dialog box appears.

6. To prevent the attributes in the Properties dialog box from affecting your NFS file, choose the Cancel button.

See File Manager Help for more information.

**UMASK and File Permissions**

The default permissions assigned to a newly created file can be changed through the UMASK obtained from the server’s PCFNSD. On many systems, PCFNSD provides the system’s UMASK rather than the individual’s UMASK. For details on the UMASK, see your server documentation.

**Converting Files through the Windows Control Panel**

To indicate the end of a line, UNIX and Windows text files use different termination characters. Specifically, UNIX uses the `<LF>` character to mark the end of a line while Windows uses the two-character combination `<CR> <LF>`.

You can use either the Control Panel or NFS Utilities to convert one end-of-line convention to the other in a text file. The NFS Utilities chapter discusses using that application to convert files. To use the Control Panel to convert termination characters, do the following:

1. Choose the Control Panel icon.

2. Choose the Network icon to display the Networks dialog box.

3. Choose the Network... button to display the NetManage ChameleonNFS dialog box.
4. Choose the Convert... button to display the Convert Text File dialog box.

5. Select or type the name of the file you want to convert.

6. Select the conversion direction (Windows to UNIX, or UNIX to Windows) and choose the Convert button.

**Displaying Filename Mappings through the Control Panel**

Windows filename conventions are more restrictive than those in UNIX. Because of this, some UNIX filenames need to be mapped to Windows-compatible filenames.

NFS automatically maps UNIX filenames to Windows filenames. This mapping is identical to the mapping performed in a variety of other DOS-based NFS products. Mapped filenames appear in the form XXXXX-YY.ZZZ. A tilde (~) is inserted as the sixth character and the next two characters are a uniquely generated key. In addition, a tilde (~) replaces any periods that appear in the UNIX filename.
You can display the original UNIX filenames and their corresponding mapped Windows filenames. To do so, use either the Control Panel as discussed in the following procedure or the NFS Utilities as discussed in that application’s chapter.

1. Use the Windows File Manager to mount an NFS drive from a UNIX computer or server.
   This connection must be maintained during the rest of this procedure. However, you can minimize the File Manager screen.

2. Choose the Control Panel icon.

3. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.
   The Networks dialog box appears.

4. Under Installed Networks, select the NetManage ChameleonNFS network option and then choose the Network... button.
   The NetManage ChameleonNFS dialog box appears.

5. Choose the Mappings... button to view the current filename mappings in the Filename Mappings dialog box.

   Filenames listed under the NFS Name heading are the original UNIX filenames.

**NFS Server Functions**

The NFS server lets ChameleonNFS clients as well as other NFS clients mount disks and share network printers. The table in the Summary of NFS Tasks section summarizes the NFS server operations. Separate discussions on each NFS server function follow.

**Note:** For information about server printing, refer to the NFS-Based Printing section in this chapter.

When the NFS server is started, the Portmapper application is started as well. The Portmapper maintains the listing of currently registered network services, such as NFS.
You can use the Portmapper to query services registered by portmappers running on other systems.

Restricting Access to an NFS Server

You restrict access to an NFS server by defining a user list. The user list specifies the names of all users who have access to part or all of your exported directories.

When defining the user list, you provide the following information for each user you want to include in the list:

- username
- user password
- user ID (UID)
  The User ID is a unique number associated with your name on the server system. The system assigns your User ID to any files that you create.
- group ID (GID).
  The Group ID is a number associated with each group name on the server. Your Group ID is assigned to any files that you create.

Separate discussions on defining the user list, modifying it, and deleting users from it follow.

Defining the User List

To define the user list, do the following:

1. Choose the NFS icon.

2. Choose the Users menu option to display the Server Users dialog box.

3. Enter the username, user password, unique user ID, and group ID, and then choose the Add button.

4. When you complete adding all the users, choose the Save button.
Modifying the User List

To modify information about a user included in the list, do the following:

1. Display the Server Users dialog box. To do so, choose the NFS icon and then choose the Users menu option.

2. Select the name of the user whose information you want to modify.

3. Modify the selected password, user ID, or group ID.

4. Choose the Modify button and then the Save button.

Deleting Users from the User List

To delete users from the user list, do the following:

1. Display the Server Users dialog box. To do so, choose the NFS icon and then choose the Users menu option.

2. Select the username you want to delete from the list.

3. Choose the Delete button, and then choose the Yes button at the prompt.

4. Choose the Save button.

Obtaining an NIS Server’s User List

Obtain an NIS server’s user list if you want the NFS server’s user list to include the users defined on a UNIX NIS server’s user list. You obtain this list by choosing Use NIS Users from the Settings menu. A check mark indicates the NIS user list feature is enabled.

If you obtain an NIS server's user list, the NFS server's user list includes the NIS server's users and any users you define as discussed in the Restricting Access to an NFS Server section.

If the NIS user list feature is disabled, the list of users includes only those users defined in the NFS server's user list.
Note: The NIS server maintains its own list. Changes or deletions made to the NFS server's user list does not affect the NIS server's user list.

You can enable the NIS user list feature only if NIS was configured in the Custom application.

Assigning Directories for Export

Assign an NFS server's directories for export to make them available to NFS client users. All subdirectories under the exported directories are also accessible to the NFS clients. To assign directories for export, do the following:

To assign directories for export, do the following:

1. Choose the NFS icon.
2. Choose the Exports menu option to display the Server Exports dialog box.

3. Select or type in the directory you want to export and choose the Add button.

The directory is added to the Exports list box. This list box contains all the available exported directories that NFS clients can mount.

Note: By default, all newly defined exported directories allow unrestricted access by any NFS clients. If no users are explicitly given access to an exported directory as discussed in the next step, all defined users are assumed to have access.

4. If you want only certain users to have access to the directory, restrict access to that directory by taking the following steps:

   a) In the Exports list box, select the directory to which you want to restrict access.
   b) Choose the Access... button.
   c) Assign users access to the exported directory.

      To add a user to the access list, select that user's name from the User list box and choose the Add... button and then the OK button.
To delete a user from the access list, select that user’s name in the Access List box and choose the Delete button and then the OK button.

The directory can now be accessed only by the users whose names appear in the Access List box.

5. Repeat steps 3 and 4 until the Exports list box contains all the directories you want to export.

6. Choose the OK button.

Removing a Directory from the Export List

To remove a directory from the list of exported directories, do the following:

1. Select the desired exported directory name from the Exports list box.

2. Choose the Delete button, and then choose the Yes button at the prompt.

3. Choose the OK button.

NFS-Based Printing

ChameleonNFS provides network printing services across a wide variety of systems through the use of the Network File System (NFS). Remotely connected printers appear no different than locally attached printers.

You can use this network printing capability to:

- turn your locally attached printer into a shared network printer
- print to any NFS-based systems such as PCs running ChameleonNFS and UNIX systems on the network that are running the PCNFSD
- browse printers attached to an NFS server to locate the desired printer
- connect and disconnect both network printers and shared PC printers.

This section discusses

- your printing options over the network, which include:
  - network printing
    Use this method of printing to print from your PC to a printer attached to a server on the network.
  - server printing
    Use this method of printing to print to a shared printer locally attached to a PC that is available on the network.
  - preparing NFS print jobs for a PostScript printer
Network Printing

Network printing involves the process of printing from your NFS-based system to a network printer. Network printers are installed, configured and modified using the standard Windows Control Panel application. To define printer output, you assign device names to printers on the network such as LPT1, LPT2, or LPT3. When you select data to be printed to one of your mounted printers, it is transferred from a buffer area on your system to a spool area on the print server and eventually reaches the selected printer as shown in the following figure.

```
Print Client
  Buffer Area

Print Server
  Spool Area
  Printer
```

Setting Up Network Printing

After your installation is completed, you are ready to set up your network operations including printer networking features. Make sure that you have set up a username (refer to the Initializing Your Username on the Network section.) Then, define the network printing options in the Windows Control Panel. To allow printing you must have at least one printer connected.

To connect to a network printer, do the following:

1. Choose the Control Panel icon.
2. Choose the Printers icon to display the Printers dialog box.
3. In the Installed Printers list box, select the printer whose port assignment you want to change.
4. Choose the Connect... button. You will see the list of installed printers with the default printer selected.
5. Select the port to which you want to assign the printer.

6. Choose the Network... button in the Connect dialog box to connect to the network printer of your choice. If you have more than one network, select the Chameleon NFS Network button.

7. Select the host to which the printer is connected.

8. Select the PCNFSD option and choose the Browse button. Select a printer from the drop down list, and then choose the Connect button to automatically insert that printer’s Network Path in your Printers - Network Connections menu.

9. If you are prompted for your password, type your password in the ChameleonNFS Username dialog box. Then choose the OK button.

The printer appears in the Current Printer Connections list.

If you want to disconnect from a network printer, select the printer and then choose the Disconnect button.

10. Choose the Close button.

11. Then choose the OK button to close the Connect dialog box. Then choose the Close button to close the Printers dialog box.

Connected printers and their respective parameters are automatically saved to your NFSClNT.CFG file and re-connected when Windows is initialized. Server access including printing access can be restricted for security purposes. If the connection configuration is protected by a password, you will be prompted for your password for each drive and printer mounted.

Server Printing

ChameleonNFS allows printers attached to PCs to be shared over the network with other PCs running ChameleonNFS. If you want to turn your PC printer into a shared print server you must first define a printer through the standard Windows Printer Control Panel. Verify that you can print locally to the defined printer before you enable the print server.

To export your printer as a network printer, do the following:

1. Choose the Control Panel icon.

2. Choose the Printers icon to display the Printers dialog box.
3. Install the print driver that is compatible with the printer you want to share in the Printers dialog box, and select it as the default printer.

4. Choose the Connect... button.

5. Choose a local port and then the OK button in the Connect dialog box.

6. Choose the Close button to close the Printers dialog box.

7. Choose the NFS Server icon.

8. Select the Exports menu item. You must add a Spooler directory (for example, /C/SPOOL) to the exports list. To do this, enter the directory in the directory list box. Choose the Add button, then choose the OK button to close the dialog box.

9. Choose the Printing menu to display the Printer Server Settings dialog box.

10. Select the Export Point you want to assign as your Spooler directory.

11. Select the Printing On box and choose the OK button.

Your local printer is now available to other network users while your local printing capability remains unaffected. You can print directly from applications the same way you use a local printer. Remotely connected printers will function the same as locally attached printers. The following figure demonstrates the network printing options explained in this chapter.
Preparing NFS Print Jobs for a UNIX PostScript Printer

Microsoft Windows places a control character <CTRL D> at the beginning of a print job. This may cause problems when spooling print jobs to a PostScript printer attached to a UNIX server. To prevent Windows from sending the control character, do the following:

1. Choose the Control Panel icon.

   **Note:** Use either the PostScript printer driver supplied by your printer manufacturer or the Apple Laser Writer driver.

2. Choose the Printers icon, and then select the PostScript printer to which you are sending the job.

3. Choose the Setup button (you do not need to change any settings), and then choose the OK button to exit back to the Printers dialog box.

   This process creates a section in the WIN.INI file to store settings for your specific printer. For example, if your printer is an Apple Laser writer II NTX, then the section in the WIN.INI file is:

   `[Apple Laser writer II NTX,LPT1]

4. In the section that was created, add the following line:

   `CtrlD=0`

Solving Printing Problems

If you are having difficulty printing, check the following:

- The spool directory must be exported on the remote host and the proper permissions set where the print job will be spooled.
Because printing involves an NFS mount, Windows must be able to allocate a drive letter to the mount point. Be sure your Lastdrive statement in the CONFIG.SYS file has allocated enough drive letters to accommodate a printer mount.

PCNFSD must be running on the host to which you are spooling the job. Version 2 or higher of PCNFSD must be running for the Browse Printers function to work.

**MultiLAN for Dynamic Switching Between Networks**

ChameleonNFS lets you switch dynamically between different networks installed in Windows without having to exit Windows.

The Windows Setup program lets you select only one network that you can connect to Windows. To switch between Novell and NFS, you have to run Setup again and restart Windows for the change to take affect.

With NetManage’s MultiLAN driver, you can add and remove networks dynamically without having to exit Windows to initialize your selection. MultiLAN currently supports NetManage’s ChameleonNFS, Novell’s NetWare, Banyan Vines, Windows for Workgroups, and LAN Manager networks.

**Note:** We recommend that you install all required networks, such as Novell’s NetWare, through the Windows Setup program, prior to the installation of ChameleonNFS. Adding networks after the installation of ChameleonNFS will necessitate re-installing the ChameleonNFS product.

Because certain Windows operations depend on the type of network installed, select one of the networks installed to be your default network. To define a default network, do the following:

1. Start the Control Panel.
2. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.
   The Networks dialog box appears.
3. Select the network you want to set as your default network from the Installed Networks box.
4. Choose the Set As Default Network button.
   The name of the network will appear in the Default Network box.
   Operations such as Browse inside File Manager, will use the appropriate functions as supplied by your Default Network.
5. Choose the Network button... to display a dialog box that describes different facilities of the network selected in the Installed Networks box. The dialog box is designed by the vendor of that specific network.
The following figure is an example of the dialog box provided by Novell for the NetWare Driver:

![Novell NetWare Driver dialog box](image)

The following figure is an example of the dialog box provided by NetManage for the ChameleonNFS network:

![NetManage ChameleonNFS dialog box](image)

**Adding Networks**

**Note:** Before adding a network, you should install the drivers for your new network through the standard Windows Setup program.

To add networks, do the following:

1. Start the Control Panel.
2. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.
   
The Networks dialog box appears.
3. From the Networks dialog box, choose the Add>> button.
   
The dialog box expands to include a list of available networks from which to choose.
4. Select a name from the list, then choose the Install... button.
The new network name will be added to the list of Installed Networks.

---

**Removing Networks**

To remove networks, do the following:

1. Start the Control Panel.

2. Choose the Network icon. If the Microsoft Windows Network dialog box appears, choose the Other Net button.

   The Networks dialog box appears.

3. From the Networks dialog box, select the network you want to remove from the list of installed networks and choose the Remove button.

4. Choose the OK button.

---

**Troubleshooting**

If you experience difficulties using NFS, refer to the following items:

- Verify that the installation and setup steps have been successfully completed. Refer to the Installation and Setup chapter.

- Make sure the remote system provides an NFS server and that the server is running. Note that some operating systems (for example, VMS) do not supply TCP/IP services with the standard package. Note also that the remote server must be running with one or more exported directories.

- Use the Ping application to verify connectivity to the remote system if NFS reports a failure to mount.

- Verify that the username and password were entered correctly if NFS reports a failure to authenticate or mount. Also verify that a PCNFSD program is running on the remote system or the system specified in the Authenticator dialog. You can verify this by choosing the PortMapper icon and connecting (select Info, Host) to the host that provides NFS services.
Note: Program Manager does not display the Portmapper icon until you associate the Portmapper program (PORTMAP.EXE) with an icon. For details about associating an application with an icon, see your Microsoft Windows documentation.

☐ Verify that the directory being mounted is correct. ChameleonNFS server paths specifications should include the drive letter. For example: /C/PUBLIC for the directory C:\PUBLIC on the server.

☐ Make sure you have permission for specific operations, such as read, write, and execute to access a directory.

☐ Make sure that the host you specify for printing has either the /USR/SPOOL or /VAR/SPOOL directories exported.

Mounting Error
"Failed To Authenticate User"
Your username and/or password were not authenticated by the system or central authenticator on which you are mounting. Confirm that you have a login on this host.

RPC Errors
"Program Not Registered"
There is no PCNFSD program on the host that is performing the authentication.

"Could Not Contact Portmapper"
The host is not running the PortMapper program.

"Access Denied"
The host on which you are mounting either does not allow your PC to do NFS mounting or your PC is not "known" by the host you are trying to mount. Verify with the Network/UNIX administrator that the host has your PC in its host table and that it has NFS mounting privileges.
Chapter 15. NFS Utilities

The file conventions used by Windows are different than those used by NFS files, which are specified by UNIX standards. NFS Utilities provides smooth integration between your local Windows files and your network files. This chapter discusses using NFS Utilities to do the following:

- converting text files between UNIX and Windows
- displaying filename mapping so you can view UNIX filenames and their corresponding mapped Windows filenames

Note: You can display filename mapping only while one or more NFS drives are mounted. However, you can convert files at any time.

Converting Files

To indicate the end of a line, UNIX and Windows text files use different termination characters. Specifically, UNIX uses the \texttt{<LF>} character to mark the end of a line while Windows uses the two-character combination \texttt{<CR> <LF>}.

To convert one end-of-line convention to the other in a text file, do the following:

1. Choose the NFS Utilities icon to display the NFS Utilities window.

2. Either choose the Convert button from the toolbar or choose the Convert... command from the Utilities menu.

   A Convert Text File dialog box appears.

   ![Convert Text File dialog box](image-url)
3. Select or type the name of the file you want to convert.
   If the desired file is not in the current directory, select items in the Directories box until you locate the correct directory.

4. Select the conversion direction (Windows to UNIX, or UNIX to Windows) and choose the Convert button.

**Displaying Filename Mappings**

Windows filename conventions are more restrictive than those in UNIX. For example, NFS allows filenames to be up to 255 characters long. Windows allows only 8 characters followed by a period and a three-character extension. Because of such differences, some UNIX filenames need to be mapped to Windows-compatible filenames.

NFS automatically maps UNIX filenames to Windows filenames. This mapping is identical to the mapping performed in a variety of other DOS-based NFS products. Mapped filenames appear in the form XHHHHH-YY.ZZZ. A tilde (~) is inserted as the sixth character and the next two characters are a uniquely generated key. In addition, a tilde (~) replaces any periods that appear in the UNIX filename.

To display original UNIX filenames and their corresponding mapped Windows filenames, do the following:

1. Use the Windows File Manager to mount an NFS drive from a UNIX computer or server.
   This connection must be maintained during the rest of this procedure. However, you can minimize the File Manager screen.

2. Choose the NFS Utilities icon.

3. Either choose the Mappings button from the toolbar or choose the Mappings... command from the Utilities menu.

   The current filename mappings are displayed in a Filename Mappings window similar to the following figure. Filenames listed under the NFS Name column are the original UNIX filenames.

   ![Filename Mappings Table](image-url)
Chapter 16. FTP - File Transfer

The FTP application provides file transfer services between remote computers and your local computer through the use of the File Transfer Protocol (FTP). FTP displays both the local and remote directory structures in the same way local files and directories are displayed in Windows. You can browse directories as well as select multiple files for transfer in either direction.

Chameleon also includes an FTP Server application, which permits other FTP clients access to selected local files and directories. Server access can be restricted for security, and client and server may run concurrently.

FTP

FTP lets you establish a connection to a remote system and then transfer files to and from that system. For ease of use, you can define connection profiles that can be used to connect to frequently used FTP servers. You can also create macros for operations you perform often. Discussions on establishing connections, transferring files, defining connection profiles, creating macros, and setting preferences for FTP follow.

Establishing Connections

Before you can transfer files with FTP, you must establish a connection to the destination to which you want to transfer the files.

Running FTP from Windows

To connect to a remote system from Windows, do the following:

1. Choose the FTP icon to display the FTP window.

The FTP window lets you create, remove, rename or transfer files or directories as discussed in the Transferring Files section in this chapter.
In the FTP window, folders represent directories, and folders containing an arrow represent symbolic links. FTP treats symbolic links as directories.

2. Choose the Connect menu option to open the Connect dialog box.

3. Enter the host name or IP address, username, and password by doing one of the following:
   - Enter the information in the appropriate fields.
   - If you previously defined a connection profile for the server to which you want to connect, select that profile in the Description box. This automatically enters the host, user, and password information defined in the profile.

   If a password is not specified, FTP prompts you for this information when you connect. For systems to which you do not have specific login rights, select anonymous from the User drop-down menu and then use your e-mail address as the password. You can set up FTP to automatically use your e-mail address for anonymous as discussed in the Setting Preferences for FTP Client.

4. Select the remote system type from those listed in the System field.

   In most cases, FTP automatically determines the remote system type. If during this connection, FTP reports that it could not determine the system type, you may need to specify the exact system type.

   If you do not know the system type to which you are connecting, select Other. Selecting Other allows you to use the Info buttons to view the files and directories in the remote system list boxes. Then you must type the directories and filenames when you transfer or change directories. You may also clear the Retrieve detailed file listing option in the Preferences dialog box to get all the directories and filenames in raw (NLST) format.

5. If the connection is established through a firewall system, select the Use Firewall check box and choose the Set Firewall button. Then follow steps 6 through 8.

   A firewall is an intermediate computer that provides security to a network, such as the Internet. For information on the effect of a firewall, see the PC to Firewall to Host Communication Explained section.
6. To monitor the connection to the firewall, open the Log option from the Settings menu.

7. Enter information in the fields that are described in the following table.

You must obtain information for the firewall, firewall user, and firewall password, and type of firewall connection from your network administrator.

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall:</td>
<td>Enter the IP address or the machine name of the firewall.</td>
</tr>
<tr>
<td>User:</td>
<td>Enter your username on the firewall computer.</td>
</tr>
<tr>
<td>Password:</td>
<td>Enter your password on the firewall computer. This is invisible to the user.</td>
</tr>
<tr>
<td>Port:</td>
<td>The number of the port to which you want to connect. The default is 21. Some firewalls may use another port number.</td>
</tr>
<tr>
<td>Use SITE command</td>
<td>Select this option to use the SITE command to connect your local network to the firewall. The firewall, firewall user, and firewall password fields are required.</td>
</tr>
<tr>
<td>Use USER after logon</td>
<td>Select this option to use the USER command to connect your local network to the firewall. The firewall, firewall user, and firewall password fields are required.</td>
</tr>
<tr>
<td>Use USER with no logon</td>
<td>Select this option to use the USER command to connect your local network to the firewall. The firewall field is required, but the firewall user and firewall password fields are ignored.</td>
</tr>
<tr>
<td>Use proxy OPEN command</td>
<td>Select this option to use the OPEN command to connect your local network to the firewall. The firewall field is required, but the firewall user and firewall password fields are ignored.</td>
</tr>
</tbody>
</table>
Note: For a more detailed description of the firewall options, see the descriptions in the PC to Firewall to Host Communication Explained section of this chapter.

If the firewall password times out, see your network administrator. Some firewalls have passwords that automatically time out after a certain time period. You may have to use Telnet to change the password on the firewall.

8. Choose the OK button to accept the firewall profile.

9. Choose the OK button on the Connect dialog box to connect to the designated system and return to the FTP window.

The host or IP address of the connected system is displayed in the caption of the FTP window, or in the icon title if FTP is minimized. The greeting message from the remote system is displayed along the top of the window. You can use the FTP window to transfer files as discussed in this chapter.

Note: Once you establish a connection, you can store the connection information as a connection profile. The connection profile feature is particularly useful for connections that you need to frequently establish. For details on connection profiles, see the About Connection Profiles section.

Running FTP from the Command Line

You can also open the FTP window and automatically connect to a system when you invoke FTP. To do so, type the following command at the command line:

FTP -c "description name"

The description name is the name you assigned to the connection profile that describes the server to which you are establishing a connection. The command must include the quotation marks (" ).

Transferring Files

After you establish a connection, FTP displays an FTP window similar to the following. You can use the window to transfer files.
To transfer files, do the following:

1. Specify the file you want to transfer and the directory or file to which you want to transfer it.

   You can either type the names in the Directory and Files fields or choose the names from the window’s list boxes. Local files and directories are specified on the left side of the window, and remote files and directories are specified on the right side.

   When specifying file and directory names, you can:
   - change to another directory by either double-clicking the directory name or by typing the name in the local or remote Directory field and then choosing the Change button.
   - create a file or directory by typing its name and then choosing Create.
   - remove or rename a file or directory by selecting it and then choosing the appropriate button (Remove or Rename).
   - display additional details about a directory by selecting it and then choosing the Info button.

2. Specify a file transfer mode by selecting either the ASCII or Binary option.

   All transfers are executed in either ASCII (text) or Binary (image) mode. ASCII mode performs carriage return/line feed translation and is only needed when transferring text files for use on a non-Windows system. If you encounter problems or data corruption, it is usually best to transfer in Binary mode.

   If you are unsure as to which mode to use, select Binary.

3. Transfer the file.

   The left Append, Copy, and View buttons signify append, copy, or view remote-to-local. The right buttons signify append, copy, or view local-to-remote.

   **Note:** You can also copy files by dragging them to the appropriate list box.

   The View button lets you transfer a file and open it in the appropriate viewer with one click. When you select a file and choose a View button, FTP retrieves the file and gives it to the appropriate viewer application. If FTP reports that it is unable to view a file, associate a viewer with that file’s three-letter extension. You can do so by opening the File Manager application and choosing the Associate... option from the File menu.

   Selected files are transferred with the same name, unless you type a new name in the local or remote edit box. Files with illegal names will be translated and prefixed with the exclamation character (!) if a new name is not specified. For example, a UNIX file named init-logcode.c copied to the local system will be translated to the filename !INIT-LO.C.
About Connection Profiles

Use connection profiles to set and store a list of frequent destinations. You can define a host, port number, user, password, system type, account, remote directory, local directory, and a description field for each destination. FTP saves profiles to a configuration file (usually FTP.CFG). The configuration file is loaded when you start FTP.

FTP lets you create, modify, and delete connection profiles as discussed in the following sections.

Creating Connection Profiles

Create a connection profile for a destination if you plan to use that destination frequently. To create a connection profile, do the following:

1. Choose the Connection Profile... command from the Settings menu.

2. Enter information in the Connection Profile dialog box fields, which are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name or IP address of the host to which you are connecting.</td>
</tr>
<tr>
<td>Port</td>
<td>The number of the port to which you want to connect. The default is 21. The port setting should be 21 unless you need to connect to a specific FTP server that is available on a non-standard port.</td>
</tr>
</tbody>
</table>

Note: You can also transfer files using a macro as discussed in the Automated File Transfers section.
### Field | Description
--- | ---
System: | FTP server type that the client expects to see.
User: | Username that is to be entered when user logs in to FTP Server.
Password: | Password you want entered at the password prompt. This will be invisible to the user.
Account: | Optional account command (ACCT) to be sent when connecting.
Remote: | Default directory on the remote system. This directory is used when FTP Client establishes a connection to FTP Server.
Local: | Default directory on the remote system. This directory is used when FTP Client establishes a connection to FTP Server.

3. Select the Use Firewall option to create a firewall connection profile. (If your local network does not connect to a firewall, skip to step 6.)

4. To monitor the connection to the firewall, open the Log option from the Settings menu.

5. Enter information in the fields that are described in the following table.

   You must obtain information for the firewall, firewall user, and firewall password, and type of firewall connection from your network administrator.

   **Note:** For a more detailed description of the firewall options, see the PC to Firewall to Host Communication Explained section in this chapter.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall:</td>
<td>Enter the IP address or the machine name of the firewall.</td>
</tr>
<tr>
<td>User:</td>
<td>Enter your username on the firewall computer.</td>
</tr>
<tr>
<td>Password:</td>
<td>Enter your password on the firewall computer. This is invisible to the user.</td>
</tr>
<tr>
<td>Port:</td>
<td>The number of the port to which you want to connect. The default is 21. Some firewalls may use another port number.</td>
</tr>
<tr>
<td>Use SITE command</td>
<td>Select this option to use the SITE command to connect your local network to the firewall. The firewall, firewall user, and firewall password fields are required.</td>
</tr>
<tr>
<td>Use USER after logon</td>
<td>Select this option to use the USER command to connect your local network to the firewall. The firewall, firewall user, and firewall password fields are required.</td>
</tr>
<tr>
<td>Use USER with no logon</td>
<td>Select this option to use the USER command to connect your local network to the firewall. The firewall field is required, but the firewall user and firewall password fields are ignored.</td>
</tr>
<tr>
<td>Use proxy OPEN command</td>
<td>Select this option to use the OPEN command to connect your local network to the firewall. The firewall field is required, but the firewall user and firewall password fields are ignored.</td>
</tr>
</tbody>
</table>

**Note:** If the firewall password times out, see your network administrator. Some firewalls have passwords that automatically time out after a certain time period. You may have to use Telnet to change the password on the firewall.

6. Choose the OK button to accept the firewall profile.

7. Choose the Add button to add the profile to the Connection Profile list box. Then choose the Close button.

**Modifying Connection Profiles**

To modify a connection profile, do the following:

1. Choose the Connection Profile... command from the Settings menu.
   FTP displays the Connection Profile dialog box.

2. In the Connection Profile list box, select the profile you want to modify.
3. Enter your changes in the other fields as necessary.
   To reset all the fields to their defaults, choose the New button.

4. Choose the Modify button and then the Close button.

Deleting Connection Profiles

To delete a connection profile, do the following:

1. Choose the Connection Profile... command from the Settings menu.
   FTP displays the Connection Profile dialog box.

2. In the Connection Profile list box, select the profile you want to delete. Choose the Delete button and the Close button.

Creating Macros

In using FTP, you may find yourself frequently performing certain operations. For example, you might connect to an FTP site and copy an index of files every day. Operations like this can be saved as macro files and executed automatically. Macro files are text files containing FTP commands. (They are familiar to users with experience using command line versions of FTP clients.) FTP macro files have the extension .FTP by default.

To create a macro, do the following:

1. Choose the Start command from the Macro menu. The status bar at the bottom of the FTP window indicates that FTP is recording your actions.

2. Perform your desired actions. For example, connect to the FTP server, select the index file, copy it to a local directory, and then disconnect from the server.

3. Choose the Stop command from the Macro menu.

4. At the prompt, specify the name of the file in which you want to save the macro FTP has recorded.

5. Choose the OK button.

After creating a macro, you can play it. To do so, choose the Play... command from the Macro menu and then indicate the filename of the macro you recorded. When you play the macro, FTP follows the sequence of actions you recorded for the macro.
Automated File Transfers

You can automatically transfer files by playing a macro when invoking FTP. To do so, do the following:

1. Capture the file-transfer operation in a macro as discussed in the Creating Macros section.

2. Enter the following command. In this command D:\MACRO.FTP is the drive, location, and name of the macro file.

   FTP -m D:\MACRO.FTP

Using this command line option in combination with the Visual Script Player allows automated file transfers any time of the day or night. For more information about how to launch FTP at a specific time, see the chapter that discusses the Visual Script Editor/Visual Script Player.

Setting Preferences for FTP Client

To set preferences for FTP Client, do the following:

1. Choose the Preferences... command from the FTP Settings menu.

2. Set the desired preferences. The following table describes the options you can set.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a File</td>
<td>Prompts user for confirmation to delete a file</td>
</tr>
<tr>
<td>Appending to a File:</td>
<td>Prompts user for confirmation to append a file.</td>
</tr>
<tr>
<td>Replacing a File:</td>
<td>Prompts user for confirmation to replace a file.</td>
</tr>
<tr>
<td>Deleting a Directory:</td>
<td>Configures FTP to prompt you so you can verify whether you want to delete a directory.</td>
</tr>
<tr>
<td>Automatic Retry up to:</td>
<td>Will automatically try to connect according to number of times specified. A value of 0 disables this option.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open Log Window:</td>
<td>Log windows automatically open upon Connection. Use this option to track the status of the default connection.</td>
</tr>
<tr>
<td>Password for Anonymous Login:</td>
<td>Lets FTP use the specified password when you log in as anonymous. Type in your e-mail address in this text box.</td>
</tr>
<tr>
<td>Automatic Rename on File Copy:</td>
<td>When copying a file from another operating system that does not have valid DOS file naming specifications, a valid DOS filename will be automatically given.</td>
</tr>
<tr>
<td>Retrieve Detailed File Listing:</td>
<td>Lets FTP determine if a file is a directory or file. If not selected, all names will appear on the remote file list box.</td>
</tr>
<tr>
<td>Use PASV Mode:</td>
<td>Select the Use PASV Mode option if you want to use a passive mode of communication when connecting to a server.</td>
</tr>
<tr>
<td>Firewall:</td>
<td>Use the Set Default Firewall... button and the Use Firewall by Default check box to configure a default firewall. To get through a firewall, you have to provide it with configuration information.</td>
</tr>
</tbody>
</table>

3. If the default connection is established through a firewall system, do the following. Otherwise, choose the OK button to close the Preferences dialog box.

   a) Select the Use Firewall by Default check box and choose the Set Default Firewall... button.

   The Firewall dialog box appears.
b) Enter information in the fields that are described in the following table.

You must obtain information for the firewall, firewall user, and firewall password, and type of firewall connection from your network administrator.

For a more detailed description of the firewall options, see the descriptions in the PC to Firewall to Host Communication Explained section in this chapter.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firewall:</td>
<td>Enter the IP address or the machine name of the firewall.</td>
</tr>
<tr>
<td>User:</td>
<td>Enter your username on the firewall computer.</td>
</tr>
<tr>
<td>Password:</td>
<td>Enter your password on the firewall computer. This is invisible to the user.</td>
</tr>
<tr>
<td>Port:</td>
<td>The number of the port to which you want to connect. The default is 21. Some firewalls may use another port number.</td>
</tr>
<tr>
<td>Use SITE command</td>
<td>Select this option to use the SITE command to connect your local network to the firewall. The firewall, firewall user, and firewall password fields are required.</td>
</tr>
<tr>
<td>Use USER after logon</td>
<td>Select this option to use the USER command to connect your local network to the firewall. The firewall, firewall user, and firewall password fields are required.</td>
</tr>
<tr>
<td>Use USER with no logon</td>
<td>Select this option to use the USER command to connect your local network to the firewall. The firewall field is required, but the firewall user and firewall password fields are ignored.</td>
</tr>
<tr>
<td>Use proxy OPEN command</td>
<td>Select this option to use the OPEN command to connect your local network to the firewall. The firewall field is required, but the firewall user and firewall password fields are ignored.</td>
</tr>
</tbody>
</table>

**Note:** If the firewall password times out, see your network administrator. Some firewalls have passwords that automatically time out after a certain time period. You may have to use Telnet to change the password on the firewall.

c) Choose the OK button to accept the firewall profile.

Setting up a firewall configuration in the Preferences dialog box automatically creates a default firewall that you can access through the Connect and Connection Profile dialog boxes.
When you choose the New button in the Connection Profile dialog box, Chameleon NFS automatically enters the default firewall configuration.

When you choose the Reset button in the Connect dialog box, Chameleon NFS automatically enters the default configuration.

d) Choose the OK button to close the Preferences dialog box.

Monitoring the FTP Client Log

The FTP Client log contains messages, results, and error codes exchanged between the FTP client and an FTP server. To monitor the contents of this log, select the Log option from the Settings menu.

PC to Firewall to Host Communication Explained

After you have created a connection profile with a firewall computer, a different set of internal interactions takes place for each of the following firewall options:

- Use SITE command
- Use USER after logon
- Use USER with no logon
- Use proxy OPEN command

This section provides a detailed description about the interactions between your PC, the firewall, and the host. Consult the Connect and Firewall dialog boxes and the following drawing to help you follow how the information is transferred between your PC, the firewall, and the host.
Use SITE command

The following takes place once you have selected the Use SITE command option:

1. When you select this option, your PC sends the FTP OPEN command to the firewall. In the example, your PC sends the FTP OPEN command to fwall.

2. The PC sends the firewall user and firewall password fields to the firewall. In the example, joe is the firewall user and ******** is the firewall password and they are sent to fwall.

3. The PC sends the FTP SITE command to the host. In the example, your PC sends the FTP SITE command to ftp.netmanage.com.

4. The PC sends the host user to the host. In the example, the host user anonymous is sent to the host ftp.netmanage.com.

5. The PC sends the host password to the host. In the example, your PC sends the host password *** to ftp.netmanage.com.

This action establishes a connection between your PC and the host through the firewall.

Use USER after logon

The following takes place once you have selected the Use USER after logon command option:

1. When you select this option, your PC sends the FTP OPEN command to the firewall. In the example, your PC sends the FTP OPEN command to fwall.

2. The PC sends the firewall user and firewall password fields to the firewall. In the example, your PC sends firewall user joe and firewall password ******** to fwall.

3. The PC sends the FTP USER command with the username combined with the host address as an argument to the host. In the example, your PC sends the FTP USER command with the argument anonymous@ftp.netmanage.com to ftp.netmanage.com.

4. The PC sends the host password in the Connection Profile dialog box to the host. In the example, your PC sends the host password *** to ftp.netmanage.com.

This action establishes a connection between your PC and the host through the firewall.
Use USER with no logon

The following takes place once you have selected the Use USER with no logon command option:

1. When you select this option, your PC sends the FTP OPEN command to the firewall. In the example, your PC sends the FTP OPEN command to fwall.

2. The PC sends the FTP USER command with the username combined with the host address as an argument to the host. In the example, your PC sends the FTP USER command with the argument anonymous@ftp.netmanage.com to ftp.netmanage.com.

3. The PC sends the host password in the Connection Profile dialog box to the host. In the example, your PC sends the host password *** to ftp.netmanage.com.

   This action establishes a connection between your PC and the host through the firewall.

Use proxy OPEN command

The following takes place once you have selected the Use proxy OPEN command option.

1. When you select this option, your PC sends the FTP OPEN command to the firewall. In the example, your PC sends the FTP OPEN command to fwall.

2. The PC sends the FTP OPEN command to the host. In the example, your PC sends the FTP OPEN command to ftp.netmanage.com.

3. The PC sends the host user from the Connect dialog box to the host. In the example, your PC sends anonymous to ftp.netmanage.com.

4. The PC sends the host password from the Connect dialog box to the host. In the example, your PC sends host password *** to ftp.netmanage.com.

   This action establishes a connection between your PC and the host through the firewall.

FTP Server

FTP Server lets you give Internet users access to your PC files and directories. You can restrict access to an FTP server by defining users and assigning passwords. You can also configure the server to define the server’s time out value and specify how many users can be connected to the FTP server simultaneously.

Restricting Access to an FTP Server

You restrict access to an FTP server by defining a user list. This list specifies who is authorized to access the FTP server.
To define a user list for an FTP server, do the following:

1. Choose the FTP Server icon.
2. Choose the Users... menu option to open the Users dialog box.

![User List Dialog Box]

3. Choose the Add button.

![Add User Dialog Box]

4. Enter the username and password.

   If the username is anonymous the server will ignore the password entry.

   **Note:** An anonymous user may be defined. Once an anonymous user has been
   defined, connection attempts for anonymous are accepted. The anonymous
   user must then enter a valid Internet mail ID in the form
   user@company.dom when asked for a password.

5. Specify the user's access by doing one of the following:
   - Grant user's access to all of the server's local drives, directories, and files by
     selecting the All Drives option.
   - Restrict user's to a specific directory and its subdirectories by selecting the
     Restricted to option. If necessary, choose the Dir... button and browse until you
     locate the desired directory.

6. If you want the user's access to be read-only, select the Read Only check box.

   Read-only users can retrieve files. They cannot, however, send the retrieved files to
   the FTP server or create or rename directories or files.
If you select the Read Only check box, the following operations are denied: put, append, delete, rmdir, mkdir, and rename.

7. Choose the OK button.

After you add a user to the user list you can modify the information for that user or delete the user from the list. For details, see the FTP Server online help.

**Connected Clients List**

When a user is connected to the FTP Server application, the IP address and username appears in the FTP Server’s main window. If the connected user is anonymous, the password (e-mail address) is shown in the user field. If you wish to disconnect a client, select that user in the main window and choose the Disconnect... menu option or toolbar button.

**Setting Preferences for FTP Servers**

To set preferences for an FTP server, do the following:

1. Choose the Preferences... command from the FTP Server Settings menu.

2. Specify your FTP server preferences by doing the following:
   - In the Minutes text box, type the number of minutes the FTP server will wait before automatically disconnecting idle users.
   - In the Maximum Connections text box, type the number of users that can be connected to the FTP server simultaneously.

3. Choose the OK button.

**Monitoring the FTP Server Log**

The FTP Server log contains information about client operation, such as login, logout, and files accessed activity. To display the contents of this log, select the Log option from the Settings menu.
Using the Right Mouse Button

If you press the right mouse button while working in an FTP or FTP Server dialog box, a menu appears. The menu contains the frequently used commands that are on the same menu as the command that opens the dialog box.

Troubleshooting

If you experience difficulties using FTP, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Make sure the remote system provides an FTP server and that the server is running. Note that some operating systems (for example, VMS), do not include TCP/IP services with the standard package, and not all TCP/IP hosts run an FTP server.
- If you fail to connect, choose the Diagnose Connection option from the Help menu in FTP Client. This option invokes the Ping application, which can show you if the host is accessible.
- Verify that the username and password were entered correctly if the FTP client reports a failure to login.
- If during connection, FTP reports that it failed to determine the system type, or if you connect successfully but are unable to see any files, you may need to specify the exact system type. If you are unable to determine the remote system type, you can select Other from the list.

When you connect as Other, all the file and directory names in the Remote Files list are displayed. You may enter the appropriate name to transfer files or change the current directory. You can also clear the Retrieve Detailed File Listing option in FTP’s Preferences dialog box to retrieve all files and directories in raw (NLST) format.

- Make sure that the correct transfer type (ASCII or Binary) is chosen. Transferring a file in the incorrect mode may corrupt that file. Unless you transfer text files to or from a UNIX FTP server, choose Binary.
- Make sure the clients have the necessary permission for specific operations (for example, write access to a directory).
- If a server’s status bar indicates the server is off during startup, exit the server, check NEWT.EXE’s socket tables, and make sure port 21 is off.
Chapter 17. TFTP - File Transfer

The TFTP application provides rudimentary file transfer services, using the Trivial File Transfer Protocol (TFTP). The application allows simple file transfer to and from a remote system without any directory or file listing. Normally, the FTP application is recommended for file transfer services, since it is supported across many systems. However, if your remote system does not support FTP, you may need to use TFTP.

Server functions are also provided permitting other Chameleon TFTP clients and non-Chameleon clients access to selected local files and directories. A TFTP server is generally used for checking or testing in a development environment.

The current connect parameters, server parameters, and options can be saved to a configuration file (default is TFTP.CFG). The configuration file is loaded when the TFTP application is started.

TFTP Client

The TFTP Client transfers files to and from the remote system (Server). Timeout values may be altered and a log produced.

Transferring Files

To transfer a file to or from a remote system, complete the following steps:

1. Select the Transfer menu. The File transfer dialog box appears:

2. In the Host Name drop-down list box, type or select the host name or IP address of the remote system.

3. Select the Transfer Type option button:
   
   Receive: Specifies that you want to receive a remote file at the local system.
Send: Specifies that you want to transmit a local file to the remote system.

4. Select the Transfer Mode option button (ASCII or binary).

All transfers are executed in either ASCII (text) or Binary (image) mode. ASCII mode performs carriage return/line feed translation and is only needed when transferring text files for use on a non-Windows system. If you encounter problems or data corruption, it is usually best to transfer in Binary mode.

If you are unsure as to which mode to use, select Binary.

5. Type or select the Remote File.

If Receive Transfer Type is selected: a remote filename does not need to be specified.

If Send Transfer Type is selected: a remote filename specifies how to rename the transferred file on the remote host. If a filename is not specified, the remote file name will be assumed to be the same as the local filename.

6. Type or select the Local File:

If Receive Transfer Type is selected: specify the same directory as the default directory set through the Server... option of the settings menu.

If Send Transfer Type is selected: specify the name of the file you want to transfer to the remote Host.

7. Choose the OK button to begin the transfer.

Creating a Log

TFTP lets you create a log (record) of the file transfer operations in your application window and save it into a log file (TFTP.LOG). Select the Preferences... option from the Settings menu and select the appropriate option button. Choose the OK button to start the log. Log entries show transfer start and end summaries, as well as server enabling and disabling.

Setting Timeout

Select the Timeout... option from the Settings menu to modify Timeout values.

The Retransmission value (between 1 and the total transmission seconds) indicates when to send the first retransmission after a failure to receive an acknowledgment.

The total transmission timeout (between 1 and 9999 seconds) indicates the value for the entire transmission; extend this value if you plan to transfer a very large file.
TFTP Server

Set the TFTP Server through the Server... option from the Settings menu. This determines the public directory for TFTP Clients and enables the TFTP Server. The public directory is shared between all TFTP Clients. TFTP Clients cannot access any files or directories outside of this public directory. The Server On check box is used to enable and disable the TFTP Server.

The TFTP Server is activated in two ways:

- On the Server side: select the Server On option from the Settings menu.
- On the Client side: a client can automatically activate the TFTP Server, if the following steps have been completed on the TFTP Server side:
  a) Save the TFTP settings with Server On selected, to the TFTP configuration file.
  b) Through custom, choose the INETD configuration option from the Services menu and create a TFTP Server on port 69 (refer to online help for more details).
  c) Restart windows.

Any messages sent to the TFTP Server will automatically activate the Server. After the end of the connection, the TFTP Server closes.

Troubleshooting

If you experience difficulties using the TFTP application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Make sure the remote system provides a TFTP server and that the server is running. The Chameleon TFTP server must be explicitly turned on and the application must be running. Some operating systems do not supply TCP/IP services with the standard package (for example, VMS).
☐ Use the Ping application to verify connectivity to any remote system to which you want access if the TFTP application reports a failure to transfer.

☐ Make sure that the transfer type (ASCII/binary) is chosen correctly. Transferring a binary file when the transfer type specifies ASCII, may cause a failure.

☐ Make sure you have permission for specific operations (for example, write access to a directory). The TFTP log can be used to help diagnose access failures.
Chapter 18. LPR/LPD

The LPR and LPD applications allow files to be printed remotely over the network. The Chameleon LPR application uses the Line Printer Remote (LPR) protocol and functions as the client side of the remote printing process; it allows you to print to network printers that are running LPD. The Chameleon LPD application uses the Line Printer Daemon (LPD) protocol and functions as the server side of the remote printer process; it makes your local printer accessible as a network printer for remote users that are sending files with LPR.

Using Chameleon LPR

Chameleon LPR allows you to perform the following functions:

- Print a file to a remote LPD printer
- Print from within an application to a remote LPD printer

LPR will continuously retry to send your file to the printer. You can view the status of your job by opening the Log file and checking the retry status of the job. Depending on the status, you may choose to remove your job from the LPR queue by highlighting the job listing in the LPR window and choosing the Delete Job command from the LPR menu.

LPR Menus

When you activate the LPR icon, the following LPR menus are displayed:

- **File** menu provides the standard New, Open, Save, Save as, and Exit options. All of these options, except for Exit, apply to the LPR/LPD configuration file.
- **LPR** menu allows you to select a file to be printed or a job to be deleted from the LPR queue. The Print File command lets you set additional options such as file format, indent, width, user, class, and job name. Additional information on the LPR Print File command is provided in the subsection, "Printing a File Using Chameleon LPR."
- **Control** menu allows you to query the status of print jobs by selecting the following commands: Print Any, Status (Short), Status (Long), and Remove Job. Additional information on the Control menu options is provided in the subsection, "Controlling Print Jobs."
- **Settings** menu provides the Log... option, which allows you to make a record of any client and host transmission problems. Additional information on the Log option is provided in the subsection, "Diagnosing Client and Host Transmission Problems."
• **Help** menu provides the standard help options: Diagnose connection, Contents, and About LPR.

**Printing a File Using Chameleon LPR**

When you print a file using Chameleon LPR, the file does not go through the Windows printer driver defined in the Control Panel’s Printer dialog box; instead, it is redirected to a remote printer as specified in LPR.

To print a file to a remote network printer, do the following:

1. Choose the LPR icon and choose the LPR menu.

2. Enter the remote host name (or IP address) and the remote printer name in the Print File dialog box, and select your file. Steps 1 and 2 are sufficient to print to a Chameleon LPD printer.

3. For other implementations of LPD, choose the LPR menu Setup button to open the LPR Setup dialog box.

4. Enter the desired information in the LPR Setup dialog box:
   - **User Name**: your user name.
   - **Class**: the class name, if your print server supports this feature for prioritizing print requests (optional).
   - **Job Name**: your job name, which is printed on a banner page if your printer supports this feature (optional).
   - **Print**: the file’s print format. Choose one of the following formats: PostScript, text (raw, unformatted text file), or text with pr (unformatted text file with a heading, page number, and pagination).

   **Note**: The remote printer must support the designated format. If you specify PostScript and the printer cannot interpret the PostScript commands, the file will not print. If this occurs, try using the text option.

5. Choose the OK button to send your file to the printer.

**LPR-Printing From Within an Application**

Before printing from within an application, you must first configure your network printer in the Windows Control Panel. The configuration of the network printer depends upon whether or not you also have ChameleonNFS.

If you have NFS, you can print from within an application to a remote printer.

**Configuring Network Printer for NFS Environment**

To print to a remote printer from within an application, you must have ChameleonNFS. Before opening your application, you must configure your network printer, as follows:
1. Choose the Windows Control Panel icon and select the Printers icon.

2. Install a print driver compatible with the remote printer. If your print driver is not on the installed printers list, choose the Add button to add your driver to the list. Make your printer the default printer by choosing the Set as Default Printer button.

3. Choose the Connect... button in the Printers dialog box.

4. Select an available (LPT) parallel port.

**Note:** Windows does not support configuring a serial port for network printing.

5. If you have ChameleonNFS installed, choose the Network... button in the Connect dialog box.

**Note:** The network button is available only if a network is installed in the Networks dialog box in the Control Panel, and if an LPT port is available. If the network button is dimmed, make sure your network is installed, and that an LPT port is free.

6. Choose the Browse button in the Printers-Network Connections dialog box.

7. Enter the print server name or its IP address. Select the LPR check box and enter the printer name as it was defined on the remote system. If you are printing to another Chameleon LPD, choose the OK button.

8. If your host requires the User, Class, and Job Name fields, choose the Print Dialog Setup button.

**Print Format when Printing from within an Application**

If you are printing from within an application, the default print type is "v" (Sun raster format).

If you need to override the print format, add these lines to the NFSCLNT.CFG file:

```
[LPD]
format=<options>
```

where options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Plot CIF file</td>
</tr>
<tr>
<td>d</td>
<td>Print DVI file</td>
</tr>
<tr>
<td>f</td>
<td>Print formatted file</td>
</tr>
<tr>
<td>g</td>
<td>Plot file</td>
</tr>
<tr>
<td>Option</td>
<td>Meaning</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>l</td>
<td>Print file leaving control characters</td>
</tr>
<tr>
<td>n</td>
<td>Print ditroff output file</td>
</tr>
<tr>
<td>o</td>
<td>Print PostScript output file</td>
</tr>
<tr>
<td>p</td>
<td>Print file with &quot;pr&quot; format</td>
</tr>
<tr>
<td>r</td>
<td>File to print with FORTRAN carriage control</td>
</tr>
<tr>
<td>t</td>
<td>Print troff output file</td>
</tr>
<tr>
<td>v</td>
<td>Print raster file</td>
</tr>
</tbody>
</table>

For example, to set the print type to "print formatted file:"

```
[LPD]
    format=f
```

**Note:** The print format options are all dependent on the LPD implementation at the remote site. The remote LPD and remote printer must be able to interpret these options.

### Printing Files in PostScript Format (NFS only)

If you have NFS, you may be able to print files in PostScript format. The printer itself must be capable of interpreting and outputting the PostScript format.

If your print server is a UNIX machine, and your printer is a local PostScript printer, you must add CtrlD=0 in the printer section in the WIN.INI file, in the following sequence. (This step is necessary because PostScript drivers add CtrlD to the beginning of a print job, and UNIX systems interpret CtrlD as an end of file indication.)

1. Make sure you install the appropriate PostScript printer driver for your specific printer in the Printers section in the Windows Control Panel. Then, select that printer from the Installed Printers list.

2. Choose the Setup button. View the setup screen to confirm your selection. Choose the Close button and then exit the Control Panel.

3. Edit your WIN.INI file to include the CtrlD=0 statement under the section that contains the name of your redirected PostScript printer.

For example, if you installed an Apple LaserWriter printer driver and connected it to the LPT1 printer in the Control Panel, the heading would look like the following:

```
[APPLE LASERWRITER , LPT1]
CtrlD=0
```
If you installed an HP Laserjet 4/4 printer driver and connected it to the LPT1 printer in the Control Panel, the heading would look like the following:

[HP Laserjet 4/4. LPT1]
CtrlD=0

4. Save these changes. Then restart Windows to make the change effective.

Tips:
• Do not mistakenly insert this statement in the [POSTSCRIPT] section.
• The section for your PostScript printer will not be created unless you first open the Printers option in the Control Panel, select your printer, choose the Setup button, and then choose the OK button.

Configuring Network Printer for Non-NFS Environment

If you do not have NFS, you cannot print to a remote printer from within an application. You will have to print to a file instead, and then send the file to the remote printer as described in "Printing a File Using Chameleon LPR." Before opening your application, you must configure your network printer to print to a file, as follows:

1. Direct your default printer to print to a file. To redirect a file, select a printer and choose the Connect button. Scroll down the list of ports until you see File. When your printer is redirected to print to a file, you will notice that every time you select the print option from within your application, you are prompted for a file name. When you enter the file name, the print job is saved to a file.

2. Use the LPR Menu Print File dialog box to select the file (that you have saved from your application) and send to the remote printer.

Controlling Print Jobs

The Control menu allows you to perform the following commands: Print Any, Status (Short), Status (Long), and Remove Job. You can use these commands to check if your print job has already printed or is still in the queue. You can also remove print jobs from the queue.

To check the status or control the print job:

1. Select the Control menu.
2. Enter the relevant information into the fields of the LPR dialog box, as follows:

- **Host:** The name of the remote host (must be specified to select any of the commands).
- **Printer:** The name of the remote printer (must be specified if you have selected any of the commands).
- **User:** Your user name (must be specified if you have selected the Remove Job command).
- **List:** If you do not enter any print job names in this field and you select Remove Job, LPR will remove all of your print jobs from the queue. If you want to select which of your print jobs will be removed from the queue, you can specify the job names in this field. If you enter one or more job names, only those print jobs will be removed (You must own those print jobs).

If you selected the status command (short or long) and you do not enter a print job name in the list field, LPR will display the status for all print jobs for the specified printer. If you enter your user name, status for all of your print jobs will be listed. If you enter one or more job numbers, status for that job or jobs will be listed.

Query commands are as follows:

- **Print Any:** Print all jobs.
- **Status (Short):** Display the terse version of your print job status.
- **Status (Long):** Display a more detailed version of your print job status.
- **Remove Job:** Delete a print job from the printer queue.

**Note:** These options are LPD implementation-dependent.

**Diagnosing Client and Host Transmission Problems**

To diagnose any client/host transmission problems, select the Log... option from the Settings menu. Open the log option (found under the Settings menu) before sending the file to the printer; LPR will automatically start recording the transmissions as soon as you send the file.
Use this option as a debugging tool. It keeps a log of data transmissions between the client and host.

**Using Chameleon LPD**

Chameleon LPD accepts print jobs from remote users and responds to LPR queries on status

- To use LPD, simply open the application to make it available, and then you can minimize it.
- In order for other users to print to your LPD server, they will need to specify your machine’s IP address or host name.

**Troubleshooting**

If you experience difficulties using the LPR application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Check the host side of your printing procedure. Check with your system administrator about the printcap file, which contains all the necessary parameters and other important information about the various printers connected to the host, and how the host handles the filtering. The printcap file is used by LPD implementation in a UNIX environment; Chameleon LPD does not use this file.
- PostScript drivers add ^D to the beginning of a print job. This causes problems if LPD is running on a UNIX machine. If your print server is a UNIX machine, you must add CTRLD=0 in the printer section in the WIN.INI file.
- The network button is active if a network is installed in the Networks dialog box in the Control Panel, and when an LPT port is free. If the network button is dimmed, make sure your network is installed, and that an LPT port is free.
- Use the Ping application to verify connectivity to any remote system to which you want access if a failure to connect is reported.
- Not every LPD implementation supports the PostScript function. If the PostScript function does not work, select the text option.
Chapter 19. Mail and Mail Administration

The Mail application provides electronic mail services using the Simple Mail Transfer Protocol (SMTP) to both send and receive mail, and the Post Office Protocol (POP2 and POP3) to retrieve mail from a server. You can use these protocols to create your own mail network, or directly integrate with UNIX mail. Mail supports MIME (Multi-purpose Internet Mail Extensions) which allows attachment of files to mail messages. Features include the ability to:

- read and prepare messages off-line, saving you connection costs
- attach multimedia files to your messages through MIME (Multi-purpose Internet Mail Extensions)
- support MAPI-enabled applications
- Routing messages to others one after another
- retrieve message header only information
- organize your messages into folders
- create rules for automatically filtering and filing incoming mail
- create your own personal address books
- attach binary files through uuencode/uudecode
- set up multiple mail accounts

The Mail Administration application allows you to manage your Mail database. Features allow you to:

- merge two mailboxes
- compact mailbox
- generate mailbox from message files
- remove unmatched entries
- build folder information

Setting up Mail

This section describes, step-by-step, how to set up a mail account for the first time user and how to add additional users. It also includes a brief discussion about mail configuration files and the mail log feature.
Setting Up a New Mail Account for a User (First Time Only)

To set up a mail account for a user for the first time, you need to complete the New User dialog box. Note you need to also have this account set up, if you want to use the Phone Tag, Tag It, NEWTNews, and NEWTCal applications.

To set up a mail account for a user for the first time, follow these steps:

1. Open the Mail icon. The Mail - New User dialog box appears.

![Mail - New User dialog box](image)

2. Under Local, enter the user's name, user's password, user's name in real life, and local mail directory in the designated fields.

3. The local mail directory identifies where all configuration files and individual mail messages are saved. You may set up a separate mail directory for each user.

4. Under Network, enter the mail gateway, mail server, user's name, and server password in the designated fields.

   A *mail gateway* routes all mail messages that are transmitted. Normally, the Mail application attempts to connect to the domain portion of a mail address and transmit the mail to the specified user. Note that a mail gateway is often used for access to the Internet. Be sure to specify a mail gateway that is configured to perform as an SMTP relay, because the Mail application does not support SMTP relay functions.

   If you are using a *mail server*, you must define it for each of the mail clients. A mail server is the host machine from where you retrieve your mail using the POP protocol.

5. Enter the address you want to appear as your address in the From field. Remember that when someone replies to your message this field is used, so be sure to use your appropriate address.

6. Choose the OK button.
Note: When upgrading from a previous version of Mail, you will not need to create a user account again. The following message is displayed the first time mail is opened after upgrading: "This version requires a conversion of your current messages into a new format. This may take a while." Choose the Continue button to complete the conversion. Your rules, folders, and messages will remain intact. You must convert to use this version of Mail.

Setting Up Mail Accounts for Additional Users

Once you have set up an account the first time for a new user, you can set up mail accounts for additional users, by first logging in as Postmaster and then as User. The steps are as follows:

Postmaster Login Steps

To log in as Postmaster, define a user's name, password, mail directory, and real name, do the following:

1. Choose the Mail icon to display the User Login screen.

2. Enter Postmaster in the Username field and choose the OK button. The Mail-Postmaster screen appears.

3. Choose the Mailboxes... command from the Services menu to display the Mailboxes dialog box.

Note: The Mailboxes... command under the Services menu only appears when you are logged in as Postmaster. This is the only dialog box in which you can add and delete users and specify a user's mail directory.

4. Enter the user's name in the User field and choose the Add... button. A dialog box with the username appears.

5. Enter the user's password, name in real life, and mail directory. Choose the Browse button to select the desired directory and choose the OK button. Then, choose the Save button on the Mailboxes dialog box to save changes. Note that setting the password and real name are optional.
The mail directory identifies where all configuration files and individual mail messages are to be saved. You should set up a separate mail directory for each user. For example, the mail directory, c:\netmanag\email\jack, in the above screen, is set up for only user Jack.

**Logging into Mail as a User**

To login into Mail as a user, do the following:

1. Choose the Mail icon to display the User Login screen.

2. Enter your previously defined username and password in the Username and Password fields and choose the OK button. The main window (Inbox folder) appears.

**Defining a Mail Server and Mail Gateway**

To define a mail server and mail gateway, do the following:

1. Select Network Setting... option from the Settings menu. The Network Settings dialog box appears.

2. Enter the name of the host (the machine acting as the mail server), user, and user's password on the host machine, and if required, the Mail directory (Mail Dir:) in the corresponding fields.
3. If desired, select the 'Delete retrieved mail from server' option if you want your mail automatically deleted from the server after you have retrieved it. Otherwise, every time you retrieve your mail you will receive duplicate copies of your messages.

4. Type or select the name of the mail gateway in the Gateway field.

5. Type or select the name in the From field you want to appear as the sender when mailing a message.

6. Choose the OK button.

**Configuration Files**

You can save current mail settings to a configuration file (default is USERNAME.CFG) which is loaded when you start the Mail application. Other files that are created by Mail are dependent on the name of the current user and are kept in the user's mail directory. For example, if the current user is Steven then mail files residing in Steven's mail directory include:

- STEVEN.ADB - personal address book
- STEVEN.FLD - list of folders
- STEVEN.SGN - signature
- STEVEN.CFG - personal settings
- 12345678.MG? - individual numbered mail messages
- STEVEN.DB - database file

**Mail Icon**

When you minimize the Mail application, an animated icon of a mailbox appears. When new mail arrives, the mailbox door opens and displays a message.

**Organizing Your Mail Messages**

In order to organize your messages efficiently, the Mail application allows you create folders into which you can place your mail messages.

When the main Mail window is displayed, you will notice that the window is split into two panes: the left pane is called the Containers pane and the right pane is called the Contents pane. The Containers pane contains a list of all mail folders and the Contents pane contains a list of all the messages in the current folder.

In the Container pane, the names of existing folders are displayed along with each folder's icon, number of unread messages and total number of messages. The default folders in descending order are: Inbox, Draft, Routing, Sent Mail, Template, and Trash. All other folders are listed alphabetically.
**Note:** You cannot delete the Inbox, Draft, Routing, Sent Mail, Template, or Trash folders. These folders always appear at the beginning of the Folder list even when they are empty.

In the Contents pane, a list of all the messages in the current folder are displayed. You can drag and drop a message from the right side of the window into the desired folder on the left side, much like moving files into directories in File Manager.

You can also associate attributes to your incoming messages by selecting the Rules option from the Services menu. You can create a rule so that all messages addressed to you are automatically moved to a specific folder. Or, create a rule so that all messages you receive from a particular person are automatically forwarded to another person. Refer to Mail online help for detailed information about folders.

**Creating and Sending Mail Messages**

To create and send a mail message:

1. From the main mail window, choose the Create button, or choose the Create command from the Message menu, or CTRL-E.

   A new mail message window appears. The Date field is automatically set to the current date and time. The From field is automatically set to your user@localhost name if you do not have a mail server defined. If a mail server is defined, it uses your From field if you have one set. Otherwise, the From field is set to user@mail server.

   **Note:** To route your message to others, choose the Add Routing Slip command from the Message menu.

2. You may address your message as follows:
   - enter the e-mail name and address of the person you want to send the message to in the text box next to the To field. Then, using the down arrow, select either To (primary recipient), CC (carbon copy), or Bcc (blind carbon copy).
   - to add additional recipients: choose the Address button to display the Address Book dialog box containing your address book(s) and their entries. Then, select
or type each entry you want to add as a recipient, and choose the To, Cc, or Bcc buttons.

3. Choose the OK button to return to the new mail window.

4. If desired, you can select the Confirm Read and Confirm Delivery options. Select Confirm Read if you want the system to return an acknowledgment that the addressee opened the message. Select Confirm Delivery if you want the system to return an acknowledgment that the message reached the addressee's mail server. Acknowledgments are returned directly to your Mail Inbox folder.

5. If desired, select the priority type of the message you are sending. You can select, high, normal, or low priority. Normal priority is the default. If you assign high priority to your message, then a red exclamation point appears next to your message header in the recipient’s Inbox. Assigning low priority to your message causes a down arrow to appear next to your message header in the recipient's Inbox.

6. Type the subject and message text, and if desired, choose the Feelings menu to add a smiling, frowning, or winking symbol in your message.

7. Choose the Send button to transmit your message to the Outbox. The message is immediately queued in the Outbox for subsequent delivery to its defined destination.

**Menu Items**

The following menu items and options are available when creating a message:

- File menu provides the Insert, Print, Print Setup, and Exit options.
- Edit menu provides the Undo, Cut, Copy, Paste, Find, Replace, Search Again, Include Original, (Bracketed or Indented), Signature and Select All options.
- Message menu provides the Send, Add Routing Slip, Save and Append to File, Save as a Draft or Template, uuencode options.
- Attachments menu provides the New, Delete, and Modify options.
- Tools menu provides the Check Spelling and Fill Paragraph options.
- Feelings menu provides the Happy, Sad, and Wink symbols.
- Help menu provides online help information and version information about Mail.

**Viewing Mail Messages**

To view a mail message from any folder:

1. Select the desired folder, and then select one or more messages.

2. Choose the View button to display the message or double-click on the message.

The view window displays the date, source address, subject, list of recipients, and the message text. You cannot modify any of these fields, however the Copy function within
the Edit menu is available. The Copy function allows you to transfer highlighted message text to other applications.

Choose the uudecode option to decode and save a uuencoded binary file that has been sent as a message you are viewing.

An override option to show the mail header is also provided. The initial setting of Show Header is determined from the setting in the Preferences dialog box.

Routing Messages to Others

The Routing Slip feature lets you send a message to a predefined route of addresses in the order you specify. Instead of sending a message to multiple recipients simultaneously, the Routing Slip feature lets you send a message to recipients one after the other. That is, after the message is viewed by a recipient, he or she can choose whether to send it to the next recipient on the routing slip.

Creating and Routing Messages

To create and route a message to others, do the following:

1. From the main mail window, choose the Create button, or choose the Create command from the Message menu, or CTRL-E. A New Mail window appears.

2. Choose the Add Routing Slip command from the Message menu. A New Mail-Routing Slip dialog box appears.

3. Choose the Add Address button to display the Address Book dialog box that contains your address book(s) and their entries. Then, select or type each entry you want to add as a recipient to your routing slip and choose the To button. Choose the OK button to return to the New Mail-Routing Slip dialog box. Notice that all mail recipients are listed and numbered in the Route text box.

4. To modify the order of recipients, select an address and move it using the arrow buttons to the right of the address list.
5. If desired, select the Return At End, and/or the Allow Modifications options, and choose the OK button. The name "Routing List" appears in the address textbox. The Return At End option sets your address as the last address on the route, thus making the route into a loop. The Allow Modifications option indicates that you allow the recipients to modify the message's text as the message is routed along.

If desired, you may later edit the route before sending it or deleting it. Do this by displaying the Routing Slip dialog box or by selecting Routing List in the address text box and choosing the Modify or Delete buttons, respectively.

6. Finish completing your message and choose the Send command from the Message menu, or choose the Send button to mail the message. The newly sent message is placed in the Routing folder.

7. The status of the routed message is updated as the message moves along from one recipient to the next. Whenever the status is updated, the message is marked as unread. All routed messages are stored by default in the Routing folder.

Viewing Routed Messages

You can view a routed message the same way you view a regular message. Routed messages are stored in the Inbox folder unless otherwise moved by a previously set rule.

When you view a routed message, a new menu named Routing appears in the menu bar. This menu has three options: Route to Next, Information, and Block Route.

The Route to Next option lets you send the message to the next recipient listed in the route and notify the originator of the progress along the route. If the route has the Allow Modifications option set, you may modify the message text by typing in the text area before routing to the next recipient. The original text of the message will be retained, while the new text is available to future recipients.

The Information option lets you display information about the route. The Routing Information dialog box appears containing a list of addresses (if you are a recipient) or the message status (if you are the originator).

The Block Route option lets you stop the message from being routed to any other recipients. The originator of the message is also automatically notified that the routing has stopped.

Replied to and Forwarding Mail

To reply to a mail message in any folder:

1. Select the message.

2. Select the Reply to Sender or All option from the Message menu, or choose the Reply button located on the mail message.
A window identical to the sending mail display appears. The Date and From fields are set normally. If you Replied to All, the list of recipients contains the source address of the original message and also any carbon copy addresses. Note that in many cases your own address also appears. If you do not want to receive a copy of the message you want to send, delete your name from the list.

3. Enter your message and choose the Send button to send the mail.

The text of the original message, for both reply and forwarding, can be left intact with a separator indicating where the original message begins (depending on your setting in Preferences). The text insertion point is placed above this separator so that you can type your reply or forward text above the original message.

To forward a message from any folder:

1. Select the message.

2. Choose the Forward button. A window identical to the sending mail display appears.

3. Enter the recipient and your message and choose the Send button to send the mail.

Deleting Mail

To delete one or more messages:

1. Select the message(s) you want to delete.

2. Choose the Trash icon or the Delete option from the Message menu.

   The deleted message is automatically transferred to the Trash folder. All messages remain in the Trash folder until you select Empty Trash from the Services menu or until you exit Mail (depending on your setting in Preferences).

To delete a folder, refer to the Folders section in Mail online help.

To empty the Trash folder, select Empty Trash from the Services menu. You can also select the Empty trash on exit option from the Preference menu if you want to delete mail in the Trash folder everytime you exit Mail.

Appending Mail Messages to a File

Mail allows you to append the contents of one or more messages to the end of a specified existing file.

While viewing or creating a message, select the Append to File... option from the Message menu and specify the file you want to append to. The contents of the message will be appended at the end of the specified file.
Note: if you select more than one message, the information will be appended in the order in which you selected the messages.

**Saving Mail Messages to File(s)**

Mail allows you to save the contents of one or more messages to a new or existing file.

While viewing or creating a message, select the Save to File... option from the Message menu and specify or select the file to which you want to save the message. The contents of the message will be saved to the specified file.

**Note:** If you select more than one message, the information will be saved in the order in which you selected the messages.

**Creating and Updating a Draft Message**

You can save and store an unfinished mail message and then send it at a later date by using the Save As Draft and Update Draft mail features.

To create a draft message:

1. Select the Create... option from the Message menu. A New Mail message form appears.
2. Enter any information or text required, as you normally would when creating a new message.
3. Save the unfinished message by selecting the Save As Draft option from the Message menu. The unfinished message is now saved in the Draft folder.

**Note:** The Draft folder always appears at the top of the Folder list even when it is empty. You cannot delete the Draft folder.

To update an existing draft message:

1. Select the Draft folder and then select the draft message you want to update.
2. Make the desired changes to the message and select the Update Draft option from the Message menu and close the message.

   The draft message is now updated and stored in the Draft folder.

To complete and send a draft message, simply select the desired draft message and complete it. Then send the message by choosing the Send icon on the Toolbar or select the Send option from the Message menu. The draft message is automatically deleted after you send it.
Creating and Saving a Template

To create a template:

1. Select the Create... option from the Message menu. A New Mail template appears.

2. Enter the subject and message text you want to be part of the template. If desired, you can also enter an addressee. You can create a template without entering a subject, however a template is easier to identify in the Template folder if it contains a subject.

3. Save the template by selecting the Save Template option from the Message menu. The template is now saved in the Template folder.

Note: The Template folder always appears at the top of the Folder list even when it is empty. You cannot delete the Template folder.

To update an existing template

1. Select the Template folder and then select the template you want to update.

2. Make the desired changes to the template and select the Update Template option from the Message menu and close the template.

The template is now updated and stored in the Template folder.

To complete and send a template, simply select the template and add any additional information. Then send the template by choosing the Send icon on the Toolbar or select the Send option from the Message menu.

Using Attachments

The Mail application allows you to attach a physical file or a pointer to a file in a mail message. If you send a pointer to a file, then the recipient can access the file through the FTP client. However, for the recipient to access the file through the FTP client, the sender’s FTP server must be running on his or her system.

All files can be either binary or ASCII. For example, you can attach a spreadsheet file (binary) to a mail message that you are sending to a list of recipients.

Sending a File as an Attachment

To attach a file to a mail message, do the following:

1. Create a new message.

2. Select the New... option from the Attachments menu.

3. Select or type the name of the file you want to attach to your current message. Click on the OK button.
4. The Attachment Description dialog box will display for you to enter the name and path of your selected file. Click on the OK button to attach the specified file to your mail message.

**Note:** To change the type of file you want to attach, click on the Advanced button. File Type selection includes Text, Multiport, Message, Application, Audio, Image and Video. The Subtype field will change according to the defined Type. In the example below, an application file is attached to the mail message. The Type is defined as Application and the Subtype as msword.

![Attachment Description Dialog Box](image)

5. The type, name and size regarding the attached file is displayed at the bottom or your Mail window above the status bar.

![Mail Window with Attached File](image)

**Note:** To modify the attachment description or delete one or more attachments, select the attachment or attachments, then choose either the Modify... or Delete option from the Attachments menu.

**Viewing and Saving File Attachments**

To view a file attachment of an incoming message, do the following:

1. Select the message that includes the attachment, and click on the file attachment you want to view.

2. Choose the View command from the Attachments menu. The attached file appears using the appropriate editor. For example, if the attached file is a .BMP file, the file will be opened using Window's Paintbrush application. Files use the File Manager Association file extensions.
To save a file attachment to a specific location, do the following:

1. Select the message that includes the attachment, and click on the file attachment you want to save to another location.

2. Choose the Save command from the Attachments menu. The Save Attachment As dialog box appears.

3. Select the desired drive, directory, and file type. Enter the name of the file you want to save the attachment as in the Filename text box.

4. Choose the OK button.

**Sending a File Pointer as an Attachment**

If desired, you can send a pointer to a file as an attachment rather than the actual file itself. This way the recipient can simply FTP the actual file to their system. The appropriate FTP Server must be running for the recipient to access the file through the FTP Client.

To do this:

1. Create a new message.

2. Select the New... option from the Attachments menu.

3. Select or type the name of the file you want to attach to your current message. Choose the Advanced button.

4. The Attachment Description dialog box will display for your verification the description and path of your selected file. Under the Type field, scroll to the Message option, and under Subtype field scroll to external-body option. You must choose both these options in order to send the file pointer.

5. Choose the OK button. Information regarding the file such as its type, name, path and size will display at the bottom of your Mail window above the status bar.

**Receiving File Pointer Attachments**

To view file pointer attachment, do the following:
1. Select the message that includes the attachment.

2. Double Click on the attachment at the bottom of your mail window. A message appears that says the attachment is a pointer to the actual document and the message also displays the filename and path. Choose the OK button to close the message.

3. Select the FTP client application to access the file.

**Uuencoding and uudecoding Messages**

Uuencode and uudecode allow the mail user to convert binary files from and into ASCII format. Choose the uuencode option to uuencode a binary file before you send it out and the uudecode option to uudecode a message you have received as a specified file on your machine.

**Note:** A mail message can have both a file attached to it and a uuencoded file included in its body.

To uuencode a file, do the following:

1. Create a new mail message.
2. Select the uuencode... option from the Message Menu.
3. Select or enter the file that you want to uuencode and choose the OK button. The file will display in ASCII form in the body of your mail message.
4. Fill out both the To and Subject fields and send your message.

To uudecode a file mailed to you, do the following:

1. Select the message you want to uudecode.
2. Choose the View button to display the message.
3. Select the uudecode... option from the Message menu.
4. Select or enter the file to which you want the uudecoded message to be saved. Then, choose the OK button. The file is now converted into its original binary format.

**Note:** Some mail applications can uudecode only one uuencoded file at a time. Therefore, you may want to uuencode only one file at a time.

**Editing Mail Messages**

This section discusses various features available for editing messages.

**Finding Text**
You can find a particular word, part of a word or any combination of characters in the mail message body. To do this:

1. With the cursor in the body of the mail message, select the Find... option from the Edit menu. The Find What dialog box appears.

2. Type the word or text characters you want to find in the Find field.

3. Select the option you want to control your search:
   • Match Whole Word Only: Find the specified text as a whole word only.
   • Match Case: Find the specified text as having the same case as the text in the Find What field. For example, if you search for "What" you will not find "what."
   • Up: Search the text above the cursor.
   • Down: Search the text below the cursor.

4. Choose the Find Next button to begin or continue the search.

5. Choose the Cancel button when you have finished your search.

**Replacing Text**

You can replace text in your mail message by using the Replace option. To do this:

1. With the cursor in the body of the mail message you are creating, select the Replace... option from the Edit menu. The Replace dialog box appears.

2. Enter the text you want replaced in the Find What field.

3. Enter the text you want to replace it with in the Replace With field.

4. Select the option you want to control your search:
   • Match Whole Word Only: Find the specified text as a whole word only.
   • Match Case: Find the specified text as having the same case as the text in the Find What field. For example, if you search for word What, the spell checker will not find the word what.

5. Choose the Find Next button to find an occurrence.

6. To replace the text, choose the Replace button. To leave the text unchanged and continue the search, choose the Find Next button.

7. To change all occurrences of the text for which you are searching without confirming, choose the Replace All button.

8. When you are finished searching and replacing, choose the Cancel button.
**Filling Paragraphs**

You can close any gaps in the text of a mail message you are creating by selecting a section of text you want to close and selecting the Fill Paragraph option under the Tools menu.

**Using the Spelling Checker**

To check the spelling of your mail message:

1. With the cursor in the body of the mail message you are creating, select the text in which you want to check spelling. If you do not select text, the entire mail message is checked beginning at the cursor.

2. Select the Check Spelling... option from the Tools menu. The Spelling Check dialog box appears if there are errors.

   The spelling checker begins checking the selected text or the mail message. When it finds a word that is not in any the default dictionary it displays the word in the dialog box and highlights it in the message.

   For each word found, you can:

   - Correct the spelling - In the Replace With field, type the correct spelling. Or, in the Suggestions field, select a correction. Then, choose the Replace button to change the current word only, or Replace All to change all instances of the word.

   - Leave the word unchanged and continue the spelling check by choosing the Ignore button.

   - Skip the current word and all other instances by choosing the Ignore All button.

   - Add the word to a user dictionary so the spell checker will not consider it misspelled in the future.

3. The Spell Checking is Complete dialog box appears when the speller is finished. Or, choose the OK button to return to the mail message.

**Spelling Checker Options**

You can customize the Spelling Checker for your own special needs. From the Spelling dialog box, choose the Options... button. A Preferences dialog box appears that lists the following options:
• **Ignore capitalized words** - Spell checker will not display any improperly
capitalized words. However, if they are misspelled the checker will still find them.

• **Ignore words with numbers** - Spell checker will not display any words containing
numeric characters.

• **Ignore words with mixed case** - Spell checker will not display any words because
there are mixed case letters. However, if they are misspelled the checker will still
find them.

• **Report doubled words** - Spell checker will display any words that appear twice
next to each other. However, if they are misspelled the checker will still find them.

• **Always suggest** - The Suggestion box automatically displays suggested words. The
default for this option is On.

### Advanced Options

This section discusses advanced options in Mail including how to retrieve message
header only information and how to use the Offline feature.

### Retrieving Message Headers Only

The Smart POP feature lets you retrieve message header information only (subject, date,
time, sender) without needing to retrieve the entire message or attachments.

Normally, most users want to retrieve their mail messages in their entirety including
attachments. However there may be times, during serial dialup or a PPP connection for
example, when you only want to retrieve the message headers only. This is very
convenient for users who do not want to retrieve large messages from the server to their
own machine when working remotely. Or, for users who want to read messages
remotely while at home or traveling, but also want to store them on a desktop machine
at work. Smart POP also lets you:

• retrieve message headers only for very large messages
• retrieve message headers only for all messages
• retrieve entire messages
• apply rules, or any other existing action, to messages whose header information you
  have already retrieved.
• do all other existing actions (such as replying or forwarding) on header only
  retrieved messages
Smart POP Preferences Tab

The Smart POP dialog box has the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve Headers Only for messages over xx KB</td>
<td>Lets you retrieve message headers only for messages that are above a certain size. All messages under the stated size are retrieved in their entirety. You can set the maximum message size in the KB text box. (Default is 1024 KB)</td>
</tr>
<tr>
<td>Always retrieve headers only</td>
<td>Lets you retrieve message header information only from messages on the server. The entire message still resides on the server. If desired, you can later retrieve an entire message by double clicking on the header message icon or by selecting a command from the menu or toolbar that needs the entire message (such as reply or forward).</td>
</tr>
<tr>
<td>Always retrieve entire message</td>
<td>This is the default setting. Lets you retrieve all messages as you normally do. That is, in their entirety including attachments.</td>
</tr>
<tr>
<td>Do not apply rules to the Header Only messages</td>
<td>If selected, this option does not apply all rules to entire messages that you retrieve. This option applies rules only to the entire message and not the header only message.</td>
</tr>
<tr>
<td>Confirm before retrieving the entire message</td>
<td>If selected, displays a prompt stating that the message resides on the server and it asks you if you want to retrieve the message now. You can also choose not to display the prompt again by selecting the Don't display this prompt again option.</td>
</tr>
</tbody>
</table>

Retrieving Message Headers Only for All Messages

To retrieve message header information only for all messages, do the following:
1. Choose the Preferences command and then the Smart POP tab from the Settings menu. The Smart POP dialog box appears.

2. Select the Always retrieve headers only option. All messages your computer retrieves will contain header only information. Header only messages have the header only icon to the left of them. If after reading the message header you decide to retrieve the entire message, then double click on the header only message.

**Note:** When a message belongs to another Mail related application such as Phone Tag or Tag-It!, or is part of a routing slip, then the message is retrieved in its entirety.

3. If you want to be prompted before you retrieve the entire message, then select the Confirm before retrieving the entire message option. If you select this option, then a dialog box containing a prompt asking you if you want to retrieve the entire message appears. Choose the Yes button to retrieve the message. You can also disable the prompt from appearing again by selecting Don't display this prompt again.

4. If you do not want rules applied to entire messages you may later retrieve, then select the Do not apply rules to Header Only messages option.

5. Choose the OK button.

**Note:** If you want to re-retrieve header only messages at a later date as entire messages, first change the option on the Smart POP tab to Always retrieve entire message, then choose the Refresh from Host command from the Message menu.

**Retrieving Message Headers Only for Large Messages**

To retrieve message header information only for messages over a specific size, do the following:

1. Choose the Preferences command and then Smart POP tab from the Settings menu. The Smart POP dialog box appears.

2. Choose the Retrieve Headers Only for messages over xx KB option.

3. Enter the number of kilobytes in the KB text box indicating the maximum size at which a message can be retrieved in its entirety. Any message over the indicated size will be retrieved as a header only. Note that 1024 kilobytes is the default size.

**Note:** When a message belongs to another Mail related application such as Phone Tag or Tag-It!, or is part of a routing slip, then the message is retrieved in its entirety.

4. Header only messages have the header only icon to the left of them. If after reading the message header you decide to retrieve the entire message, then double click on the header only message.
5. If you want to be prompted before you retrieve the entire message, then select the Confirm before retrieving the entire message option. If you select this option, then a dialog box containing a prompt asking you if you want to retrieve the entire message appears. Choose the Yes button to retrieve the message. You can also disable the prompt from appearing again by selecting Don't display this prompt again.

6. If you do not want rules applied to entire messages you may later retrieve, then select the Do not apply rules to Header Only messages option.

7. Choose the OK button.

Note: If you want to re-retrieve header only messages at a later date as entire messages, first change the option on the Smart POP tab to Always retrieve entire message, then choose the Refresh from Host command from the Message menu.

Retrieving Entire Messages

The Always retrieve entire message option on the Smart POP tab lets you retrieve messages in their entirety including attachments as you normally would. This option is the default setting.

Using the Offline Option

Anytime you launch Mail, after you have an established account, you will need complete the Mail - Login dialog box. This dialog box prompts you for your username and password. It also provides you with the Offline option.

The Offline option disables the automatic timers for sending and receiving mail. If you select Offline, you will need to:

1. Manually retrieve your messages by selecting the Retrieve Messages option from the Mail menu.

2. Open Outbox and manually send all queued outbound messages.

Suppose you select one interface in Custom for Dial On Demand and want to work offline before actually sending or retrieving mail. Selecting the Offline option allows you to prepare a batch of e-mail for sending and it will not cause your dial-up connection to be initiated until you explicitly choose to send or retrieve mail.

Customizing Mail

Mail contains several features that allow you to customize your own mail application. These features allow you to:

- Create your own personal address books
- Set rules for incoming messages
- Modify preference settings for Mail
- Use command line options
- Set display information
- Sort by the Date, From, and Subject fields
- Rearrange the columns width and order
- Attach a signature to outgoing messages
- Change your password
- Set timing parameters

**Creating Your Personal Address Book(s)**

You can select the Address Book option from the Services menu to simplify the selection of mail recipients and to create distribution lists. The Address Book option lets you create one or more address books.

You can list individual addresses or create groups that contain many individual addresses. All the names and mail groups you enter into an address book automatically appear in the Address dialog box at the time you are ready to send a message. You simply select the individual or group to whom you want to send mail instead of having to type the full name and destination address.

**Adding Individuals to an Address Book**

To add an individual to an address book, open the address book and type the individual name and address, select Individual and choose the Add Name button or choose the Add Name... command from the Edit menu. The name appears on the list and is automatically added to the address book.

![Address Book Interface](image)

**Adding Groups to an Address Book**

To add a group to the address book, do the following:

1. Open the address book to which you want to add a group.
2. Type the group name, select the Group option and choose the Add Name button. A dialog box that lets you add user names and addresses to the new group appears.

3. Select the name or names you want to add to the group and choose the Add button. The selected names appear in the Group Members list.

4. When you are finished adding user names to the group, choose the OK button. All group names appear in the Address Book dialog box in square brackets. For example, [groupname].

5. You can double-click on any individual user to see if they belong to a group.

**Creating Additional Address Books**

You can create a new address book or add additional address books that are stored locally. You can also allow access to an existing address book that resides on a remote host.

**To create a new or add another locally stored address book:**

1. With the Address Book dialog box open, select the Add Address Book... option from the Address Book menu. The Add Address Book dialog box appears.

2. Enter the name of the new address book in the Name text box.

3. Enter the new address book's path and filename in the File text box. You can enter the pathname directly or use the Browse button to browse for the selected drive and directory. Your address book filename must use a .ADB extension. For example, the new address book called Joe could reside in: C:\NETMANAG\JOE.ADB.

4. Select the Local option.

5. Choose the OK button.

**To add access to an existing address book on remote host:**

1. With the Address Book dialog box open, select the Add Address Book... option from the Address Book menu. The Add Address Book dialog box appears.

2. Select the Remote option.

3. Enter the new address book's path and filename in the File text box. You can enter the pathname directly or use the Browse button to browse for the selected drive and directory.
directory. Your address book filename must use a .ADB extension. For example, the new address book called Joe could reside in: C:\NETMANAG\JOE.ADB.

4. Enter the name of the host in the Host text box. This is where the address book you want to access remotely is stored.

5. Choose the OK button.

You can open the remote address book by double clicking on its name in the listbox. The first time you open the book, the application connects to Directory Server, downloads all the addresses, and displays them in the listbox.

These addresses are cached in a local file so you can open the address book over and over without having to go through the network. However, if you want to update the address book contents from the network, then choose the Update Remote command from the Address Book menu.

**Deleting Existing Address Books**

You can also delete existing address books by selecting the address book you want to delete, and then selecting the Delete option from the Address Book menu.

**Copying Names Between Address Books**

You can easily copy one or more individual or group names from one address book to another. To do this:

1. Open the address book from which you want to copy.

2. Highlight the name(s) of individuals or groups you want to copy.

3. Select the Copy To... option from the Address Book menu to display the Copy Address To dialog box.

4. Select the address book into which you want to copy the names and choose the OK button.

**Viewing Address Book Properties**

You can view the properties of a existing address book by selecting the desired address book and then selecting the Properties option from the Address Book menu. A Properties dialog box appears that lists the address book name and its .ADB file location.
ECCO Setup Option

The ECCO Setup option in the Address Book dialog is provided for the convenience of ECCO users. If you have the ECCO software package on your system, you can add e-mail addresses from your ECCO phonebook into one of your Mail address books. You can choose to add all the e-mail addresses from your ECCO phonebook or only a selected set of addresses.

To do this:

1. From the Address Book dialog box, select the Options menu to display the ECCO Setup dialog box.

2. In the Field Name field of the ECCO Setup dialog, enter the name of the field containing e-mail addresses in your ECCO address book. (The field for e-mail addresses is an optional, user-specified field in the ECCO phonebook. Therefore, the name of this field depends on what you named the field in your ECCO phonebook.) For example, if you named the field containing e-mail addresses in your ECCO address book as E-Mail, then you would enter the name E-Mail in the Field Name field.

3. In the Criteria field, select All to add all the e-mail addresses from your ECCO address book to the Mail Address Book. Or scroll the down arrow and select an alpha character to add only the addresses beginning with that character. For example, if you want to include only e-mail addresses beginning with the letter B, select the letter B from the list.

NetManage's ECCO Simplicity, ECCO Lite, and ECCO Professional are all personal information manager (PIM) software applications.

Setting Rules

You can associate attributes to your incoming messages by selecting the Rules... option from the Services menu. For example, you can create a rule so that all messages addressed to you are automatically moved to a specific folder. Or, create a rule so that all messages you receive from a particular person are automatically forwarded to another person.

The following steps show you how to create a rule where all messages whose chosen field contain a specific name or string to be automatically moved to specific folder.
1. Enter the name of the rule in the Rule name: field. In this example, test2 is the name of the rule.

2. Enter the string (single word or several words) you want the system to search for in the String to match: field. In this example, the name Support is the string.

3. Select the field (From, To, Subject, or Sender) where the string is located. In this example, the name Support would have to appear in the To field.

4. Select the action (Move to Folder, Forward, Delete) you want executed when the matched string is found. In this example, any message whose To field contains the name Support will be automatically moved to a folder named Urgent.

If you want to select a folder to which incoming messages are automatically sent, the folder does not have to previously exist. You can define the folder when you make the rule.

Note: If you have more than one rule that contains the identical string to match, then the system will apply the first rule that is listed in the Rules: field.

Setting Preferences

You can modify several preferences for Mail by selecting the Preferences... option from the Settings menu and selecting each preference you want to activate. There are five tabs on the Preferences dialog box: Outgoing Mail, Edit/View, Misc, International, and Smart POP. Select the preferences you want, and choose the OK button.

Using Command Line options

You can use one or any possible combination of the following options to customize your Mail login. The options are:

- `-u {username}` automatically enters the user's Mailbox name.
- `-p {password}` automatically enters the user's Mailbox password
- **-offline** enables the Offline option
- **-nologo** removes the splash screen (large Mailbox with copyright information) upon startup

To set one or more Mail command line options, do the following:

1. Single-click (highlight) your mail icon. Mail can be closed or opened.
2. From the Program Manager, choose the Properties... command from the File menu. The Program Item Properties dialog box appears.
3. Enter the option or options at the end of the Command Line text box.

   For example, to set up Mail so that your username and password are entered automatically, thus bypassing the login box, enter the -p and -u options as follows:
   
   ```
   C:\NETMANAG\MAIL.EXE -UJack -Pmypassword
   ```
   
   where Jack is the user's mailbox name and mypassword is the user's (Jack) mailbox password.

   **Note:** All options are case insensitive. If you use the -p option your password will appear in the command line text box, thus making mail less secure.

**Display Information**

The Display Information option allows you to choose how information is displayed. You can have the number of unread messages and total number of messages in a folders displayed or hidden along with folder names. (Default folder names are always displayed).

![Display Information dialog box](image)

Under Messages, you can choose to have the information in the Status, Date, From and Subject fields sorted by ascending or descending order.
Sort by the Date From and Subject Fields

You can sort by the Date, From and Subject fields while viewing the contents of a folder. The Date column is sorted by either the date the message was sent or received. The From field is arranged alphabetically to allow you to view all messages sent from a particular sender. The Subject field is also sorted alphabetically to allow you to group messages sent about the same topic.

The arrow to the right of the Subject field determines how messages in each field are sorted:

- If the arrow is pointing up: Sorts messages in the Date field from most recent to oldest date. You can select either the date the message was sent or it was received from the popup dialog box that appears when you double click on the Date field. Sorts messages in the From and Subject fields alphabetically from Z to A.

- If the arrow is pointing down: Sorts messages in the Date field from oldest to most recent date. You can select either the date the message was sent or received from the popup dialog box that appears when you double click on the Date field. Sorts messages in the From and Subject fields alphabetically from A to Z.

To sort by any of the above fields, double click on the arrow to determine how the messages will be sorted for a particular field, then double click on the desired field.

Changing Column Width and Order

In some applications you can change the width of each column or field. You can also rearrange fields if you want to view them in a different order.

To change the width of a column:

1. Position the mouse pointer at the right side of the column border for the column you want to resize.

2. Drag the column border to the desired size.

To move a column:

Select the column you want to move and drag it to its new position.

Attaching a Signature

You can design a signature that is automatically attached to the end of each mail message you send out. To create a mail signature, do the following:

From within Mail, select the Signature... option from the Settings menu. The Signature... dialog box appears.

1. Type in your own personal signature that you want to attach to outgoing mail.
2. If desired, select the Attach to outgoing mail box if you want it automatically attached to every outgoing message.

**Changing Your Password**

You can change your password at any time. To change your password, do the following:

1. Select the Password... option from the Settings menu. The Password dialog box appears.
2. Enter your current password in the Old Password field.
3. Enter your new password in the New Password field.
4. Enter your new password again in the Confirm Password field and choose the OK button.

**Note:** You can change the passwords for all users by logging in as Postmaster and accessing the Mailboxes dialog box.

**Setting Timing Parameters**

You can specify Retrieve timing parameters by selecting the Timers... option from the Settings menu.

Retrieve time values specify how often mail is retrieved from the mail server. Your Inbox queries the server periodically, as specified by this time value. You can also select the Retrieve Mail option from the Message menu to manually retrieve server mail, if mail is not automatically retrieved.

**Using the Outbox**

Anytime you send a message it first goes to the Outbox and then is delivered to the mail gateway, if defined. This includes all messages sent using Mail, Tag It, Phone Tag, and messages you post using NEWTNews and NEWTCal.

The Outbox attempts to deliver a message as soon as it receives it. Messages that remain in the Outbox past a specified amount of time expire and Mail messages are returned to the sender as undeliverable.

**Opening the Outbox**

You can manually open and close the Outbox application through its icon. Or, by selecting the Outbox option under the Services menu.
Using the Messages Menu

The Messages Menu in Outbox lets you view, send, and delete messages in the Outbox. Simply select the desired message and then select either the View, Send, Delete, or Abort options.

You can also use the Pause Sending Message and Check Unmatched Message Files options to stop messages in the Outbox from being sent. This is especially useful if you are using a dialup connection.

For example, before you disconnect you can select this option and the Outbox will not try to send messages. Then, when you reconnect you can try to send your messages again by deselecting this option.

Use the Check Unmatched Message Files... option from the message menu when sent messages fail to arrive to the Outbox. This option manually places the sent messages into the Outbox list.

Setting Outbox Preferences

You can choose how long you want a message to remain in the Outbox before it expires. Messages that remain in the Outbox past a specified amount of time expire, and are returned to the sender as undeliverable or the sender is notified that the mail was not delivered.

Specify various timing parameters by selecting the Preferences... option from the Settings menu. Send time values specify mail delivery times to the Outbox. The Outbox re-transmits all pending messages every retry time, and returns messages to the original user after the timeout period.

When you minimize the Outbox, a mail truck icon appears that indicates queued mail pending delivery. The door of the mail truck opens when one or more messages are queued for delivery and closes when empty.

Mail Administration

The Mail Administration application allows you to manage your Mail database. To use Mail Administration, do the following:

1. Quit the Mail application if it is open.

2. Choose the Mailbox Administration icon. The Mailbox Administration-Login dialog box appears.

3. Enter the username and password and choose the OK button. The Mail Administration window appears. There are five options available:
   - Merge two mailboxes
   - Compact mailbox
• Generate mailbox from message files
• Remove unmatched entries
• Rebuild folder information

4. Select one of the five options and choose the Start button.

![Mail Administration dialog box](image)

**Merge Two Mailboxes**

Select this option to merge the messages from any mailbox into the current mailbox. Messages in the source mailbox remain unchanged. All messages are copied into the current user's mail directory, and are added to the current mailbox. **The mailboxes (user's .DAT files) must have the same name.**

To use this option do the following:

Select the Merge two mailboxes option and choose the Start button. The Mail Administration - Merge dialog box appears. Choose the Dir... button and select the source directory of the mail database you want to merge into the current mailbox and choose the **OK** button.

**Compact Mailbox**

Select this to reduce the mail database file size by eliminating empty space in the Mailbox that occurs when you have deleted numerous messages.

To use this option:

Select the Compact mailbox option and choose the Start button. A dialog appears displaying the progress of the action. Choose the Abort button to stop compacting.

**Generate Mailbox from Message Files**

Select the Generate mailbox from message files to generate or create a new database.

To use this option:
Select the Generate mailbox from message files option and choose the Start button. An information dialog box appears that explains what occurs and ask you if you want to continue. Choose the Yes button.

A dialog appears displaying the progress of the action. Choose the Abort button to stop generating.

**Remove Unmatched Entries**

Select the Remove unmatched entries option to remove entries in the mail database that do not have actual message files associated with them.

To use this option:

Select the Remove unmatched entries option and choose the Start button. A dialog appears displaying the progress of the action. Choose the Abort button to stop removing entries.

**Rebuild Folder Information**

Select the Build Administration folder information option to have the Mail Administration rebuild the folder hierarchy from the files and directories on the disk. Choosing this will automatically be followed by a Generate to rebuild the mail database.

**Note:** Mail Administration will make a best guess at what the folder names should be, based on the names of the directories on the disk. If desired, you may rename your Mail folders later. However, this should only be necessary for folder names that could not be used as a DOS directory name.

To use this option:

Select the Build folder information option and choose the Start button. A prompt appears stating that some folders may need to be renamed and that the process will take some time. Choose the Yes button to continue.

A dialog appears displaying the progress of the action. You can choose to abort during this time by choosing the Abort button.

**Mailbox Administration Menu Items**

**Exiting Mailbox Administration**

Select the Exit option from the File menu to exit Mailbox Tools.

**Running the Log**

Select the Log option from the Report menu to access the Log dialog box. Refer to the Mail Log... option description in Mail online help for details.
Accessing Online Help

Select the Contents option from the Help menu.

Troubleshooting

If you experience difficulties using the Mail application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- If you cannot open your mailbox because you forgot your password, then edit the MAIL.CFG file and remove the encrypted password next to your name. For example, if John=fg78%$, then fg78%$ is the encrypted password.
- If you are having trouble retrieving mail, make sure that the remote system supports the SMTP protocol. Verify that the POP2 or POP3 daemons are running on the mail server system. The POP2 known port is 109 and the POP3 port is 110. To verify if the daemons are running, use the Telnet application to connect to ports 109 or 110. The system replies with a message indicating if the correct daemons are running on ports 109 or 110.
- If you have trouble sending mail, verify that SMTP is available on the remote host, and you have specified the correct mail gateway address under Network settings. Also verify that the To: field (destination address) is complete. For example, steven@netmanage.com.
- For POP2 only, you also need to verify that the mail directory settings are correct. Make sure that your password and mail path (/usr/spool/mail/username) are correct. Contact your system administrator for more information.
- Use the Ping application to verify connectivity to the domain portion of any destination address if Mail reports a failure to deliver. Verify connectivity to your mail server if defined.
- Use the logging feature to help diagnose client transmission and mail server retrieval problems. Check replies for connection errors or destination address errors.
- Make sure the user name portion of the destination address is defined at the destination. The Postmaster may define new users by using the Mailboxes item under the Services menu.

If you experience difficulties using the Outbox application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- If you are having trouble sending mail, make sure that the remote system supports the SMTP protocol.
- If you have trouble sending mail, verify that SMTP is available on the remote host, and you have specified the correct mail gateway address under Network settings.
Use the Ping application to verify connectivity to the domain portion of any destination address if Outbox reports a failure to send.

If you experience difficulties using the **Mail Administration** application, refer to the following items:

- Back up the user's e-mail directory and then do a Generate or Rebuild.
Chapter 20. Directory Server

The Directory Server lets you keep a company-wide address book, or an ECCO phonebook available so that other users can easily access it. The Directory Server can also be accessed as a regular Whois server through NetManage's Whois client application.

You can place any regular address book that has an .ADB extension or an ECCO phonebook that has an .ECO extension on the Directory Server. However, only one file (one address or phone book) can be made available on the server at a time.

Launching the Directory Server

You can launch the Directory Server manually, or through the Internet Services Daemon (INETD). To launch it manually, simply choose the Directory Server icon to display the Directory Server dialog box.

To launch it through INETD, refer to the discussion about INETD configuration in the chapter titled, Customizing Your Setup.

Configuring the Directory Server

The Configure command from the Settings menu lets you select the address book file you want to make available to users. You can select a regular address book file (.ADB), or an ECCO file (.ECO).

For example, suppose you have two files: one is a regular address book called NetManage, with the filename C:\NETMANAG\EMAIL\JANE\NETMAN.ADB, and the other is an ECCO-based phonebook with the filename C:\ECCO\NETMAN.ECO. You can choose which of these files you want to make available on your server.

To place an address book on the Directory Server, do the following:

1. Choose the Directory Server icon to open the application.
2. Choose the Configure... command from the Settings menu. The Configure dialog box appears.
3. Under Data File Type, select the Address Book (.ADB) option.
4. Enter the complete pathname of the address book you want to make available in the Filename text box. Choose the Browse button to search for the address book's correct pathname if you do not already know what it is.
5. Choose the OK button.
To place an ECCO-based phonebook on the Directory Server, do the following:

1. Choose the Directory Server icon to open the application.

2. Choose the Configure... command from the Settings menu. The Configure dialog box appears.

3. Under Data File Type, select the ECCO (.ECO) option.

4. Enter the complete pathname of the ECCO phonebook, which you want to make available on the server, in the Filename text box. Choose the Browse button to search for the phonebook's correct pathname if you do not already know what it is.

5. In the Email Field Name text box, enter the name of the field in the ECCO phonebook that specifies the e-mail address. The default is Email.

6. Choose the OK button.
Chapter 21. Phone Tag

The Phone Tag application provides a handy method of recording and sending phone memos. It allows you to create phone memos from your PC and send them directly to people, without having to write the memo down on a piece of paper and physically handing that person the memo. This application is also helpful for telephone operators and other employees who take a lot of phone memos for other people.

You can set Phone Tag (through the Preferences menu) so that a Phone Tag memo someone sends you automatically pops up on top of any other Windows application you are using.

Phone Tag provides a template for your mail memo, so you can simply type in the memo, and you do not have to worry about typing the other extraneous information (for example, date time and so on). This information automatically appears in the template when you bring up the phone memo template.

Opening Phone Tag

You do not have to log in to use Phone Tag, if you are already logged into Mail, Tag It!, NEWTNews, or NEWTCal. All five applications share the same login ID. Note, however, that you must have a Mail account and have Mail running in order to receive Phone Tag memos. You also can send a Phone Tag memo to someone who does not have the Phone Tag application. This person would simply receive the Phone Tag memo as a regular e-mail memo.

Phone Tag uses the same login information and gateway settings used in Mail. Set up the username, password, Gateway, and Server through the Mail application (using Postmaster to add a user). Refer to the chapter titled, Mail and Mail Administration, in this manual.
Creating Memos

Create a memo by following these steps:

1. Choose the Create... command from the Memo menu. The Phone Memo-Create template appears. The following toolbar icons appear on the top of this template: Send the memo, Date and time stamp outgoing memo, Bring up Address book, Create a memo, and print a memo.

2. Enter information into the following fields:

   • **To**: The e-mail address of the person to whom you are sending the memo. This field must contain a valid mail address or alias recognized by Chameleon Mail. To send to more than one user/alias, separate them by commas.
   
   • **From**: The caller. This is the person leaving the phone memo.
   
   • **Of**: The company name of the person listed in the From field.
   
   • **Date**: The date the memo is sent. This field is automatically stamped. It can be overwritten with current time by checking the Time Stamp button.
   
   • **Time**: The time the memo is sent. This field is automatically stamped. It can be overwritten with current time by checking the Time Stamp button.

   **Note**: The Date and Time stamp must conform to the international date/time setup under the Control Panel.

   • **Area Code**: Area code of the caller.
   
   • **No.**: Phone number of the caller.
   
   • **Ext.**: Phone extension of the caller.
   
   • **FAX#**: FAX number of the caller.
   
   • **Message**: Contains a message from the caller.
   
   • **Signed**: The name of the person (operator) who is recording the phone memo. This field is automatically filled in with the sender's default From field set in mail.
The following fields may be checked to indicate what the caller wants to convey about his/her message:

Phoned, Call Back, Returned Call, Wants To See You, Was In, Will Call Again, Urgent.

**Sending Memos**

To send a memo after you enter all information into the phone memo, select the Send Memo toolbar icon or press CTRL S to send the memo.

*Note:* The To, From, and Signed fields are required. The To field must be a valid e-mail address or mail alias recognized by Chameleon Mail. The Signed field is automatically signed in with the name set as default in the Mail from field.

**Forwarding Memos**

You can forward a Phone Tag memo by selecting the memo you want to forward and selecting the Forward option from the Memo menu.

**Deleting Memos**

You can delete a Phone Tag memo by selecting the memo you want to delete from the main Phone Tag window and selecting the Delete option from the Memo menu.

**Viewing Memos**

You can view a Phone Tag memo by selecting the memo you want to view from the main Phone Tag window and selecting the View option from the Memo menu.

*Note:* You can scroll through a Phone Tag memo you are viewing by using the up/down arrow buttons.

**Using the Settings Menu**

The Settings menu allows you to set preferences, fonts, colors, and use the logging feature. Refer to Phone Tag online help for detailed information about options in the Settings menu.

**Troubleshooting**

If you experience difficulties using the Phone Tag application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
If you receive Phone Tag memo's as regular e-mail, ensure that the directory in which NetManage is installed is in the DOS path and that PHONETAG.EXE is installed.

If you are not receiving Phone Tags, make sure Mail is running and retrieving Mail. Have the person sending the Phone Tag, send a regular e-mail message to the same address. If the regular e-mail message is not received, see the Troubleshooting section in the Mail application.
Chapter 22. Tag-It!

The Tag-It! application lets you send informal messages to other people. The Tag-It! window looks similar to an online version of a Post-It™ note. The messages are displayed as yellow popup notes. If you want to create longer and more formal messages, you should use the Mail application.

You log into Tag-It! the same way you do in Phone Tag, Mail, NEWTCal and NEWTNews, because Tag-It! uses the Mail SMTP send mechanism. Tag-It! messages you receive are automatically opened by Mail.

Note: Unlike Mail and Phone Tag messages, you cannot save Tag-It! messages.

Sending Tag-It! Messages

You can easily send a Tag-It! message by taking the following steps:

1. Choose the Tag-It! icon to display a Tag-It! window.

   The window includes a title bar and provides access to the Control menu if you have specified Tag-It! to do so (as discussed in "Setting Preferences," later in this chapter). If not, you can display the title bar and make the Control menu accessible by double-clicking the window or by pressing ESC.

   Note: To access the Control menu, you should first make the title bar available by double-clicking on the Tag-It! window or by pressing ESC. Then press ALT+SPACEBAR to display the Control Menu or click on the small box in the upper left corner of the window (the Windows Control Menu icon).

   The window also includes toolbar buttons for the Send, Address, Close, and Minimize functions.

2. Specify to whom you want to send your message. To do so, perform either of the following operations:
• Type the e-mail address of each user in the To: field. Separate addresses with a comma (,).

• Display the Address Book either by choosing the Address button from the toolbar, by choosing the Address command from the Control menu, or by pressing CTRL+A. After Tag-It! opens the Address Book, select a name and then choose the To button. Continue selecting names and choosing the To button until you specify all the users to whom you want to send the message. Then, choose the OK button.

The Address Book lists the addresses of the users included in the Mail Address Book. For additional information, see the chapter on Mail in this manual.

3. Type your message in the window.

4. Either choose the Send button on the toolbar or choose the Send command from the Control menu or press CTRL+S.

**Forwarding Tag-It! Messages**

After Mail opens a Tag-It! message sent to you by another Tag-It! user, you can forward that message to other users. To do so, take the following steps:

1. Choose the Forward button from the toolbar or choose the Send command from the Control Menu or press CTRL+F.

   The To: field is cleared, the From: field automatically changes to your login username, and the Forward button becomes the Send button.

2. Specify to whom you want to send your message. To do so, perform either of the following operations:
   • Type the e-mail address of each user in the To: field. Separate addresses with a comma.
   • Either choose the Address button from the toolbar or choose the Address command from the Control menu. After Tag-It! opens the Address Book, select a name and then choose the To button. Continue selecting names and choosing the To button until you specify all the users to whom you want to send the message. Then, choose the OK button.

3. If you want to, type additional information in the message you are forwarding.
4. Either choose the Send button on the toolbar or choose the Send command from the Control menu, or press CTRL+S.

**Setting Preferences**

To set up preferences for Tag-It!, take the following steps:

1. Choose the Tag-It! icon to open a Tag-It! window.

2. Choose the Preferences option from the Control menu.

**Note:** To access the Control menu, you should first make the title bar available by double-clicking on the Tag-It! window or by pressing ESC. Then press ALT+SPACEBAR to display the Control Menu or click on the small box in the upper left corner of the window (the Windows Control Menu icon).

3. Configure Tag-It! by performing one or more of the following operations:
   - Select the Show Title check box if you want Tag-It! to always display the title bar and make the Control menu available upon startup.
   - Specify whether Tag-It! remains running after a message is sent.
     - To close Tag-It! once a message is sent, select the Close on send option.
     - To continue running Tag-It! but minimize the window, select the Minimize on send option.
     - To continue running Tag-It! and leave the window open, select the Stay on screen on send option.
   - Select the Minimize on receipt option if you want any Tag-It! messages that you receive to be displayed as minimized icons on your desktop.
   - Select the Beep on receipt option if you want Tag-It! to emit a sound when you receive a Tag-It! message. If you specify a .wav file, the specified sound file will be played. If you do not specify a .wav file, a beep will be emitted.
   - Select the Confirm exit option if you want Tag-It! to display a prompt verifying whether you want to exit Tag-It! This option is selected by default.
Note: If this option is not selected, you may unintentionally press ALT+F4 and thereby close the Tag-It! application without having a chance to read a note that you have received. Therefore, it is recommended that the Confirm on exit option be selected.

4. Choose the OK button.

Troubleshooting

If you receive Tag-It! messages as regular mail messages (instead of Tag-It! messages), refer to the following items:

☐ Ensure that the Chameleon mail application is activated (can be minimized).
☐ Ensure that Tagit.exe is present in your system.
☐ Ensure that the directory containing the Tag-It! application is in the DOS Path.
☐ If the above items do not apply, Tag-It! may not be able to start for some other reason, such as insufficient memory. When Tag-It! is not available, any Tag-It! messages received by you will be available in Mail, instead.
Chapter 23. NewtPROFS

NewtPROFS is an electronic mail application that allows your PC to communicate with an IBM mainframe, using the IBM internal mailing system. This type of e-mail is also called pMail.

NewtPROFS requires that you start a TN3270 session first, and logon using an IBM userid. With NewtPROFS, you can use your notebook or desktop PC to send (upload) mail to the IBM host, or retrieve (download) notes (mail messages) from the host mainframe to your PC.

NewtPROFS is a MDI (Multi Document Interface) application with multiple windows confined to the main window. The additional windows opened within the application can be tiled or cascaded.

Starting NewtPROFS

Before you start NewtPROFS, you need to open a communications session with TN3270. The following steps describe how to establish your communications session:

1. Open the TN3270 application and choose the Connection Profile... command from the Settings menu.

2. Create a Connection Profile by specifying information in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Specify the name of the connection profile. This name will appear in the Connection Profile List field in the Connect dialog box.</td>
</tr>
<tr>
<td>Host</td>
<td>Specify the name or IP address of the IBM host to which you want to connect.</td>
</tr>
<tr>
<td>Port</td>
<td>Specify port 23, the Telnet communications port.</td>
</tr>
<tr>
<td>Model</td>
<td>Specify model 2 (for the alternate model).</td>
</tr>
<tr>
<td>Short Name for HLLAPI</td>
<td>Specify &quot;P.&quot; The HLLAPI short name is the identifier used by NewtPROFS windows application to communicate with the IBM mainframe.</td>
</tr>
</tbody>
</table>

(To fill in the short-name box, select a letter from the drop down list. You cannot simply click the cursor in the box and type the letter.)
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Prompt</td>
<td>Optional. Should be used for automatic login. Specifies the login prompt that you would see on your screen when you log in to the specified host. The login prompt is case sensitive.</td>
</tr>
<tr>
<td>Username</td>
<td>Optional. Should be used for automatic login. The username that you use to login to the specified host. Optional. Should be used if automatic login is required.</td>
</tr>
<tr>
<td>Pwd Prompt</td>
<td>Optional. Should be used if automatic login includes password. Specifies the host password prompt that you would see on your screen. The pwd prompt is case sensitive.</td>
</tr>
<tr>
<td>Password</td>
<td>Optional component of automatic login with password. Specifies the password that you would enter after you have entered your username to log in to the specified host.</td>
</tr>
<tr>
<td>Script</td>
<td>Optional. Enter a script file name if you want to automatically invoke a script file when you connect to this host. You can also choose the Browse button to select an existing script file. If your script includes information requested for the other fields in the connection profile, you do not have to enter the information in the other fields.</td>
</tr>
</tbody>
</table>

The Connection Profile list contains the profiles that you previously defined.

3. After you have specified a description, choose Add and then OK.

4. Select Connect and test your connection profile by selecting the defined description from the Connection Profiles list. When the connection and login process are complete the Ready prompt appears.

After a TN3270 session has started do the following to start NewtPROFS:

5. Open the NewtPROFS application. The first time you open it, the pMail System Administration dialog box appears.

6. This menu allows you to specify or verify the settings for your pMail sessions. For example, you can choose the mailing system (PROFS or Office Vision) and set one or more CMS commands, to be executed before the mailing system is accessed.

**Note:** The next time that you start NewtPROFS, the System Administration dialog box will not appear unless you specifically request this option. You can
request that the pMail System Administration dialog box be displayed by adding the parameter -m to the Program Manager's command line. To do this select run from the Program Manager's File menu and enter the following:

```
C:\NETMANAG\NEWTPROFS\PMAILW.EXE -M
```

7. Then select the System Administration... item from the Options menu.

8. Verify that Command #1 indicates either a command line or a script that attaches the terminal emulation session to the PROFS application running on the host system. (Such a command or script is generally provided by the host administrator). Choose the OK button.

9. Verify that NewtPROFS is working correctly by composing a note (mail message) and sending it either to yourself (send it to the userid that you specified in TN3270 to log onto the IBM host) or to another valid userid on the same host.

### Sending/Uploading Mail

Sending pMail involves the following steps:

1. To compose a new note choose the Compose command from the Mail menu or select the Compose a new note button.

![Compose](image)

NetManage's international expansion includes newly opened sales offices in Germany, the United Kingdom and France. The large corporate site licenses purchased in the fourth quarter reflect the growing acceptance of NetManage as a leader in the Windows TCP/IP integrated application marketplace. NetManage, Inc. develops, markets and supports an integrated set of TCP/IP inter-networking application marketplace.

2. Enter information into the following fields:

   **To:** Enter an IBM userid or a list of userids separated by blanks. The list may contain any valid Office Vision/VM addresses - full addresses, nicknames or distribution lists.

   You need to specify a host name only if the mail is being sent to a user on a different host, rather than another user on your own IBM host. If you do not specify a host name when you select the Send option, the notes will be uploaded to your own IBM host, that is, the host to which you logged in via TN3270.

   **Subject:** Enter a subject - optional.

   **Cc:** Enter the Cc userid or list using the same format as the To list - optional.
Type your text at the bottom part of the window.

3. Choose the Send button in the Compose window.

An Addressee Not Validated dialog box appears if the system does not recognize one of the addressees as an existing nickname. If you wish, you can specify a nickname to represent a particular user on a particular host. (If the user is on the same host, you do not have to specify the host name.) If you do not to specify a nickname, close the nickname dialog box by selecting NO.

Note: The Send button puts the note in the Outgoing Queue. It does not actually send the note to the mainframe.

You can see which notes are waiting in the Outgoing Queue by choosing the Outgoing... command from the File menu.

4. Choose the Upload mail command from the Communications menu to actually send the notes from the Outgoing Queue to the IBM host all at once. You can make last minute changes to the note while it is still in the Outgoing Queue by selecting the Edit Note button. Alternatively, you may move a note from the Outgoing Queue back to a Draft Folder for later editing by selecting the Return Note to Draft button.

Receiving/Downloading Mail

To receive pMail do the following:

1. After starting your TN3270 session and opening NewtPROFS, choose the Download command from the Communications menu to download any notes that have been received for your userid and are waiting on the IBM host.

NewtPROFS downloads and stores notes in folders. When you start NewtPROFS, your incoming folder opens automatically by default. (If you have not already downloaded notes, the Incoming Folder will be empty.)

2. The Incoming window displays a list of received incoming notes. This may take a few minutes or longer depending on how many notes were waiting on the host.
3. Select the incoming note that you wish to view.

Clicking on a note header selects it, and its contents appear in the bottom part of the window. Double clicking on the note header opens a view window with note details and contents.

If the note has a file attached to it, it appears as an icon in the bottom part of the window. Select the icon to launch the viewing application associated with the file.

Modify the ratio between the two parts of the window by dragging the separating line with the mouse.

**Options for Received Note**

You can perform the following actions on a selected note using the appropriate buttons or Mail/File menus as follows:

- **Delete** a note. It will be erased from the local folder and a command to erase it from the mainframe will be issued next time you upload mail.

- **File** a note in a folder. Choosing the file button brings up a list of existing folders. Select a folder to store the note(s).

- **Forward, reply** or **resend** a note. When you select one of these options, you get a window similar to the window for composing a new note. In all cases, the subject line is the same as the original note (with Resend added for resent notes). In the case of reply, the To: line is also fixed with the same addresses as the original note. You can add Ccs.

- **Print** on a local PC printer - the current Windows printer. Use the printer setup from the File menu to modify the current selection. Note that you can use this option to fax a note if you have the appropriate PC fax hardware/software.

Some of the above actions will operate on multiple notes. Select more than one note by dragging the cursor over a number of headers, or by clicking on a number of notes out of sequence with the control key pressed. Then you can delete, file or print a number of notes.

You can operate a search within a selected note by clicking the search, or Repeat last Find button, or selecting the Find... or Next option from the Edit menu.

**Options for Sending Notes**

In addition to the functions described above, NewtPROFS provides options for sending notes as follows:


**Entering Note Content**

The bottom part of the window is used to enter the note content. You can enter content in any of the following ways:

- type in your text
- select the Original button to include the content of the currently selected note in a reply
- choose the Import Entry... command from the Edit menu to import a PC file
- select Cut, Copy or Paste options from the Edit menu
- search/Replace text by clicking the search, or Repeat last Find/Replace button, or selecting the Find..., Replace... or Next option from the Edit menu

**Formatting**

The auto wrap feature starts a new line whenever you reach a line length of 80 characters.

You can change the font used for the folder header and note body by selecting the Fonts item from the Options menu.

**Spell-Checking**

After you have completed composing the note, choose the Spell command from the Edit menu. Words that are not recognized by the spell-checker will be displayed in dialog box with optional suggestions for you to modify, ignore or place in a private dictionary for later use.

**Attaching a File**

You can attach a text or binary file (such as spreadsheet or word processor data) to your text note if this feature is enabled. Do this by clicking Attach and specifying the filename of the attachment, or drag and drop a file from the MS/Windows File Manager. This attachment will be delivered to any other NewtPROFS user with the text associated with it. Non NewtPROFS users receive the attachments as files in their VM reader.

**Inserting a File**

You can insert a file into the text note by place the cursor at the position you want the file inserted. Choose the Import... command from the Edit menu. The Import File menu appears, select the file you want to insert and choose OK.
Outgoing Note and/or Draft Basket

Once satisfied with the contents of your note, choose the Send button to place the note in the Outgoing folder. (Remember that the note will not actually be sent to the host until you Upload it.) Select the Edit Later button to place it in the Draft folder for later editing or sending.

Nicknames

When sending notes, NewtPROFS compares the addresses in the To and Cc lists against the nickname lists. Nicknames can be either downloaded from the host by using the Nicknames... command from the Communication menu, or a local nickname dictionary created using the Nicknames... command from the File menu. The nickname search is conducted in a similar manner to spell checking: if a name is not found in an existing list, you are prompted to either cancel sending in order to modify the name, ignore it and send anyway, or enter it into your local list.

Processing Outgoing Notes

Until the upload operation is started, outgoing notes reside in the Outgoing queue where you can view, edit, erase or return it to the Draft Folder. Open the outgoing mail queue by selecting Outgoing from the File menu.

Outgoing Queue items are divided in two groups:

- new notes and operations to existing notes
- commands to the mainframe to delete or file notes

Select the note by clicking on it, then click the appropriate button. Cancel the commands to mainframe by selecting the command and choosing the Eliminate command to host button.
Saving Notes to File

Received and created notes may be saved as a text file.

1. Select the note in the folder, then choose Export... command from the Edit menu. The Export Text dialog box appears.

2. Select a directory and enter a filename for the note.

3. Choose OK.

You can save a note as a file while it is still in the Compose dialog box by following the same procedures with the Compose dialog box active.

Refresh Mail

The Refresh mail option from the Communication menu performs both Uploading and Downloading of mail messages.

Working with Folders

A folder is a collection of notes. There are two types of folders:

- user defined folders
- system folders

User Defined Folders

You can create either local or dual folders.

- **Dual Folders**: When you create a dual folder the corresponding note logs will be created on the host the next time you upload your mail. Likewise, notes filed into folders in pMail will also be filed into the corresponding note logs on the host. Dual folders can also be downloaded from the host.

- **Local Folders**: Local folders are folders that are created on the PC only, and not on the host. Notes filed in Local folders are deleted from the host.

System Folders

pMail generates special purpose system folders:

- **Incoming notes folder**: contains the incoming notes downloaded from your PROFS/OV mail account on the host. By default, the Incoming folder will open when you begin pMail. When downloading mail, a pop-up dialog box presents the option of placing new mail in the Incoming folder or by clicking Cancel saving these messages on your PC for later incorporation into the Incoming folder. To move these messages into the Incoming folder choose the Mail... Open New Mail command.
• **Draft folder**: contains unsent notes that were previously stored for later use. The notes were stored either by using the Edit Later button that appears at the top of the create note window or by clicking the Return to Draft button in the Outgoing Queue. Double clicking a note header in the note list will open a note window with the selected note in edit mode.

• **Out Log folder**: contains all notes which were previously sent.

**Folder Windows**

The folder window displays the contents of a folder, and lets you read and process the notes contained in the folder. Folder windows are divided into:

- The upper part displays a list of all notes in the folder.
- The lower part displays the text of the selected note.

To facilitate selective mail processing, use the View menu to sort notes in the folder by date, sender or subject. Activating a filter from the same menu enables you to display notes:

- from a specific sender
- with a certain character pattern in their subject, addressee or content
- those received in a specific date range

Deactivate Filtering by selecting the Clear Filter option from the View menu.

You can select notes by single-clicking or by using the up and down arrows on the keyboard. Use the windows special <Shift>, <Ctrl> scheme for multiple selection. Selected notes appear highlighted, and you can apply to them operations such as filing, deleting and viewing.

Move, resize, maximize, and minimize Folder windows in keeping with standard Microsoft Windows operating conventions.

**Folder dialog box**

The Folders dialog box lists all user defined folders. You may use the Folders dialog to select folders to process (file, view, delete and create). Choose the Folders... command from the File menu to activate the Folder dialog box. When active, the Folder dialog box always remains on top of all other windows. The icon indicates if the folder is dual (blank icon), or local (PC icon). Execute Open, Delete, File and New through the buttons in the Folders menu.
Opening a folder

To open an existing folder choose the Open Folder... command from the File menu. An Open Folder dialog box appears. Select a folder and choose the Open button (or double click the folder name).

Creating new folders

To create new folders select the New Folder option from the File menu. The Create New Folder dialog box appears. Enter a folder name. A new folder is defined as a dual folder unless the local folder box is selected. When you create a dual folder the corresponding note logs will be created on the host the next time you upload your mail.

Deleting folders

In the Folder Dialog box choose the Delete button to permanently delete the selected folder.

Filing notes in folders

To file notes into a folder, select the notes for filing and in the Folder dialog box select the destination folder, then choose the File button. Alternatively you can drag and drop between folder windows, drag the selected notes and drop into a different folder. If the note is filed from the incoming folder, the note is moved into the new folder. When filing between all other folders the note is duplicated.

Off-line

NewtPROFS can also work off-line. After Downloading you can logoff from the host in the TN3270 session and remain working in NewtPROFS, while processing the mail. Do not close the TN3270 window. New notes and commands are saved in the Outgoing Queue. Later, log into the host again to download or upload mail. Select Upload to send the notes to the host.
Processing Calendars

This version supports local calendars only. To open the calendar choose the Open Calendar... or My Calendar command from the File menu. From within the dialog box, choose the sample calendar and choose OK. The calendar window is divided into a Calendar data box and a monthly calendar.

By default, the current month and day are displayed on the calendar.

- To change the date: Choose another date on the calendar display, or use the Day arrow keys to select the date required.
- To change the month: Use the Month arrow keys to select the month required.

The calendar data box is divided into two sections: the top section displays the appointments, the bottom section displays notes for this day. You can change the ratio between the two portions by dragging the separating line with the mouse.

Scheduling an Appointment

To schedule an appointment do the following:

1. Choose the Add button. A dialog box appears.

   - Start time: Select or type the time the appointment begins.
• End time: Select or type the time the appointment should finish.
• Description: Type the name, or description of the meeting.
• For events lasting more than one day, check the All day event box, and enter the number of days the event will last.

2. Choose OK.
The appointment should now appear in the upper part of the split window.

3. To alter appointments select the appointment to be changed by clicking on it.
   • **Modify**: Choose the Change button. In the Change appointments dialog box enter any modifications.
   • **Reschedule**: Choose the move button. In the Move appointment dialog box enter the new date for the appointment. Select the radio button to determine how many days are passed with each click of the arrow.
   • **Copy**: Choose the copy button. In the Copy appointment dialog box enter the date to copy the appointment to. Select the radio button to determine how many days are passed with each click of the arrow.
   • **Delete**: Choose the delete button.

   **Note**: To add notes click on the bottom portion of the Calendar Data window. Type notes into this space, the notes are attached to the specific date.

**NewtPROFS Configuration and Maintenance**

You can maintain and configure NewtPROFS from the Options menu. The Preferences entry allows you to tailor NewtPROFS appearance. The following parameters are available:

• **Maximize note view window**: when double clicking on a note header, the note opens in a maximized window if this parameter is set.
• **Maximize note edit window**: when composing a new note, or responding to existing note the note opens in a maximized window if this parameter is set.
• **Save desktop on exit**: Saves the position of all opened windows on the NewtPROFS desktop when exiting NewtPROFS and restores them next time it is invoked.
• **Prompt on non existent addressee**: when sending a note with this parameter set, NewtPROFS will search nickname files for all addresses and prompt you whenever it does not validate an address. You can elect to ignore, modify or store the address in the local nickname file.
• **Confirm delete and file operations**: when set, you will be asked to verify note deletions and filing.
• **Indentation string**: appears in the beginning of each line when you insert the original note while composing a reply. The default string is ">".

---

ChameleonNFS Installation and User’s Guide
• **Time format**: 12 or 24 hour format.

Choose the Font command in the Option menu to alter the Fonts. Select Folder headers or Note body for setting font type, style, size, color or special effects (strikeout) separately for the two parts of folders split window.

The Maintenance entry from the Options menu allows you to perform the following tasks:

- backup and restore mail to diskette or hard disk. Choose the mail folder to backup from a list of existing folders, including the standard Incoming, Outgoing and Draft. If the diskette contains a past backup of the selected folder, you can choose to append new mail to it or replace entirely by checking the corresponding radio button.
- clear Incoming or Outgoing. Resets the Incoming or Outgoing folders. Does not affect the host data bases, only the PC side.
- erase the script log
- erase the calendar
- convert folders to local. Local folders are kept on the PC side only, while regular folders are also maintained on the host.

**Troubleshooting**

If you experience difficulties using NewtPROFS refer to the following items:

- Verify that the installation and setup steps have been successfully completed.
- Ensure that the Connect port is correct: it should be the default (23) in almost all cases.
- Ensure that the short session name is "P" (in the Options... Communication dialog box).
- Use the Ping application to verify connectivity to any IBM mainframe to which you want access, if a failure to connect is reported.
- Verify that TN3270 was invoked and the Ready prompt displayed before invoking NewtPROFS.
- Verify that executing CMS Command #1 (in the Options... System administration dialog box) will invoke Profs in line mode.
- If the communication upload/download does not appear to operate, check the command information in the TN3270 window.
Chapter 24. NEWTCal

The NEWTCal application lets you schedule appointments in an online calendar. When you schedule an appointment, NEWTCal notifies people about the proposed meeting. You can then use NEWTCal to track responses to your appointment requests. You can also view your online calendar in a daily, weekly, monthly, or yearly format.

This chapter discusses logging in to NEWTCal, scheduling appointments, responding to appointment requests, viewing your appointment calendar, and configuring NEWTCal.

Login

When you open the NEWTCal application, the NetManage NEWTCal Login dialog box appears unless you have already logged into Mail (or one of the related Mail applications, Tag-It! or Phone-Tag).

1. To log in to NEWTCal, type your username and password in the appropriate fields. (This is the same username and password that you use for Mail.)

![NEWTCal Login dialog box]

After the login has been completed, NEWTCal displays your online appointment calendar. The following figure is an example of a calendar in the monthly format, but you can also display a calendar in a daily, weekly, or yearly format. For details, see “Viewing Your Appointment Calendar,” later in this chapter.

![NEWTCal monthly calendar]
NEWTCal lets you schedule new appointments and modify or delete existing appointments. For details on these procedures, see the section on "Scheduling Appointments."

**Viewing Your Appointment Calendar**

You can view your online appointment calendar in a daily, weekly, monthly, or yearly format. To do so, select the appropriate option (Daily View, Weekly View, Monthly View, or Yearly View) from the View menu.

**Setting NEWTCal Preferences**

NEWTCal lets you set the number of hours your daily calendar includes. It also gives you the option of printing your calendar with or without appointment information. Refer to NEWTCal online help for detailed information about setting preferences.

**Scheduling Appointments**

*Note:* Set up Mail before scheduling appointments because NEWTCal uses Mail to notify people of proposed meetings. Your mail application must be running (it can be minimized) in order for you to send and receive notifications of appointments.

**Scheduling New Appointments**

To schedule new appointments, take the following steps:

1. Perform one of the following operations to open the Appointment Settings dialog box:
   - If your calendar is in a weekly, monthly, or yearly format, double-click the day you want to schedule the appointment.
   - If your calendar is in a daily format, double-click the hour you want to schedule the appointment.

2. Enter the appointment’s description, date, time, length and location in the appropriate fields.

   In the Date, Time, and Duration fields, you can enter information by either typing it or choosing the up or down buttons.
3. If desired, type additional information about the appointment in the Notes field.

4. Either type addresses in the Who field or choose the Attendees... button to open the Address Book.

![Address Book screenshot]

a) From the Address Book list, select an e-mail address, and then choose the To button.

b) Continue selecting addresses in the Attendee list box and choosing the To button until the Attendee List box includes all the desired addresses.

**Note:** The Address Book is a shared feature of Mail, NEWTCal, Phone-Tag, and Tag-It! It is accessible from all these applications. To add an e-mail address to the Address Book, use the Mail application's Services Menu, or choose the Ecco Setup option within the Address Book dialog.

5. Notify people of a proposed appointment by choosing the Send Request button from the Appointment Setting dialog box.

The Mail application notifies attendees about the appointment as discussed in “Responding to Appointment Requests” later in this chapter. If you want to view the responses to your appointment request, choose the Show Status button. A Status dialog box appears.

![Status dialog box screenshot]

6. When you finish scheduling appointments, close the Appointment Settings dialog box by choosing the OK button.
Modifying Existing Appointments

To modify existing appointments, take the following steps:

1. In your online appointment calendar, double-click the appointment you want to modify. Or click once on the appointment in the calendar display and choose the Edit Menu/Edit Appointment option. The Appointment Settings dialog box, containing information for the selected appointment appears.

2. Modify the fields of the Appointment Settings dialog box as necessary. (See also "Rescheduling Tips.") Then choose the OK button.

NEWTCal automatically notifies the attendees of the changes you have made to the appointment time and date.

Rescheduling Tips

When modifying appointments, you can quickly reschedule them by moving them (using drag/drop) from one location to another in your online calendar:

- To reschedule appointments to another day, select the appointment you want to reschedule (to/from another day on the display or to/from the busybar) and move it to the new day.
- To increase the time of an appointment, stretch the block on the busy-bar.
- To reschedule appointments to another time on the same day, display your online calendar in the daily format as discussed in “Viewing Your Appointment Calendar.” Then select the time of the appointment you want to reschedule and move it to the new time.

Deleting Existing Appointments

To delete existing appointments, take the following steps:

1. In your online appointment calendar, double-click the appointment you want to delete. The Appointment Settings dialog box, containing information for the selected appointment appears.

2. Choose the Delete button. Or click once on the appointment in the calendar display and choose the Edit Menu/Delete Current option.

NEWTCal automatically notifies the attendees that you have deleted the appointment information.

Responding to Appointment Requests

If another NEWTCal user sends you an appointment request, a dialog box similar to the following figure is displayed on your computer terminal.
The Meeting Request dialog box contains all the relevant information pertaining to the meeting.

To respond to an appointment request, do the following:

1. Enter optional comments in the Comment box. These comments will be delivered with your response.

2. Choose one of the following response buttons:
   - **Accept**: NEWTCal will automatically add the appointment to the appropriate date and time in your calendar, and Mail will send a notification of your acceptance to the user who sent the Meeting Request.
   - **Decline**: Mail will send a notification of your decline to the user who sent the Meeting Request.
   - **Defer**: NEWTCal will hold the Meeting Request in its buffer, so that you can make a decision later. To display the Meeting Requests that you have deferred, use the Get Pending Requests option from the View Menu.
   - **Discard**: The Meeting Request will be discarded.

**Troubleshooting**

If you experience difficulties using the NEWTCal application, refer to the following items:

- Set up the user name and password through the Mail Postmaster, if you have not already done so.
- Make sure that Mail is running.
- Check the Outbox if your Meeting Requests are not being sent. Sometimes there is a temporary Mail overload, and the Meeting Requests might be held in the Outbox. Resend them from there.
Chapter 25. InPerson

The InPerson desktop conferencing software lets you have online working sessions with people at other locations.

During a working session, each conference member can sketch drawings, type notes, paste captured images, and import text and image files into the InPerson window.

The information included in an InPerson window can be viewed and modified by all members. For example, suppose you want your co-workers to review your design for a new gadget. You can take a screen shot of your design and then paste it into your InPerson window where everyone can examine it and make comments or changes to it.

InPerson can also provide audio and video support so that members can talk to and view one another during a conference.

This chapter

• discusses video and audio support requirements
• tells you how to start InPerson
• provides an overview of using InPerson

Video Support Requirements

InPerson's video feature requires the following:

• video capture card that can support real-time capture in preview mode (as opposed to overlay)
• a video camera compatible with your video capture card
• Video for Windows 1.1 software

Audio Support Requirements

InPerson's audio feature requires a 16-bit Sound Blaster or compatible card.

Starting InPerson

Start InPerson by choosing the InPerson icon. An InPerson window appears.
The left side of the InPerson window includes a member window. The member window contains an image for each conference member. The name of a member is displayed below that person's image.

The other major region of the window is the whiteboard. This is the area in which you insert text and objects. The whiteboard consists of one or more pages. Each page is marked by a numbered tab. If there are multiple pages, the tab of the current page is white and the tabs of the other pages are gray. To turn to a page, select its tab. You can change the layout of the whiteboard by using the Preferences... command as discussed in the online help.

The InPerson window also includes a menu bar, toolbar, and control bar. Like the toolbar in other applications, the InPerson toolbar includes smart buttons for many InPerson commands. The control bar includes three buttons. If you want to disable the recording and playing of sound, choose the first button. If you do not want to display your video image on your computer, choose the second button. If you do not want to transmit your video image to other users, choose the third button.

**Inviting Conference Members**

InPerson lets you conduct online working sessions (conferences). To invite people to a conference, do the following:

1. Choose the Invite... command from the Conference menu. The Invite window appears.
2. Specify who you want to invite by adding names to the Conference Members list box. To add names, do the following:

- If the Phone Book list box includes the person or group you want to invite, select the appropriate name or group from the Phone Book list box. Then choose the >> button.
  
  You can store the names and addresses of frequently invited members in the InPerson phone book. For information about how make entries in the phone book, see the Defining the Phone Book section.

- If the person you want to invite is not listed in the Phone Book, type that person's InPerson address in the Address text box and the person's actual name in the Real Name text box. Then choose the >> button.

  When typing InPerson addresses, it is recommended you use the format user@host or user@IPaddress. For example, to specify user Jillian on host rainbow, type jillian@rainbow or jillian@156.27.50.200.

3. If you want to provide members with a brief description of the conference, type one in the Subject field.

4. Choose the Call button.

  **Note:** Users can receive an invitation only if they are currently running InPerson. Therefore, any users planning to frequently participate in InPerson sessions should add InPerson to their Windows Startup group.

In most cases, the InPerson conference will continue until all members disconnect from the session. However, the conference will end for all members if the person who established the conference disconnects from InPerson.

**Defining the InPerson Phone Book**

If you frequently invite a person or a group of people to a conference, you may want to define phone book entries. You will then be able to invite people by selecting the appropriate name or group from the Phone Book list box.

When defining phone book entries, you can

- add members to the phone book
- create phone book groups
- change phone book entries
- delete phone book entries

Separate discussions on each task follow.
**Adding New Members to the Phone Book**

To add a person to the phone book, do the following:

1. Choose the Invite... command from the Conference menu.
2. In the Invite dialog box that appears, choose the New Member... button.
   The New Member dialog box appears.
3. If the person you want to invite is not listed in the Phone Book, type that person's InPerson address in the Address text box and the person's actual name in the Real Name text box.
   When typing InPerson addresses, it is recommended you use the format user@host or user@IPaddress.
4. Choose the OK button.
   InPerson adds the person to the Invite dialog box's Phone Book list box.
5. To close the Invite dialog box, choose the Close button.

**Creating a Phone Book Group**

If you frequently invite the same group of people to conferences, you may want to create a group for those users. A phone book group consists of two or more members previously added to the InPerson phone book. You can send an invitation to all members of the group by simply selecting the group name rather than having to select each individual's name.

To create a phone book group, do the following:

1. Choose the Invite... command from the Conference menu.
2. If you have not already done so, add a phone book entry for each person you want to include in the group. For details, see the Adding New Members to the Phone Book section.
3. In the Invite dialog box that appears, choose the New Group... button.
   The New Group dialog box appears.
4. In the Members list box, select the names of each person you want to include in the group.
5. In the Name text box, type a group name.
6. Choose the OK button.
   InPerson adds the group to the Invite dialog box's Phone Book list box.
7. To close the Invite dialog box, choose the Close button

**Changing Phone Book Entries**

To change phone book entries, do the following:

1. Choose the Invite... command from the Conference menu. The Invite dialog box appears.
2. Select the name or group you want to change from the Phone Book list box.
3. Choose the Change button.
   
   If you selected an individual's name, the Change Member dialog box appears.
   
   If you selected a group, the Change Group dialog box appears.
4. Do one of the following:
   
   • If you are modifying an individual's entry, edit the text boxes of the Change Member dialog box as necessary.
   
   • If you are modifying a group's entry, select each name you want to include in the group. Unselected names will not be included in the group.
     
     You can make multiple selections using the Ctrl and Shift keys as discussed in your Windows documentation.
5. Choose the OK button.
6. To close the Invite dialog box, choose the Close button

**Deleting Phone Book Entries**

To delete a phone book entry, do the following:

1. Choose the Invite... command from the Conference menu. The Invite dialog box appears.
2. Select the name or group you want to delete from the Phone Book list box.
3. Choose the Delete button.
4. When InPerson prompts you to confirm you want to delete the selected entry; choose the Yes button.
5. To close the Invite dialog box, choose the Close button
**Drawing on the Whiteboard**

The whiteboard is designed so you can easily draw simple shapes. InPerson provides five drawing tools – a tool for drawing freehand and tools for drawing arrows, lines, circles, and boxes. You draw on the whiteboard by selecting one of the drawing tools and a pen color and width.

To select a drawing tool, choose the appropriate button from the toolbar or choose the Pen, Arrow, Circle, Line, or Rectangle command from the Object menu. When you select a drawing tool, the cursor changes to reflect the selected tool. For example, the cursor changes to a circle when the circle tool is selected.

If you choose Pen (the default), you can draw freehand. If you select one of the other drawing tools, you draw the selected shape by dragging the mouse until the arrow, circle, line, or box is the desired size.

You can select an object’s color using the Pen Color command. You can also select the width of an object’s lines by using the Pen Width command. For details on these commands, see the InPerson online Help.

You can find out who created an object on the whiteboard. To do so, move the cursor to the object you want to examine. The name of the person who placed the object on the page is highlighted in the member window.

InPerson automatically assigns a different cursor symbol to each conference member. This helps you identify who is currently working on the whiteboard. When a person works on the whiteboard, the cursor on your computer will look like that person's cursor symbol.

**Adding Text to the Whiteboard**

You can add text to a whiteboard page at any time. To do so, choose the text button from the toolbar and then begin typing in the whiteboard.

When adding text to the whiteboard, you can perform the following operations:

- Start a new line of text by pressing the Enter key.
- Delete characters by pressing the Backspace key.
- Paste text copied from another application by choosing Paste from the Edit menu. When you paste text from another application, tab settings and font characteristics are lost.
Importing Files

You can import the following types of files into an InPerson document:

- ASCII text files
  To import a text file, use the Text File... command as discussed in the online Help.
- image files
  InPerson supports the BMP format and the Silicon Graphics RGB format. To import an image file, use the Image File... command as discussed in the online Help.

Manipulating the Whiteboard’s Objects

When working on the whiteboard, you may need to perform one or more of the following operations on any whiteboard object (text or graphic). Separate discussions on each task follow.

- selecting objects
- moving objects

Selecting Objects

The whiteboard is designed so that you can easily sketch drawings and type notes. By default, whenever you press the left mouse button and drag, you create a drawing object. If you want to move, delete, or change the appearance of an object, you need to select it.

To select objects, do one of the following:

- To select specific objects, choose the Select button from the toolbar and then select your first object. You can continue selecting additional objects by holding down the Shift key while making your selections.
- To select all the objects on the current page, choose the Select All command from the Edit menu.
- To select only the objects you have placed on the current page, choose the Select Mine command from the Edit menu.

Moving Objects

To move an object, select the object and then continue holding down the mouse button while you drag the object to the desired location.
Troubleshooting

The following list includes troubleshooting information for InPerson:

- If you experience difficulties using InPerson, verify that the installation and setup steps have been successfully completed. For details, see the installation and setup sections of this guide.

- If discussions sound choppy, adjust the sound synchronization by setting the Playback level and Playback delay (sec) options. You set these options through the Preferences... command as discussed in the InPerson online Help.

- If no sound or video is being transmitted, check the settings of your audio and video options. You set these options through the Preferences... command as discussed in the InPerson online Help.

- If you cannot establish a connection to conference members, ensure that all the invited conference members are in the correct format (user@host or user@IPaddress) and make sure that all invited members are currently running InPerson.
Chapter 26. NEWTScan

The NEWTScan application lets you scan images for printing and/or sending through e-mail.

Note: NEWTScan is compatible with Twain drivers and has been certified to use with the HP DeskScan II-CX scanner. Before using NEWTScan, install and set up your scanner according to your scanner manufacturer's documentation.

Scanning a Document

To scan a document the first time you are using NEWTScan, do the following:

1. Place the document you want to scan in the scanner and open the NEWTScan application.

2. Choose the Preferences... command from the Settings menu. The Preferences dialog box appears.

3. Under Configure Start Button, select the Scan and Mail option.

4. Under Scan Setup, choose the file format so that all scanned documents are automatically saved with a specific file extension. (DCX extension is the default.)

5. Select the scan mode so that your scanned document appears as black and white letter size (default). Or, if you want to customize your scanned document, you can use your scanner's user interface instead.

Note: Refer to the documentation provided by your scanner's manufacturer for detailed information about using the Scan Mode user interface.
6. Select the resolution of the scanned document in dots per inch (DPI) and adjust the brightness of the image. Choose the OK button to save and close preferences.

7. Select the Scan option from the File menu or choose the Scan button. A dialog box appears asking you to select a scanner. Generally only the scanner connected to your PC is displayed.

   **Note:** The dialog box asking you to select a scanner only appears the first time you use NEWTScan.

8. Choose the Select button. NEWTScan begins to scan your document and a thumbnail of the document appears in the NEWTScan main window.

At this point you can mail the image, save it as a file, or print it.

**Saving a Scanned Document**

You can save a scanned document to a file by choosing the Save As... command from the File menu or the Save button after you have scanned a document.

A dialog box appears where you can indicate the drive, directory, file type and filename of the scanned document.
Printing a Scanned Document

You can print a scanned document to your default printer, however you need to first set up your printing options. Note that the Print option is only enabled for black and white images.

1. Before printing the scanned document, select the Print... command from the File menu. The Print Document dialog box appears.

![Print Document Dialog Box](image)

2. Select either the All option to print the entire scanned document, or select a range of pages. Best Fit resizes the image to best fit the page. Stretch to Page stretches the image to fit the page. X Axis and Y Axis determine the width and height ratio of the scanned document.

3. Choose the Print button.

**Note:** You can always choose the Print... command from the File menu to print a scanned document if do not want to change your Print Setup options.

Mailing a Scanned Document

You can mail a scanned document directly through e-mail. To do this:

1. Scan the document you want to send through e-mail, or select an existing scanned document.

2. Choose the Send Mail... command from the Mail menu or choose the Mail button. The Send Message dialog appears.

![Send Message Dialog Box](image)
3. Enter the user e-mail address to whom you are sending the image. If you want to access your Mail Address Book, select the Address... button.

4. If desired, you can select the Confirm Read and Confirm Delivery options. Select Confirm Read if you want the system to return an acknowledgment that the addressee opened the message. Select Confirm Delivery if you want the system to return an acknowledgment that the message reached the addressee's mail server. Acknowledgments are returned directly to your Mail Inbox folder.

5. Enter the message subject in the Subject field and the message body below.

6. Choose the Send button to mail the your message and current scanned document.

Your scanned document will be received as a mail attachment by the addressee.

Troubleshooting

If you experience difficulties using the NEWTScan application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Make sure you are using a scanner that is Twain compatible.
- Make sure your scanner is properly installed and set up according to the documentation of your scanner's manufacturer.
WebSurfer is a client application that allows you to browse multimedia information on the World Wide Web (WWW). WebSurfer displays hypertext documents and supports multimedia such as sound, video, and interactive graphics.

About the World Wide Web

The WWW is a set of servers on the Internet that are interconnected through hypertext. Hypertext is a method of presenting information where you can expand selected items at any time to provide information about the item. These selected items are links which allow you to move from document to document and server to server.

WebSurfer Features

• Displays formatted documents (electronic text in a variety of fonts, bold and italic, bulleted lists, extended characters sets)
• Browses hypertext-linked documents
• Provides and supports links to FTP, Gopher, and Telnet
• Displays hypermedia documents including interactive graphics, sounds, and movies
• Lets you create Hotlist folders for organizing documents
• Lets you instantly access other tools without closing WebSurfer
• Provides NEWTNews OLE support
• Provides context-sensitive menus using the right mouse button
• Supports caching of information downloaded to your local drive from the Web
• Tracks the links of your search through the Web, and allows quick backtracking
• Supports external viewers, such as WEBSpider, NEWTView and NEWTSound, so you can view text, image, video files, and listen to sound files

What is Hypertext?

The Web attempts to organize all the information on the Internet, plus whatever local information you want as a set of hypertext documents that use the Hypertext Markup Language (HTML) document format.

Hypertext is a method of presenting information where selected words in the text can be expanded at any time to provide other information about the word. These words are links to other documents, which may be text, files, graphics, or anything.
HTML enables text formatting, embedded pictures, and hypertext links (anchors) to other documents and different locations within documents. An HTML anchor is a reference to another document or object, or to a place within a document. These references are made through a standard Universal Resource Locator (URL), which is a text string consisting of the resource type, the Internet address of the machine, and the location of the item on that machine.

**About Uniform Resource Locators (URLs)**

Uniform Resource Locators (URLs) let you identify where a resource resides anywhere on the Internet by pointing at other Web documents on HTTP servers. If you know the document’s URL, you can point your browser there, though generally you will be navigating via other Web documents and will not need to know the URLs. URLs provide information about resource type, location, and path.

Resource types indicate the type of server on which the document resides. WebSurfer supports the following resource types:

- `http://` is the HTTP Server
- `ftp://` is the FTP Server
- `file://` is the local HTML file
- `telnet://` is the Telnet Server
- `gopher://` is the Gopher Server

**Note:** For more information about using resource types other than HTTP, refer to the section in this chapter titled Accessing Resources on Gopher, FTP, and Telnet.

For example the NetManage home page document title is NetManage Home Page and its URL is:

```
```

where:

- `http` is the resource type (HTTP Server)
- `//www.netmanage.com:80` is the resource location
- `/netmanage/index.html` is the pathname and filename

**Using WebSurfer**

When you start WebSurfer, the default document window containing the NetManage logo will normally appear. However, in some case this might not happen as Automatic Internet can download pointers to a new default. To display the NetManage home page, single-click on the NetManage logo. The interface consists of the document window and the menus and controls surrounding the document.
The Title bar at the top of the window displays the document title. The Menu bar displays all the menu names, with each menu containing drop down lists of commands. The Toolbar contains buttons that serve as shortcuts for WebSurfer menu items.

Below the Toolbar is the Dialog bar which displays the URL address of the current document. As you move the mouse around the document, the Status bar displays the URLs for any anchors or links over which the mouse passes.

A document can contain text and pictures, some of which are hypertext links to other multimedia documents or objects. The links are highlighted in blue (default). You can change the document format, that is, how it appears on your screen by using the Style Schemes command from the Settings menu.

To gather information about the document you are currently viewing, choose the Properties command from the Retrieve menu. The Properties dialog box displays information such as: title, URL, file type, and the local file where the document is located.

You can browse through the document and single-click using the left mouse button on the highlighted text to link to another document. WebSurfer downloads and displays the new document, including any graphics that may be a part of it. To return to the previous page, choose the Back command from the Retrieve menu or the Back toolbar icon. To return the home page, choose the Home command from the Retrieve menu or the Home toolbar icon.

**Opening Documents in WebSurfer**

There are two methods of opening documents in WebSurfer: opening a document through its URL pathname, and opening an existing local .HTM file from the local file system.

**Opening Documents using URL Pathnames**

While navigating through a Web document, you can open another document by:
• single-clicking the left mouse button on the highlighted text to link to it
• enter a document’s URL pathname by choosing the Go To URL command under the Retrieve menu
• enter a document’s URL pathname in the Dialog bar

All three methods will retrieve the chosen document from the network or local cache (local drive) and display it for you.

Opening Existing Local HTML Files

You can open existing local .HTM files from your local file system. This is useful if you want to edit your own .HTM files. You can open either an unformatted or formatted version of the file.

To open an unformatted version of a local .HTM file, choose the Source command and then Text Editor from the Edit menu. You can also choose the Properties command from the Retrieve menu and choose either the Edit HTML command or the View/Play button in the Properties command dialog box to edit the document.

Both commands display the .HTM file in the default text view if the file is a text file. It displays the file with the default image viewer if it is an image file, and plays the file with the default player if it is a sound or movie file.

After you have edited and saved the file, you can view its changes immediately by choosing the Reload From Disk command from the Retrieve menu.

To open a formatted version of a local .HTM file, choose the Source command and then HTML Editor from the Edit menu. The formatted file is displayed in the HTML editor you have designated. WebSpider is the default HTML editor.

Caching Documents

A major feature that WebSurfer provides is the ability to cache documents or files. Caching keeps a copy of documents that you have opened, in your local cache (local drive). When you re-visit a document, that is, reopen a previously opened document, you do not have to wait while the information downloads all over again from the network.

Default Caching Behavior

Initially when you retrieve a document from the Web, it is retrieved directly from the network and automatically placed in your local cache for the current session. If you want to reuse a document you have already retrieved during the current session, WebSurfer will retrieve it for you automatically from your local cache.

However, when you close the current session, all documents in your local cache will not be saved. If you want to re-visit a document you opened during a previous session, then
the document is automatically retrieved from the network and once again placed in your local cache.

Default caching behavior for documents is established under the Preferences command (global behavior of all documents) and the Properties command (individual behavior of a specific document). Note that the settings for the caching behavior of a document in the Properties command overrides those set in the Preferences command.

**Overriding Default Caching Behavior**

There are several ways you can override the default caching behavior of documents:

- Choose the Reload From Network command from the Retrieve menu to automatically refresh a document retrieved from your local cache with its latest version from the network.
- To retrieve documents directly from the network and not your local cache, regardless of how many times you re-visit the same document in the current session, deselect the Reuse Retrieved Documents Within Session checkbox located in both the Properties and Preferences dialog boxes.
- To save documents to your local drive between sessions, choose the Save Cached Documents Between Sessions command, located on both the Properties and Preferences dialog boxes. Use this command to retrieve the same document from your local drive between sessions.

**Viewing Files in WebSurfer**

WebSurfer supports external viewers so you can edit text, view image, and movie files, and listen to sound files. Use the File Manager file association system to determine the appropriate viewer program for viewing different kinds of files. For example, associate files with the .TXT extension with a viewer such as notepad or write. To view .GIF images, you must have a GIF image viewer and associate it to the .GIF extension.

**Advanced Navigation**

Once you know how to move around a document and find interesting items, you may discover that you want to access the same items over and over. The Hotlist and History features allow you to quickly access documents you have already seen.
Using the Hotlist

The Hotlist contains items (documents) that you find particularly interesting and want to access regularly without having to search for them within the Web. You can display the Hotlist by choosing the Show Window command from the Hotlist menu, selecting the Hotlist toolbar icon, or by positioning the mouse cursor on the left hand border of the WebSurfer window and dragging the border to the right. The Hotlist appears in the left pane of the WebSurfer window, while the selected document is displayed in the right pane.

The Hotlist feature lets you add items, create folders for organizing items, display folder properties, import Mosaic or Netscape hotlist information, and merge existing hotlist items into your current hotlist.

You can add items to your Hotlist by choosing the Add Item command from the Hotlist menu. Or, by placing the cursor on the highlighted link or image, clicking the right mouse button and dragging it to a folder in your Hotlist.

History of Documents

WebSurfer keeps a history of documents you have viewed within the current session thus allowing you to easily access previous selections.

To view a history of documents, choose the History... command from the Retrieve menu to display the WebSurfer-History dialog box. You will see a list of every document you have looked at in the current session. The document you are currently looking at will be highlighted. To display a document, double-click on the item, or choose the item and choose the Go To button.
Using Short Cut Menus

Instead of using the standard menus to find the command you need, click the right mouse button on an image or empty space in the current document to display short cut menus. The short cut menus contain several commands that let you edit or modify images, or add the document to your Hotlist.

Short Cut Menu for Document Images

To display the short cut menu for an image:

1. Place the cursor on the image you want to edit or modify.

2. Click the right mouse button. A short cut menu with the following commands appear.

   • Save Image As lets you save the selected image to a file.
   • Edit Image lets you save the image to your default image viewer.
   • Refresh Image reloads the most current version of the image from the network.

Short Cut Menu for Document Text

To display the short cut menu for a document (not including images):

1. Place the cursor anywhere in the document, except on an image.

2. Click the right mouse button. A short cut menu with the following commands appears:

   • Open lets you open the desired .HTM file
   • Save As lets you save the current document to a file.
   • Save Background As lets you save the current document's background image.
   • Reload lets you reload the most current version of the document from the network.
   • Text Editor displays the unformatted version of the document in your local text editor (default is notepad).
• HTML Editor displays the formatted version of the document in your local HTML editor (default is WebSpider).

Setting WebSurfer Preferences

You can set preferences in WebSurfer to indicate the startup document, network software, document viewers, proxy server, global document retrieval behavior of all documents, and Hotlist options. Choose the Preferences command from the Settings menu to display the WebSurfer - Preferences dialog box. Preferences are grouped within five tabs: General, Network, Viewers, Proxies, Cache, and Hotlist. Refer to WebSurfer online help for detailed information about Preferences.

Modifying Document Styles

You can change the style format of documents that you view or want to print using the Style Schemes command under the Settings menu.

The Style Schemes command has many types formatting commands that you can use to customize the current document. It allows you to set font types and styles, point size, foreground/background colors, document color, and margins.

To set the style scheme for a URL file:

1. Display the URL file whose style scheme you want to set.

2. Choose the Style Scheme... command from the Settings menu. The Style Schemes dialog box appears. You can set the following commands:

   • **Style Schemes**: Identifies a scheme that has attributes assigned to it. After creating a scheme you name it by choosing the Save Scheme button. Or, remove a scheme by choosing the Remove Scheme button.

   • **Preview**: Lists document elements whose attributes you want to change (You can also scroll for scheme elements by name in the Scheme Elements field).
To set element and document attributes, access either the Elements Attributes or Document Attributes tab dialog boxes.

**Elements Attributes Tab Dialog Box**

The Element Attributes tab dialog box lets you set the scheme elements, indent, font, font style, size, foreground and background colors, and effects of the documents you are viewing or printing.

- **Scheme Elements**: Element whose style/attributes you want to change.
- **Indent**: Determines, in inches, how far the selected element is indented within the document.
- **Font**: Font type of the selected element.
- **Font Style**: Font style of the selected element.
- **Size**: Point size of text of the selected element.
- **Foreground color**: Color of the text of the selected element.
- **Background color**: Background color or highlight of the text.
- **Effects**: Strikeout/Underline: Selected element will have a line through it or under it.
Document Attributes Tab Dialog Box

The Document Attributes tab dialog box lets you set the document color, margins, and printing settings of the documents you are viewing or printing.

- **Document Color**: Color of the document background.
- **Margins**: Left and right margins of the document during display.
- **Printing**: Left, right, top, and bottom margins of document for printing.

Printing Documents

You can print the local HTML document by choosing the Print command from the File menu. To see how the current HTML document will look when you print it, choose the Print Preview command, also located on the File menu.

Launching NEWTNews and Other Applications

You can now launch other Chameleon applications directly through the WebSurfer Tools menu instead of the program group. NEWTNews is activated and appears within the WebSurfer application, while other activated applications appear in separate windows.

Activating NEWTNews

Because the NEWTNews application is now designed as an OLE (object linking and embedding) server, you can now activate and view the NEWTNews application within the WebSurfer application. Use NEWTNews as you normally would and return to WebSurfer at anytime. To do this:

Choose the Customize command and then the News option from the Tools menu. Or, choose the Customize command to display the WebSurfer -Customize Tools dialog box, and then select the news option and choose the OK button.
NEWTNews is automatically activated within the WebSurfer application window. You can display or hide the Hotlist. Return to WebSurfer at any time by choosing the Return to WebSurfer command from the Connections menu or choose the Escape button.

**Activating Other Tools**

You can also activate other applications directly through the WebSurfer Tools menu without having to use the Program group. All applications other than NEWTNews will appear in separate windows. Use the Customize command from the Tools menu and select the application you want to activate. The selected application automatically opens in another window while WebSurfer is still open.

**Importing NCSA MOSAIC.INI and Netscape File Information**

If you have already used NCSA Mosaic or Netscape, you may have created your own menus and hotlists. You can easily import your user created information from an NCSA Mosaic or Netscape file intact into WebSurfer. Information includes user created menu items and hotlist items.

To import the user created menu items and hotlist items from an MOSAIC.INI or Netscape file into WebSurfer:

1. Choose the Import MOSAIC.INI file or Import Netscape command from the Hotlist menu.

2. Select the desired drive, and directory and enter the name of MOSAIC.INI or Netscape file or files whose contents you want to import.

3. Choose the OK button.

**Accessing Resources on Gopher, FTP, and Telnet**

Although you may be accessing resources mainly located on HTTP servers, you may also want to access resources on the Internet that reside on Gopher, FTP, and Telnet servers.
If you access a resource (double-clicking on the link or entering its URL) that is located on Gopher or FTP, you will be dropped into the NetManage Gopher or FTP server application.

Selecting a resource that is located on Telnet temporarily drops you out of the Web and starts a Telnet session. When you end the Telnet session, you will return to the Web. Several sample URLs are shown below:

ftp://anonymous:@ftp.netmanage.com.21
gopher://gopher.netmanage.com.70
file://localhost/c://

Troubleshooting

If you experience difficulties using the WebSurfer application, refer to the following item:

☐ Make sure that the installation and setup verification steps have been successfully completed.

☐ If you get a message, "Failed to launch viewer for file *.bmp, *.gif etc., check file associations; check for viewer;" do the following:

a) Go to file Manager.

b) Choose Associate command in File Menu.

c) For the file type bmp, gif, etc., choose the viewers using the Browse button.

You can also add, modify or delete viewers automatically. Choose the Settings menu, and then Preferences and Viewers tab.

☐ NEWTSound and NEWTView are NetManage sound and viewer applications provided for your convenience. However, if you get a message, "Failed to launch viewer for file *.bmp, *.gif etc., check file associations; check for viewer;" do the following:

Other example viewers are: PAINTBRUSH.EXE, WINGIF.EXE, and so on.

☐ When you get messages "Unable to resolve the hostname" Check for the following:

• Can you ping the hostname?

• If you have upgraded to the current version, Make sure that you are not using the old configuration file and that the corresponding entry for this application is removed from the TCPIP section of the WIN.INI file

• Check whether the correct configuration file is opened in Custom, and all the settings are correct.

☐ If you are not retrieving any images in the documents, see whether the Defer Image Display command in Preferences is enabled. Disabling it will help you to retrieve the images automatically.
If you have problems in retrieving the updated documents for example, Stock Quote information and reading newspaper articles, make sure that the Reuse documents retrieved documents within session is disabled. If it is enabled, then the cached documents are displayed instead of the new updated documents from the network.
The Personal Web Server application allows you to publish information on the World Wide Web so that other users can access it using a Web client such as WebSurfer. Information you can publish includes HTML (Hypertext Markup Language) and other documents, images, sound file, and movies. The World Wide Web, which is based on a protocol known as HTTP (Hypertext Transport Protocol), is one of the most flexible tools for navigating the Internet.

What is a Web?

A Web is a collection of HTML documents and other files you want to serve to Web clients. This collection of documents and files reside in your Windows file system and the starting point of this collection is called the Web Root Directory.

You can have subdirectories under the Web Root Directory and you can place the file that you want to serve in both the Web Root Directory and subdirectories. Only the Web Root Directory and its subdirectories are visible to Web clients.

NetManage provides a sample Web to help you set up your own Web server. These sample files are located in the Web Root Directory. Open the Personal Web Server icon and choose the Configure... command from the Settings menu to view this directory.

Requesting a File from the Web Client

Typically, users request a file when they specify a URL to a Web client, for example:

http:\\machine@company.com\homepage.htm.

In this case, the Web Server will serve the file, HOMEPAGE.HTM to the Web client if the file exists. However, if the user specifies only a directory (with no file), then the Web Server handles this situation in one of two ways:

- it serves a default HTML file
- it generates directory listings

Default HTML File

The Web Server can serve an HTML file by default if you have configured it to do so. The sample Web Server is configured to serve a file called INDEX.HTM if this file exists in the directory requested by the user. You can change the name INDEX.HTM to another name by changing the filename in the Default HTM File field in the Personal Web Server Configuration dialog box. To use this feature, create the default files in each directory where you want this capability.
Note: The name of these default files must be exactly what you specify in the Default HTML File field in the Configuration dialog box. If you do not change this field, then your default files must be named INDEX.HTM.

Directory Listings

The Personal Web Server first checks to see if the default file that is being requested exists. If it does not exist, the Web Server will try to generate a directory listing for the user. The user can browse this listing and request further file fetches by clicking on the file names in the listing.

Setting Up Your Own Web

Look through the files that make up the sample Web can help you understand how to set up your own Web documents and files. Once you have created your Web files, you are ready to reconfigure the Web Server to make it serve files from your Web rather than the sample Web. To do this follow the instructions in the next section that describes how to configure your own Web server.

Configuring the Personal Web Server for the First Time

To start and configure the Personal Web Server, do the following:

1. Open the Personal Web Server icon.

2. Choose the Configure... command from the Settings menu. The Personal Web Server Configuration dialog box appears.

3. Enter the communications port number in the Port field. The default port number is 80.

   The Default HTML File field contains the NetManage supplied default file DEFAULT.HTM, which resides in the default directory specified in the Web Root Directory field. This file contains a sample server homepage that you can change at any time. If you rename this default file then you must also change its name in the this field.
When a user is trying to access your Web Server (using a Web client), and specifies
a directory but does not request a specific file, than the NetManage default file
DEFAULT.HTM (sample server homepage) is displayed. If the .HTM file exists in
the requested directory it is displayed. If it does not exist or is not in the requested
directory, then an error message occurs.

4. You can create your own homepage or customize the sample homepage, if desired.
However, if you rename the DEFAULT.HTM file or place it in another directory,
then change the default HTML filename and the document root directory to reflect
your changes.

5. Enter the root directory where the Web resides in the Web Root directory field.
NetManage has already created a directory called WEBDOCS that contains the
DEFAULT.HTM file. Note that you are not limited to one directory for your Web
documents; you can have a directory tree under the Document Root.

6. Choose the Browse... button to display the directory tree under the Document Root.

Your Personal Web Server is now configured. You can reconfigure the server at any
time by following the above steps.

Troubleshooting

If you experience difficulties using the Personal Web Server application, refer to the
following items:

☐ Make sure that the installation and setup verification steps have been successfully
completed.

☐ After configuring the Web Server, if the web client is not able to access the Web
Server please check the port number in the Personal Web Server Configuration. If
the port number is other than 80 (this is the default port number), then it has to be
specified in the URL. Other wise an error message such as "World Wide Webserver
not active on hostname" may be displayed.
Chapter 29. WebSpider

WebSpider is used to create and design documents to be viewed over the World Wide Web (WWW). Documents for the Web are written in the HyperText Markup Language (HTML), which is a text-based language. HTML documents, unlike word processor documents, can be viewed over many different platforms using various Browsers, such as the NetManage WebSurfer.

HTML is simple ASCII with embedded tags. These tags allow adding various attributes to the plain text, such as adding graphics to your text, changing the appearance of the text, and creating hypertext links. The WebSpider allows you to create such HTML documents without having to learn HTML.

WebSpider is a standalone HTML editor that provides a simple word processor environment. It makes formatting an HTML document as easy as formatting any regular text document. A convenient button bar and menus are used to apply styles, headings and links. WebSpider automatically applies the tags, without making you aware of the HTML implementation. Therefore HTML tags are defined, but not displayed.

The Editor displays the HTML in a WYSIWYG format (What You See Is What You Get), meaning the created documents appear in the Editor as they will appear when viewed in the Browser.

WebSpider can be used with other NetManage applications to publish your own HTML pages for the World Wide Web (WWW), refer to the online Help for details.

Formatting Text

WebSpider provides a quick and easy way to format of text. The typical word processor functions are available through the Edit menu: cut, copy, paste, delete, find, replace, select, insert. All of these options are documented in the online Help. In addition, HTML formatting tools are available: character styles, paragraph styles (including various headings) and lists.

Character Style

Character styles apply the following style options to the characters selected:
• Bold
• Italics
• Strong (HTML tag)
  Used to emphasize text. The display implementation is Browser dependent. The common implementation is Bold.
• Cite (HTML tag)
  Used to mark citations. The display implementation is Browser dependent. The common implementation is Italics.
• Fixed Font (HTML TT tag)
  Indicates that the text should be displayed using monospace (fixed size) font. The font is Browser dependent. The common implementation is Courier.

Character style is accessed through the Format menu. Refer to online Help for details on applying the style.

**Paragraph Style**

Paragraph style applies a style to the paragraph containing the current selection. The HTML editor creates tags specifying how to format that paragraph.

The following styles are available:

• H1 to H6
  Defines text in relatively different size fonts for emphasis. H1 is the larger font, common implementation is bold. Each of these styles becomes progressively smaller. H6 common implementation is smaller than the normal font.

• Preformatted
  Defines that the current paragraph should be displayed in a fixed font, and that no Browser adjustments should be performed on this text.

  For example, Browsers will usually eliminate white space such as double spaces and tabs. In a preformatted paragraph, no adjustments will be performed. The common implementation uses the Courier font.

• Address
  Defines that the current paragraph should be displayed as an Address. The common Browser implementation is Italic. This style is often used for email addresses.

• Normal
  Defines that the current paragraph should be displayed as a regular paragraph, no styles applied.

Paragraph style is accessed through the Format menu. Refer to online Help for details on applying the style.
Indent Style

Indent styles are applied to blocks of text to format their justification. No indent, left indent and center indent styles are available. Indent styles are accessed through the Format menu or button bar. Refer to online Help for details on applying the style.

Lists

WebSpider allows you to create different types of lists to enhance text. All lists are indented from the left. The list styles available are:

- Ordered
  Automatically inserts item numbers.
- Unordered
  Automatically inserts bullets.
- Dir
  Bulleted list similar to the Unordered list, consisting of short items, typically up to 20 characters each. Items in a directory list may be arranged in columns, typically 24 characters wide. The common browser implementation is as an Unordered list.
- Menu
  Bulleted list of items with typically one line per item, making it a more compact than the ordered list style. The common browser implementation is as an Unordered list.

Increase List Indent creates a nested list by moving a list item right by one tab stop. Decrease List Indent moves a nested list item back (to the left) one tab stop. Refer to online help for details on these procedures.

Note: Increase and Decrease List Indent commands will be available only when cursor position is in a list.

Links

Links are used to create a Hyperlink from the selected text to another specified document or Internet resource. The Hyperlink (also referred to as Link and URL) is used to reference any resource on the Internet. When a link appears in the document, the Web Browser uses the Link to go directly to that resource, using the protocol selected when creating the link. Internal links jump to a reference in the same document, relative links to a file in the same directory and external links to a file on another computer. These various links are described fully in online help.

To create a Link:

1. Select the text you want to link to the destination document.
2. Choose Create Link... from the Link menu.

A Link dialog box appears, for you to specify the URL components (Protocol, Host, Port, File, Target).

- **Protocol** - select the communication protocol required to access the destination Host: HTTP, Gopher, FTP, FILE, TELNET, MAILTO, NEWS.

- **Host** - Enter the name of the destination Host.

- **Port** - The Port displayed is the standard port used by the chosen protocol. It is recommended to keep the standard port.

- **Path and File Name** - The destination file name, including directory path if necessary.

- **Target** - With HTTP and File protocols it is possible to Link to a specified point inside a document, if it has been defined as a Target. Enter the Target name you want to link to. Use this option to link to a different point within the same document.

- **Username** - Enter the appropriate username for Hosts that require a username for connection.

- **Password** - Enter the appropriate password for Hosts that require a password for connection.

- **Title** - Allows you to provide an alternative name for the destination document. Enter the name you require.

- **Link To** - The information that you entered in the Link Information fields automatically appears in the Link To field.

You can enter the string, if known, directly into the Link To field, eliminating the need to fill in all the options of the Link Information (the URL Components).

**Note:** It is advised to enter the details into each of the Link information fields and automatically this is created into a valid URL displayed in the Link to field.
Advanced users, or users that know the exact URL they wish to link to, may enter the information directly into the Link To field.

- Test Link - Choose this button to test the Link you just created.

3. Choose the OK button.

The style of the selected text changes to reflect the existence of a Link.

Note: The Create Link command is available only when text, that is not already a link is selected.

You can test, modify and remove Links - refer to the online Help for details.

**Targets**

Links automatically jump to the beginning of documents. If you want the Link to jump to a specific part of a document, you must create a Target at that point. The Link can be specified to jump to the target. The Create Targets command is accessed from the Link menu. Refer to online Help for details on creating, editing, and moving targets.

If the Highlight Targets command from the Settings menu is checked, the style of the selected text or background will change, to reflect the existence of a Target. The reflection of the Targets in the Editor is for your convenience. The common Browser implementation of Targets will not display the targets in a different style.

Note: The Create Target command is available only when text is selected which is not an existing target.

**Insert Inline Image**

You can insert a picture into the document as an inline image at the current cursor position, and set the image's attributes. Various graphic formats are supported, but it is advised to use the GIF format for maximum browser compatibility. If your graphics are of a format other than the GIF format, use NEWTView to convert the existing graphic to the GIF format. You can access Insert Inline Image through the Insert menu. Refer to the online Help for more details.

WebSpider provides you with a library of icons and graphics, found in the netmanag\webspid directory. To use these icons or graphics, refer to online Help.

**Example HTML files**

WebSpider provides you with a small library of example HTML files in the netmanag\webspid directory. To use these files first open an example file, save as another name, and edit as you wish.
Launch Web Surfer

This command will launch the Web Surfer with the current document, allowing you to view and test your document in the Browser environment.
Chapter 30. NEWTNews

The NEWTNews application allows you to subscribe to newsgroups on the Usenet, read articles, mail articles, post articles, post follow-up articles, forward e-mail, and check for new newsgroups.

Usenet is a public forum for the exchange of ideas in the form of news articles that are broadcast to member sites. News articles that are posted on the Usenet are classified into newsgroups according to their subject matter. The number of newsgroups available to you will be set by your system administrator. The number of available groups is sometimes restricted to limit telephone traffic and disk space usage.

Newsgroup Types

Newsgroups are divided into the following seven main categories or hierarchies:

<table>
<thead>
<tr>
<th>News Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>comp</td>
<td>groups relating to some aspect of computer science (for example, comp.ai)</td>
</tr>
<tr>
<td>sci</td>
<td>groups relating to sciences other than computer science (for example, sci.physics or sci.math.symbolic)</td>
</tr>
<tr>
<td>news</td>
<td>groups relating to news software in general and the administration of Usenet news (for example, news.admin or new.announce)</td>
</tr>
<tr>
<td>rec</td>
<td>groups relating to recreational activities and hobbies (for example, rec.arts.sf-lovers or rec.games.chess)</td>
</tr>
<tr>
<td>soc</td>
<td>groups for social interaction or discussion of social topics (for example, soc.singles or soc.culture.jewish)</td>
</tr>
<tr>
<td>talk</td>
<td>groups prone to extended heated discussion (for example, talk.religion or talk.politics)</td>
</tr>
<tr>
<td>misc</td>
<td>groups that do not fit into any of the other categories (for example, misc.jobs.offered for job postings)</td>
</tr>
</tbody>
</table>

There are also local newsgroups whose names begin with a distribution prefix that restricts the distribution of the newsgroup to certain geographical areas or organizations. For example, a prefix ca. in the newsgroup ca.wanted indicates that it will only be distributed to sites in California.
In addition to the standard seven hierarchies, and local or regional groups, there are several alternative hierarchies. These are created by groups of people who agree to carry and distribute these groups, independently of the standard hierarchies. Some of the major hierarchies are:

<table>
<thead>
<tr>
<th>Hierarchy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alt</td>
<td>Short for alternative. The original alternative hierarchy. A major feature is that anyone may create any group they please. Major groups include alt.gourmand, alt.aquaria, alt.sources and alt.binaries.</td>
</tr>
<tr>
<td>gnu</td>
<td>A set of groups devoted to the Free Software Foundations GNU project.</td>
</tr>
<tr>
<td>pubnet</td>
<td>Groups devoted to the interests of public access UNIX sites.</td>
</tr>
<tr>
<td>bionet</td>
<td>Groups devoted to the exchange of information on the biological sciences.</td>
</tr>
</tbody>
</table>

Getting Started

To access NEWTNews, do the following:

1. Choose the NEWTNews icon.

2. Log into NEWTNews using the same name and password which you would use for mail. The Directory dialog box appears.

3. If this is the first time you are running NEWTNews, then enter the name of the directory to which you want all your configuration files downloaded and articles written and choose the OK button.

4. Choose the Connect menu to display the Connect dialog box.

5. Enter the name of the host to which you want to connect in the News Server Name: field and choose the OK button.

Note: Most news servers have access restrictions. You need to get permission from the administrator of a system before using that system as a news server. Restrictions are usually imposed on a per-machine basis (per-IP-address) rather than a per-user basis.

The first time you log into NEWTNews, the server name you enter is stored in the .CFG file. It automatically connects at Startup. If you disconnect and then reconnect while NEWTNews is up, it will ask you for the name of the server.
Subscribing and Unsubscribing to Newsgroups

This section describes how to subscribe and unsubscribe to available newsgroups.

1. Choose the Subscribe command from the Groups menu. The Subscribe to newsgroups dialog box appears.

2. If you know the name or part of the name of the newsgroups you want to subscribe to, then select the Text To Match option and enter the partial or whole name in this field. The desired newsgroup name will appear in the Unsubscribed groups list. Note that the names of newsgroups that contains this string will appear, not just the one you want.

3. Highlight the desired newsgroups(s) to which you want to subscribe and choose the right arrow (») button. The selected groups will appear in the Subscribed groups list.

4. If you do not know the name of a newsgroups, or simply want to view the available list of newsgroup hierarchies, then select the Hierarchies option and scroll through the list.

5. Select the desired hierarchy. A list of newsgroups within the selected hierarchy automatically appear in the Unsubscribed groups list.

6. As previously described, highlight the desired newsgroups(s) to which you want to subscribe and choose the right arrow (») button. The selected groups will appear in the Subscribed groups list.

Note: Constructing the list of all available newsgroups may take several minutes the first time.

7. When you are finished select the Close button to update your subscriptions. All subscribed groups, which have articles, now appear on the NEWTNews screen.
If you want to subscribe to additional groups at a later date, you can choose the Check New Groups command from the Groups menu. This command lists all new groups available for subscription since the last time you checked.

NEWTNews automatically checks for new groups whenever you start News. You can change this setting in the Preferences dialog box.

To unsubscribe to or delete your subscription to a newsgroup, do the following:

1. Select the newsgroups to which you want to unsubscribe.
2. Choose the Unsubscribe command from the Groups menu. The selected newsgroups are deselected.

**Reading News Articles**

This section describes how to:

- display a listing of articles in a newsgroup
- use the Threading feature
- choose an article to read
- print an article
- save an article to a file.

A news article consists of header and body information. The header information may include: the network address of the sender, the newsgroups to which the article belongs, a subject, a Usenet message ID, the date it was sent by the author, the date it was received at your site, the name of the organization from which it was sent and the number of lines in the body of the text.
Listing, Viewing, and Threading Articles

To list and view a newsgroup's articles, do the following:

1. Select the newsgroup whose articles you want to view. Shown next to each newsgroup are the number of unread articles and the total number of articles.

2. Choose the Go To Articles command from the Groups menu or choose the Articles button to display the newsgroup's list of articles. Or, double-click on the group.

The Threading feature organizes the message listing so that all messages and their associated responding messages (Re:) are grouped together. You can display a message and its associated responding messages hierarchically by selecting the Expand Current option or double-clicking on the thread. Use Expand All only if you want to expand all threaded messages. If you want to hide all the responding messages hierarchically, then select the Collapse Current or Collapse All options.

Note that an icon or multiple pages appears next to threads that have more than four responding messages associated with the original message. For example, one page equals two to three messages, two pages equals three to five messages and so on.

3. Select the article(s) you want to view and choose the View button.
4. After you read the article, choose the Exit command from the File menu to close the article and return to the screen displaying the list of articles.

Note that an open book icon appears to the left of a previously read article.

You can catch up on a group, or mark all messages in a particular newsgroup as read, or catch up even if you have not read any of them. To do this, select the subscribed newsgroup, then select the Catch Up option under the Groups menu. This automatically marks all of the messages in the newsgroup as read.

By default, previously read articles are not displayed again. You can set this differently the next time you view that newsgroup. To keep read articles from disappearing from the newsgroup upon exit, you can do any of the following:

- If you are reading the article, choose the Mark Unread command from the Articles menu before closing the group. This marks the article as unread so it will appear the next time you open the newsgroup.

- If you are reading the article, choose the Set Flag command from the Articles menu before closing the group. The article is marked as read but also has an icon next to it indicating that the flag is set and that the old message will not disappear from the newsgroup. Note that the Set Flag option will not mark an article as "read" if it has not already been read.
To remove the flag, choose the Clear Flag command from the Articles menu.

**Note:** Flagged messages will not be available permanently. They will only be available as long as the news server keeps the messages. Ask your system administrator to find out how long news is kept on the server.

- From the Settings menu, choose the Preferences... command and then the Select the Show Previously Read Messages option to display all articles in a newsgroup, including those previously read. Note that if you are already in a newsgroup and you change this option, it will not change the display. The next time you enter a newsgroup, it will take effect.

**Printing Articles**

To print an article, do the following:

1. Select or view the article, then choose the Print... command from the Messages menu to display the Print dialog box.

2. Choose the OK button to print the article.

**Saving Articles**

To save an article to a specified file, do the following:

1. Select or view the article, then choose the Save button to display the Save As dialog box.

2. Enter the Filename, File Type, Directory, and Drive and choose the OK button. Note that you can select multiple messages and save them all at once.

**Posting Articles**

This section describes how to post an article on the Usenet, send an article through e-mail, and post a reply to an article you have just read.

To post an article on the Usenet, do the following:

1. Choose the Post command from the Messages menu to display the New Article dialog box.

2. Enter your e-mail (if necessary), subject matter, and the message.

3. Choose the Groups... button to display the Newsgroups dialog box, and select the desired newsgroups.

4. Choose the Names... button to display the Address Book dialog box and select the e-mail addresses of persons to whom you want to send your article.

5. Choose the Send button from the Message menu to post and/or mail the article.
To post a reply to an article you have just read, do the following:

1. Open the article you want to reply to and choose the Reply button. Another screen appears containing the same article.

2. Enter your address, the newsgroups to which you want to send your reply, and your reply message. Choose the Send button. Note that the group of the original article is put in automatically.

**Settings Menu**

You can set preferences to control which articles you want to read and how they should be displayed. You can set fonts, colors, run the Log, and display information. Refer to NEWTNews online help for detailed information using the Settings menu.

**Downloading Articles to Your Local Drive**

While using NEWTNews, you can download articles to your local drive. This feature allows you select a group of articles, or an individual article, to download so you can read them at your own leisure from your local drive.

To download one or more articles to your local drive, do the following:

1. Select a group you want to download without opening it, or open a group and select the articles you want.

2. Choose the Download command from the Groups or Articles menu.

A group that has some downloaded messages will have a diskette icon next to the name at the top level. You can access downloaded articles from your local drive the same way you access them remotely.

**Note:** Downloaded messages can take up a lot of disk space.

**Troubleshooting**

- Verify that the installation and setup verification steps have been successfully completed.
- Make sure the host name to which you are trying to connect is correctly entered, and that the News system administrator gave you the correct access permissions.
- If NEWTNews reports a failure to connect, use the Ping application to verify your connection to the news server you want to access.
- Verify that the NEWTNews settings are correct and the timer settings for retrieval of new messages from the host are set appropriately.
Chapter 31. Archie

Archie helps you to retrieve text, graphics, and sound files from anonymous FTP hosts (hosts that can be accessed by anyone on the Internet using a special userid named anonymous).

The NetManage Archie client program provides a menu-driven interface that lets you browse through the various Archie servers on the Internet as though you were browsing through card catalogues of remote libraries.

Archie is an Internet information service for gathering data and indexing widely distributed collections of data. The anonymous FTP hosts contain certain directories that are designated for public access. Other computers, called Archie servers, provide an archiving search service to help Internet users find directories and files on the anonymous FTP hosts.

Preparing to Use Archie

NetManage Archie requires no special setup or configuration. To see if the proper network connection exists, select the Diagnose Connection option from the Help menu.

Starting an Archie Search

You can start a search in either of the following ways:

- Specify the desired search criteria in the dialog bar and press ENTER.
- Select the Search menu, specify the search criteria in the Search dialog box, and choose OK.
Search Parameters

The Search parameters, which can be specified either in the dialog bar or the Search menu popup dialog box, are as follows:

Criteria: The dialog bar begins a sentence instructing Archie to "Search for filenames that contain..." This partial sentence indicates both the type of search (Search the Archie archives) and the scope criteria (contain) of the search. You can scroll the first field of the dialog bar if you wish to select different criteria. If you are using the Search dialog box, you can scroll the Criteria bar to select a different search criteria and you can scroll the Query field to select a different search type. (Additional information on Query Types is provided later in this section.).

The default of the criteria field is "contain." The scrolling list of choices includes the following:

- **Contain**: Archie searches the database for file names that contain the specified string.
- **Match exactly**: Archie searches the database for file names that exactly match the specified string. This is the fastest search method.
- **Start with**: Archie searches the database for file names that start with the specified string.
- **End with**: Archie searches the database for file names that end with the specified string.
- **Regular exp**: "Regular expressions" are a combination of UNIX regular expressions and Archie's own syntax. This option allows you to specify wild cards or other substitution characters within the specified string. (Type the string in the blank field of the dialog bar or in the **Keyword** field of the Search Menu’s popup dialog box.) Refer to Archie online help for detailed syntax information.

Keyword: You can specify the object of the search (a string to be searched for) in the blank field of the dialog bar or in the **Keyword** field in the Search menu’s popup dialog box. If you select the "Case Sensitive" option, Archie will search only for strings that match the case (uppercase/lowercase letters) of the string that you have specified.

Open Log: If you wish to record a log of the current search, you can select this option in the Search menu dialog box.
Query types: This is an additional search parameter that can be specified only in the Search menu dialog box. The Query field determines the type of search that will be conducted.

You can select any of the following search types:

- **Search**: Searches for a file name containing the keyword in the Archie archives.
- **WhatIs**: Searches for a description of the keyword in the Software Description Database.
- **Query**: Searches for additional Archie servers.

Additional Search Delimiters

The Settings Menu\Preferences option allows you to limit the Archie search, as follows:

**Maximum responses**: Specifies the maximum number of items that Archie will report as a result of a search. The default is 100 maximum responses. If Archie seems too slow, you can reduce this value to a lower number.

**Maximum identical filenames**: Specifies the maximum number of identical file names that Archie will report.

Selecting an Archie Server

You can start a search using the Archie default server. You can change the server selection by picking a different server from the Services Menu\Server option dialog box, or by selecting a different server from the scrolling list in the Search menu dialog box. The contents of the Archie database are usually the same on different servers. If you cannot connect to one server (the servers are often busy), you can select a different server. You can use the Query option from the Search menu to find additional Archie servers.

Specifying the Object of the Search

You can specify the object of the search in either of the following ways:

- Type a text string in the empty field in the Archie dialog bar.
- Select the Search menu and type a text string in the Keyword field of the Search dialog box.

WhatIs

WhatIs searches for the specified text string in a collection of information called the "Software Description Database." The Software Description Database contains short descriptions of programs, documents, and other files that are located on the anonymous FTP server archives. These descriptions are provided optionally by the person who
submitted the file to the anonymous FTP server. Note that these descriptions are submitted on a voluntary basis, are not edited, and are not updated on a regular basis.

WhatIs is an alternative to the Search command. If your WhatIs search is successful, it can help to narrow your search of the Archie archives themselves. However, you may often be able to find files in the Archie archives even though the WhatIs search was not successful.

When you select WhatIs, Archie displays a popup dialog box with a blank field in which you can type a word (or text string).

You can select the WhatIs command either from the Search menu\WhatIs option or from the scrolling Query list in the Search menu\Search dialog box.

Retrieving Information

After Archie has successfully connected and logged in to the selected server, Archie displays a list of items retrieved.

The display of items retrieved includes the following columns (from left to right): the name of the anonymous FTP host, the size of the file, the path of the directory or, and either a file name or short comment. Note that the icons in the furthermost left column indicates whether the retrieved item is a directory or a file.

![Image of Archie interface with search results]

You can transfer the files from the anonymous FTP server to your PC by selecting an item on the list and doing one of the following:

- Select a file from the list and choose it.
- Select FTP Retrieve Selection from the Services Menu.
- Select Launch FTP from the Services Menu.

Launch FTP: This transfer method is useful if you are unsure which file you should select. For example, you could use the Launch FTP option to view the files contained in a directory item retrieved from the Archie search.

Note: When you first use FTP, the standard user name, “anonymous,” has already been provided for you. However, you may need to type your Internet email address in
the password field to gain access to the server. When you save your Archie configuration, the FTP password will be saved for future use.

**Quote**

The Chameleon Archie application provides you with a menu-driven point-and-click interface for conducting an Archie search. However, if you wish, you can also type the UNIX-based Archie commands by using the Quote command in the Services menu. To display a listing of all the Archie commands, type the word “help” within the Quote text box.

**Troubleshooting**

If you experience difficulties using the Archie application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.

- If you cannot connect to a specific server during peak hours, try connecting again during off hours. Use the Diagnose Connection option to start Ping and verify that the server is available.

- If you cannot connect using the default TCP protocol, select the Preferences option from the Settings Menu to change to the UDP protocol. Then retry the Search.

- Make sure that the correct transfer type (ASCII or Binary) is chosen. Transferring a file in the incorrect mode may corrupt that file. For transferring text files, use ASCII. For all other files, choose Binary.

- Display the status bar (the Status Bar command in the Settings Menu should have a checkmark beside it) so that you can view messages regarding the status of the connection or data retrieval.

- Open the Log option from the Settings menu before connecting because the Archie log can be used to help diagnose access failures. Many errors become obvious when watching the dialogue between client and server.
The Talk application lets you participate in real-time conversations with remote users. Talk acts as both a client and server, and notifies you of remote Talk invitations by displaying a popup dialog box with or without sound.

**Preparing to Talk**

You can specify a remote user and host in the Talk With field of the main Talk window, or you can use a conversation profile.

A conversation profile stores necessary connection information, so that you can establish a conversation with a remote user without re-entering connection details. After you create a conversation Profile for a remote user, you will be able to send a Talk invitation by selecting the user's profile from a list box. You can define as many conversation profiles as you wish.

**Creating Conversation Profiles**

To create a Conversation Profile, take the following steps:

1. Choose the Conversation Profile... command from the Settings menu.

   ![Conversation Profile dialog box]

   - In the Description field, type the name you want to assign the profile.
   - Enter other field information, as desired, and choose the Add button. See field descriptions below.
   - Choose the Close button.

**Conversation Profile Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
</table>

ChameleonNFS Installation and User's Guide 319
### Field | Definition
--- | ---
Description | Enter the name you want to assign to the profile. This name will appear for your selection in the profile list box.
User | Enter the name of the remote user with whom you wish to connect. In general, you should specify both the user and the host name. However, if you are establishing a conversation with a user on a single-user host, you may omit the user name. (For example, if you are initiating a Conversation with a remote user who is using Chameleon, you can omit the user name.)
Host | Enter the name of the remote host to which you wish to connect. The remote host identifies the physical machine that is being used by the user with whom you wish to talk. For example, if Camille (the NetManage pet chameleon) had a PC, we might identify her PC’s host name as camille.netmanage.com or as its IP address (such as, 111.22.3.444). The host name must match the name or IP address that is listed in the Domain Name Server (DNS). Sometimes, the a host name looks similar to an e-mail address. This is because system administrators sometimes configure hosts to have the same name as the e-mail address. However, the format of the host name is different than the format of an e-mail address. For example, the host name of Camille’s PC on the Internet would be camille.netmanage.com, but her e-mail address would be camille@netmanage.com.
Protocol | Select the protocol to be used when conversing with the remote user. For details on a protocol see your UNIX or Sun documentation.
NTALK (default): uses UNIX NTALK.
TALK: uses older Sun talk.
Notes | You may enter additional information to be included in this conversation profile.

### Modifying Conversation Profiles

To modify a conversation profile:

1. In the profile list box, select the description you want to modify.
2. Edit the profile's fields as necessary. You can clear all the fields by choosing the New button.

3. Choose the Modify button and then the Close button.

Deleting Conversation Profiles

To delete a conversation profile:

1. Open the Conversation Profiles dialog box by selecting the Conversation Profile... command from the Settings menu.

2. In the Profile list box, select the profile you want to delete.

3. Choose the Delete button and then the Close button.

Establishing a Conversation

To establish a conversation with a remote user:

1. In the Talk With field, type a remote user and host name or select an existing Conversation Profile from the drop-down list box (click on the down arrow next to the Talk With field to display the list box).

2. Choose the Talk button to open a conversation window.

3. Type your message in your section of the window, which is the box located near your username.

   You can also enter information by using the Edit menu’s Copy and Paste options. Talk sends your message to the remote user. If the user responds to your Talk message, the response is displayed in that user’s section of your conversation window. You can continue conversing with the user.

4. If you want to save the information displayed in the conversation window, take the following steps:
   a) Choose the Save button.
      A Save Conversation File As dialog box appears.
   b) Specify the file in which you want to save the conversation.
      You can use the Network button to save the conversation to another server on the network (if you have NFS installed).
c) Choose the OK button.

If the specified file exists, Talk prompts you to append the information. Talk saves your portion of the conversation in one section of the file and the remote user's portion in another section.

5. After you finish conversing, choose the Disconnect button.

**Receiving Talk Invitations**

You can use Custom to configure your system, so that Talk can respond to Invitations without having to keep your Talk application activated. Do the following:

1. Open your Custom application icon.

2. Choose the INETD Configuration option from the Services menu.

3. Add both Talk servers to the list of installed servers by selecting NTALK or TALK server from the list of servers and clicking on the right arrow button.
   a) Check to make sure that the Server name now appears in the list of Installed servers.
   b) Repeat this procedure for the other server.

4. Choose the OK button and close the INETD Configuration dialog box.

5. Restart Windows.

When you receive a Talk invitation, a Can We Talk? dialog box appears. You can set up Talk to also notify you audibly by selecting an option from the Preferences dialog box, as discussed in online help.

Respond to the Can We Talk? dialog box by selecting an option:

- To converse with the sender, choose the Accept button. Talk displays the sender's message in the conversation window.
- To refuse the invitation and notify the sender you decline to talk, choose the Decline button.
- To refuse the invitation without notifying the sender you decline to talk, choose the Ignore button.

**Setting Talk Preferences**
Refer to Talk online help for detailed information about setting preferences.

**Ending Conversations**

To end a Talk conversation and exit Talk, choose the Exit option from the File menu.

**Troubleshooting**

If you experience difficulties using the Talk application, refer to the following items:

- You can establish Talk conversations only with users who have access to a server running Talk. If Talk cannot establish a conversation with a user whose server is running Talk, a message indicating the conversation has failed appears. This message does not appear, however, if the user's server is not running Talk.

- If the initial dialog window does not display, there may be a low memory problem. Shut down other applications and try again.

- If Talk does not accept the address, check address format. The format should be "user@hostname." For example, it could be lizzie@lizzie.netmanage.com. You can also use an IP address for the host; for example, "lizzie@123.45.6.77."

- If the remote side does not answer:
  - The remote host may not have the talkd daemon running.
  - talkd daemon on remote host is using another protocol. Try the other protocol (talk vs. ntalk)
  - The remote user is ignoring you. On UNIX systems, if they use 'mesg n' they won't get your invitation.
  - The remote user is not logged in.

- Ensure that NetManage users have their host name set up correctly. The host name should be specified in the format "lizzie.netmanage.com" or by its IP address, not just "lizzie". Then ensure that their domain name is set up correctly.

- If an Invitation to you does not cause a popup Talk dialog box to be displayed on your PC, check to see if your ined.ini file is set up correctly. There should be an entry, similar to the following:

  ```
  [UDP]
  = old talk (Sun protocol)
  = new talk (NTALK)
  ```
Chapter 33. NEWTView

NEWTView is a tool for displaying, copying, and printing bit-mapped graphics files produced by various applications. For example, NEWTView lets you view, copy, or print a graphics file received as an attachment from email or downloaded from Gopher or Archie. You can view, copy, or print the graphics file without using or having the application that created it. NEWTView also supports the CCITT Group 3 protocol standard for fax machines, so it can be used for displaying, copying, or printing electronic documents transmitted via fax.

Supported File Formats

NEWTView works with the following file formats:

- BMP
- DCX
- GIF
- JPG
- OCX
- PCT
- PCX
- TIF

The NEWTView File Menu/Association... option allows you to select which of the supported file extensions that you want to associate with the NEWTView application.
This option allows you to open image files with that extension by selecting them from the File Manager. Associating the file with NEWTView will override any previous file associations with that file extension.

Troubleshooting

If you experience difficulties using the NEWTView application, refer to the following items:

- Verify that file you are trying to view is in one of the file formats supported by the NEWTView application.

- Verify that the file you are trying to view is not corrupted. Check the file listing in the File Manager. If the file is listed as having "0" bytes, it is a corrupted file.
Chapter 34. Gopher

Gopher is an Internet access protocol tool. It allows you to browse through large amounts of information residing on the Gopher system called GopherSpace. GopherSpace organizes information into hierarchical menus related to subject matter or the Gopher server's geographical location.

Much like browsing through a remote library's card catalogue and automatically fetching the material you want, Gopher helps you access any of the data it presents.

The resource material in GopherSpace consists of data in a variety of formats such as text, images, sounds, and services such as Telnet connections, index servers, and phone book servers. Each item is labeled by an icon that identifies it as a directory, text file (.TXT), graphics file (.GIF), phonebook, or searchable index.

While documents reside on many servers, it does not matter where the resources are located, as long as they are part of GopherSpace.

Setting Up Gopher

The NetManage Gopher client requires no special setup or configuration. However, the network on which Gopher runs must be properly configured, and you need to make sure that the File Manager associations exist between certain file types and their viewers. To see if the proper network connection exists, choose the Diagnose Connection command from the Help menu.

Gopher uses the File Manager file association system to determine the appropriate viewer program for viewing different kinds of files. For example, files with the .TXT extension should be associated with a text viewer such as Notepad or Write. To view GIF images, associate files with a .GIF extension to NEWTView or any other GIF viewer. Associate sound files with NEWTSound.

Starting Gopher

When you first start Gopher, a split window appears. The left half displays a directory tree and the right half displays only a directory of the current server's contents. The directory tree contains the contents of all the Gopher servers visited in the current session, as well as any servers saved in your configuration file.

The Gopher interface resembles a file system like File Manager and tracks two types of items: directories and resources. All resources are accessed through directories. Choose to the Symbol Legend... command under the Help menu for a list of all resource types. Directories and individual resources are labeled with their own distinct icons.
Gopher maintains a configuration file (usually GOPHER.CFG) that stores your user preferences and GopherSpace hierarchy information.

**Retrieving Resources from the Network**

To increase retrieval performance, Gopher stores everything it retrieves in a local directory on your computer. Published Gopher resources do not change often and at times the resources may be difficult to retrieve (servers may not always be up and communication links may be slow). When Gopher cannot retrieve a desired resource from the network, it looks for it in your local directory instead.

Gopher retrieves two types of information:

- Hierarchical information, which appears in the GopherSpace display and is stored in the configuration file.
  
  You can open a Gopher item by choosing the Retrieve Item option from the Item menu. This option retrieves the selected item directly from the Gopher server and then opens it. When you close the item it is automatically placed in your Gopher cache directory.

- File information, which is stored in the Gopher cache directory (which you set up in Preferences). These files are often named with the letter G, a number, and an extension indicating file type.
  
  After an item is closed and placed in the Gopher cache directory you can open it again using the Open command from the Item menu. However, this item may not contain the most current update since you did not retrieve and open the item directly from the Gopher server.

The configuration file defaults to the name GOPHER.CFG and the Gopher cache directory is called gopher. By default, both are stored in the same directory in which Gopher was installed.
Navigating Around GopherSpace

The GopherSpace hierarchy is divided into two sections: bookmarks and Gopher servers. Bookmarks are items of specific interest which have been copied from elsewhere in the hierarchy for convenient access using the Set Bookmark command from the Item menu.

Servers are references to the Gopher server machines which act as a starting point for exploring the Gopher hierarchy.

In the left side of the Gopher window, you can select items by clicking on them or using the arrow keys. For example, to view the contents of a directory, double-click on its name. Additional directories and/or files, index searches, or phonebooks may also appear. As you continue to move through the directory in search of items of interest, the file system will expand. To collapse any part of the file structure, double-click on the directory you want to close.

You can retrieve items in the right side of window, but you cannot select items from the right window because the right side tracks the left side.

Saving to a Gopher Server

To add a server to your saved list of Gopher servers, choose the Add Gopher Server command from the Items menu. Enter the required information, choose OK and a directory icon will appear in the servers list bearing the new server name.

The University of Minnesota publishes a list of Gopher servers which is included as one of the default bookmarks (Other Gopher and Information Services). This list contains the servers whose owners have submitted a request to the university to be placed on the server list.

In the Add Gopher Server dialog box, the field descriptions are:

- **Name Displayed** is the identifier displayed in the directory tree
- **Host Name** is the address of the Gopher server
- **Port Number** is the protocol port number which is part of the server address.
- **The common value for Gopher servers is 70.**
Troubleshooting

If you experience difficulties using the Gopher application, refer to the following items:

- Make sure that the installation and setup verification steps have been successfully completed.

- If you cannot connect to a specific server during peak hours, try connecting again during off hours. Use the Diagnose Connection option to start Ping and verify that the server is available.

- Gopher should clean up after itself by deleting files in the cache directory when appropriate. However, it is possible to "orphan" files, so you may want to purge your cache directory occasionally.
Chapter 35. Automatic Internet

Automatic Internet lets you connect to the Internet by configuring your connection information in a matter of minutes.

- If you do not yet have an Internet account, you can choose an Internet Service Provider and sign up for an account online. When you sign up for your account, your software is automatically configured with the appropriate connection information.

- If you already have an Internet account (or if you have been given a Provider Identification Number), you can use the Automatic Internet application to register your existing account with NetManage. If your Internet Service Provider has filed a configuration for their service with NetManage, your software will be automatically configured with the appropriate connection information. This automatic configuration includes the setup of the Mail server, the NEWTNews server, and the Web server.

- If your Internet Service Provider has not filed a configuration with NetManage or if you do not have a Provider Identification Number, you can still use the NetManage tab portion of Automatic Internet application to automatically configure some of the Custom information. However, your configuration will not include setup of a Mail server, NEWTNews server, or Web server.

Choosing and Signing Up for a New Internet Access Account

Use Automatic Internet to choose and sign up for an account with an Internet Service Provider, as follows:

1. Open the Automatic Internet application by double-clicking on the icon in the program group. A dialog box appears that includes tabs for several Internet service providers, and a tab for NetManage.

Note: NetManage is not an Internet Service Provider.
2. Select one of the Internet Service Provider tabs and then choose the More Info button.

The Provider's More Info dialog displays information on contacts, service, and pricing. Some providers offer free demonstration accounts. Read the information displayed by the More Info button for each provider to find out if they offer demos. Once the time has expired on your demo, you must use Automatic Internet again to sign up for a permanent account. Demos are limited to one per person. Call the Provider directly if you have additional questions about local access availability or pricing.

The tab dialog of NetManage provides introductory information on the Automatic Internet application and explains the registration process. NetManage is not a provider.

3. To sign up for an account with a Provider, select the tab of the Provider that you want to use and then choose the Signup button.

Note: Automatic Internet uses a secure phone call to communicate with the registration server. Your credit card number will not be sent over the Internet.

Most of the time, you need a credit card to sign up for a Provider account using Automatic Internet. If you do not have a credit card, call the Provider directly for information.

You will be presented with various connection options and prices when you actually connect with the provider's server. You will have an option to cancel the sign-up process after you have connected with a registration server.

An Automatic Internet Account Sign Up dialog box similar to the following figure appears. This is where you enter your personal registration information to send to the provider.
4. Type your name, address, and phone numbers in the appropriate fields. Enter your
name and address as it appears on your credit card. You can enter information in
the State/Province and Country fields by either selecting or typing it.

5. Select the type of credit card to which you want to charge the Internet services, and
type that card's number and expiration date. You must enter the expiration date
using the following format: mm/yy.

6. Depending on the Service Provider you choose, there may or may not be additional
tabs to supply additional information the provider is requesting at signup. Select
these tabs if they are present and supply the requested information.

**Note:** If you forget to select the second tab, Automatic Internet will prompt you to select
the tab and fill out the additional information.

7. Choose the Phone List button to select the phone number to be used for sending in
your registration information. Choose the one most local to you. You may edit this
number to add special dialing prefixes (such as 9) if required by your phone system.

**Note:** This is not the number you use to call your provider for connecting to the
Internet. This is the number of the registration server. You will not be
communicating your registration information over the Internet. That number
will be downloaded from the provider upon sign-up.

8. Choose the Send button to sign up for your account. Once you choose the Send
button, the status area on the lower right will indicate the progress of your
connection and sign up. The traffic lights signal the flow of the registration data from your computer through the phone line to the provider’s server and back. Accompanying status messages are displayed in the text box located below the traffic lights.

**Note:** Registration servers may be busy at times. Please try registering again later. If a problem occurs during registration that prevents the registration process from completing, the Send button is replaced by a Resend button. In this situation, recheck your information and choose the Resend button.

9. Choose the Advanced button only if you need to specify a different communications port. The Automatic Internet application will automatically sense your modem on the appropriate COM port. If your modem does not initialize correctly, please verify the COM setting by selecting the Advanced button and choosing the correct COM port. By default, the first available COM port will be chosen.

In a few minutes, the provider’s server will send back your personalized account information and automatically configure your software. An interface will be created for Custom that defines how Internet Chameleon connects to your Provider. This includes your username, password and dialup number. Automatic Internet will also create a mail account for you and set WebSurfer, NEWTNews and Gopher defaults according to your Provider’s specifications. A welcome message from your Provider will be displayed and you are now ready to explore the Internet.

10. Reboot your system, then open the Custom application and select Connect to connect to the Internet.

11. Minimize Custom and begin using the applications.

**Automatically Configuring Connection Options for an Existing Internet Account**

You can use Automatic Internet to register and automatically configure the connection options for an existing Internet account, as follows:

1. Open the Automatic Internet application by double-clicking on the icon.

2. Select the NetManage tab and choose the More Info button for information about the Automatic Internet application and the registration process.

3. Choose the Sign Up button to register your existing account with NetManage.

**Note:** You do not need to fill out the credit card information if you are simply registering an existing account with NetManage.
4. Fill out the two registration forms as completely as possible. Your provider should have given you information needed to fill out the second registration form when you signed up for an account.

**Provider identification number:** A unique number for each provider assigned by NetManage, and given to the user by the Provider. This field is optional. If your provider does not have one, leave this blank. If you do specify an appropriate Provider identification number, your automatic configuration includes the setup of the Mail server, the NEWTNews server, the Gopher server, and the Web server.

**User account name and password:** Uniquely assigned to you by your provider. Your account name and password allows you to access the Internet through your provider.

**Your IP address:** A unique number assigned to you by your provider. If your Provider uses dynamic IP assignment (that is, you get a different IP address assigned to you each time you connect), fill the IP address field with a "dummy" address. For SLIP/CSLIP accounts, use "1.1.1.1" and for PPP accounts, use "0.0.0.0."

**Mail account name and password:** Uniquely assigned to you by your provider. Your mail account name and password allows you to send mail through the Internet.

**Type of account:** Choose from one of the following: PPP, SLIP, CSLIP, ISDN. Your provider will notify you of your account type.

5. When you have finished filling out the form(s) completely, hit the Send button. Select "configuration only" and click OK to continue with the registration process. Automatic Internet will configure your PC for an Internet connection.

You may receive a message that your provider has not filed a configuration for their service with NetManage. In this case, you will need to open Custom and complete the configuration. Do this by filling in the domain name, dial (access phone number), and domain name server in the Setup menu. Do a Save in the File menu,
exit Custom and restart Windows. Reopen the Custom application and select Connect. Minimize Custom and begin using the applications.

Follow the instructions in the manual to set up your mail gateway, mail server, (NNTP) news server and connection script.

**Verifying or Modifying Your Automatic Internet Configuration**

The first time after you run Automatic Internet, you should verify the settings for port, modem, and Dial under Setup in the Custom application. If you are using an ISDN card that supports direct interface with the card via the WinISDN standard, and if your provider has downloaded an ISDN interface, you will need to select the Hardware Type in the Setup menu. You need to verify these settings only once. Use Automatic Internet only once to sign up for each account.

**Caution:** Creating a second account from a new provider will overwrite the domain name server, Mail server and gateway, NNTP News Server, and World Wide Web default home page. Therefore, before creating a second account, you should write down these settings or backup the *.CFG files.

**Connecting to the Internet**

You use Custom to initiate your dial-up Internet connection. After verifying your settings, simply select Connect from the Custom menu.

**Troubleshooting**

- Be sure to fill out all the input fields before you send your registration information in. An account application must be completely filled out in order to be accepted by the provider.
- Enter your name as it appears on your credit card.
- If the provider's server takes too long to respond, your connection will be timed out. Try to send your registration information later, or increase the Timeout before Disconnecting option in the Custom application (use the Setup menu, Communications command, Dial option).

See Automatic Internet Online Help for additional Troubleshooting Tips.
The NEWTSound application enables you to run a sound file. Supported sound file extensions are as follows:

- .WAV
- .AU
- .VOC
- .SND
- .IFF

When you open the application, a NEWTSound File dialog box is displayed, allowing you to select a directory and a sound file.

**Note:** You must also have a sound board or a sound-board emulator installed in your computer to use this application.

The NEWTSound application does not contain any additional menus. However, the NEWTSound File dialog box does contain a few buttons. When you choose the Associate button, the NEWTSound Association dialog box is displayed.

The NEWTSound Association dialog box contains a list of currently supported file extensions. Select whichever file extension(s) you want to associate with the
NEWTSound application. This option allows you to play sound files with that extension by selecting them from the File Manager. You can also play an associated sound file by dragging and dropping the sound file onto the NEWTSound application.

Associating the file with NEWTSound will override any previous file associations with that file extension.

**Troubleshooting**

If you experience difficulties using the NEWTSound application, refer to the following items:

- Verify that you have specified an Association for the file you are trying to open.
- Verify that the file you are trying to open is not corrupted. Check the file listing in the File Manager. If the file is listed as having "0" bytes, it is a corrupted file.
Chapter 37. Ping - Network Testing

The Ping application is a network diagnostic tool used to verify connectivity to a particular system on your network. The Ping application transmits any number of echo requests to a particular system and displays the results for each echo reply. This exchange is referred to as pinging. These echo requests and replies are supported by all systems on the network, including those that are currently running one or more Chameleon applications. This is accomplished through the use of the Internet Control Message Protocol (ICMP). If you encounter a problem in an application, pinging determines if the problem is with the application or due to a non-responding host. You may have multiple instances of the Ping application active simultaneously.

The current options and host name can be saved to a configuration file named PING.CFG (default). The configuration file is loaded when the Ping application is started. If a host name or IP address is specified, the Ping application immediately begins pinging that host. You can also supply a command line option to specify the host name or IP address.

Ping Host

To request a particular system to ping do the following:

1. Select Start. The Host dialog box appears.
2. Type or select a host name or IP address in the Host dialog box.
3. Choose the OK button. The application sends an echo request and waits for the echo reply. If no reply is received within the timeout value (default is 6 seconds), the ping fails.

A single ping produces summary lines in the Ping window. Multiple iterations or continuous pinging produces a single summary line for each ping. After each ping, summary lines are generated, giving the total statistics for this sequence of pings.

Note: When minimized an animated icon of a ping-pong ball indicates active pinging. The ball moving back and forth indicates successful pings.
Ping Settings

The Ping Settings menu allows you to access the Preferences dialog box and the Auto Start option.

The Preferences dialog box contains the following options:

**Iteration:** Specify the number of echo requests to transmit (1 through 9999 seconds), or for an infinite number of iterations select Continuous.

**Data Length:** Specify the length of each echo request (0 through 1,400 bytes). The default is 64 bytes.

**Interval:** Specify the time the application waits for a response to the ICMP_ECHO request sent (1 through 999 seconds). If there is no response after the specified time the ping returns "0 bytes received".

**Timeout:** Specify the timeout value for the echo reply (1 through 999 seconds).

To automatically start Ping through your Windows application do the following:

1. Choose the Auto Start option from the Preferences menu.
2. Choose Run from the Program Manager's File menu and type the following command line:
   ```
   ping<system name>
   ```

Troubleshooting

If you experience difficulties using the Ping application, refer to the following items:

- Verify that the installation and setup steps have been successfully completed.
- Try to Ping by using the IP address (instead of Host name) to determine if there is a name resolving problem.
- The network portion of the IP address must be a locally connected interface, or a default gateway must have been specified to route unknown networks.
- A local host table or domain server must be specified when pinging by host name. The host name entry must specify the correct IP address.
- For a Windows system, the NEWT application must be running for Chameleon to respond to an echo request.
- Make sure that the Ethernet type is correct: it should be Ethernet/DIX in almost all cases.
- Verify that there is a valid Frequent Destinations entry for this IP address.
Chapter 38. Finger

To use finger, do the following:

1. Choose the Finger icon, to display the Finger dialog box.
2. Select or type the desired host in the Host field.
3. Type the desired user name in the User field.
   If a user name is not specified in the User field, Finger displays information on all the users currently logged in to the specified host.
4. Choose the Finger button.

Verbose Option

Choose the Verbose option from the Settings menu.

Verbose displays information provided by the Finger application for each user logged on to the specified host. This information includes:

- login name
- full name
- home directory
- login shell
- time of login (if user is currently logged in)
- time of last login (if user is not currently logged in)
- terminal or host from which the user logged in
- last time the user received and read mail, and idle time
- information of any plan contained in the file .plan and any project described in the file .project, both are located in the user’s home directory

By default, Finger displays one line of information per user including login name, user name, TTY, idle time, time of login, and terminal or host from which the user logged in.

**Troubleshooting**

If you experience difficulties using the Finger application, refer to the following items:

- Verify that the installation and setup steps have been successfully completed.
- Use the Diagnose Connection from the Help menu to start Ping and verify connectivity to any remote system to which you want access.
- Verify that the host entered is a valid Finger server.
Chapter 39. Whois

The Whois application is a TCP/IP Internet user name directory service that displays information about Internet users who are listed in that directory.

For example:

Clark, Shawn (SC178) sclark@SENCO.COM (513) 333-232

Information about a user includes:

- full name - for example Clark, Shawn
- handle - a unique identifier, in parenthesis. For individuals the handle is composed of the person's initials and where necessary a trailing number - for example (SC178).
- network mailbox for Defense Data Network (DDN) users (who are registered in the Network Information Center (NIC) database) - for example sclark@SENCO.COM
- telephone number - for example (513) 333-232
- U.S. mailing address

Using Whois

The Host field contains the hostname of a Whois Server. The default server is rs.internic.net. You can search the Whois directory on a different server by selecting or typing the hostname of another Whois server in this field.

Note: To view a list of Internet Whois servers, select Whois Servers List option from the online Help Contents menu. A list of Internet Whois servers is also available via anonymous FTP to sipb.mit.edu, in the pub/whois directory.

To start a search:

1. Type or select the name of an alternative Whois server or use the default server.
2. Type the username or text you wish to search for in the User field.
3. Choose the Whois button to start the search.

**Search Options**

Whois allows you to perform a comprehensive search or a more specific search. In general, searches are conducted in the way outlined below, but this may vary between Whois servers. Most Whois servers provide their own help files.

- **General search:** If you specify a string of alpha characters, Whois searches for a name, handle, or mailbox matching that string. For example, if you specify "Smith" in the user field, Whois searches for the name Smith, the handle (Smith) and the mailbox Smith@.

- **Name-only search:** Precede the name with a period. For example, if you specify ".Smith, Jane" in the user field, Whois searches only for the name Jane Smith (not for the handle or mailbox).

- **Handle only search:** Precede the handle with an exclamation point. For example, if you specify "!Smith" in the user field, Whois searches only for handle Smith, such as Smith College (Smith)

- **Mailbox only search:** Type the @ character after the name. For example, if you specify "Smith@" Whois searches for the mailbox Smith only, such as Smith@ CVR.COM

- **Group or organization entry search:** Type an asterisk as the first character. For example, if you specify *SRI-NIC, Whois searches for all users in that group entry.

- **Partial search, to find all entries starting with specific text:** After the text you want to search for type a dot or trail of dots. For example Robert... looks for all names preceding with the letters ROBERT, such as Robert, Roberts, Robertson.

**Note:** If there are a large number of members, it will take longer for the list to display. The Whois button remains dimmed until the full list is displayed.

If the User field is blank and the Whois button clicked, any Help or information files available from the directory specified in the Host field are displayed.

**Troubleshooting**

If you experience difficulties using the Whois application, refer to the following items:

- Verify that the installation and setup steps have been successfully completed.
- Use the Diagnose Connection option from the Help menu to verify connectivity to any remote system to which you want access.
- Verify that the Host is a Whois server. Note that not all Internet Hosts are Whois servers. Chameleon Whois provides the major Internet Whois server (rs.internic.net) in the Hosts drop-down list by default. A list of Internet Whois servers is available via anonymous FTP to sipb.mit.edu, in the pub/whois directory.
Alternatively, select the Whois Server list option from the online Help Contents menu option.
Chapter 40. Bind - Name Server

The Bind application provides name server functions as a Domain Name Server (DNS). You can specify multiple domains and a list of host names within each domain. Bind provides hostnames to IP address resolution according to the DNS protocol. DNS is used to administer host and domain names from a central location, which is simpler than maintaining a hosts file on each network host.

Name Server Setup

To specify a Domain, choose the Add button and type in the name of a domain (for example, netmanage.com) and choose the OK button. Choose the Save button at any time to save changes to the list of domains and any hosts defined for each domain. The saved information is in a standard format as a collection of files for each domain.

To add host definitions to a domain, select the domain and choose the Modify button. A dialog box appears with the domain name as the caption. You may add, modify, or delete individual host definitions. Choose the OK button when finished.

By choosing the Add or Modify button, a dialog box appears in which you can type the name of the host and its IP address. The name should not specify the full domain. For example, defining a host named howard resolves requests for both howard and howard.netmanage.com.
Troubleshooting

If you experience difficulties using the Bind application, refer to the following items:

- Verify that the installation and setup steps have been successfully completed.
- The Bind application must be running to respond to name server requests. You can place a copy of Bind in your Startup group to ensure this. You may run Bind minimized, as an icon.
- Verify that the domain server IP address is entered correctly in the system originating the name lookup request.
- Verify that the domain name and host name definitions are entered correctly in the Bind application.
Chapter 41. PC NetTime

PC NetTime is a client/server application that allows you to synchronize the time between your PC and any time server. As a client, you can use PC NetTime to automatically synchronize your PC's time with the server, or to update the time manually by selecting the update button. You can also set your preferences so that your PC NetTime will act as a server with which other PC NetTime clients can synchronize their PC's time.

Setting Up PC NetTime

To set up PC NetTime, take the following steps:

1. Choose the PC NetTime icon. A PC NetTime window similar to the following figure appears:

2. Select Preferences... from the Settings menu. A Preference dialog box similar to the following figure appears:
3. Select the desired options in the dialog box. The options are as follows:

Current Location: Specify the time zone where your PC is located. Using the drop-down list box, you can select the time zone according to its geographical area or its relationship to GMT (Greenwich Mean Time).

Host: Type or select the name of the time server with which you are synchronizing the time of your PC.

Port: Type or select the time server's port number. The default port is 37 (as defined in RFC 868).

Host Location: Specify the time zone where your host is located. Using the drop-down list box, you can select the time zone according to its geographical area or its relationship to GMT (Greenwich Mean Time).

Exit after Update: When you start PC NetTime it automatically updates or synchronizes the time of your PC with the specified host. Select the check box for the application to automatically exit after the update is completed.

Listen on port: Enables Time Services, which allows your PC to act as a server to PC NetTime clients. Other PC NetTime users can identify your PC as the host for synchronizing the time of their PCs.

Port number: Select or type the time server's port number that should be listened to for incoming time requests (if Time Services is enabled.)

4. When you have finished selecting the desired options, choose the OK button.

Updating and Getting Local and Host Times

You can easily update the local time or get the host time by using the Commands menu options or the Update and Get buttons. You should do this after making any changes in the Preferences dialog box.

Changing Between Analog Clock/Digital Clock

To change the clock's screen display choose Analog/Digital clock from the Settings menu.

Changing the Default Time Zones

An advanced user can create another timezone.ini file by copying and renaming the default file, then editing it to include the additional country and time zone. Each listed country is followed by the time difference from GMT. To expand the list, add the country and time difference in the same format. For example:

Hongkong=GMT+08:00

To change the default time zone file used:
1. Select the Time Zone... option from the File menu.

2. Select the desired file with the needed time zone specifications.

3. Choose the OK button.

**Automatic Startup**

Select the Run at Startup option from the Settings menu if you want the PC NetTime application to start automatically when Windows is started.

**Troubleshooting**

If you experience difficulties using the PC NetTime application, refer to the following items:

- Use the Diagnose Connection option from the Help menu to verify connectivity to any remote system to which you want access.
- Verify that the correct time zone has been set.
- Verify that a valid host is selected.
- Verify the time on the selected host.
- Verify the time zone of the selected host.
Chapter 42. Name Resolver

The Name Resolver application enables you easily to retrieve the IP address of a known host or the hostname of an IP address.

To find the IP address of a host, enter the host name in the IP Address or Hostname field and choose the Lookup button or press the Enter key.

To find the hostname of an IP address, enter the IP address in the IP Address or Hostname field and choose the Lookup button or press the Enter key.

If Name Resolver is able to locate what you are looking for, both IP address and host name are displayed. Otherwise, it will display a message stating why the host name or IP address cannot be found.

Troubleshooting

If you experience difficulties using the Name Resolver application, refer to the following items:

☐ Make sure that the installation and setup verification steps have been successfully completed.

Use the Ping application to verify connectivity to any remote system to which you want access.
Chapter 43. NISLookups

The NISLookups application, which uses the Network Information Service (NIS) protocol, displays information retrieved from NIS including map entries, domain and server names.

NIS maintains centralized network administrative information in tables or maps. You can select a map name from the map list or enter the name manually. Some of the more common NIS map names, such as host and password maps, are included in the list.

NIS domains consist of NIS clients and servers sharing common information. NIS clients request information from a domain, rather than from a server, thereby allowing dynamic server configuration completely transparent to the clients.

Looking Up Map Entries

To look up an NIS map entry, you must specify the map name in the Map field and key name in the Key field and choose the Lookup button. The corresponding map entry is then retrieved from NIS and displayed in the display window. For example, a host name and IP address can be retrieved.

Retrieving Entire NIS Maps

To retrieve an entire NIS map, specify the map name in the Map field and choose the Retrieve button. The entire map is retrieved from NIS and displayed in the display window. For example, you can retrieve a host map.

Retrieving NIS Domain Names

To retrieve the NIS domain name, select the Domain option from the Settings menu.
To configure the NIS domain name, use the Custom application. Refer to the chapter titled, Customizing Your Setup, in this manual for additional information on configuring the NIS client.

**Retrieving the Domain NIS Server Name**

You can retrieve the NIS server name for the domain by selecting the Server option from the Settings menu. Although a NIS domain may contain multiple NIS servers, only one server, the first to respond, is used.

**Troubleshooting**

If you experience difficulties using the NISLookup application, refer to the following items:

- Verify that the installation and setup verification steps have been successfully completed.
- Verify that an NIS domain has been specified in Custom. Contact your System Administrator for the NIS domain name. From a UNIX host, the domain name can be retrieved using the domain name command.
- Verify that an NIS server is serving the specified NIS domain. From a UNIX host, you can retrieve the server using the ypwhich command. The Portmapper application can be used to determine if the ypserv program is running on the NIS server.
- Verify communication with the NIS server using the Ping application.
- Verify that the NIS server resides on the same subnet as this machine.
Chapter 44. R-Commands

The R-Commands application lets you enter and execute the rcp (remote copy) and rsh (remote shell) UNIX commands in a Windows environment:

- **rcp** (remote copy) is a network version of the UNIX cp command. Use this command to copy files from one computer to another system on the network.
- **rsh** (remote shell) is a network version of the UNIX sh command. Use this command to establish a connection to a remote UNIX system and then execute a command on that system.

Both the rcp and the rsh commands eliminate the need to first log in to a remote system. Passwords are also bypassed, by creating "trusted" Hosts or User names, avoiding the need to send passwords over a network. Therefore, you may find these commands more convenient to use than the standard UNIX cp and sh commands.

The commands you enter can be executed immediately or saved for later use. Save commands if you want to add them to a Command Profile or execute them later. Similar to a batch file, a Command Profile is a series of rcp and rsh commands that are executed one after the other. Like the commands, a Command Profile can be executed immediately or saved and then executed later.

Setting Up R-Commands

**Note:** "Local user" refers to the user entering the R-commands.

"Remote user" refers to the user connected to the UNIX system where the command will be executed.

Entries in UNIX /etc/hosts.equiv and .rhosts files determine whether the Local user is permitted to access a Remote user's login account. These files define all Local user names and their host (machine) names that are allowed to access the remote login account. You may edit these files. They are plain text files with the entries in the following format:

```
hostname <space> username
hostname <space> username
```

Where -

"hostname" is the name of the UNIX or PC Host from which the rcp/rsh will be performed

"username" is the Local user, who is granted the right to access this account/s and to perform any rcp/rsh commands using this account.
Adding an entry into the UNIX /etc/hosts.equiv file allows the Local user access to all login accounts on that host.

Adding an entry into the .rhosts file allows the Local user access only to this specific account. The file, belongs to the Remote user's login account and resides in the user's home directory, with the other "." (dot) files. The owner of the specific login account may need to create the .rhosts file.

If the Local user's name does not appear in either of these files, access to the remote login account will be denied.

To set up R-Commands, do the following:

1. Choose the R-Commands icon.

2. Choose Preferences... from the Settings menu. A Preferences dialog box similar to the following appears:

3. In the UserName field, type your user name.

4. In the Working dir field, specify the directory from which you want to take and/or place files. Choose the Working dir button to browse through the directories.

5. If desired, specify one or both of the Confirm On options:
   - Select the File Replace option to confirm when a file replaces an existing local file.
   - Select the List box selection delete option to confirm the deletion of a command in the command list selection region.
By default both the Confirm On options are selected.

6. Choose the OK button.

**Entering rcp Commands**

The rcp command lets you copy files or directories between two systems on the network. Use the rcp command to copy files or directories from:

- your local computer to a remote system
- a remote system to your local computer
- one remote system to another remote system

To enter an rcp command, do the following:

1. Choose the Build... option from the Commands menu.
2. Choose the RCP tab. A dialog box similar to the following appears:

   ![RCP dialog box]

3. In the Description field, type a name for the command you are entering.
4. Select a direction from the Transfer direction file drop-down list.

The Transfer direction selection determines which fields (From and To) must be specified:

- local to remote transfer: specify only the To fields
- remote to local transfer: specify only the From fields
- remote to remote transfer: specify both sets of fields

5. To define the From field, do the following:

   - In the From Name field, select or type your username for the machine from which you plan to copy the file.

   The Username you entered when setting up R-Commands is listed in the drop-down list.
• In the From Host field, select or type the name of the host on which the file or directory you want to copy resides.

If you plan to copy a file or directory from a remote system, include a backslash (\), quotation mark ("), or apostrophe (') in the remote host's pathname. This ensures the metacharacters of the remote system are interpreted remotely.

• In the From File field, enter the name of the file or directory you want to copy.

For a local PC, the machine on which your working directory is located is the default. You specify your working directory as discussed in "Setting Up R-Commands."

6. To define the To field:

• In the To Name field, type the username assigned to you on the host to which you want to copy the file or directory.

• In the To Host field, select or type the name of the host to which you want to copy the file or directory.

Note: If you plan to copy a file or directory to a remote system, include a backslash (\), quotation mark ("), or apostrophe (') in the remote host's pathname. This ensures the metacharacters of the remote system are interpreted remotely.

• In the To File field, enter the file or directory to which you want to copy.

For local connection you can choose the browse button to help you locate and select the desired file.

7. If desired, specify either or both of the rcp command options.

• Select the -r (copy each subtree) check box to copy any subdirectories rooted at the directory of the original file.

• Select the -p (attributes) check box to assign the original file's modification time, access time and modes to the duplicate file.

8. Choose the OK button to save the command to the commands list so that later you can execute it or add it to a Command Profile.

9. Choose the Run button to execute the command immediately without saving it to the commands list.

**Entering rsh Commands**

The rsh command establishes a remote host connection and executes a specified UNIX command or a batch file containing multiple UNIX commands. Output from rsh is displayed in the R-Commands window's output region unless you redirect the output to a file.
To enter an rsh command, do the following:

1. Choose the Build... option from the Commands menu.

2. Choose the RSH tab. A dialog box similar to the following appears:

   ![RSH Dialog Box]

3. In the Description field, type a name for the command you are entering.

4. In the Shell command field, type the UNIX command you plan to execute on the remote host. For example, the ls UNIX command lists directories. For details on UNIX commands, see your UNIX documentation.

   The From Name, Host and File fields are inapplicable, and therefore dimmed.

5. In the To Name field, type the username assigned to you on the host to which you want to establish a connection.

   In the To Host field, select or type the name of the remote host to which you want to establish a connection.

   Type the file's complete pathname in the Output field to send output to a file rather than display it in the R-Commands window's output region. Select the local path check box to send an output to a local file. Selecting the local path check box enables the browse button, to help you locate and select the file.

6. If you redirect output to an existing file and want to overwrite that file's contents, select the rewrite an existing file check box.

   **Note:** If the rsh command causes conflicts between rsh and the shell on the remote host, select the -n option. This redirects the input of rsh to /dev/null.

7. Choose the OK button to save the command to the commands list, so that later you can execute it or add it to a Command Profile.

8. Choose the Run button to execute the command immediately without saving it to the commands list.
Creating Command Profiles

Command Profiles, which are similar to batch files, contain a set of rcp and rsh commands that are executed in a series. Create a Command Profile using the rcp and rsh commands that were previously saved to the commands list.

You can execute a Command Profile immediately after you create it, or you can save it to the commands list, in the main window, and execute it later. The commands are executed in the order they are listed in the profile.

To create a Command Profile, do the following:

1. Choose the Build... option from the Commands menu.

2. Choose the Profile tab. A dialog box similar to the following appears.

3. In the Description field, type a name for the Command Profile you are creating.

4. Add commands to the Profile commands box in the order in which you want them executed. To do so, select a command in the List of commands box and a command in the Profile commands box. Then do one of the following:
   • Choose the Before button to add the command before the one currently selected in the Profile commands box.
   • Choose the After button to add the command after the one currently selected in the Profile commands box.

You can delete a command from the profile by selecting the command in the Profile commands box and then choosing the Delete button.

5. After you have added all desired commands to the profile, perform one of the following operations:
   • Choose the OK button to save the profile to the commands list so you can execute it later.
   • Choose the Run button to execute the profile immediately without saving it to the commands list.
The bottom status bar displays details about the highlighted command.

**Executing Commands List Items**

To execute commands or Command Profiles previously saved to the commands list do the following:

1. Select the desired command or profile from the R-Commands window’s commands list.

   ![Command List Image]

2. Choose the Run button, or double click the command.

   An executed command or Command Profile's output is displayed in the output region of the R-Commands window. You can copy this information to another application, delete it or print it.

   To copy the information to the clipboard, select it and choose the Copy option from the Edit menu. You can then copy the information from the clipboard to another application.

   To delete the information displayed in the output region, choose the Clear Buffer option from the Edit menu.

   To print the information, select it and then choose the Print... option from the File menu.

**Modifying Commands or Command Profiles**

You can modify a command or Command Profile by performing either of the following operations:

- Select a command and edit it in the Command field of the R-Commands window.
- Select it from the commands list and then choose the Modify... option from the Commands menu. A Modify dialog box appears. This dialog box contains the same fields as the Build dialog boxes. For details on a command or profile’s fields, see the previous section in this chapter that discusses that command or profile.
Deleting Commands or Command Profiles

To delete a command or Command Profile from the R-Commands window's commands list do the following:

1. Select the command or profile from the commands list.
2. Select the Delete option from the Commands menu.

Stopping Command Profiles

You can stop a Command Profile while it is running.

To stop a Command Profile while it is running select the Abort option from the Commands menu.

Troubleshooting

If you experience difficulties using the R-Commands application, refer to the following items:

- Verify that the installation and setup steps have been successfully completed.
- Use the Diagnose Connection option in the Help menu to verify connectivity to any remote system to which you want access if a failure to connect is reported.
- Interactive programs such as word processors and spreadsheet programs should not be run in R shell.
- Make sure you only copy individual files and not entire directories from Local to Remote Hosts (including use of the -r or *. commands).
Chapter 45. NEWT and SNMP

When you use any Chameleon application, an icon representing the NEWT TCP/IP kernel appears on the screen. The NEWT application permits you to view information about the current network interfaces. The NEWT application must be running for network connectivity to be enabled. It cannot be terminated explicitly, but exits automatically when the last Chameleon application exits. NEWT provides information through a set of dialog boxes which you can display by choosing the NEWT icon.

Note: You can minimize the NEWT application with many open dialog boxes and it will minimize all the dialog boxes as well. When the NEWT application is restored, all dialog boxes reappear as they were prior to being minimized.

Network Statistics

The Statistics menu consists of selections for all network protocol layers (Interface, ARP, IP, ICMP, UDP, TCP and SNMP). The following tables describes the type of statistics each protocol level displays.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Types of Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Ethernet board statistics</td>
</tr>
<tr>
<td>ARP</td>
<td>Address lookup statistics</td>
</tr>
<tr>
<td>IP</td>
<td>IP address statistics</td>
</tr>
<tr>
<td>ICMP</td>
<td>IP management protocol statistics</td>
</tr>
<tr>
<td>UDP</td>
<td>Datagram statistics</td>
</tr>
</tbody>
</table>
### Protocol Types of Statistics

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Types of Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP</td>
<td>Connection oriented statistics</td>
</tr>
<tr>
<td>SNMP</td>
<td>Network Management protocol statistics</td>
</tr>
</tbody>
</table>

The Interface statistics are displayed for the currently selected interface. Double-clicking on a particular interface entry also displays the Interface statistics dialog box. Each menu selection displays a dialog box with statistic values for that protocol. Each of these dialog boxes can be set to update values every second, by pressing the Start button. Further updates can be prevented by pressing the Stop button (which appears after you have pressed the Start button). The Reset button can be used at any time to reset the statistics values to zero for that window.

### Network Tables

The Tables menu consists of selections for all network protocol tables (ARP, route, socket, Gateway and DNS, and SNMP).

- The ARP table displays the current mapping of IP addresses to physical addresses and any defined Frequent Destinations.
- The Route table displays the current set of route entries corresponding to all local interfaces, static route entries, and the default gateway, if specified.
- The Socket table displays the currently open sockets, as well as their connections and states. There is always at least one socket entry used by the NEWT application.
- The Gateway and DNS table provides a view of the current default gateway, as well as the DNS (Domain Name Server) IP addresses. The default gateway specifies the machine that will accept and route packets destined for other networks. The IP address of a DNS and up to two alternatives may be specified.
- The SNMP table provides a view of currently active agents with their corresponding Enterprise ID. The Enterprise ID is a unique identification number given by the Internet registration to organizations who request an ID for purposes of defining SNMP MIBs. This is done to ensure the uniqueness of all managed objects for SNMP. NetManage's Enterprise ID is 233.

### Using the SNMP Protocol

SNMP is the Simple Network Management Protocol that allows TCP/IP Managers to manage Agents over the network.

ChameleonNFS offers an extensible SNMP agents that greatly extend the capabilities of SNMP-based management applications. SNMP is a standard feature of ChameleonNFS and requires no additional base memory space.
Several SNMP agents are provided with ChameleonNFS. The main MIB agent (Management Information Base) is known as MIB-II, which is the industry standard for managing the TCP/IP protocol suite. In addition, ChameleonNFS includes an enterprise MIB for managing Windows desktops. For example, this NetManage MIB can provide information about DOS and Windows versions or about software currently running on the workstation. Additional agents written by NetManage or other developers can be registered with SNMPD and easily become part of your managed PC.

Setting UP SNMP

When you use the SNMP for the first time, you need to enter the following:

- Host administration information
- Trap information
- Community setting information

This information will be available to management systems that support MIB-II.

Host Administration Information

In order to personalize your workstation, you need to enter information that describes it. This information is part of the "system" group of MIB-II, and includes the following:

- your name
- administrative contact regarding this workstation
- location where the workstation resides

To enter the host administration information, do the following:

1. Choose the NEWT icon.
2. Choose the Host Administration... command from the SNMP menu..
3. Enter your name, the name of an administrative contact for this workstation, and the location where the workstation resides.
4. If desired, select the Generate Traps option, and choose the OK button.
**Trusted Managers Information**

The Trusted Managers option allows you to assign special permissions to an SNMP manager. Special permissions include, for example: the ability to launch applications.

1. Choose the NEWT icon.
2. Choose the Trusted Managers... command from the SNMP menu.
3. Enter the node IP address or name from the list of SNMP managers provided in the field.
4. Choose the OK button.

**Trap Administration Information**

The trap administration option allows you to determine which destinations receive notification from an SNMP agent. To enter trap administration information, do the following:

1. Choose the NEWT icon.
2. Choose the Trap Administration... command from the SNMP menu.
3. Enter the default destination to where SNMP agent notification will be sent.
4. If desired, select additional preferences and choose the OK button.
Community Information

The Community... option allows you to enter the community string you want to apply to the Get and Set receipt operations. When you do not enter community field information, the community is not checked and any message is accepted. To enter Community information, do the following:

1. Choose the NEWT icon.
2. Choose the Community... command from the SNMP menu.
3. Enter the string you want to apply in the Get and Set fields.
   Many systems use a community of "public" for Get and "private" for Set. Note that the text you enter in each field is case sensitive and your selections are saved encrypted in the configuration file.
4. Choose the OK button.

This personalized information is now included in the administration portion of the MIB-II in your agent.
Chapter 46. Diagnostic Center

The Diagnostic Center is comprised of the Trace Agent, which is a Windows-based SNMP application that performs packet capture of every TCP/IP packet that goes in and out of your PC. When a trace is created, it becomes available for detailed packet analysis. The analysis can be performed by sending the files to NetManage Technical Support for diagnosis or by using the NEWTTrace application.

You can activate the Diagnostic Center one of the following ways: locally or remotely.

- Locally - by the user. Choose the Trace Agent icon to display the pop-up menu, and select the Start option. Later, when you select Stop, it prompts you for a filename to which you want to write the trace. This file may then be analyzed by the NEWTTrace application.

- Remotely - by a manager/support engineer who may need this data for troubleshooting/analysis. When activated remotely it complies fully with Remote Monitoring (RMON).

RMON is an industry standard definition for network information collected remotely by any SNMP (Simple Network Management Protocol) based system.

RMON is widely accepted as the standard for performing remote functions such as trouble shooting, performance monitoring, and accounting. Using RMON insures compatibility with the widest range of management devices.

NEWTTrace is part of NEWTWatch, which is a separate administrative Desktop Management Package offered by NetManage. It performs full protocol decoding. It
takes its input from any trace collected by the Trace Agent present in the Chameleon, or any other RMON-compliant device.

It is especially useful for developers of network applications, and administrators performing protocol and application troubleshooting.
Chapter 47. Internet Relay Chat

Internet Relay Chat (IRC) is a multi-user, multi-channel chatting network. It lets people connected to the Internet talk to one another in real-time. Conversations take place in areas called channels. A channel is a separate and distinctive electronic meeting area where people can talk simultaneously. There can be any number of channels in IRC, and any number of people within a channel. Some channels exist all the time, while others come and go as the need arises.

Each channel usually has at least one operator, who is responsible for managing the channel. Channel operators control the channel and have special privileges to maintain it. The initial creator (and the first person) of a channel has channel operator privileges and can give or take away these privileges to others on the channel.

Users are known by a nickname. This nickname must be unique on the network at the time and is limited to nine characters. Nicknames are really not owned because you may find your normal nickname in use the next time you connect to IRC, and will be asked to use another nickname for that session.

While on a channel, all normal text that you enter goes to the channel for all others to see. The one exception to this is if the text starts with a slash. A slash means the text that follows should be interpreted as a server command.

The IRC server that you connect to defines what network you are on. There is one main network often referred to as EFFNET. EFFNET usually hosts about 2500 channels with up to 5000 people at peak times. Other networks have improved the servers in varying ways and have fewer members (examples include UNDERNET and DALNET). Volunteers, usually at colleges and universities, operate and maintain these networks of servers. These networks are not secure; do not assume any form of privacy.

**Connecting to IRC**

To start the IRC application, choose the IRC icon to display the main IRC window.
There are two types of tabs: a Server tab and a Channel tab. There is only one Server tab, which has two main text areas. The top text area, the Server Information box, is where server output is displayed. This area can also contain error messages if local operations fail. The bottom text area, the Channel box, lists the current channels on the connected server. It displays the channel name, the number of users on the channel, and the topic.

There are as many channel tabs as there are channels that you have joined (the maximum is ten). When you join a channel, a new channel tab is created and brought to the top. It contains a small text box on top with the topic and any status information, and a large area for the channel conversation text on the bottom.

To connect, do the following:

1. Select either the Connect! menu option on the menu bar or the Connect button on the Server tab to display the Information not found dialog box. This dialog box explains what information you must enter to connect to an IRC server as a first-time user.

2. Choose the OK button to display the User Preferences dialog box.
3. Under the User tab, enter your nickname in the Default nickname: field. This name can be nine characters or less.

4. Enter another nickname in the Alternate nickname checkbox if you want to automatically try another nickname when your default nickname is in use.

5. Enter your username if it is blank.

6. Enter your hostname. The local hostname is the actual machine name. The username and the local hostname might already be filled in if the IRC client can get this information from the local machine.

7. Enter a single line of text identifying yourself in the Description: field (this is optional).

8. In the “Away” text: field, enter a single line of text that will be sent to people when you are away from IRC, but still connected and someone sends you a private message. This is also optional.

9. When you have entered information in all these fields, choose the Server tab to display the Server Preferences dialog box.

10. Select a server from the list in the drop-down menu or enter one in this field.

11. Leave 6667 as the port number unless you know a server uses a different port number.
12. The Current server list from file field shows the default server network selection. Choose the Browse button to display the Select server list dialog box.

13. Select one of the server networks listed in the File Name: field, then choose the OK button. The Current server list from file field is then updated with the network server that you have selected.

14. Select the Connect button on the Server tab or the Connect! menu option. After connecting, the Server Information box shows the following information:

- The number of IRC users
- The number of channels being used
- Other information that the server may send

After connecting, the Channel List box shows the following information:

- The Channel column shows the names of channels in use.
- The Users column shows the number of users on that channel.
- The Topic column describes the subject being discussed and may be blank.

**Note:** Your currently used nickname now appears in the Nickname: field.

From here, you can browse the channel list, join a channel, or create a new channel.
Setting Preferences

To set Preferences, do the following:

1. Select the Settings menu, then choose the Preferences... command to display the Preferences Options dialog box.

2. Select the Misc tab to display the Misc Preferences dialog box.

3. If you do not want to be on the list of current users, choose the Invisible to other users checkbox.

4. To automatically connect to a server after startup, choose the Automatically connect to server on startup checkbox. Select this setting to enable automatic connection to your IRC server the next time you start IRC.

5. To automatically enlarge your window to the largest possible size after startup, choose the Automatically maximize window on startup checkbox.

6. To automatically retrieve the channel list after startup, choose the Automatically retrieve channel list on connect checkbox. This is the default.

7. If you want to join a specific channel or channels automatically after startup, enter the channel name or names, separated by commas in the Auto-load channel(s): field.

8. Choose the OK button when you are done. The changes will take effect in your next IRC session.

Creating a New Channel

To create a new channel, do the following:

1. From the IRC window, select the Create.. button to display the Create Channel dialog box.
2. In the Channel Name: field, enter the new channel name, beginning with a pound sign. Channel names are not case sensitive and cannot contain spaces or commas. You can create up to 10 channel tabs. If the channel you enter already exists, IRC treats it as if you were joining the channel.

3. In the Topic: field, enter the new topic name.

4. If you do not want your channel name to be listed, choose the Private (listed as "PRV" without topic) checkbox.

5. If you do not want any channel information to be listed, choose the Secret (not listed at all): checkbox. Use this selection for privacy.

6. If you want to give permission to talk to other users, choose the Moderated: checkbox.

7. If you want to reserve the right to change a channel topic, choose the Topic can only be changed by channel operator: checkbox.

8. If you want to let other users join your new channel only by invitation, choose the Invite Only: checkbox.

9. If you do not want messages directed to the channel (from outside the channel) to appear, choose the No messages to channel from outside: checkbox. Use this selection as another level of privacy.

10. To limit the number of users on a channel, choose the Limit number of users to: checkbox and enter the number you want.

11. To limit the number of users by requiring a password to join a channel, choose the Use a channel key (password): checkbox and enter the password.

12. Choose the OK button when you are done.

For example, if you have created a new channel named #chameleon, a new channel tab is created and added to the tab list, following the Server tab.
**Using IRC**

To join an existing channel, from the Server tab, select the channel and choose the Join button. The channel tab of the channel you joined appears after the Server tab.

To leave the channel you are using, from the Channel tab, choose the Leave button. The channel tab then disappears.

To view a list of channel members, from the Server tab, choose the List Members... button to display the List of members dialog box.

After reviewing the list, choose the OK button.

To change nicknames, do the following:

1. From the Toolbar, choose the Nickname: button to display the Change nickname: dialog box.
2. Enter the new nickname in the New nickname: field, then choose the OK button. This change is temporary and is only in effect during the current session. All member lists and channels are updated when you change your nickname.

The WhoIs..?, Ignore, and Set Topic buttons are enabled even if you are not the channel operator.

The Mode, Invite, Kick, and Ban buttons are only enabled if you are a channel operator.

**Caution:** Preceding a message with a slash sends the message directly to the server as a command. Do this only if you are an experienced IRC user.

**Entering a Message and Getting Member Information**

To enter a message into the channel, do the following:

1. Enter the text in the Prepare your message here: field.

2. When you are done, choose the Send button or press the Enter key. The message appears in the Output column so that all users can see it.

To get information about a member on the channel, select a username in the Member column and choose the WhoIs...? button to display the User Information dialog box.

![User Information Dialog Box](image)

This dialog box shows the nickname, username, description, server connected to, idle time (how long the member has not typed on the keyboard) and lists all the channels the user belongs to.

**Note:** To get information on anyone using the IRC server, select the WhoIs? command in the Member menu instead of the WhoIs? button in the IRC window.

To get information about a previous user who has disconnected from IRC, do the following:

1. From the Member menu, select the WhoWas...? command to display the Who was...? dialog box.
2. Enter the nickname of the user you want information about, then choose the OK button. Check the Server Information box for a response to this request.

To prevent receiving messages from a specific user, do the following:

1. From the Channel tab, select the member from the Members: column, then choose the Ignore button to display the Ignore nickname: dialog box.

2. Enter the nickname of the user that you do not want to receive messages from in the Nickname to ignore: field, then choose the Add button.

3. To remove users from this list, choose the Remove button. When you have finished adding or deleting nicknames, choose the Done button.

To set a new topic, do the following:

1. From the Channel tab, choose the Set Topic button to display the Set new topic dialog box.

2. Enter the new channel topic, then choose the OK button. The output column shows the updated topic.

Using Filters

To show a range of the number of members on a channel, use filters. An x in the Filter checkbox indicates that filters are enabled for this session.
To add filters, do the following:

1. From the Server tab, select the Filter button to display the Filter/Search Channels dialog box.

2. Enter a number in the Min: and Max: checkboxes to define a range of users.

3. To search for text in a channel name, enter the text in the Text to match: field, then choose the OK button or press the Enter key.

To remove all filters, select the Remove filters button in the Filters/Search Channels dialog box, then choose the OK button.

**Changing and Updating Topics, Users, and Channels**

To change channel modes, do the following (only if you are a channel operator):

1. Choose the Mode button to display the Change channel modes dialog box.

2. See the Creating a New Channel section for information on how to complete the fields in this dialog box.

In the Channel column, select the right mouse button to display the following popup menu:

   Get Channel List (or refresh)
   
   Filter...

- Choose the Get Channel List (or refresh) command within the channel list to refresh and update the channels, users, and topics for all channels that exist on the server.
- Choose the Filter... command to redisplay the Filter/Search Channels dialog box and change your filter ranges.
From a channel tab, in the Output column, select the right mouse button to display the following popup menu:

<table>
<thead>
<tr>
<th>Pause scrolling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
</tr>
</tbody>
</table>

- Choose the Pause scrolling command to stop items added to the channel from scrolling up and out of view.
- Choose the Clear command to continue scrolling.

From a channel tab, in the Members: column, select the right mouse button to display the following popup menu:

<table>
<thead>
<tr>
<th>Who Is?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Give Ops</td>
</tr>
<tr>
<td>Take away Ops</td>
</tr>
<tr>
<td>Kick from channel</td>
</tr>
<tr>
<td>Ban from channel</td>
</tr>
<tr>
<td>Private message</td>
</tr>
</tbody>
</table>

- Choose the WhoIs? command to display current user information in the selected channel.
- Choose the Give Ops command to give operator rights to any user on the channel.
- Choose the Take away Ops command to take away operator rights from any user on the channel.
- Choose the Kick from channel command to remove a user from the channel.
- Choose the Ban from channel command to prevent a user from rejoining the channel.
- Choose the Private message command to send a private message to a specific member on the channel.

## Removing or Banning Users from a Channel

To remove a user from a channel, choose the Kick button. Any channel operator on that channel has these privileges. A message is displayed in the Output column, informing other members that a specific user has been kicked off the channel.

To prevent a user from rejoining a channel (Any channel operator on that channel also has these privileges.), do the following:

1. From the Channel tab, choose the Ban button to display the Ban dialog box.
2. Enter the name of the user in the Nickname to ban: field, then select the Add button. The Ban will be: field is updated with the name of the user you want to ban.

3. Select the Ban this user option to ban a single user.

4. Select the Ban this host option to ban all users from that user's host.

5. To remove a ban, select the nickname of that user from the Cancel ban: field, then choose the Remove button.

6. When you are finished adding or removing nicknames, choose the Done button.

**Disconnecting from IRC**

To disconnect from an IRC server, do the following:

1. Select either the Disconnect! menu option or the Disconnect button on the Server tab.

2. The Server Information box is updated and all channel tabs are removed, indicating that you are no longer connected.

**Troubleshooting**

- If you cannot connect to a server, do the following:
  - Make sure that a valid server name appears in Preferences on the Server tab. The port number is almost always 6667 unless otherwise instructed.
  - Select the Help menu and choose the Diagnose Connection.. command to see if you can ping the server.
  - Wait—sometimes the servers takes several minutes to respond.
  - You or your site has been banned from that server.

- If changes do not occur immediately after you make them, do the following:
  - Be aware that very busy servers may respond slowly.
  - Wait—you may not see a screen display change until the server confirms the action you performed.
If you made a change and nothing happened, do the following:

- A server may silently ignore an incorrect or redundant request. For example, if you try to set a mode on a channel that already has that mode, nothing happens and you receive no error messages.

- Check the Server Information box on the Server tab: it may have an error message displayed. Error dialogs do not appear because they may be out of order and confusing.

If you repeatedly get disconnected when you connect to a server, do the following:

- Check the server information box for any messages.

- Try changing your nickname or try another IRC server or another IRC network.

If you cannot join or create a channel, check the Server Information box on the Server tab. Perhaps the channel already exists and is Invite only, needs a keyword, has a user limit, or has banned you.

It is possible that the servers listed in the Current server list from file: field are no longer available. If you know the name of a valid IRC server, enter it in this field.
Appendix A. Windows for Workgroups

Note: This appendix is intended ONLY for users that are:

- installing ChameleonNFS to run in a Windows for Workgroups environment.
- installing ChameleonNFS on Windows for Workgroups using a third-party TCP/IP stack.
- using OEM Setup for Windows for Workgroups

Installing Windows for Workgroups

Generally, the Install application makes all the necessary changes to your configuration. However, if you are upgrading from Chameleon 3.11 or earlier, you may refer to this section for additional information. (You may also refer to this section to see a list of changes that have been made automatically to your configuration.)

The section includes separate headings, describing how ChameleonNFS is configured to coexist with each of the following:

- Windows for Workgroups version 3.11 over NDIS
- Windows for Workgroups version 3.11 over NDIS with no workgroups networking installed.
- Windows for Workgroups version 3.11 and Novell version 3.X shell/ODI or later.
- Windows for Workgroups version 3.11 and Novell version 3.X shell/ODI or later, with no workgroups networking installed.

Prerequisites

Before installing ChameleonNFS make sure that Windows for Workgroups is configured properly and all functions are operational. It is recommended that you upgrade to Windows for Workgroups version 3.11 from 3.10 or Windows 3.1 to have a successful install.

Over NDIS

This section describes configuring ChameleonNFS version 4.5 or later to coexist with Windows for Workgroups version 3.11 over NDIS.

Follow these steps:
1. Install Windows for Workgroups, version 3.11.

2. Install ChameleonNFS according to the installation instructions below:

**ChameleonNFS Installation Instructions**

Your ChameleonNFS product includes several diskettes.

**New Installation**

To install the product for the first time, start Windows in enhanced mode:

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.

2. Continue to insert the remaining diskettes when prompted.

   At this point, Setup will start Custom. The Custom application guides you through a customized configuration portion of your installation with a short series of dialog boxes, prompting you to make selections.

   Note that you will not be prompted for setting domain servers and entries for Host Table. You must manually define these names for name resolving.

3. Select the Save option from the File menu and exit the Custom application.

4. At the prompt, remove all diskettes and choose the OK button to reboot.

**Upgrade Installation**

To upgrade from a previous NetManage installation, start Windows in enhanced mode:

**Note:** Make sure that you do not have PROTMAN.DOS and NETMANAG.DOS drivers loaded in CONFIG.SYS. In addition, NETBIND and ODINSUP should be removed from the AUTOEXEC.BAT file.

Quit all Chameleon applications and any other TCP/IP applications.

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.

2. Continue to insert the remaining diskettes when prompted.

3. At the prompt, remove all diskettes and choose the OK button to reboot.

4. In case NFS was not installed or was installed improperly, do the following:
   - Choose the Network icon from the Control Panel icon.
Select the NetManage ChameleonNFS (all versions) from the list and choose the Install... button. This network is added to the list of Installed Networks.

Select Windows for Workgroups from the list and choose the Install... button and make it your default network.

Choose the OK button. The NEWT icon will appear on your screen.

The following files will be modified:

- AUTOEXEC.BAT
- WIN.INI
- SYSTEM.INI
- PROTOCOL.INI

**Verifying the Changed Files**

The automated Install program generally makes all the necessary modifications. If you experience any problems with these modifications, check these files as follows:

**File Name: AUTOEXEC.BAT**

**Modifications:** Adds NETMANAG to Path.

**Example:**

```
C:\WINDOWS\SMARTDRV.EXE
C:\WINDOWS\net start
PATH C:\NETMANAG;C:\WINDOWS;dos
SET TEMP=C:\WINDOWS\TEMP
```

**Note:** If a NETBIND statement exists from a previous installation of NetManage, you must remove it. The NETBIND functionality is performed by the NET START command provided by Windows for Workgroups.

**File Name: CONFIG.SYS**

**Modifications:** None

**Note:** Do not load the IFSHLP.SYS file into high memory.

There should not be a NETMANAGE.DOS device driver in CONFIG.SYS. Many of the drivers that were loaded from CONFIG.SYS previously, are now loading from the SYSTEM.INI file. See the example of the SYSTEM.INI file.

**File Name: WIN.INI**

**Modifications:** Adds [TCPIP] section

**Example:**

```
[TCPIP]
```
ID=XXX... (your encrypted serial number)
FILE=C:\NETMANAG\TCPIP.CFG
.
.
.

**Note:** You should create a pasted backup of the [TCPIP] section for future possible troubleshooting.

**File Name:** SYSTEM.INI

**Modifications:**

- uses MULT46.DRV as secondary network driver only for a new install, or as a primary network driver only for an upgrade
- updates boot description
- adds nmredir and NMTCPIP.386 in [386Enh] section
- changes [network drivers] section
- changes LoadRMdrivers value from No to Yes

**Example:**

```
[boot]
shell=progman.exe
secondnet.drv=C:\NETMANAG\MULT46.DRV
.
.
.
```

The installation of the MULT46.DRV driver as secondary network driver allows the user to run more than one network at the same time with Windows For Workgroups. Once the MULT46.DRV driver is loaded, it automatically loads additional drivers.

The following lines will be added to the [boot description] section:

```
[boot.description]
secondnet.drv=NetManage ChameleonNFS
.
.
```

The following lines will be added to the [386Enh] section:

```
[386Enh]
;BEGIN NetManage Modification.
device=c:\netmanag\nmtcpip.386
device=c:\netmanag\nmredir.386
```
In the [network drivers] section, the netmanag.dos driver is added to the transport line:

[network drivers]
netcard=elnk3.dos
transport=ndishlp.sys,c:\netmanag\netmanag.dos,*netbeui

Install changes the value for LoadRMDrivers line from No to Yes.

devdir=C:\WINDOWS
LoadRMDrivers=Yes

Note: Because the WFWNET.DRV driver is already loaded as the primary network (for a new install) in the SYSTEM.INI file, you must not attempt to reload it using the Control Panel Network.

File Name: PROTOCOL.INI

Modifications: Adds [netmanag] section

Example:

[network.setup]
version=0x3110
netcard=ms$elnk3,1,MS$ELNK3,3
transport=ms$nwlinknb,NWLINK
transport=ms$ndishlp,MS$NDISHLP
transport=ms$netbeui,NETBEUI
lana0=ms$elnk3,1,ms$nwlinknb
lana1=ms$elnk3,1,ms$ndishlp
lana2=ms$elnk3,1,ms$netbeui

[protman]
DriverName=PROTMAN$
PRIORITY=MS$NDISHLP

[NETMANAGE]
DRIVERNAME=netmng$
BINDINGS=MS$ELNK3

[MS$ELNK3]
DriverName=ELNK3$
Adapters=MS$ELNK3

[NWLINK]
BINDINGS=MS$ELNK3

[MS$NDISHLP]
DriverName=ndishlp$
BINDINGS=MS$ELNK3

[NETBEUI]
DriverName=netbeui$

<=== Inserted during Netmanage install
<=== network card section
SESSIONS=10
NCBS=12
BINDINGS=MS$ELNK3
LANABASE=1

Setting MULTILAN.DRV as a Primary or Secondary Network

When MULTILAN.DRV is used as the primary network, other networks can be installed through this application. The SECONDNET.DRV file in the SYSTEM.INI file becomes unnecessary and you can leave it blank in this case. Although this allows file sharing among installed multiple networks, some of the Windows for Workgroups networking features become disabled.

Applications such as Windows for Workgroups Mail, WinPopup and Windows for Workgroups printer sharing will not work if Windows for Workgroups is not configured as the primary network.

In ChameleonNFS version 4.5 and later, this problem is resolved if you configure MULTILAN.DRV as the second network. In this case Windows for Workgroups network redirector WFWNET.DRV can become the primary network and MULTILAN.DRV can be the secondary network. Other networks such as Novell can still be installed from the multilan application.

To configure MULTILAN.DRV as the secondary network, do the following:

1. Remove MULTXXX.DRV from the primary= statement in the boot section of SYSTEM.INI.

2. Install Windows for Workgroups networking from the Network Setup application in the Network program group of the Windows for Workgroups program manager.

3. Once Windows for Workgroups is properly installed, add the path to your MULTXXX.DRV to SECONDNET.DRV= parameter in the boot section of the SYSTEM.INI.

4. Modify your MULTILAN.CFG file in the directory where you have installed ChameleonNFS files.

5. If you used the Windows for Workgroups network via MULTILAN.DRV as the secondary network, then remove the "Install Windows for Workgroups network" statment from the Installed section in the MULTILAN.CFG file.

If this line exists in the MULTILAN.CFG file and you changed Windows for Workgroups to run as the primary network, and MULTILAN.DRV as the secondary network, your system crashes upon loading Windows.
The setup program, by default, configures MULTILAN.DRV as the secondary network for new installation of ChameleonNFS on a Windows for Workgroups configured system.

**Over NDIS with No Workgroups Networking Installed**

This section describes configuring ChameleonNFS version 4.5 or later to coexist with Windows for Workgroups version 3.11 over NDIS with no Workgroups Networking installed.

Follow these steps:

1. Install Windows for Workgroups, version 3.11.
2. Install ChameleonNFS according to the installation instructions below:

**ChameleonNFS Installation Instructions**

Your ChameleonNFS product includes several diskettes.

**New Installation**

To install the product for the first time, start Windows in enhanced mode:

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.
2. Continue to insert the remaining diskettes when prompted.
   
   At this point, Setup will start Custom. The Custom application guides you through a customized configuration portion of your installation with a short series of dialog boxes, prompting you to make selections.
   
   Note that you will not be prompted for setting domain servers and entries for Host Table. You must manually define these names for name resolving.
3. Select the Save option from the File menu and exit the Custom application.
4. At the prompt, remove all diskettes and choose the OK button to reboot.

**Upgrade Installation**

To upgrade from a previous NetManage installation, start Windows in enhanced mode:

1. Quit all Chameleon applications and any other TCP/IP applications.
2. To close the NEWT application:
   
   • Choose the Network icon from the Control Panel icon.
• Select NetManage ChameleonNFS (all versions) from the list of networks and choose the Remove... button. The NEWT icon will disappear from your screen.

3. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.

4. Continue to insert remaining diskettes when prompted.

5. At the prompt, remove all diskettes and choose the OK button to reboot.

6. In case NFS was not installed or was installed improperly, do the following:
   • Choose the Network icon from the Control Panel icon.
   • Select the NetManage ChameleonNFS (all versions) from the list and choose the Install... button. This network is added to the list of Installed Networks. You need to make this network your default network.
   • Choose the OK button. The NEWT icon will appear on your screen.

Verifying the Changed Files

The automated Install program generally makes all the necessary modifications. If you experience any problems with these modifications, check the following files:

- AUTOEXEC.BAT
- CONFIG.SYS
- WIN.INI
- SYSTEM.INI
- PROTOCOL.INI

File Name: AUTOEXEC.BAT

Modifications: Adds a line for NETBIND and adds NetManag to Path line.

Example:
C:\NETMANAG\NETBIND
C:\WINDOWS\SMARTDRV.EXE
PATH C:\NETMANAG;C:\WINDOWS;C:\Dos
SET TEMP=C:\WINDOWS\TEMP

File Name: CONFIG.SYS

Modifications: Adds NDIS driver

Example:
FILES=30
BUFFERS=30
LASTDRIVE=Z
DEVICE=C:\WINDOWS\HIMEM.SYS
DEVICE=C:\WINDOWS\SMARTDRV.EXE /DOUBLE_BUFFER
DEVICE=C:\WINDOWS\IFSHLP.SYS
STACKS=9,256
DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG
DEVICE=C:\NETMANAG\ELKNII.DOS
DEVICE=C:\NETMANAG\NETMANAG.DOS

File Name: WIN.INI

Modifications: Adds [TCPIP] section

Example:

[TCPIP]
ID=XXX... (your encrypted serial number)
FILE=C:\NETMANAG\TCPIP.CFG
.
.
.

Note: You should make a pasted backup of the [TCPIP] section for future possible troubleshooting.

File Name: SYSTEM.INI

Modifications:

- uses MULT46.DRV as primary network driver
- updates boot description
- adds nmredir.386 and nmtcpip.386 in [386Enh] section

Example:

[boot]
shell=progman.exe
network.drv=C:\NETMANAG\MULT46.DRV
.
.
.

The installation of the MULT46.DRV driver as primary network driver allows the user to run more than one network at the same time with Windows For Workgroups. Once the MULT46.DRV driver is loaded, it automatically loads additional drivers. Please refer to the chapter titled NFS -Network Drives for more information about multiple networks and MULT46.DRV functionality.

The following lines will be added to the [boot description] section:

[boot.description]
network.drv=NetManage ChameleonNFS
The following lines will be added to the [386Enh] section:

```
[386Enh]
;BEGIN NetManage Modification.
device=C:\netmanag\nmtcpip.386
device=c:\netmanag\nmredir.386
;END NetManage Modification
```

File Name:  PROTOCOL.INI

Modifications:  Adds [NETMANAG] section

```
[EtherLink3]
DRIVERNAME=ELNK3
[protman]
[NETMANAGE]
DRIVERNAME=netmng$
BINDINGS=EtherLink3
```

With Novell and Workgroups Networking

This section describes configuring ChameleonNFS version 4.5 or later to coexist with Windows for Workgroups version 3.11 and Novell 3.X or later running in the ODI environment.

Prerequisites

Before installing ChameleonNFS make sure that Windows for Workgroups is configured to run with Novell over ODI and all of the Novell and Windows for Workgroups functions are working properly. In particular, make sure that Novell's latest version of LSL.COM is loaded.

Note: We highly recommend installing the Novell network over ODI before installing the Windows for Workgroups.

Once the two networks, Microsoft Windows Network 3.11 and Novell NetWare (shell) are functioning properly over ODI, you can install ChameleonNFS. The new version of ChameleonNFS (4.5) will automatically detect the ODI and Windows For Workgroups environments and will make the necessary changes.

Follow these steps:

1. Install Windows for Workgroups, version 3.11.
2. Install ChameleonNFS according to the installation instructions below:
ChameleonNFS Installation Instructions

Your ChameleonNFS product includes several diskettes.

**New Installation**

To install the product for the first time, start Windows in enhanced mode:

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in Program Manager and type: `a:\setup`. Then choose the OK button.

2. Continue to insert the remaining diskettes when prompted.

   At this point, Setup will start Custom. The Custom application guides you through a customized configuration portion of your installation with a short series of dialog boxes, prompting you to make selections.

   Note that you will not be prompted for setting domain servers and entries for Host Table. You must manually define these names for name resolving.

3. Select the Save option from the File menu and exit the Custom application.

4. At the prompt, remove all diskettes and choose the OK button to reboot.

**Upgrade Installation**

Please refer the section titled, Setting MULTILAN.DRV as a Primary or Secondary Network, for detailed information about setting the MULTILAN.DRV as a primary or secondary network.

To upgrade from a previous NetManage installation, start Windows in enhanced mode:

**Note:** Make sure that you do not have PROTMAN.DOS and NETMANAG.DOS drivers loaded in CONFIG.SYS. In addition, NETBIND and ODINSUP should be removed from the AUTOEXEC.BAT file.

**Note:** Be sure to configure Windows for Workgroups for ODI before continuing.

1. Quit all Chameleon applications and any other TCP/IP applications.

2. To close the NEWT application:
   - Choose the Network icon from the Control Panel icon.
   - Select NetManage ChameleonNFS (all versions) from the list of networks and choose the Remove... button. The NEWT icon will disappear from your screen.

3. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in Program Manager and type: `a:\setup`. Then choose the OK button.
4. Continue to insert the remaining diskettes when prompted.

5. At the prompt, remove all diskettes and choose the OK button to reboot.

6. In case NFS was not installed or was installed improperly, do the following:
   - Choose the Network icon from the Control Panel icon.
   - Select the NetManage ChameleonNFS (all versions) from the list and choose the Install...button. This network is added to the list of Installed Networks.
   - Select Windows for Workgroups from the list and choose the Install...button. You need to make this network your default network.
   - Choose the OK button. The NEWT icon will appear on your screen.

The following files will be modified:

- NET.CFG
- AUTOEXEC.BAT
- WIN.INI
- SYSTEM.INI
- PROTOCOL.INI

**Verifying the Changed Files**

The automated Install program makes all the necessary modifications. If you experience any problems with these modifications, check these files as follows:

The following NET.CFG file was created by Windows for Workgroups when configured to support Novell NetWare. The ChameleonNFS added more settings to this file. The order of the Frame and Protocol statements is important.

Please refer to the Ethernet and IBM Token Ring examples below.

**NET.CFG**

```
#Ethernet Adapter
Link Driver 3C509
   Frame Ethernet_802.3
   Frame Ethernet_802.2
   Frame Ethernet_SNAP
   Frame Ethernet_II
   Protocol RARP 8035 ethernet_ii
   Protocol ARP 806 ethernet_ii
   Protocol IP 800 ethernet_ii
#IBM Token Ring Adapter
Link Driver TOKEN
   Frame TOKEN-RING
   Frame TOKEN-RING_SNAP
   Protocol IPX 80 TOKEN-RING
   Protocol IP800 TOKEN-RING_SNAP
```
The installation of ChameleonNFS will add the NMODI driver to the AUTOEXEC.BAT file. This driver allows ChameleonNFS to run on top of ODI.

**File Name: AUTOEXEC.BAT**

**Modifications:** Install makes the following changes to this file:

- Adds nmodi
- Adds netmanag to Path

**Note:** The Windows for Workgroups configuration should include the ODIHLPEXE driver in this file. While you are verifying the file, check also for the ODI driver.

**Example:**

```bash
C:\WINDOWS\net start
@ECHO OFF
PATH C:\NETMANAG;C:\WINDOWS;C:\DOS;C:\ODI
PROMPT=$p$g
C:\odi\lsl
C:\odi\3c509
                <== The ODI driver for your Network

Interface Card
C:\odi\ipxodi
C:\netmanag\nmodi
C:\WINDOWS\odihlp.exe
C:\odi\netx
                <== Added by the Install program
```

**File Name: CONFIG.SYS**

**Modifications:** None

**Example:**

```
FILES=30
BUFFERS=30
LASTDRIVE=Z
DEVICE=C:\WINDOWS\HIMEM.SYS
DEVICE=C:\WINDOWS\SMARTDRV.EXE /DOUBLE_BUFFER
DEVICE=C:\WINDOWS\IFSHLP.SYS
STACKS=9,256
```

**File Name: WIN.INI**

**Modifications:** Adds [TCPIP] section

**Example:**

```
[TCPIP]
```
ID=XXX... (your encrypted serial number)
FILE=C:\NETMANAG\TCPIP.CFG

Note: You should make a pasted backup of the [TCPIP] section for future possible troubleshooting.

File Name:  SYSTEM.INI

Modifications: Makes the following changes:

- Uses MULT46.DRV as secondary network driver only for a new install, and as a primary network driver only for an upgrade
- Updates boot description
- Adds nmredir.386 and nmtcip.386 in [386Enh] section

Example:

```
[boot]
secondnet.drv=C:\NetManag\mult46.drv
[boot description]
secondnet.drv=NetManage ChameleonNFS

The following lines will be added to the [386Enh] section:

[386Enh]
;BEGIN NetManage Modification.
device=C:\netmanag\nmtcip.386
device=c:\netmanag\nmredir.386
;END NetManage Modification.
```

Windows For Workgroups provides support for only two networks. In order to access Novell, Windows For Workgroups and ChameleonNFS at the same time, we install MULT46.DRV driver as the secondary network driver for a new install. MULT46.DRV remains a primary network for an upgrade

MULT46.DRV is the driver developed by NetManage for the support of multiple networks at the same time. By installing the MULT46.DRV driver as secondary network driver we allow the user to run more then two networks at the same time with Windows For Workgroups. Once the MULT46.DRV driver is loaded it will load additional drivers automatically.

Following is an example of a PROTOCOL.INI file.

Example:  PROTOCOL.INI

```
[network.setup]
```
version=0x3110
netcard=ms$odimac,1,MS$ODIMAC,4
transport=ms$nwlinknb,NWLINK
transport=ms$netbeui,NETBEUI
lana0=ms$odimac,1,ms$netbeui
lanal=ms$odimac,1,ms$nwlinknb
[net.cfg]
PATH=C:\WINDOWS\net.cfg

[MS$ODIMAC]
[Link Driver 3c509]
data=Frame Ethernet_802.3
data=Frame Ethernet_802.2
data=Frame Ethernet_SNAP
data=Frame Ethernet_II
data=Link Driver 3c509

[NWLINK]
BINDINGS=3c509

[NETBEUI]
BINDINGS=3c509
LANABASE=0
SESSIONS=10
NCBS=12

With Novell with No Workgroups Networking Installed

This section describes configuring ChameleonNFS version 4.5 to coexist with Windows for Workgroups version 3.11 and Novell 3.X or later running in the ODI environment, with no Workgroups networking installed.

Prerequisites

Before installing ChameleonNFS make sure that Windows for Workgroups is configured to run with Novell over ODI.

Note: We highly recommend installing the Novell network over ODI before installing the Windows for Workgroups.

Once Windows for Workgroups and Novell NetWare (shell) are functioning properly over ODI, you can install ChameleonNFS. The new version of ChameleonNFS (4.5) will automatically detect the ODI and Windows For Workgroups environments and will make the necessary changes.

Follow these steps:

1. Install Windows for Workgroups, version 3.11.
2. Install ChameleonNFS according to the installation instructions below:
ChameleonNFS Installation Instructions

Your ChameleonNFS product includes several diskettes.

New Installation

To install the product for the first time, start Windows in enhanced mode:

1. Insert the NFS diskette in the drive of your choice (a: in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.

2. Continue to insert the remaining diskettes when prompted.

3. At this point, Setup will start Custom. The Custom application guides you through a customized configuration portion of your installation with a short series of dialog boxes, prompting you to make selections.

   Note that you will not be prompted for setting domain servers and entries for Host Table. You must manually define these names for name resolving.

4. Select the Save option from the File menu and exit the Custom application.

5. At the prompt, remove all diskettes and choose the OK button to reboot.

Upgrade Installation

To upgrade from a previous NetManage installation, start Windows in enhanced mode:

Note: If you have ChameleonNFS version 3.11, make sure that you do not have PROTMAN.DOS and NETMANAG.DOS drivers loaded in CONFIG.SYS. In addition, NETBIND and ODINSUP should be removed from the AUTOEXEC.BAT file.

1. Quit all Chameleon applications and any other TCP/IP applications.

2. To close the NEWT application:
   - Choose the Network icon from the Control Panel icon.
   - Select NetManage ChameleonNFS (all versions) from the list of networks and choose the Remove... button. The NEWT icon will disappear from your screen.

3. Insert the NFS diskette in the drive of your choice (a: in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.

4. Continue to insert the remaining diskettes when prompted.

5. At the prompt, remove all diskettes and choose the OK button to reboot.
6. In case NFS was not installed or was installed improperly, do the following:

   • Choose the Network icon from the Control Panel icon.
   • Select the NetManage ChameleonNFS (all versions) from the list and choose the Install...button. This network is added to the list of Installed Networks. You need to make this network your default network.
   • Choose the OK button. The NEWT icon will appear on your screen.

The following files will be modified:

   • NET.CFG
   • AUTOEXEC.BAT
   • WIN.INI
   • SYSTEM.INI

**Verifying the Changed Files**

The automated Install program generally makes all the necessary modifications. If you experience any problems with these modifications, check these files as follows:

The ChameleonNFS installation will add more settings to the NET.CFG file. The order of Frame and Protocol statements is important.

Please refer to the Ethernet and IBM Token Ring examples below.

**NET.CFG**

**File Name:** #Ethernet Adapter

Link Driver 3C509

- Frame Ethernet_802.3
- Frame Ethernet_802.2
- Frame Ethernet_SNAP
- Frame Ethernet_I
- Protocol RARP 8035 ethernet_ii
- Protocol ARP 806 ethernet_ii
- Protocol IP 800 ethernet_ii

#IBM Token Ring Adapter

Link Driver TOKEN

Frame TOKEN-RING

Frame TOKEN-RING_SNAP

Protocol IPX E0 TOKEN-RING
Protocol IP 800 TOKEN-RING_SNAP
Protocol ARP 806 TOKEN-RING_SNAP
Protocol RARP 8035 TOKEN-RING_SNAP

The installation of ChameleonNFS will add the NMODI driver to the AUTOEXEC.BAT file. This driver allows ChameleonNFS to run on top of ODI.
File Name: AUTOEXEC.BAT

Modifications:

- Adds nmodi
- Adds netmanag to Path

Example:

@@ECHO OFF
PATH C:\NETMANAG;C:\WINDOWS;C:\DOS;C:\ODI
PROMPT=$p$g
c:\odi\1sl
c:\odi\3c509
<== ODI driver for your Network Card
c:\odi\ipxodi
c:\netmanag\nmodi
<== Added by the Install program
c:\odi\netx

File Name: CONFIG.SYS

Modifications: None

File Name: WIN.INI

Modifications: Adds [TCPIP] section

Example:

[TCPIP]
ID=XXX... (your encrypted serial number)
FILE=C:\NETMANAG\TCPIP.CFG

Note: You should make a pasted backup copy of [TCPIP] for possible future troubleshooting.

File Name: SYSTEM.INI

Modifications: Makes the following changes:

- Uses MULT46.DRV as primary network driver
- Updates boot description
- Adds nmredir.386 and nmtcip.386 in [386Enh] section

Example:

[boot]
network.drv=C:\NETMANAG\MULT46.DRV
[boot description]
network.drv=NetManage ChameleonNFS

The following lines will be added to the [386Enh] section:

[386Enh]
;BEGIN NetManage Modification.
device=C:\netmanag\nmtcpip.386
device=c:\netmanag\nmredir.386
;END NetManage Modification.

Using a Third-Party TCP/IP Stack

This section describes how to install ChameleonNFS on Windows for Workgroups with the Microsoft TCP/IP or other third-party stack option. If your system has a third-party stack, you can install ChameleonNFS with the NetManage stack or the third-party stack. However, you cannot run both stacks at the same time.

If you use any third-party stack, be aware that you will not be able to use the Custom, NFS, Ping, and Diagnostic Center applications. This is because these applications are directly tied to the NetManage TCP/IP stack.

New Installation with the Microsoft TCP/IP Stack

If you want to install ChameleonNFS with the Microsoft TCP/IP stack:

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the Run... option under the File menu in the Program Manager and type: a:\setup. Then choose the OK button.

2. A dialog box appears that says: Setup has detected an existing WinSock TCP/IP stack that reported the following information: Description, Version, System Status. Do you want to keep the existing stack? Choose the Yes button.

   Note: If you choose Yes, you will not be able to use the Custom, NFS, Ping, and Diagnostic Center applications.

3. Insert each diskette when prompted, and when finished choose the Continue button. Installation is complete at this time.

   Note: The NetManage WINSOCK.DLL, located in the directory where ChameleonNFS is installed, will automatically be renamed to WINSOCK.DL. No changes in the SYSTEM.INI file will occur.
New Installation Replacing Microsoft Stack with NetManage Stack

If you want to install ChameleonNFS and replace the Microsoft TCP/IP stack with the NetManage TCP/IP stack:

1. Select the Drivers... button to display the Drivers dialog box.
2. Select the Microsoft TCP/IP-32 3.11 option and choose the Remove button.
3. Choose the OK button in the Confirm dialog box. Choose the Close and then the OK buttons.
4. Additional messages appear telling you what files have been modified. Continue to choose the OK buttons until the Windows Setup dialog box appears.
5. Choose the Restart Computer button to reboot your machine.
6. After your machine has been rebooted, restart Windows.
7. Run Setup.

Note: Your SYSTEM.INI and WIN.INI files will automatically be changed by Windows for Workgroups when you remove the Microsoft stack.

New Installation with a Third-Party TCP/IP Stack

If you want to install ChameleonNFS with a third-party TCP/IP stack other than Microsoft TCP/IP stack:

1. Insert the NFS diskette in the drive of your choice (a: \ in this example). Select the Run... option under the File menu in Program Manager and type: a:\setup. Then choose the OK button.
2. Continue to insert the remaining diskettes when prompted.
   Note: Take note of the name of the backup file for SYSTEM.INI because you need to rename this backup file to SYSTEM.INI at Step 6.
3. At this point, Setup will start Custom. A dialog appears prompting you to define an interface. Choose the Cancel button.
4. Close the Custom application.
5. From the c:\NETMANAG directory (your install directory), rename WINSOCK.DLL to WINSOCK.DL.
6. Rename the backup file (mentioned in Step 2) to SYSTEM.INI.
All ChameleonNFS applications are now installed and can be run with your third-party TCP/IP stack.

**OEM Setup for WFW**

NetManage provides its own OEM (Original Equipment Manufacturer) support. For example, you may want to recover your original settings in the Network Setup dialog box after you install ChameleonNFS.

**OEM Setup for NDIS**

1. Choose the Network program group and then the Network Setup icon. The Network Setup dialog box appears.
2. Choose the Drivers... button to display the Network Drivers dialog box.
3. Choose the Add Protocol... button to display the Add Network Protocol dialog box.
4. Select the Unlisted or Updated protocol item and choose the OK button. The Install Driver dialog box appears.
5. Select the Browse... button to select the directory where you installed ChameleonNFS (default directory is C:\NETMANAG) and choose the OK button to display the Install Driver dialog box.
6. Choose the OK button to display the Unlisted or Updated Protocol dialog box. The NetManage ChameleonNFS network now appears on the Drivers list.
7. Choose the Close button. The Network dialog box appears.
8. Choose the OK button. The Network Setup dialog appears and choose the OK button again. Additional messages appear telling you what files have been modified. Continue to choose the OK buttons until the Network dialog box appears.
9. Choose the Restart Computer button to reboot your machine.
10. After your machine has been rebooted, restart Windows.

**Note:** The network settings in the SYSTEM.INI file are automatically restored to their original settings.

**OEM Setup for ODI**

1. Choose the Network program group and then the Network Setup icon. The Novell Netware dialog box appears.
2. Choose IPXODI.COM and LSL.COM (recommended) option and choose the OK button. The Network Setup dialog box appears.
3. Choose the Networks...button to display the Networks dialog box.
4. Select the Other option and scroll to select Unlisted or Updated Network and choose the OK button. The Install Driver dialog box appears.

5. Select the Browse... button to select the directory where you installed ChameleonNFS and choose the OK button. (default directory is C:\NETMANAG). The Install Driver dialog box appears.

6. Choose the OK button. The Unlisted or Updated Additional Network dialog box appears. The NetManage NFS Driver is highlighted in the Additional Networks list.

7. Choose the OK button. The Networks dialog box appears.

8. Choose the OK button. The Network Setup dialog appears and choose OK again. Additional messages appear telling you what files have been modified. Continue to choose the OK buttons until the Network Setup dialog box appears.

9. Choose the Restart Computer button to reboot your machine.

10. After your machine has rebooted, restart Windows.

Note: The network settings in the SYSTEM.INI file are automatically restored to their original settings.
Appendix B. Open Data-Link Interface (ODI)

Note: This appendix is intended ONLY for users that are using the Open Data-Link Interface (ODI) for Windows 3.1 or Windows for Workgroups without Workgroups networking.

Open Data-Link Interface (ODI)

This appendix applies to users who are using the Open Data-Link Interface (ODI) for Windows 3.1 or Windows for Workgroups without Workgroups networking.

The Open Data-Link interface (ODI) allows multiple network protocols to be used concurrently on a LAN adapter in a workstation on the network and is an alternative to NDIS. The components of ODI are:

- Network drivers: Multiple Link Interface Drivers (MLIDs) are device drivers that handle the sending and receiving of packets to and from a physical or logical LAN media.
- Link Support Layer (LSL): Novell's LSL handles the communication between protocol stacks and the network drivers (MLIDs)
- Protocol Stacks: Network Layer protocol stacks transmit and receive data over a logical or physical network.

Custom verifies that your system has LSL.COM running during setup time, and if so, automatically installs the version of the stack that supports ODI. After ODI is installed you can access a Novell Netware server, for example, as well as use Chameleon in Windows.

The three scenarios described in this section regarding ODI installation are:

- setting ODI manually (first time installation)
- switching from an NDIS environment to an ODI environment
- switching from an ODINSUP environment to an ODI environment

Setting ODI Manually

Follow this section if you are performing a first time installation.

- Follow steps 1 - 10 if you do not have ODI installed on your system and you are installing ChameleonNFS (new installation) for the first time.
Follow steps 7 - 10 if you have ODI on your system and are installing ChameleonNFS (new installation) for the first time.

Once your system is configured for ODI drivers, the ChameleonNFS installation will load the driver NMODI.COM in the AUTOEXEC.BAT file. This driver allows ChameleonNFS to communicate with the ODI drivers.

ODI Online Help File

Refer to ODI online help for additional information about the NMODI driver. The ODI online help file, named ODI.HLP, contains the following information: ODI driver requirements, a sample NET.CFG, advanced NET.CFG parameters, and troubleshooting tips.

Setting Up Your ODI Environment

The files mentioned in the following steps are contained on the Novell ODI diskette:

- LSL.COM
- LAN Driver for network board (for example, 3C503.COM)
- protocol stack file (for example, IPXODI.COM)

Note: Use the latest LSL.COM, IPXODI.COM, and NETX files from Novell before setting up your ODI environment.

1. At the DOS prompt, create a directory named C:\ODI.
2. Copy the LSL.COM, driver (3C503.COM for example), protocol stack files (IPXODI.COM), and Netware shell (NETX) to this directory.
3. Append the following lines to the end of the AUTOEXEC.BAT file:
   
   ```
   C:\ODI\LSL.COM
   C:\ODI\<LAN driver> (for example, 3C503)
   ```
   
   Optionally, you can add the following lines if you want to have the Novell IPX protocol stack:
   
   ```
   C:\ODI\IPXODI.COM
   C:\ODI\NETX
   ```

4. Create a NET.CFG file and place it in the C:\ODI directory. Refer to the sample file provided at the end of this appendix.

   A NET.CFG file is required to run both NetWare and ChameleonNFS concurrently.

   Caution: You need to know which NET.CFG file is used by the ODI environment (LSL). We suggest that you have only one NET.CFG file on your disk.

   To ensure smooth establishment of an ODI environment, refer to your network adapter vendor's ODI documentation.
5. Reboot your system.

6. If you are using Novell Netware and loaded Novell ODI drivers, then log onto your server using the appropriate account and password, and verify to see if you are connected to the server by using the WHOAMI command.

**Running Custom Application**

7. Start Windows.

8. Install ChameleonNFS (refer to your Quick Install Card).

You can tell when ODI-based ChameleonNFS is installed on your system by viewing the Setup menu on the Custom application. If the Hardware option is grayed out, then ODI is installed on your system and has been detected by the installation program.

When you are finished setting up Custom, select the Save option to save your configuration.

9. Custom automatically detects the location of the NET.CFG file and then modifies it.

If Custom cannot detect the NET.CFG file, a prompt appears asking you to enter its path. If you know the file's location, then enter its path and choose the OK button.

If you do not know the location of the NET.CFG file, then choose the Cancel button. Custom will automatically copy NetManage's sample NET.CFG file and place it at the root directory of drive C. Custom will also open a Window Help file that will give you information about NET.CFG.

**Note:** The NET.CFG file that NetManage supplies is only a sample file. Because user environments are configured differently, this sample file may or may not work with your configuration. There is an ODI online help file available that contains detailed information about the sample NET.CFG file. You can choose to view this help file when prompted for it.

10. Reboot your system.

**Switching from an NDIS Environment to an ODI Environment**

This section applies to users who are switching from an NDIS-based interface to an ODI-based interface. This section describes, step-by-step how to:

- upgrade your ChameleonNFS to version 4.6
- modify your configuration files in order to switch from an NDIS environment to an ODI environment

Follow these steps:

2. Install ChameleonNFS (upgrade installation) according to the instructions on your Quick Install Card.

3. After completing installation, reboot your system and do the following:
   - Start Windows and then choose the Network icon from the Control Panel icon.
   - Select NetManage ChameleonNFS (all versions) from the list of networks and choose the Remove... button. The NEWT icon will disappear from your screen.

4. From the CONFIG.SYS file, delete the lines:
   ```
   DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG
   DEVICE=C:\NETMANAG\ELNKII.DOS (or your card's driver)
   DEVICE=C:\NETMANAG\NETMANAG.DOS
   ```

5. Delete this line from the AUTOEXEC.BAT file:
   ```
   C:\NETMANAG\NETBIND
   ```

6. At the DOS prompt, create a directory named C:\ODI.

7. Copy the LSL.COM, Multiple Link Interface Driver (MLID) (3C503.COM for example), protocol stack files (IPXODI.COM), and Netware shell (NETX) to this directory.

8. Append the following lines to the end of the AUTOEXEC.BAT file:
   ```
   C:\ODI\LSL.COM
   C:\ODI\<LAN driver> (for example, 3C503.COM)
   ```
   Optionally, you can add the following lines if you want to have the Novell IPX protocol stack:
   ```
   C:\ODI\IPXODI.COM
   C:\ODI\NETX
   ```

9. Create a NET.CFG file and place it in the C:\ODI directory. Refer to the sample file provided at the end of this chapter.
   A NET.CFG file is required to run both NetWare and ChameleonNFS concurrently.
   **Note:** Make sure you add C:\ODI to your path statement in your AUTOEXEC.BAT file.

   To ensure smooth establishment of an ODI environment, refer to your network adapter vendor's ODI documentation.

10. Reboot your system.

11. Start Windows from the Program Manager, and select the Run entry from the File menu and enter the following:
    ```
    C:\NETMANAG\CUSTOM.EXE -o
    ```

12. Custom automatically detects the location of the NET.CFG file and then modifies it.
If Custom cannot detect the NET.CFG file a prompt appears asking you to enter its path. If you know the file's location, then enter its path and choose the OK button. If you do not know the location of the NET.CFG file, then choose the Cancel button. Custom will automatically copy NetManage's sample NET.CFG file and place it at the root directory of drive C.

Note: The NET.CFG file that NetManage supplies is only a sample file. Because user environments are configured differently, this sample file may or may not work with your configuration. There is an ODI online help file available that contains detailed information about the sample NET.CFG file. You can choose to view this help file when prompted for it.

13. Close Custom, reboot your system and do the following:

- Start Windows and choose the Network icon from the Control Panel icon.
- Choose the Add>> button. The Dialog box expands to include a list of available networks.
- Select NetManage ChameleonNFS (all versions) from the list and choose the Install... button. This network is added to the list of Installed Networks.
- Choose the OK button. The NEWT icon will appear on your screen.

Switching from an ODINSUP Environment to an ODI Environment

This section applies to users who are switching from an ODINSUP-based interface to an ODI-based interface.

Note: There is no need to keep the ODINSUP configuration with native ODI support. You may want to eliminate some extra layers, thus releasing more memory and increasing reliability.

1. Start Windows in the enhanced mode.

2. Install ChameleonNFS (upgrade installation) according to the instructions on your Quick Install Card.

3. When the installation is complete, delete these lines from the AUTOEXEC.BAT file:

   ODINSUP
   NETBIND

4. From the CONFIG.SYS file, delete the lines:

   DEVICE=C: \NETMANAG\PROTMAN.DOS /I:C: \NETMANAG
   DEVICE=C: \NETMANAG\NETMANAG.DOS

5. From the Program Manager, select the Run option from the File menu and enter the following:
6. Reboot your system.

Sample NET.CFG File

```plaintext
# # # # # # # # # # # # # # # # # # # # # # # # # # # #
# net.cfg
# NetManage, Inc. 05/11/95
#
# This net.cfg file is a working example and tested
# with NetManage TCPIP protocol stack (nmodicom/newt) and Novell IPX
# protocol stack (ipxodi/netx) simultaneously.
#
# In case a problem occurs:
#
# 1. Make sure there's no other net.cfg on your hard # disk.
#
# 2. In order for nmodi.com to load/run you need at # least the following
# entries in the appropriate LINK DRIVER section of NET.CFG.
# Ethernet Adapters:
# frame ethernet_ii
# Protocol IP 800 ETHERNET_II
# Protocol ARP 806 ETHERNET_II
# Protocol RARP 8035 ETHERNET_II
#
# TokenRing Adapters:
# Frame TOKEN-RING_SNAP
# Protocol IP 800 TOKEN-RING_SNAP
# Protocol ARP 806 TOKEN-RING_SNAP
# Protocol RARP 8035 TOKEN-RING_SNAP
#
# Please note that all ethernet sections are similar # as well as all
token-ring sections.
# # # # # # # # # # # # # # # # # # # # # # # # # # # #
Link Support
Buffers 8 4212 ; for token-ring
MemPool 4096
Max Stacks 8
#
# 3COM EtherLink III Adapter
Link Driver 3C509
Frame ETHERNET_802.3
Frame ETHERNET_II
Protocol IPX 0 ETHERNET_802.3
Protocol IPX 8137 ETHERNET_II
Protocol IP 800 ETHERNET_II
Protocol ARP 806 ETHERNET_II
Protocol RARP 8035 ETHERNET_II
#
# INTEL Ether Express Adapter
Link Driver EXP16ODI
Frame ETHERNET_802.3
Frame ETHERNET_II
Protocol IPX 0 ETHERNET_802.3
Protocol IPX 8137 ETHERNET_II
```

414 ChameleonNFS Installation and User's Guide
Protocol IP 800  ETHERNET_II
Protocol ARP 806  ETHERNET_II
Protocol RARP 8035  ETHERNET_II

#IBM Token Ring Adapter
Link Driver TOKEN
  Frame TOKEN-RING
  Frame TOKEN-RING_SNAP
  Protocol IPX E0  TOKEN-RING
  Protocol IP 800  TOKEN-RING_SNAP
  Protocol ARP 806  TOKEN-RING_SNAP
  Protocol RARP 8035  TOKEN-RING_SNAP

#IBM LAN Support Program
Link Driver LANSUP
  Max Frame Size 1514
  Frame TOKEN-RING
  Frame TOKEN-RING_SNAP
  Protocol IPX E0  TOKEN-RING
  Protocol IP 800  TOKEN-RING_SNAP
  Protocol ARP 806  TOKEN-RING_SNAP
  Protocol RARP 8035  TOKEN-RING_SNAP

#OLICOM Token Ring Adapter
Link Driver OCTOK16
  Frame TOKEN-RING
  Frame TOKEN-RING_SNAP
  Protocol IPX E0  TOKEN-RING
  Protocol IP 800  TOKEN-RING_SNAP
  Protocol ARP 806  TOKEN-RING_SNAP
  Protocol RARP 8035  TOKEN-RING_SNAP

#Madge Token Ring
Link Driver MADGRODI
  Frame TOKEN-RING
  Frame TOKEN-RING_SNAP
  Protocol IPX E0  TOKEN-RING
  Protocol IP 800  TOKEN-RING_SNAP
  Protocol ARP 806  TOKEN-RING_SNAP
  Protocol RARP 8035  TOKEN-RING_SNAP

# eof

ODI Troubleshooting

1. Make sure your system is running the latest version LSL and MLID. Usually manufacturers of network interface cards have the latest version of available MLID.

   Or, you can download them from Compuserve (GO NOVLIB), or from FTP.NOVELL.COM using FTP.

2. In case the NMODI driver fails to load, check the following:
   a) Make sure there is no other NET.CFG on your hard disk.
   b) In order for nmodi.com to load/run you need the following entries in the appropriate LINK DRIVER section of NET.CFG.
Ethernet Adapters:

```
frame ethernet_ii
Protocol IP     800    ETHERNET_II
Protocol ARP  806    ETHERNET_II
Protocol RARP  8035   ETHERNET_II
```

TokenRing Adapters

```
Frame TOKEN-RING_SNAP
Protocol IP     800    TOKEN-RING_SNAP
Protocol ARP  806    TOKEN-RING_SNAP
Protocol RARP  8035   TOKEN-RING_SNAP
```

- Please note that all Ethernet Link Driver sections are the same as well as all token-ring sections, independent of a particular MLID.

If your network media is Token-Ring and you have more than one ring, you may want to put the following line in your AUTOEXEC.BAT file before NMODI:

`C:\ODI\ROUTE BOARD=2`

- The board parameter insures that ROUTE.COM is bound to logical board TOKEN-RING_SNAP, which handles TCP/IP traffic. Refer to the Novell IPX documentation for more information about ROUTE.COM.
<table>
<thead>
<tr>
<th><strong>Glossary</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>access</strong></td>
</tr>
<tr>
<td><strong>account</strong></td>
</tr>
<tr>
<td><strong>address mask</strong></td>
</tr>
<tr>
<td><strong>ANSI</strong></td>
</tr>
<tr>
<td><strong>API</strong></td>
</tr>
<tr>
<td><strong>application</strong></td>
</tr>
<tr>
<td><strong>ARP</strong></td>
</tr>
<tr>
<td><strong>ASCII</strong></td>
</tr>
<tr>
<td><strong>authenticator</strong></td>
</tr>
<tr>
<td><strong>AUTOEXEC.BAT</strong></td>
</tr>
<tr>
<td><strong>Backup</strong></td>
</tr>
<tr>
<td><strong>Bind</strong></td>
</tr>
<tr>
<td><strong>Buffer</strong></td>
</tr>
<tr>
<td><strong>Client</strong></td>
</tr>
<tr>
<td><strong>Command Line</strong></td>
</tr>
<tr>
<td><strong>CONFIG.SYS File</strong></td>
</tr>
<tr>
<td><strong>Daemon</strong></td>
</tr>
<tr>
<td><strong>DLL</strong></td>
</tr>
<tr>
<td><strong>Default</strong></td>
</tr>
<tr>
<td><strong>Device Name</strong></td>
</tr>
<tr>
<td><strong>DNS</strong></td>
</tr>
<tr>
<td><strong>Domain</strong></td>
</tr>
<tr>
<td>Term</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td><strong>driver</strong></td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
</tr>
<tr>
<td><strong>Ethernet address</strong></td>
</tr>
<tr>
<td><strong>export</strong></td>
</tr>
<tr>
<td><strong>file access</strong></td>
</tr>
<tr>
<td><strong>file server</strong></td>
</tr>
<tr>
<td><strong>Finger</strong></td>
</tr>
<tr>
<td><strong>FTP</strong></td>
</tr>
<tr>
<td><strong>group Id</strong></td>
</tr>
<tr>
<td><strong>HLLAPI</strong></td>
</tr>
<tr>
<td><strong>host</strong></td>
</tr>
<tr>
<td><strong>host table</strong></td>
</tr>
<tr>
<td><strong>ICMP</strong></td>
</tr>
</tbody>
</table>
test can determine whether a destination is reachable and responding.

**IP**

The TCP/IP standard protocol defined as a unit of information passed across the Internet, providing the basis for packet delivery service. IP includes the ICMP control and error message protocol as an integral part. The entire protocol suite is often referred to as TCP/IP because TCP and IP are the two most fundamental protocols.

**IP address**

Internet protocol address. This is a 32-bit address assigned to host on a TCP/IP Internet. The IP address has a host component and a network component.

**IPX/link**

The IPX/link application for NetWare connects your PC Novell NetWare LAN through the Network Device Interface Specification (NDIS) developed by Microsoft and 3COM.

**log in**

To perform a sequence of actions at a terminal that establish a user’s communication with the operating system and sets up default characteristics for the user’s terminal session.

**log out**

To terminate interactive communication with the operating system, and end a terminal session.

**LPR/LPD**

Line Printer Remote/Line Printer Daemon. An application that allows you to print to network printers.

**Mail server**

A host and its associated software that offer electronic mail reception and forwarding service. Users may send messages to, and receive messages from, any other user in the system.

**MIB**

Management Information Base. The set of variables that a gateway running SNMP maintains.

**MIB-II**

An extended management database that contains variables not shared by SNMP.

**mount**

NFS user command that makes remote file systems and resources available to the local PC.

**NDIS**

Network Device Interface Specification. NDIS is used for all communication with network adapters. The specification was developed by Microsoft and 3COM to provide a common programming interface for MAC drivers and transport drivers. NDIS works primarily with LAN Manager and allows multiple protocol stacks to share a single network interface card.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBIOS</td>
<td>Network Basic Input/Output system. It provides a Session Layer interface between network applications running on a PC and the underlying protocol software of the Transport and Network Layers.</td>
</tr>
<tr>
<td>NETBUI</td>
<td>The NetBOIS Extended User Interface. This is the transport layer driver frequently used by LAN Manager.</td>
</tr>
<tr>
<td>NetWare</td>
<td>A network operating system developed by Novell.</td>
</tr>
<tr>
<td>network address</td>
<td>A unique number associated with a host that identifies it to other hosts during network transactions.</td>
</tr>
<tr>
<td>network printing</td>
<td>Printing to a shared printer locally attached to one of the PCs on the network.</td>
</tr>
<tr>
<td>NEWT</td>
<td>NetManage TCP/IP communication stack for Microsoft Windows. NEWT provides users a degree of network access previously only available to workstation and mainframe users.</td>
</tr>
<tr>
<td>NFS</td>
<td>Network File System. A protocol developed by Sun Microsystems that uses IP to allow a set of computers to access each other's file systems as if they were local. Originally designed for UNIX systems, this protocol has been implemented on many other operating systems, including DOS and Windows.</td>
</tr>
<tr>
<td>NIC</td>
<td>Network Information Center. The NIC at SRI in Menlo Park, California, assigns IP addresses and network numbers by request. The number assigned is appropriate to the number of host devices on the network.</td>
</tr>
<tr>
<td>PCNSD authenticator</td>
<td>A program that runs continuously and authenticates a user name and password before attempting to mount a network drive, access files, or print on the network.</td>
</tr>
<tr>
<td>Ping</td>
<td>The Packet Internet Groper is a program that is useful for testing and debugging networks. It sends an echo packet to the specified host, and waits for a response. It reports success or failure and statistics about its operation.</td>
</tr>
<tr>
<td>POP</td>
<td>Post Office Protocol. This protocol is used by the Mail application to provide electronic mail services.</td>
</tr>
<tr>
<td>prompt</td>
<td>Word or words used by the system to assist a user's response. Such messages generally ask the user to respond by typing some information in a supplied field.</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>RAM is random access memory.</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td><strong>remote</strong></td>
<td>Files, devices, and users not attached to your local machine.</td>
</tr>
<tr>
<td><strong>remote host</strong></td>
<td>The computer receiving a network command.</td>
</tr>
<tr>
<td><strong>remote printer</strong></td>
<td>In LPR/LPD, a printer with a special network card, or a PC or workstation.</td>
</tr>
<tr>
<td><strong>RFC</strong></td>
<td>Request For Comment. The RFC documents describe all aspects and issues associated with the Internet protocols.</td>
</tr>
<tr>
<td><strong>router</strong></td>
<td>A router has two or more network interfaces to different networks. The primary function of a router is to direct packets between these networks, delivering them to their final destination or to another router. When used with TCP/IP, the term refers to an IP gateway that routes data using IP destination addresses.</td>
</tr>
<tr>
<td><strong>RPC</strong></td>
<td>Remote Procedure Call. A mechanism defined by Sun Microsystems that provides a standard for initiating and controlling processes on remote or distributed computer systems.</td>
</tr>
<tr>
<td><strong>script</strong></td>
<td>A sequence of ASCII text lines stored in a file.</td>
</tr>
<tr>
<td><strong>server</strong></td>
<td>A computer that provides services to a network.</td>
</tr>
<tr>
<td><strong>SMTP</strong></td>
<td>Simple Mail Transfer Protocol. A protocol used by the Mail application to provide electronic mail services.</td>
</tr>
<tr>
<td><strong>SNMP</strong></td>
<td>Simple Network Monitoring Protocol. A standard protocol used to monitor network activity on &quot;agent&quot; nodes from management stations.</td>
</tr>
<tr>
<td><strong>subnet</strong></td>
<td>A field used by routers and hosts for routing packages on the network.</td>
</tr>
<tr>
<td><strong>subnet address</strong></td>
<td>An extension for the IP addressing that allows a site to use a single IP network address for multiple physical networks.</td>
</tr>
<tr>
<td><strong>subnet mask</strong></td>
<td>Identifies the subnet field of a network address. The subnet mask is a 32-bit Internet address written in dotted-decimal notation with all the 1s in the network and subnet portions of the address.</td>
</tr>
<tr>
<td><strong>TCP/IP</strong></td>
<td>Transmission Control Protocol/Internet Protocol. TCP allows a process on one machine to send data to a process on another machine using the IP protocol. TCP can be used as a full</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Telnet</strong></td>
<td>Provides virtual terminal services for a wide variety of remote systems using the Telnet protocol. The application allows a user at one site to interact with a remote system at another site as if the user's terminal were connected to the remote machine.</td>
</tr>
<tr>
<td><strong>terminal emulator</strong></td>
<td>A program that makes a PC screen and keyboard act like a video display terminal of another computer.</td>
</tr>
<tr>
<td><strong>TFTP</strong></td>
<td>Trivial File Transfer Protocol. A standard TCP/IP protocol that allows simple file transfer to and from a remote system without directory or file listing. TFTP is used where FTP is not available.</td>
</tr>
<tr>
<td><strong>token-ring</strong></td>
<td>A type of ring-shaped network that supports high-speed communications between computers. A distinguishing packet, called a &quot;token,&quot; is transferred from machine to machine. Only the machine that holds the token can transmit the packet.</td>
</tr>
<tr>
<td><strong>TSR</strong></td>
<td>Terminate-and Stay-resident. A DOS program that is loaded into memory before Windows and stays in memory until the machine is rebooted.</td>
</tr>
<tr>
<td><strong>user id</strong></td>
<td>A unique number, created by your system, that is associated with each user name on a server system.</td>
</tr>
<tr>
<td><strong>user name</strong></td>
<td>A character string, usually assigned by the system administrator that identifies a user on the system.</td>
</tr>
<tr>
<td><strong>utility</strong></td>
<td>A command or operation that works at the level of the operating system.</td>
</tr>
</tbody>
</table>
# Index

<table>
<thead>
<tr>
<th>Page</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>306</td>
<td>.CFG</td>
</tr>
<tr>
<td>171</td>
<td>/usr/spool</td>
</tr>
<tr>
<td>171</td>
<td>/var/spool</td>
</tr>
<tr>
<td>131</td>
<td>3270 Printer</td>
</tr>
<tr>
<td>101</td>
<td>3287 printer</td>
</tr>
<tr>
<td>331</td>
<td>Access account</td>
</tr>
<tr>
<td>291</td>
<td>accessing resources</td>
</tr>
<tr>
<td>291</td>
<td>on FTP</td>
</tr>
<tr>
<td>291</td>
<td>on Gopher</td>
</tr>
<tr>
<td>291</td>
<td>on Telnet</td>
</tr>
<tr>
<td>65</td>
<td>activating a script</td>
</tr>
<tr>
<td>416</td>
<td>adapters</td>
</tr>
<tr>
<td>416</td>
<td>Token Ring</td>
</tr>
<tr>
<td>274</td>
<td>adding text</td>
</tr>
<tr>
<td>209</td>
<td>address book</td>
</tr>
<tr>
<td>226</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Address Resolution Protocol (ARP)</td>
</tr>
<tr>
<td>72</td>
<td>Advanced tabs</td>
</tr>
<tr>
<td>105</td>
<td>Advanced Options</td>
</tr>
<tr>
<td>105</td>
<td>TN3270</td>
</tr>
<tr>
<td>45</td>
<td>Advanced tab</td>
</tr>
<tr>
<td>43</td>
<td>alternate gateway</td>
</tr>
<tr>
<td>313</td>
<td>anonymous FTP hosts</td>
</tr>
<tr>
<td>106</td>
<td>APA Graphics</td>
</tr>
<tr>
<td>214</td>
<td>Appending Mail</td>
</tr>
<tr>
<td>214</td>
<td></td>
</tr>
<tr>
<td>313</td>
<td>Archie</td>
</tr>
<tr>
<td>315</td>
<td>default server</td>
</tr>
<tr>
<td>316</td>
<td>retrieving information</td>
</tr>
<tr>
<td>313</td>
<td>servers</td>
</tr>
<tr>
<td>313</td>
<td>starting a search</td>
</tr>
<tr>
<td>45</td>
<td>ARP</td>
</tr>
<tr>
<td>366</td>
<td>ARP table</td>
</tr>
<tr>
<td>309</td>
<td>articles, listing and viewing</td>
</tr>
<tr>
<td>115</td>
<td>AS400</td>
</tr>
<tr>
<td>179</td>
<td>ASCII</td>
</tr>
<tr>
<td>192</td>
<td></td>
</tr>
<tr>
<td>194</td>
<td></td>
</tr>
<tr>
<td>196</td>
<td></td>
</tr>
<tr>
<td>75</td>
<td>ASCII Terminal</td>
</tr>
<tr>
<td>109</td>
<td>ASCII-EBCDIC translation</td>
</tr>
<tr>
<td>162</td>
<td>assigning exported directories</td>
</tr>
<tr>
<td>140</td>
<td>Assist menu</td>
</tr>
<tr>
<td>133</td>
<td>Associate command</td>
</tr>
<tr>
<td>78</td>
<td>Async connection type</td>
</tr>
<tr>
<td>79</td>
<td>Asynchronous Communication Settings</td>
</tr>
<tr>
<td>78</td>
<td>Asynchronous Connection Type</td>
</tr>
<tr>
<td>232</td>
<td>attaching a signature</td>
</tr>
<tr>
<td>216</td>
<td>Attachments</td>
</tr>
<tr>
<td>216</td>
<td>Attachments, sending</td>
</tr>
<tr>
<td>269</td>
<td>audio requirements</td>
</tr>
<tr>
<td>99</td>
<td>Auto Mode</td>
</tr>
<tr>
<td>340</td>
<td>Auto Start option</td>
</tr>
<tr>
<td>31</td>
<td>AUTOEXEC.BAT</td>
</tr>
<tr>
<td>334</td>
<td>automatic configuration</td>
</tr>
<tr>
<td>331</td>
<td>Automatic Internet</td>
</tr>
<tr>
<td>332</td>
<td></td>
</tr>
<tr>
<td>334</td>
<td></td>
</tr>
<tr>
<td>336</td>
<td></td>
</tr>
<tr>
<td>106</td>
<td>Autoreconnect</td>
</tr>
<tr>
<td>30</td>
<td>Banyan Vines</td>
</tr>
<tr>
<td>88</td>
<td>baud rate</td>
</tr>
</tbody>
</table>
BBS, 11, 75
binary, 179, 192, 194, 196
Binary Connection
    Serial to Telnet application, 125
Bind, 347
BINDINGS, 25
boolean, 143
BOOTP, 38, 39
Break Handling
    Serial to Telnet application, 125
broadcast, 20, 38
buffer size, 155
bulletin board service, 75

---
caching documents, 284
Capture to File, 81
carriage return, 86
Carriage-Return padding, 124
CCITT Group 3 protocol, 325
Challenge Handshake Authenticator
    Protocol, 65
ChameleonNFS, 1
    printing to a remote printer, 198
Changing and Updating Topics, Users,
    and Channels, IRC, 382
changing passwords in Mail, 233
CHAP, 65
choosing
    Internet Service, 331
clear signal
    CICS, 112
clearing data
    Telnet and ASCII Terminal, 84
client, NFS, 150
column order, changing, 9
column width, changing, 9
COM ports, 123
Command Profiles, 362
commands
    Script, 142
    Comments, 143
    community option, 369
    compact mailbox, 234
    completing draft message, 215, 216
    Compressed SLIP Protocol, 51
    Compuserve, 11
    CONFIG.SYS, 31
    CONFIG.SYS file, 24
configuration files, 8, 209
configuring the Personal Web Server, 296
Configuring your Communications
    Program for Serial to Telnet, 126
Connect command
    3270 Printer, 133
Connecting to a Host
    TN3270, 102
    TN5250, 116
Connecting to a Modem Server, 130
Connecting to IRC, 373
connection profile
    for NewtPROFS, 249
    Telnet and ASCII Terminal, 80
    TN3270, 103
    TN5250, 117
Connection Profile fields
    TN3270, 104, 118
connection types
    ASCII Terminal, 75
    Async, 75
    Rlogin, 75
contacting NetManage, 11
Control Mode, 99
controlling
    printing, 201
Conversation Profiles
    creating, 319
converting files, 157, 173
Copy and Paste functions, 82
copying messages to files, 215
Creating a New Channel, IRC, 377
creating a script, 146
creating and routing messages, 212
creating draft message, 215, 216
CSLIP, 51
CSLIP setup, 52
Custom, 16, 17, 35, 63, 64, 71
Custom Terminal feature, 61
Custom, interface types, 35
customer support, 11

dead-Lock Timer
Serial to Telnet application, 125
default caching behavior, 284
default gateway, 43
default print type, 199
Defense Data Network, 343
deleting
exported directories, 163
deleting mail, 214
deleting phone messages, 243
demonstration accounts
Internet Service Provider, 332
demos
Internet Service Provider, 332
Detect, 90
Device name
TN3270, 105
DHCP, 38, 40
Diagnostic Center, 371
Dial field, 78
Dialer, 63
dialing parameters, 89
Dialog, 145
dialog box fields, 8
dialup, 51
Dial-up Login, 70
Directory Server, 239
Disconnecting from IRC, 384
Disk list, 110
DLL, 2
DNS, 41
Document Attributes tab dialog, 290
Documents for the Web, 299
domain name, 21
Domain Name Server (DNS), 41, 347
double quotes, 144
downloading articles to local drive, 312
drawing in InPerson, 274
Dynamic Host Configuration Protocol, 38, 40

ecco Setup option, 229
echo
local, 77
Echo mode, 125
echo reply, 339
Element Attributes tab dialog, 289
e-mail, 205
empty trash, 214
emulated printer buttons, 134
end-of-line characters, 157
Entering a Message, IRC, 380
Error Codes, 143
error message
Script, 143
Serial to Telnet application, 125
escape sequence
Telnet, 124
Ethernet, 17, 35
Ethernet adapters, 416
Ethernet/DIX, 45
Ethernet/IEEE, 45
Event, 145
existing Internet account, 334
Exit on Disconnect, 106
expanded packets, 109
exported directories
assigning, 162
removing, 163
restricting access, 162
Extended Attributes, 106
Extended data stream, 105

FAX, 325
File Conversion, 111
file transfer options, 109
File Transfer Protocol (FTP), 175
files
converting, 157, 173
attributes, 156
manipulating, 155, 173
file-transfer protocols
ASCII Terminal, 80
filing mail, 209
finger, 341
flow control, 52, 55, 88
folders, 209
folders, Trash, 214
font size
Program Symbol Graphics, 106
forwarding a memo, 243
forwarding mail, 213
Frequent Destinations, 45
FTP, 175
FTP Server, 189
Function, 144
main, 144
nesting, 144

gateway, 366
alternate, 43
default, 43
Gateway tab, 44
generate mailbox, 235
Getting Member Information, IRC, 380
global variables, 144
Gopher, 327
gopher bookmarks, 329
gopher servers, 329
Graphics, 106
graphics files, 325
graphics options
TN3270, 106
group ID (GID), 160

hardware, 18
hardware requirements, 13
InPerson, 269
history buffer, 82
scrolling, 83
size, 83
HLLAPI, 102, 112, 116
HLLAPI short name
for NewtPROFS, 249
Hold button
printer, 134
host
operating system, 109
Talk, 320
host administration option, 367
Host File Format, 111
host name, 21
Talk, 320
TN3270, 102
TN52570, 116
host table, 42
Hotlist, 286
hotspots, 108
HTML, 281, 282, 295, 299
HTML Editor, 284
HTML files, 284
HTTP, 295
Hyperlink, 301
Hypertext, 281
Hypertext Transport Protocol, 295

IAC character
Telnet escape character, 124
IBM, 101
IBM 3270 keyboard, 84, 107
IBM Office Vision, 115
ICMP, 339
icons, 16, 23
importing files, 275
IND$FILE, 109
INETD, 48
initializing name, 151
inline image, 303
InPerson, 269
   hardware requirements, 269
   phone book, 271
   software requirements, 269
   starting, 270
Inquire command, 145
Installation and Setup, 13
installing windows for workgroups, 387
installing with Microsoft stack, 405
installing with multiple protocols, 27
installing with NetManage stack, 406
installing with third-party stack, 405
Interactive Log Window Feature, 61
Interface Type option, 55
International character sets, 115
Internet access account, 331
Internet address, 20, 38
Internet Control Message Protocol (ICMP), 339
Internet Relay Chat, 373
Internet Service Provider choosing, 331
   connecting, 334
IP address, 23, 38, 43, 102, 116
   available and reserved, 20
   entering, 20
IP address in SLIP, 69
IP Configuration tab, 38
IP/UDP bootstrap protocol, 39
IRC, 373
ISDN, 13, 35
ISDN interface, 18
ISDN.INI, 16, 18
Telnet, 93

Key Mappings, 120
   Telnet and ASCII terminal, 85
   TN3270, 84, 107
   keyboard, 85

Label, 142
LAN Manager., 24
LAN support, 28
license violation, 10
line feed, 86
line mode, 77
Line Printer Daemon (LPD) protocol, 197
Line Printer Remote (LPR) protocol, 197
list articles, 309
list box
   connection profile, 80
local user name, 78
logging into Mail, 208
login
trouble with, 113
Login Script, 95
Logout Script, 95
loopback, 20, 38
LPD, 197, 203
LPR, 197
LPR query commands, 202
LU name, 105

Mail
address book, 226
advanced options, 222
deleting, 214
filing, 209
folders, 209
inserting, 225
personal settings, 209
replying to and forwarding, 213
setting preferences, 230
signatures, 232
suggestions, 221, 222
timing parameters, 233
troubleshooting, 237
Mail Administration, 234
Mail and Mail Administration, 205
Mail setup, 205
Mail, viewing, 211
MAIL.CFG, 209, 237
mapping, 174
Maximum string length, 144
member window, 270
merge two mailboxes, 234
Method
dailing, 89
Microsoft LAN Manager, 27
Microsoft Window for Workgroups, 30
MIME, 205
MLID, 412, 416
modem, 89
model, 89
Modem Server application, 129
Modem tab, 56
modems, 129
modifying document styles, 288
modifying existing scripts, 67
monochrome terminal emulation, 115
More button, 79
TN3270, 105
MOSAIC.INI, 291
mount
network drive, 153
MultiLAN, 168
MULTILAN.DRV
primary or secondary network, 392, 397
Multiple Link Interface Driver, 412

Name Resolution tab, 41
Name Resolver, 353
National Character Set, 87
navigating the Web, 285
NCSA MOSAIC.INI file information, 291
NDIS, 1, 2, 24, 26, 27, 387, 393, 411
NET.CFG, 22, 25, 410, 412
NETBIND.COM program, 24
NETBUI protocol, 27
NetManage
phone numbers, 11
Netscape, 291
network adapter, 1
Network Device Interface Specification (NDIS), 1
Network File System Protocol (NFS), 149
Network Information Center, 343
Network Information Service, 21
network printer, 132
network printing, 163
Network Virtual Terminal (NVT) mode
TN3270, 101
news articles, reading, 308
newsgroup types, 305
newsgroups, subscribing, 307
newsgroups, unsubscribing, 308
NEWT, 1, 26, 63, 74, 340, 365
NEWTCal, 263
  deleting appointments, 266
  modifying appointments, 266
  responding to requests, 266
  scheduling appointments, 264
  setting preferences, 264
  viewing, 264
NEWTNews, 305
NewtPROFS, 249
  configuration, 260
  starting, 249
NEWTScan, 277
NEWTShooter, 9
NEWTSound, 337
NEWTTrace, 371
NewtView, 325
NEWTWatch, 371
NFS, 149
  mount options, 155
  user list, 160
NFS client, 150
NFS Utilities, 173
Nicknames
  NewtPROFS, 255
NIS, 21
NIS domain name, 355
NIS map entries, 355
NIS map entry, 355
NIS server name, 356
NIS user list, 161
NISLookup, 355
NMODI, 415
NMODI driver, 410
NMODI.COM, 410
Novell, 30, 401
NRC replacement, 87
null-modem, 56
numeric constant, 142
numeric expressions, 143
numeric variable, 142
  initial value, 144
NVT mode, 77

—O—

Obtaining
  NIS user list, 161
ODI, 1, 13, 22, 25, 409
ODINSUP, 413
OEM for NDIS, 407
OEM for ODI, 407
Offline option, 225
OLE, 290
ONC RPC/XDR, 6
online help
  TN3270, 101
Open Data-Link Interface, 409
operating system
  host, 109
Original Equipment Manufacturer, 407
overriding default caching behavior, 285
overview, 1

—P—
PAP, 64
Parameter
  Script, 142
Password Authentication Protocol, 64
PC ANSI keyboard, 85
PC NetTime, 349
PCCONFIG, 30
PC-NFSD, 152, 154, 170
Personal Web Server, 295
phone book
  InPerson, 271
phone numbers
  NetManage, 11
Phonetag, 241
Ping, 170, 237, 238, 339
pinging, 339
pMail, 249
Point to Point Protocol, 51
POP2, 205, 237
POP3, 205
port, 113
Portmapper, 159
Post Office Protocol, 205
posting articles, 311
PostScript format, 200
PPP, 35, 51
PPP setup, 52
Preparing your machine, 129
primary interface, 45
print
  status, 201
print file, 136
Print Mode, 98
Printer application, 131
Printer Configurations, 132
printing
  to a remote network printer, 198
printing a scanned document, 279
printing from within an application, 198
printing problems, 167
printing Web documents, 290
Program Symbol Graphics, 106
progress box, 111
Protocol Manager, 24
PROTOCOL.INI, 25, 31
protocols, 39, 45
Provider
  Internet Service, 331
PSI, 51

-Q-
  Quiet, 111
Quote command
  Archie, 317
quotes, 144

-R-
  RARP, 38, 40
  R-Commands, 357
rcp command, 359
reading news articles, 308
Redirecting COMM Ports, 123
Redirection of COMM Ports
  removing, 126
Registering, 334
registration card, 11
Regular expression, 314
rem, 143
remote login, 78
remote machine, 78
Remote Monitoring, 371
remote user name, 78
removing
  exported directories, 163
Removing or Banning Users from a
Channel, IRC, 383
replying to mail, 213
Reset key, 113
restricting
   exported directories, 162
Result Code, 143
Retries
dialing, 89
Retrieving Information
   Archie, 316
retrieving message headers only, 222
Reverse Address Resolution Protocol,
   38, 40
RFC 1041, 101
RFC 1647, 101
Rlogin, 75
route entries, 73
route table, 366
routing hubs, 77
Routing Slip feature, 212
RPC-SDK, 6
rsh command, 360
Rsize, 155

—S—
saving a scanned document, 278
scanning a document, 277
Screen Mode, 98
script
definition and components, 141
syntax, 142
template, 146
script components, 141
Selecting COMM Port Numbers
   Serial to Telnet application, 125
selecting preferences, 243
sending draft message, 215, 216
sending mail, 253
Serial Line Interface Protocol, 51
serial number, 10
Serial Port Diagnostic, 90
Serial to Telnet
application, 123
server printing, 165
Service Provider, 331, 334
Session Manager, 137
session short name, 102, 116
Setting IRC Preferences, 377
setting Mail preferences, 230
setting preferences, NEWTNews, 312
setting up mail, 205
short cut menus, 287
signing up
   Internet Service, 331
Simple Mail Transfer Protocol, 205
Simplified Mode commands
   VSE, 139
SLIP, 17, 35, 51
SLIP interface, 70
SLIP scripting, 65
SLIP setup, 52
SLIP/PPP/CSLIP script example, 65, 66
Smart Buttons, 8
Smart POP, 222, 223
   retrieving message headers, 224
   retrieving entire messages, 225
   retrieving message headers, 223
SMTP, 205, 237
SNMP, 365, 366, 371
SNMP agents, 366
SNMP table, 366
socket table, 366
Software Description Database, 315
software requirements
   InPerson, 269
sorting fields, 232
sound file, 337
Starting
   InPerson, 270
starting applications, 7
status
  print job, 201
Status Bar, 8
string constant, 142
string variable, 142
  initial value, 144
subnet bits, 20, 38
subnet mask, 20, 38
subscribing to newsgroups, 307
Suggestions, 221, 222
support, 11
syntax
  rules, 143
  script, 142
SYSTEM.INI, 25

—T—

tabs
  Advanced, 45, 72
  Gateway, 44
  IP Configuration, 38
  Modem, 56
  Name Resolution, 41
Tag-It!
  forwarding messages, 246
  preferences, 247
  sending messages, 245
Talk, 319
  ending conversations, 323
  exiting, 323
Telnet, 75
  keymappings, 85
Telnet Connection settings, 77
Telnet connection type, 76
TELNET.EXE, 23
terminal emulation
  serial, 123
Terminal Emulators
  viewing session status, 137
terminal types supported
  Telnet and ASCII Terminal, 75
termination characters, 157
Text Editor, 284
text string, 142
third-party stack option, 405
Threading, 308
Timeout, 109
dialing, 89
timer
  Serial to Telnet application, 125
timing parameters, 233
Title, 106
TN3270, 101
  Advanced Options, 105
  connecting to a host, 102
  connection profile, 103
  Connection Profile fields, 104, 118
  Device name, 105
  features, 101
  graphics options, 106
  keymappings, 84, 107
  More button, 105
  transferring files, 108
  Troubleshooting, 112
TN3270E, 105
TN3270E server, 133
TN3270E standard, 101
TN5250, 115
  connection profile, 117
  features, 115
Token Ring, 17, 35
  adapters, 416
Toolbar, 8
  transfer program name, 109
Transferring Files
  TN3270, 108
  TN3270 options, 109
Translation Table, 109
trap administration option, 368
Trash folder, 214
Trivial File Transfer Protocol (TFTP), 193
Troubleshooting
  script, 147
  TN3270, 112
  TN5250, 120
Troubleshooting in IRC, 384
troubleshooting, NFS, 170

—U—
UDP/IP, 38
UMASK, 157
Uniform Resource Locators, 282
UNIX commands, 357
unmount
  network drives, 154
unsubscribing newsgroups, 308
updating draft message, 215, 216
Upgrade Installation, 22
URL, 282, 283, 284, 288, 292
Usenet, 305, 311
user ID (UID), 160
User list
  NIS server, 161
using dialup protocols, 51
Using Filters, IRC, 381
Using IRC, 379
  using routing, 71
uudecode, 219
uuencode, 219

—V—
Verbose, 341
video requirements
  for InPerson, 269
viewing and saving file attachments, 217
viewing articles, 309
viewing mail, 211
viewing phone messages, 243
viewing routed messages, 213
visual script editor, 139
visual script player, 139

—W—
Web, 295
  setting up your own, 296
WebSpider, 299
WebSurfer, 281, 282, 286, 291
  launching other applications, 290
  NEWTNews, 290
  short cut menus, 287
WhatIs, 316
whiteboard, 270
Whois, 343
WIN.INI, 24
window display, 113
Windows for Workgroups, 387
Windows Terminal application, 123
WINSOCK error message
  Serial to Telnet application, 125
Wsize, 155
NetManage Inc. welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? if so, where?

If you find any errors or have any suggestions for improvement, please indicate the topic, chapter, and page number.

Please mail or fax your comments to:

Technical Publications, NetManage Inc.
10725 N. De Anza Blvd., Cupertino, CA 95014, USA

Phone: (408) 973-7171 Fax: (408) 972-8272

e-mail: doc@netmanage.com

If you would like a reply, please give your name, company name, address, and telephone number below. We are committed to responding promptly to your suggestions.

We are grateful for your assistance.